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Introduction

t may be hard to remember, or it may seem like only yesterday, but

some years ago, the personal computer was introduced. The rise and rise
and rise of the personal computer — with maybe an occasional stumble but
never a real fall — seemed certain to be the most important social and tech-
nological event at the end of the twentieth century. From the “two Steves” —
Wozniak and Jobs — and their Apple II, to Bill Gates’s Windows 95, it seemed
nothing could ever be bigger, or more life-changing and important, than PCs.

But people do talk. In fact, talking is one of the main things that people are
all about, and in the beginning, the personal computer didn’t let you interact
with others. However, first with modems, and then with networks, and
finally through their combination and culmination in the Internet, personal
computers became the tools that opened up a new medium of communica-
tion. The most visible and exciting part of the Internet is the World Wide
Web. Now communication, not computation, is the story. Computers are still
important, but mostly as the means to an end; the end result is to enable
people to interact.

If the most exciting channel of communication is the Web, the means of
communication is the Web page. Ordinary people demonstrate amazing
energy and imagination in creating and publishing diverse Web home pages.
And although ordinary people have a desire to create Web pages, businesses
have a need to set up shop on the Web. So the rush to the Web continues,
often with the same people expressing themselves personally on one Web
page and commercially on another.

So you want to be there, too. “But,” you ask, “isn’t it difficult, expensive, and

complicated?” Not anymore. As the Web has grown, easy ways to get on the
Web have appeared. And I discuss the best of them in the pages of this book.

About This Book

It’s about 340 pages.

Seriously, what do you find here? Easy ways to get published on the Web for
any kind of Internet user we could think of. Quick ways to get a blog, photos,
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or videos online. Ways to make your first Web page rich with carefully
arranged text, graphics, and multimedia, plus the information you need to go
beyond your first Web page and create a multipage personal or business Web
site. And free online tools, which we describe in the book, to help you go as
far as you want to go in creating a Web site.

Foolish Assumptions

<WE CD

A\

Lots of good information is in this book, but almost no one is going to read
every word of it — except our long-suffering editors. That’s because we cover
Web page topics from beginning through intermediate levels, including how
to publish a Web page via Google, how to use several different tools, and
some Windows-specific and Mac-specific stuff. No one needs to know all of
that! But anyone who wants to get a Web page up on the Web does need to
know some of it.

But what do you need? We assume, for purposes of this book, that you have
probably used the Web before and that you want to create a Web page. We
further assume that you are not yet a Web author, or that you're fairly new
to the process. To use the information in this book, here’s what you need:

v Access to a personal computer, preferably one running Microsoft
Windows XP or Vista.

The CD-ROM only works with Windows. If you have a Macintosh or a
Unix/Linux system and an Internet connection, much of this book
works for you as well, but you won’t have access to the tools on the
CD-ROM, nor to most of the online service or Web-page creation
tools that we describe, except those available directly to your user
community on the Web.

v Access to the Web — either through an online service or an Internet
service provider (ISP).

v You should be running a Web browser such as Microsoft Internet
Explorer, Firefox, or a browser provided by an online service.

v You should already have spent at least some time surfing the Web, or
be willing to do so as you gather information and examples for your
Web page.

In other words, if you're wired, or willing to get wired, you're in. With that,
the door to this book is open to you, whether you want to create your first
Web page or add new features to one you already have.

The figures in this book show up-to-date Windows screen shots for a
consistent appearance. We wrote most of the instructions and steps in this
book to work equally well for Windows and the Macintosh, though the
CoffeeCup instructions are for a program that runs only on Windows.
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Conventions Used in This Book

When our publisher first told us that this book was going to have conven-
tions, we got out our silly hats and our Democratic and Republican
paraphernalia, but apparently she just meant that we had to be consistent.
The conventions in this book are standard ways of communicating specific
types of information, such as instructions and steps. (One example of a
convention is the use of italics for newly introduced words — as with the
word “conventions” in the first sentence of this paragraph.)

Here are the conventions for this book:

v Things that you, the reader, are asked to type are shown in bold.
1 New terms are printed in italics.

v Information used in specific ways is formatted in a specific typeface. In
this book, one of the most common kinds of information displayed this
way is HTML tags; that is, formatting information used to create Web
pages (see Appendix B for a more complete definition). An example of a
tagis <title>.

We also use a special typeface for URLs (Uniform Resource Locators),
which are the addresses used to specify the location of Web pages. For
example, the URL for the For Dummies Web site is www . dummies . com.

v The Web is fast-paced and evolving. By the time you read this book,
some of the URLs listed in it may have changed.

1 Representative browser versions appear among the figures.

v Menu selections look like this: File=>Save. This particular example means
that you choose the File menu and then choose the Save option.

v Related, brief pieces of information are displayed in bulleted lists, such
as the bulleted list that you're reading right now.

+* Numbered lists are used for instructions that you must follow in a
particular sequence. This book has many sequential steps that tell you
just how to perform the different tasks that, when taken together, can
make you a successful Web author.

To make the steps brief and easy to follow, we use a specific way of
telling you what to do. Here’s an example of a set of steps:

1. Start your Web browser.
2. Go to the Web site www. tryfreestuff.com.
Note: This site is not real, just an example.

3. Click the link that matches the type of computer you have:
PC, Macintosh, or Unix.
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Part-y Time: How This Book Is Organized

We wrote this book to a carefully plotted, precise, unvarying plan, with the
predictable and predicted result: the book you’re holding in your hands now.

Wait a second. Isn’t it true that the Web is changing every day, that Web sites
appear and disappear like so many jacks-in-the-box — or whack-a-moles, if
that’s a more familiar example to you — and that Web companies can pop
into and out of existence in a few weeks? So, what was that about a plan?

Well, okay, we did change things a little along the way. Maybe a lot. But we
did have a plan behind the book, even if it was finalized in a conference

call at 5:00 this morning. The following sections explain the parts that make
up the book.

Part I: Create a Web Page Today

You probably want to dive right into becoming a Web publisher. So we start
the book with some ideas about what to do in your Web site, and then give
specific instructions on how to get your first, simple Web page up. You can
start with Google Page Creator and get a firm handle on designing your Web
page, no matter what tools you use.

Part II: Getting the Content Right

What goes into your Web page is the core of your efforts, and you can use
newer, social-networking tools to work with all the different kinds of content
you might want. For example, consider creating a blog to help you generate
interesting text, using Flickr and YouTube to post interesting photos and
videos, and more.

Part I11: Your Site in WYSIWYG

CoffeeCup HTML Editor (and its many younger brothers and sisters) has
been around for years, quietly getting better and better and more and more
numerous. CoffeCup is a What You See Is What You Get, or WYSIWYG, tool
that helps you work on a screen that looks like your Web page and handle
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many of the messy HTML details for you. This book includes the excellent
CoffeeCup Editor trial software so you can get started today. Now I'm
including CoffeeCup tools in this part of the book and on the CD-ROM. If
you’re running a Windows PC, fire it up and go to town!

Part 1U: Your Site in HTML

Many Web developers don’t want to use a tool, even a cool one like
CoffeeCup HTML Editor, at least at first. They want to dive right into the
“bare metal” approach and work with HTML in a text editor. I'm a bit

like that myself, and no Web author ever suffered from learning HTML too
well. Here’s where you can develop your skills.

Part U: The Part of Tens

A Top Ten list is a great way to make complex information fun and easy to
remember. My Top Ten lists show you key dos and don’ts of Web publishing
and more.

Part UVl: Appendixes

Appendixes in books are usually like appendixes in people: funny little things
that get taken out of the patient in a hurry if they act up. But for this book, |
pack in great information that can really help you. In Appendix A, a glossary
defines Web publishing terms that may be confusing to you. In Appendix B,
you get a comprehensive — yet brief — guide to HTML tags, the most basic
tools that developers use to create today’s Web sites. Appendix C tells you
about the CoffeeCup programs on the CD-ROM.

Icons Used in This Book

All Dummies books include icons that point you in the direction of really
great information that’s sure to help you along your way. Here I briefly
“\QN\BEH describe each icon used in this book.
<
&
Marks information that you need to keep in mind as you work.
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QNING/

Points to things you may want to know but don’t necessarily need to know.
You can skip these and read the text, skip the text and read these (if you're
into geek-style light reading), or go ahead and read both.

Designates the tools included on the CD-ROM.

Flags specific information that may not fit in a step or description but that
helps you create better Web pages.

Points out anything that may cause a problem.
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Create a Web
Page Today

The 5th Wave By Rich Tennant
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“Great goulash, Stan., That veminds me, are
gou still scripting your own Web page?”
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In this part . . .

ump right in with simple Web page publishing. Decide

what to put on your page, and then use a simple Web-
based service to get it online today. Make your page look
good. Your reward: Telling your friends, family, and col-
leagues your Web address tomorrow!
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Chapter 1

Web Publishing Basics

In This Chapter
Getting started with Web publishing
Putting together a Web page the easy way — and the easier way
Examining types of Web sites
Reviewing Web page guidelines

Tle Web is an incredibly easy way to get your message — any message —
out to anyone in the world who’s interested in it. By putting up a Web
page you can stay in touch with friends and family, entertain people, help
yourself get a job, or help yourself do your job. You can start a business,
grow a business, or just have fun expressing yourself.

Having a Web page is also ever more important as social networking and
online selling sites — eBay, MySpace, Facebook, YouTube, Flickr, and many
others — continue to grow. You need a base that establishes your online
presence, and any online commercial interests you have, across all the
“walled gardens” that each want you to spend all your online time within
their boundaries.

Nearly a million people have purchased this book since its first edition more
than ten years ago; my readers have used every technique I describe in this
book — and more — to get their first Web pages up and running. By reading
this book, you're starting on a path that many, many people before you have
followed to Web-page success.

Web Basics 101

You may have begun using the Internet and the Web without really getting a
chance to learn how they work. Knowing how they work can help you
become a better Web publisher and Web user. Here’s a brief, to-the-point
description. For more information, you can search the Web; the World Wide
Web Consortium site at www.w3 . org is a good place to start. (Start with the
HTML section.)
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Understanding how the Web works

The Web, formally called the World Wide Web, is a collection of a bunch of
text and graphics files (plus some other stuff) that make up Web pages. Web
pages are combined into linked sets of pages called Web sites. People often
use the term interchangeably, but technically, a Web page is a single HTML
text file, possibly with one or more graphics and other features added; a Web
site is one or more Web pages linked together. These terms will be explained
further later in this book.

Underlying the Web is the Internet. The Web depends on the Internet to con-
nect its many files together and to allow people to get to the Web. E-mail is a
separate function that also depends on the Internet. And FTP (file-transfer
protocol) is another Internet capability, used to move files from one
computer to another.

The Web is defined by two specifications: HyperText Transfer Protocol
(HTTP) and HyperText Markup Language (HTML). The underlying idea behind
the Web is hypertext — text that can contain links to other pieces of text and
other files, such as graphics files, stored anywhere on the Internet. The Web
got its name from the way all the links connect the pieces of text together like
a huge spider’s web.

You look at Web pages by using a program called a Web browser. A Web
browser uses HTTP to request a Web page from a Web server. The Web
page, in turn, uses HTTP to request any other files, such as graphics

images or ads, that are part of the Web page. After you request a Web page,
your Web browser pulls the files that make up the Web page from one or
more Web servers and assembles those files into a single page displayed on
your screen.

The most popular Web browsers are Microsoft Internet Explorer; Mozilla
Firefox (the successor to the once all-conquering Netscape Navigator);
Opera, a standards-compliant Web browser from a small company; and
Safari, Apple’s browser for Macintosh computers.

After a Web browser requests a Web page using HTTP, HTML steps in. Each
Web page has as its core a text file written in a format called HTML (for
HyperText Markup Language), which usually includes links to one or more
graphics files. HTML defines a Web page’s appearance and functionality.
Actually, HTML doesn’t precisely specify the Web page’s appearance:
Different Web browsers display various HTML commands differently. Also,
users can specify how they want things to look on their own screen. So what
one user sees when she looks at a Web page may be different from what
another user sees. (Part IV goes into detail about HTML.)

Getting a Web page up on the Internet is surprisingly easy. In fact, if you're in

a hurry, you may want to go straight to Chapter 3 to use Google Page Creator.
Follow the instructions there to get your first Web page up in about an hour.
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Getting Webbed

This book talks a lot about the Web, but doesn’t
discuss how to get on the Web as a user.
Even if you're on the Web already, perhaps
through a connection at work, you may also
want to get on the Web from home. How do you
do that?

There are a wide variety of broadband
offerings — some tied to cable TV or satellite
TV services, others to phone offerings, and
even a few to mobile phones. There are
wireless hotspots that may give you inexpen-
sive (or even free) Internet access. And yes,
there are still some dialup — that is to say,
slow — offerings left.

The most popular online service is still America
Online (AOL). AOL has robust Web-publishing
features, coverage around most of the world,
good spam blocking, kid-safe controls, and
many other good features. However, it tends
to be expensive, and is gradually losing
subscribers.

It's quite likely that your Internet service
provider, whether it's a big name (such as AOL
and MSN) or a little guy, offers you space for
your Web site — and perhaps helpful support
services as well. Check your ISP’s offerings
as you decide how to get your first pages up on
the Web.

Chapter 1: Web Publishing Basics

Getting up URL-y

The Internet is the giant computer network that connects other computer
networks around the world. At its base, the Internet is just a giant mechanism
for moving files from one computer to another. It finds files by using a kind

of address called a URL (Uniform Resource Locator — which sounds like
something the Army invented to track down clothes!). The acronym URL is
usually pronounced “you are ell,” although some pronounce it “earl.” Most
people today use the term “Web address” or “Internet address” instead of
“URL,” but as a Web publisher you should know all of the terms.

The address that you type to get to a Web page is a URL. For example, www .
dummies . com is the URL for the For Dummies site. A URL consists of three
parts (see Figure 1-1):

v Protocol: The name of the communications language that the URL
uses: HTTP (used on the Web), HTTPS (for secure Web pages), FTP,
and so on.

+»* Domain name: The name of the server the file is on, such as
dummies.com.

1+ Pathname: The location of the desired file on the server.
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|
Figure 1-1:
URL-yto —~=€—Protocol—»= ~=—Domain name —3» ~«—Pathname —»
Web, URL-y http:// www.server.com/ folder/filename.ext
to rise.
|

The “For Dummies” Way
to Web Publishing

Reading this book is going to make you a Web publisher — because anyone
who puts up even a single, simple home page is a publisher on the World
Wide Web. Congratulations in advance!

Because there’s so much you can do on the Web these days, including on
social networking sites such as YouTube (for videos) or Flickr (for photos), |
have split the description into two basic pieces: getting your content
together (Part I) and getting it up on the Web (Part Il or Part IV). Part III
describes how to get your Web page up using the tool included with this
book, CoffeeCup; Part IV describes how to “go to the bare metal” (well, the
bare fiber-optic cable) and use HTML directly.

Given the many ways you can work, and the way different Web sites and
different tools handle some of the process for you, but not all of it, it’s
important to understand the underlying steps that define Web publishing.
The steps may have different names, or be intermingled with each other, but
they’re always basically the same. Here they are:

1. Create the HTML text file that’s the basis for your Web page.

2. Create or obtain the graphic images you’ll use to spice up the
appearance of your page.

3. Create a link to the graphics in your HTML text file so they appear
where you want them to.

. Preview your Web page on your own machine.
. Find Web-server space.
. Transfer the HTML text file and the graphics files to the Web server.

N S G e

. Check that your new Web page works correctly now that it’s online.

If you use an easy-to-use tool such as Google Page Creator (see Chapter 3),
the steps given here are combined and most of the details are handled for
you. However, it’s good to know what’s happening “behind the scenes,” to
help avoid problems or to help you tackle a more complicated site later.
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Web terms to know

To clear up how | define and use some Web
terms, here's a brief primer:

v Web page: A text document that is

published on a Web server, has HTML tags
init, almost always includes hypertext links,
and usually includes graphics. When you
click the Back button in your Web browser,
you move to the previous Web page that
you visited.

Web site: A collection of Web pages that
share a common theme and purpose, and
that users generally access through the
site’s home page.

v Home page: The Web page that people

generally access first within a Web site.
You let people know the URL (address) of
your home page and try to get other Web
page creators to provide links to it.

HTML tags: Brief formatting or linking
commands placed within brackets in the
text of an HTML file. For instance, the <b>
tag tells the Web browser to display text
after the command in bold type; the </b>
tag turns the bold off. (See Part IV for more
on HTML.)

\\3

These steps are usually simple if you're creating a basic Web page. However,
they do get more complicated sometimes, especially if you're trying to create
a multipage Web site. This book tells you several different, easy ways to get
content up on several different kinds of sites or create a Web page, and gets
you started on expanding your Web page into a multipage Web site.

When you create a Web page that has complex formatting, or that mixes text
and graphics, you'll want to test it in the most popular Web browsers. You
should download Microsoft Internet Explorer, the America Online client, the
Firefox browser, the Opera browser, the Safari browser, and/or other tools.

For an example of a good-looking Web page, check out the For Dummies
home page, shown in Figure 1-2. It has an attractive layout, interesting
information, and links to a great deal more information on the For Dummies
site and other sites. The For Dummies Web site is professionally done, but
you too can achieve good results with a reasonable amount of planning
and hard work. In this book, I concentrate on helping you create a simple,
individual Web page and combining several Web pages into a closely linked
group of pages called a Web site, such as the For Dummies site.

Note: The For Dummies home page is shown in Microsoft Internet Explorer,

the most popular Web browser. For consistency, I use Internet Explorer for
most of the Web-page images in this book.
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Making simple things simple

If all you want to do is create a simple “I exist” Web page, either for yourself
or for your business, you don’t have to go through the rigmarole of figuring
out HTML or learning a tool, finding server space, and so on. Chapter 3 helps
you use Google Page Creator, a tool from the leaders in Web search, Google.
To see how easy publishing on the Web is, just turn to Chapter 3 and get
started. You'll be a Web publisher with just a couple of hours of effort.

Making difficult things possible

If you want to concentrate on one type of media at a time, Chapter 4 talks
about writing words for the Web and shows you how to create a blog;
Chapter 5 talks about creating images, especially photos, that are online-
ready, and tells you how to manage photos on Flickr; Chapter 6 discusses
making sound files and tunes Internet-friendly, and how to get a tune up on
MySpace; and Chapter 7 focuses on videos — how to trim their massive
storage requirements and get one up on YouTube.
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Seeing HTML

When Tim Berners-Lee invented HTML at CERN
(the European particle-physics research facil-
ity) in the late 1980s, he probably never imag-
ined that so many people would be interested in
seeing it. Today, most browsers include a
command that enables you to see the actual
HTML source instructions that make the page
look and work the way it does.

For example, in Internet Explorer, choose
Viewr>Source to view the underlying HTML file.
You see all the HTML tags that make the Web

some HTML pages are “cleaner” and easier to
read and understand than others. Keep looking
until you find some pages that make sense
to you.

After you open the HTML file, you can edit the
text and the HTML tags, save the file, and then
open the file again in your browser to see how
it looks with the HTML changes. Don't publish
someone else’s page, of course — but other
than that, experimenting in this way is a good
way to learn.

15

page look and act the way it does. However,

Part Il — Chapters 8 through 11 — shows you how to use the CoffeeCup
editor to pull your content together into a Web site. Part [V — Chapters 12
through 15 — shows you how to do the same in “pure” HTML.

Types of Web Sites

The Web offers examples of nearly every communications strategy known to
humanity, successful or not. But not every example of a Web page that you
find online applies to your situation. For one thing, the resources of different
Web publishers vary tremendously — from an individual putting up family
photos to a large corporation creating an online commerce site. For another,
several different types of Web sites exist, and not every lesson learned in
creating one type of Web site applies to the others.

The major types of Web pages are personal, picture, topical, commercial, and
entertainment sites. Increasingly, you can combine different kinds of sites in
mashups — sites that combine different kinds of technologies. (The Web itself
already does that, but a mashup takes combining technologies to another
level.) In the next sections, I describe some of the specific considerations
that apply to each type of Web page and not to the others. Decide in advance
what type of Web page you want to create, and look for other pages like it
online to use as models.
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|
Figure 1-3:
Jeff Lowe
pilots the
blimp (and
posts his
résume too).
|

Personal sites

Personal Web sites can have many goals. Often, your goal is simply to share
something about yourself with coworkers, friends, family, and others.
Personal Web pages are a great way for people to find out about others with
similar interests and for people in one culture to find out about other
cultures. You can also use a personal Web site to share family photos and
events — kind of like a holiday letter that’s always up to date. Figure 1-3
shows part of the personal site of Web designer Jeff Lowe, who’s piloting

a remote-controlled blimp in the pictures. You can find the site at www.
jefflowe.com and the blimp image among the pictures at www.jefflowe.
com/site/pictures/index.php.

Creating a personal Web site is a great deal of fun and great practice for other
work. But personal Web sites are often left unchanged after the initial thrill of
creating and publishing them fades. Be different — keep your Web site
updated!

As personal Web sites evolve, their creators tend to add more information
about a single key interest, in which case the pages may become topical
Web sites (described later). In other cases, the Web site creator adds more
information about professional goals and accomplishments, in which case
the Web page becomes more like a business Web site.
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Are personal Web sites still relevant?

Most of the activity you hear about on the Web
these days relates to large, commercial sites,
political sites, advanced technical sites, and
so on. Individuals are still contributing a great
deal of content but it's through more special-
ized sites — photo sites, video sites, social-
networking sites, and so on. But these tend to
appeal to only some people rather than to
everyone.

Personal Web sites have gotten somewhat lost
in the shuffle as better-funded sites belonging
to companies and organizations get all the
attention. Never fear; personal Web sites are
still fun and easy to create. (And did | mention
that they're fun?)

Part of what's driving the continuing interest in
personal Web pages is that more and more
people all over the world have access to
the Web. (The Web passed 1 hillion users
a few years ago, an important milestone.) The
chances are better than ever that a high
percentage of your friends, family, and
colleagues can visit and appreciate your site.
So don't be put off by the tremendous growth of
business and large organizational sites on the
Web. The personal and fun side is growing, too;
it's just getting less media attention than the
commercial side.

A\

Following a few simple rules helps make your personal Web site more fun and

less work:

v What’s on first? No, no. What’s on second . . . The upper part of your
Web page — the part that appears first when you bring the page up

on-screen — needs to make the main point of the site clear. If the main

point is “you,” the first thing people see should be your name, your

photo, and links to some of the things about “you” that are in your site.

If the point of your site is a topical interest, business interest, or
professional self-promotion, the first area of the home page should

make that clear, too.

v Keep it simple. Start with modest goals and get something up on the

Web; then create a “To Do” list of ways in which to extend your site.
Consider spinning off commercial and topical pages that reflect your
desires and interests — into separate sites by topic — rather than

17

creating a sprawling personal Web site.

v Provide lots of links. One of the best ways to share your interests is to
share information about Web sites that you like, as well as books and
other resources. You can put this list on your one and only Web page or
make it a separate page that’s part of a personal Web site. If you develop
a thorough, carefully updated list of links for a specific interest area, you
create a valuable resource for others.
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QUING/ v Consider your privacy. A Web page is just like a billboard — except

Y that 1 billion or more people can see it, not just a few hundred. Don’t put
anything up on your Web page that you wouldn’t want on a billboard.
Identity thieves can do a frightening amount of damage with your full
name, your address, the name of your employer and your mother’s
maiden name. And think twice before putting up information about
your kids and other family members: You may well be willing to
compromise your own privacy, but you shouldn’t make that decision
for other people.

Picture sites

Lots of people just want to share pictures online; it’s a lot easier to share
pictures on the Web than to mail them around, or wait until you get together
with people.

You can use any of the Web-page creation tools described in this book to
create a photos-mostly Web site, although Flickr (see Chapter 5) is for this
purpose alone.

Sharing pictures is often a great joy, but also often quite boring for other
people. Here are some tips to help keep your site interesting:

v Get organized. Think about how photos are going to be organized.
Basically, your site should be like a magic photo album — with new
content at the front, and as many older photos as you want at the
back. So use the home page to highlight the new stuff, and keep the
older stuff moving back into archived folders.

+” Be a photo editor. “Less is more,” up to a point, even on sites designed
to show off the grandkids’ latest photos to proud grandparents. Usually,
one or two photos of a given spot or event, whether it’s a birthday party,
a visit to an historic site, or something similar, are enough to give a
flavor of it.

1 Watch the megabytes. Use a photo-editing program to save your files as
JPEG images with the appropriate degree of compression (Chapter 5 has
details). Even though many Web users today have broadband access,
you don’t want to freeze out the people who don’t, and even broadband
runs slowly sometimes.

* Protect your identity. Make sure not to provide identifying information
such as anyone’s full name, address, or phone number. This helps
prevent identity theft.
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Getting personal with blogs

A Web log, or blog for short, is a sort of
online diary that usually includes links to
Web sites that the user has recently found
interesting — thus the term Web log. Blogging,
or maintaining a Web log, is a whole new form
of Web publishing.

You can create a Web page or Web site that's
nothing but a blog, or combine blog content with
traditional content. Some blogs are extremely
personal — sometimes uncomfortably so. Web
logs are also used in hig Web sites, such as
major newspaper sites. In other words, Web
logs cross the boundaries between personal
sites and other categories — including the

topical and business categories — and some
of them are pretty entertaining as well!

| have the somewhat old-fashioned view that
you probably would benefit from knowing about
Web-page creation in general, not just blog-
ging, so | defer a detailed discussion of this
larger topic to Chapter 4. But if your whole
reason for wanting to create Web pages is to
create a blog to call your very own, please skip
ahead and read Chapter 4 now, and then come
back here when you want to find more about
Web pages in general.

Topical sites

That’s “topical,” not “tropical.” A fopical home page is a resource on a
specific topic. A topic can be an interest or volunteer group to which the
author belongs, in which case the page may grow over time into something
much like a business Web site. (Creating a Web site for a group is a
tremendous contribution that you can make, but it can be a lot of work;

watch what you may be getting yourself into!) Or your topical Web page can

be about any interest, cause, concern, obsession, or flight of fancy that you
have. In this sense, the Web is like an out-of-control vanity press, allowing

anyone to go on and on about anything — sometimes offering something of

great value, oftentimes not.

Making a second career out of maintaining and extending a topical Web site

is easy, but the pay is usually low. Here are some things to consider when

you create a topical Web site:

1+ What’s on first? As with a personal Web page, the title of a topical

Web page and the first screen that users see need to make unmistakably

clear the topic that the page covers. And, to the extent possible, they
must describe what resources the Web site offers about the topic.

1 Keep focused. A topical Web site loses some of its value if it goes

beyond a single topic. How many of the people who share your love for

Thai cooking also share your abiding interest in rotifers (microscopic

creatures that are too small to use in most recipes, Thai or not)? If you
have two different interests that you want to share on the Web, consider

creating separate Web sites.
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v Create a succession plan. If your Web site grows beyond your capacity
to maintain and extend it properly, find someone to help out or to take it
over. The first person you should ask about taking over is anyone who’s
complaining that you’re not extending the site fast enough! Decide what
role you can handle and then ask for help in doing the rest.

Business sites

Business Web sites, also known as commercial sites, constitute the 50,000-
pound gorilla of the Web, with a tremendous amount of time, energy, and
money devoted to them. Business Web sites cover a wide range of styles
because their goals and the expertise and resources behind them vary so
much. This book provides enough information for you to create a competent
“Web presence” site with several pages of contact and company information.
But even these kinds of sites vary quite a bit, and you need to be sure that
your company’s page is well implemented.

Figure 1-4 shows the BATCS home page I created along with my wife, Olga
Smith, a publisher and tutor. It’s created with an online tool provided by the
Web host, and is a bit “rough around the edges” from a design point of view,
but full of content useful for the purpose. Go surf around the BATCS site to
see what a site designed and implemented by someone with a job to do
(rather than all the time in the world to show off Web-design skills), looks
like: www.batcs.co.uk.

The first question to ask about a business Web site is “Who can access it?”
Some sites are intended for the World Wide Web and everyone on it; others
are on the World Wide Web but are password-protected or otherwise
restricted in access; still others are on private networks and inaccessible to
outsiders. These inaccessible networks are described as being “behind the
firewall.” Any Web page that isn’t accessible to everyone is considered to be
on an intranet, if access is limited to one company, or an extranet, if access is
limited to a group of companies that are business partners.

Despite the wide variety of business Web sites, following just a few rules can
help you create a page that meets your goals:

v What’s on first? A business Web page should make the name and
purpose(s) of your business immediately clear. Also, the site should
provide easy-to-find information on how to contact your business or
organization and what products and services it offers.

v Get the right look. Telling someone you don'’t like his Web site is like
telling him you don’t like his haircut — he’s likely to take it personally.
But an ugly Web site, like an ugly haircut, can make a permanently
bad impression. Make sure that the look of your Web site is up to the
professional standards set by other aspects of your business.
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Business and Technical Communication Services Limited, or
BaTCS, is a UK Limited company

Our vision: To become a global leader in accent reduction teaching
and training.

I | Qur mission: Empower people by helping them to improve their
communication skills.
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done' Qur competitive advantage: v
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QUING/ +* Get permission. Unless you own the business, you need to ask for
Ny permission before putting a company page on the open Web. You also
need to make absolutely sure you have the permissions you need
for any images or documents that you use before you publish your
Web page.
e\(,\s\\. STy, v~ Inside or outside the firewall? Deciding who gets access is tricky. For

example, a small amount of otherwise-closely-held information can make
a site more valuable, but the presence of confidential information also
prevents you from opening up the entire site to the broader public.
Implementing access controls can also be difficult. Investigate how to
password-protect a site, or ask a network administrator at your com-
pany whether you can physically control access. For instance, you may
be able to selectively allow access based on which network the user
connects from.

v+ Find experts. Businesses similar to yours — or even colleagues, if you're
in a large company — likely have Web sites that have a purpose similar
to yours. Look to similar sites for guidance and inspiration.
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v Monitor usage. Investing time, energy, and money in a business Web
site requires a trade-off among the Web site and other things that those
resources could go to. One of the crucial questions you may need to
answer in order to justify Web site maintenance or expansion is how
much use the site gets. Investigate ways to measure the use of your site.
A good way to start is a basic hit counter, such as the free one you can
find at the following URL: www . statcounter . com.

1 Seek out additional resources. This book focuses on hands-on creation
of single Web pages and simple Web sites. For a larger business site, you
need access to additional information to help you with the planning,
hosting, and maintenance of the site. Consider purchasing HTML, XHTML
& CSS For Dummies, 6th Edition, by Ed Tittel and Jeff Noble, for more
information on the HTML specification, and Web Marketing For Dummies,
by Jan Zimmerman (both books from Wiley), for more information on
planning and creating a business Web site with a marketing bent.

Having a Web site that’s too obviously “handmade,” rather than professionally
created, can be embarrassing for a business. However, many sites are going
“back to the future” with a simple, clean look that’s light on graphics. So how
do you decide whether to make your look fancy or simple? The best way to
get a quick reality check is to look at some competitors’ Web sites and make
sure that your initial site looks roughly as good as theirs. And remember:
Often the most embarrassing thing is having no site at all.

Entertainment sites

Entertainment is one of the top few reasons why people use the Web, and
the number of entertainment sites continues to grow. Humorous pages and
shared games on online services are now a major presence on the Web.

People have high expectations of entertainment sites — which can make
them some of the most demanding to create. Here are a few suggestions for
creating entertainment sites:

v Don’t start here. Don’t try to figure out Web publishing by creating an
entertainment site at the outset. It’s a very demanding task. Try another
type first and edge your way into entertainment.

v Keep it fresh. How funny is a joke the second time you hear it? You have
to either frequently update the content on your entertainment site, or
allow participants to provide new content through their interaction with
one another — neither option is easy.

v Push the technology. Interactivity is also key to entertainment, which
means going beyond HTML and static graphics. You probably need to
figure out and use at least one more advanced Web technology, such as
Flash, to make a fresh and interesting entertainment Web site.

www.it-ebooks.info


http://www.it-ebooks.info/

23

Chapter 1: Web Publishing Basics

\NG/
S
Is your page cybersmut?

For most Web page publishers, the best policy  Also, consider your environment — the site the
with respect to putting anything potentially content appears on. MySpace pages are full of
offensive in your Web pages is to keep your site dubious content, whereas YouTube tries to
clean. The use of gratuitous sex and violence in  keep things cleaner. A business site should not
your Web pages will simply put off many people  have anything potentially offensive. Don’t have
and put you and your Web site in a bad light. your content violate the local etiquette.

But what if the sex or violence is not gratuitous  Even this enlightened approach may not be
and is actually central to your point? Then send  enough, however. Some Web-server owners
the author and publishers your URL so that we  will drop your page if it violates their rules, and
can see it for ourselves. No, seriously: Be sure  several countries have laws that specify what
to make the first page a home page that spe- canand can't be on a Web page. Be sure to find
cifically warns readers that they may find your  out about the rules and laws that apply to you
content offensive. Doing so lets them gracefully  before you put anything questionable on your
opt out before they view whatever you show. Web page.

Q\QN. STy, 1 Let the technology push you. The technology can give you ideas that

are in themselves pretty funny. Try using Java to create a Three
Stooges-type animated routine, or use ActiveX to create a virtual-reality
environment that includes funhouse mirrors. (I describe both Java and
ActiveX in Appendix A.)

Thinking Your Web Page Through

A Web page or Web site is basically a publication, though an interactive one.
Thinking about a few simple principles now, before you start, can help make
your Web page much more interesting and useful to the people who see it.
You can also revisit this section after you put up your initial Web home page;
use these guidelines to revise your page and make it even more interesting
and useful!

Ask “Why am 1 doing this?”

Ask yourself, as you're starting, “Why am [ doing this?” (As you do more and
more work on your page, your answer to this question may come to have
some degree of profanity in it!) That is, why are you creating the page, and
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not having someone else create it for you? The answer helps you determine
some important things about the page. The following list details the most
common reasons for people to get involved in creating a Web page:

v For work: More and more people are being asked to create Web pages
and Web sites as part of their jobs; for example, they use the Web to
communicate with people inside or outside their companies. But unless
you plan to be a full-time Webmaster, you need to balance the time you
spend developing your pages with the time you spend on the other
demands of your job. Be modest in your initial goals, and keep track of
each step in creating and modifying your Web pages so that you — or
the person who takes over for you — can refer to the records later.

v For fun: Fun sites are a good thing, and they are a lot of what makes the
Web worthwhile. But if you create your site for fun, you may find time to
work on it only after you spend time on other things, such as work,
school, and time with friends and family. So don’t be too ambitious in
your initial plans, or you may take quite a while to finish and publish
your page. (Many bloggers, for one example, now feel that they need to
be online 24/7 to keep up.)

v As a career move: So you want to be a full-time, or nearly full-time,
Webmaster, blogger, or eBay seller; or you want, in some other way, to
make the Internet or Web part of your career? In this kind of situation,
you can afford to plan an ambitious Web site that uses advanced tools,
tracks usage, and otherwise gets closer to the cutting edge of the Web.
To gain experience, create your initial Web page by using the accessible
and broad-based tools and approaches I describe in this book. Then
take your page closer to the cutting edge by using the more advanced
techniques described and taught elsewhere.

1+ Who knows? As famous baseball manager Yogi Berra once said, “When
you come to a fork in the road, take it.” You may not have a specific
reason for publishing on the Web, but that shouldn’t stop you. You may
figure out a good reason after you have a little Web experience under
your belt. Start simple, so you can score an early success in getting a
basic Web page up, and then go from there.

Don’t spend too much time on design

Designing a Web page is unlike designing any other kind of publication,
because you don’t have as much control over the precise appearance of a
Web page as you do with other types of publications. Different network
connection speeds, browsers, screen sizes, and font and other settings within
a browser vary so much that users can have very different experiences with
your Web page. Some people may (for example) bring up your page on a
personal digital assistant, laptop, Web-connected TV, or mobile phone.
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Big issues for big sites

This book focuses on the needs of people who
create a single Web page or a small Web site,
and who do so on their own. Larger sites, or
sites that need to be put up quickly or changed
rapidly, need to have additional people working
on them.

If you want to create a larger site down the
road, start thinking now about what resources
may be available to putinto it. How many people
in your company or other organization work on
advertising, public relations, and marketing?
How many people question whether those jobs
are real work? (Just kidding — the author is a
marketer, among other things!)

You may reasonably expect your company to
re-target some of its advertising, marketing, and
PR resources to support a presence on the
Web. And what about sales? Some portion of
your company'’s sales effort is likely to be or
become Web-based, necessitating a suitable
up-front commitment to bring returns down
the road.

Or your company may already suffer from Web
burnout. Classic symptoms of Web burnout

include massive early investment to create a
beautiful site, months of failure to update or
maintain the site, followed by finger-pointing
about who wasted all that money. Usually the
problem is that no one set goals for the site,
so no one managed the site's design and con-
struction with those specific goals in mind.
Companies often designate too few financial
and human resources for maintenance and
improvement of the site. If this scenario has
happened in your company, you know the prob-
lems that result, so be sure to establish clear
goals for your own Web efforts.

The most important element in adopting any
new technology for business is a successful
pilot project. As someone creating a smallish
Web site, you're developing important skills and
knowledge about the all-important conver-
gence of your business’s needs with the Web's
opportunities. Set specific goals, strive to meet
them, and record both your problems and your
successes. By doing so, you position yourself to
justify further investment of resources as the
Web grows in importance for your company.

With the latest versions of HTML, controlling more aspects of your Web
page’s appearance is possible. Advanced sites, such as amazon.com, use
many different aspects of HTML, as well as programming languages such as
JavaScript, to create dense, rich layouts more like a magazine than a typical
Web page. However, some aspects of the newest versions of HTML are not yet

standard across different Web browsers. In this book, I stick with HTML 4.0,
which works the same way for nearly all Web users.

Keep your design simple and don’t spend too much time on it initially. A
simpler design is more likely to work for everyone — and be easier to update
as well. Then improve the design as you find out more about Web publishing

and more about how people use your page.
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Put the good stuff first

Imagine the Web as a giant magazine rack and the person surfing the Web as
someone scanning the front covers of all those magazines. People who see
your Web page decide whether to stay at your site — or go elsewhere —
based largely on what they see when your page first comes up.

If your purpose is to provide information or links, put that information first.
For example, to create a site that provides information about a company,
make getting contact information — your company name, address, phone
number, and fax number — very easy. To create a personal site that is
attractive to potential employers, make clear what employment field you're
in right at the top of your Web page and make your résumé easy to access.

If your purpose is to draw people into your site to entertain them, educate
them, or expose them to messages from advertisers — or to do all of these
things at once — then the first part of the page should make a strong
impression and invite the user to go further into your site. Figure 1-5 shows
the Fabrik home page, certainly one that catches your attention, located at
the following URL: www . fabrik. com.
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But, like the Fabrik Web page, your home page also should help people who
seek a quick “hit” of information; they’re more likely to come back later if you
don’t waste their time during their first visit.

Think twice about download times

Putting lots of graphics in your pages is time-intensive for you because creat-
ing or finding good graphics and placing them appropriately in your Web
page can take a great deal of time and effort. Graphics are also time-intensive
for those who surf your site because they can take a long time to download.

Many people are ignoring this concern these days because they (and many of
their users) are on broadband, so even large images load quickly. There are
three problems with making this assumption:

v Much broadband service has inconsistencies and hiccups that slow
speeds at particular times, making that large file download crawl.

v Even a “fast” download can never be fast enough. A 3-second wait is still
annoying, and unnecessarily so if trimming the image size could have
taken the wait entirely away.

v There are still some dialup users out there, and a graphic, say, 1 MB in
size, can take several minutes to download on a dialup connection. If
you impose this wait, you can unknowingly drive some of your users
nuts and put them off your site entirely.

So plan to use spot graphics (small images that download quickly) at first.
Think twice before creating large clickable image maps or attractive opening
graphics like those you find on the sites of large companies, such as General
Motors or Apple. If you do use an opening graphic, keep the file size under
20 K or so. See Chapters 2 and 5 for details on the efficient use of graphics,
whether they’re design elements on your site or stored photos on Flickr.

There has been a good deal of coverage in the computer press, and even in
mainstream newspapers and news magazines, about ongoing efforts to make
faster access available to ordinary users. But for all the talk about cable
modems, Digital Subscriber Line (DSL), and other up-to-date techniques,
nearly half of home users in the United States are still on 56 Kbps or slower
modems — with even more dialup users in most other countries. (Business
users are typically on faster connections.) So ignore the hype — the speed at
which the average person accesses the Web is still moving upward gradually,
not leaping ahead. For now, be conservative in how much data you put in
each page, and test the download times of your pages over a modem-based
connection before you publish them.
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Know your audience

According to Web researchers, Web users overwhelmingly speak English as
either a first or second language. Consequently, the great majority of Web
content, Web creation tools, and Web browsers use the English language.
More than fifteen years after the birth of the Web — which happened in
Switzerland, where there are three official languages, none of them English —
the English-speaking world is still considered the “center of gravity” for Web
access. This situation will gradually change as other countries catch up to
Web penetration in the United States.

Why are people online? Surveys indicate that the top reasons people use the
Web are for information-gathering, entertainment, education, work, “time-
wasting,” and shopping. Which of these purposes do you intend for your site
to serve? How do you appeal to people who are online? How do you help
them find you? The answers to these questions can help you enhance the
appeal and usefulness of your site.

Finally, what kind of browsers are your users running? Surveys indicate that
over 90 percent of Web users run Microsoft Internet Explorer; most of the
rest use Mozilla Firefox. Both of these browsers (and most others that make
up the remaining user base) support graphics, tables, and Cascading Style
Sheets — an advanced layout feature. Nearly all users run their browsers
with graphics turned on (which doesn’t mean that they appreciate waiting for
complex images to load — unless those images are very cool!).

A still-small-but-increasing percentage of Web access is via “sub-PC” devices
such as advanced cellphones. That means relatively tiny screens and slow
(and expensive) connections. For more on this kind of Internet use, see Mobile
Internet For Dummies by Michael O’Farrell, et al, 2008.

Use “text bites”

As mentioned earlier in this chapter, when preparing a Web site, less is
more. Saying something with less text makes users more likely to read and
remember it. A text bite is like a sound bite — it’s a short, clearly written
piece of text that makes a single point.

Text bites are especially important on the Web because reading from a
computer screen is physically less comfortable than reading from a printed
page. People tend to end their Web sessions after too much reading. You
need to shoehorn your messages into the limited amount of reading time
people will devote to your Web site.
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Although you can overuse text bites, they're very important in Web-page
design. Text bites help you convey as much information as possible in the
limited amount of time users spend looking at each Web page. And they help
you balance the basic elements of Web page design: text, links, and graphics.

If you want to put long documents on the Web, consider rewriting them as

a series of text bites. If rewriting them is too much work to be practical, at
least create short, punchy text for navigation and for introductory paragraphs
to the long documents. Within a long document, add headers to break up

the flow of text and provide pointers on your Web site to key areas within the
document. Without such guidance, users may well give up in frustration
without reaching the information they’re looking for.

Look at sites you like

Look at sites you like and at sites whose purposes are similar to your own.
What’s good about them? What’s not? Imitate successful elements — without
copying, which would be a violation of ethics as well as copyright laws — and
avoid unsuccessful models. As the development of your site progresses, keep
checking it against the sites you previously identified and widen your search
to get additional ideas — what not to do as well as what to do.

Few original ideas exist on the Web, so it’s no big deal if your initial site
contains one or two new ideas at best. The rest of your site may echo things
readers have already seen, and you're still better off if your site brings to
mind other good sites, rather than bad ones. (But be careful: If you start
yelling “Bad site! Bad site!” at your computer screen and swatting it with

a rolled-up newspaper, you may not have a working Internet connection
much longer.)

Plan for ongoing improvements

As you plan and implement your initial Web page, you will, no doubt, find
yourself creating a “To Do” list of things that you can’t fit into the original site
but want to add later, when time allows. (Creating this list for later use is

great protection against trying to create a supersite right off the bat, getting
stuck in the creation process, and never getting to a point where you can
actually publish your first Web page.) This list is the start of a plan for ongoing
improvements.

Some things you put in a Web site need to be kept current. For example, if
your business Web page shows your company’s quarterly results, be ready
to update it quickly when the next quarter’s results come out. If it lists
company officers, update it as soon as a change takes place. (Unless you're
one of the people changed — and then it’s your successor’s problem!)
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QNING/ Web-site information that is obviously out of date is one of the quickest ways
Sy to leave a bad impression of you or your organization or company; it steers
visitors right away from your Web site. For business, an out-of-date site can
cost you customers.

Not only do you want to update the Web site, but you also want to avoid
using “Under Construction” signs and otherwise apologizing for things that
aren’t there yet. Everything on the Web is under construction, which is half
the fun of using the Web and creating pages for it in the first place. You get
only one chance to make a first impression, and an “Under Construction”
sign doesn’t count in your favor.

Decide how you define success

Before you design and create your Web page, define what you believe can
make it a success. For an initial effort, simply putting up something on the
Web that clearly conveys basic information is probably enough. You may just
need an online reference point for people who need to get in touch with you
by phone or by mail, or want to know a bit more about you or your business.

For follow-up work, get more specific. Are you trying to reach a certain
number of people or a certain type of people? Will measuring page views —
the number of times that people look at one page from your site — be
enough, or do you need some other measure of response, such as having site
visitors send e-mail or call an 800 number? Do you want to create a cutting-
edge site full of bell-and-whistle features like fancy graphics and animation —
and if so, are you willing to invest the time and money to make this site
happen? Talk to people who do advertising and marketing in the real world,
as well as to people who work on the Web; get a sense of what goals they set
and how they measure success in meeting their goals.
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In This Chapter
Getting the look
Minding the principles of good design
Circumventing design no-nos

Working with tables, frames, and layout

Tlere are two approaches to a new project — jump in and get your hands
dirty, or plan what you’re doing first. These could be called the Picard
and Riker strategies after the lead characters in the Star Trek: The Next
Generation TV show and movies.

Captain Picard, famously bald and thoughtful, always seemed to be planning
interstellar strategy, even when in the grips of the Borg or other evildoers.
Commander Riker, famously hirsute and energetic, was always anxious to
lead an “away team” into battle, blasting away more than once right on board
the U.S.S. Enterprise.

So it is in creating a Web page. If you want to have a clear idea of what you're
trying to accomplish before you start, read this chapter first. If you want to
get something done right off the bat, then go to Chapter 3, or one of the
media-specific chapters in Part II, and get something — anything — up on the
Web. Then come back here for a brief refresher on the bigger picture.

Vou Got the Look

One of the trickiest issues in creating and publishing Web pages is creating
and maintaining the overall look of each Web page. Some pages look great.
Others look okay. Still others look hokey and amateurish. And how good a
page looks varies considerably depending on who’s looking — after all,
“beauty is in the eye of the beholder.” Up to a point, anyway; some pages are
so bad, or so good, that everyone agrees on them.
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How Web 2.0 simplifies — and limits — design

Web page design is advancing with Web 2.0,
which is defined well by Wikipedia: “a trend in
the use of World Wide Web technology and
Web design that aims to facilitate creativity,
information sharing, and, most notably, collabo-
ration among users.” (From en.wikipedia.org/
wiki/Web_2.)

Web 2.0 designs actually make Web pages
simpler by taking away some power from the
user — you can't make a very useful blog in
YouTube, for instance. And people who spend a
lot of time on one type of social networking or

e-commerce site — say, Facebook or eBay —
tend not to give their blogs as much time and
focus to most other bloggers.

In Web 1.0 — what you're doing when you
create your own independent Web page — all
the power, and all the responsibility, is in your
hands. As mentioned before, a standalone Web
page of your own is great for supporting and
tying together your presence on various social
networking and e-commerce sites, serving as a
broadly accessible connecting point across dif-
ferent online communities.

You can create a first, “try it” Web page without worrying too much how it
looks. But if you're creating a Web page a lot of people will be looking at, or if
you're practicing to create a Web page for business or career use, you're

going to want it to look good. And explaining how to make a Web page look

good is hard.

The overall impression a Web page makes depends on many different
factors — the balance of white space (empty space) to text and graphics,
the size of text used, the font used, appropriate use of headings versus

regular text, and appropriate use of bulleted and numbered lists, hyperlinks,
and other eye-catching elements. Each of these factors has to be “right,” but
“right” is hard to define — you know it when you see it. All the choices you
make have to work together as a whole.

It usually takes a professional to make a Web page look really good — so at
the end of this chapter, I talk about how to get professional help for the look
of your Web page. But it doesn’t take a professional to make your Web page
look pretty good — or at least to avoid having it be out-and-out ugly. [ show
you how to make sure your Web page looks at least reasonably good in

this chapter.

Three Key Principles of Design

The design of a Web page can be most simply described as the look of the
page and how it’s perceived by the user — as attractive or unattractive, and
as easy to use or difficult to use. Design is artistic and aesthetic; getting it
right draws on people’s creativity, and judging when it’s right depends on

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 2: Designing Your Online Look

WING/

people’s individual taste. So there are no hard-and-fast rules that always yield
a good-looking design. This fact drives some people crazy, but many of the
most important things in life — like love, fine food, good wine, and good
design — don’t operate strictly by specific rules.

In years of work with the Web, I've learned many of the “tricks” of Web
design. Instead of relying on the specific and formal rules that some
professional Web designers follow, I find that following general principles
usually yields good results for smallish Web design projects. Of course, it’s
good to begin with existing models that most people agree look good, but at
carefully chosen times, it’s also good to break the rules. The design process
is a challenge to anyone’s sanity, but mixing and matching is my favored way
to consistently create designs that look good.

The design tips in this chapter are based on the author’s experience in
designing and using many Web sites, not on formal design principles.
Furthermore, my advice is just for people doing single Web pages and small
Web sites of 5 to 10 Web pages — not large sites that have to be planned
carefully from the beginning. All this means that my advice may be infuriating
to professionals — but is likely to be very helpful to people just starting out.
For detailed information about Web page and Web site design, [ recommend
Web Design For Dummies, 2nd Edition by Lisa Lopuck (Wiley) or the industrial-
strength Building Web Sites All-in-One Desk Reference For Dummies by Doug
Sahlin and Claudia Snell (also from Wiley).

The three most important principles for designing Web home pages and
small Web sites are simplicity, predictability, and consistency. It’s necessary
to follow each principle in order to also follow the others. In the next few
sections are pointers showing how to apply these principles.

Achieving simplicity

Simplicity is considered the hallmark of good design. The modern eye is
trained to look for and appreciate simple, unornamented designs. Use

the simplest design that accomplishes your task, and then figure out how
to simplify it further. For Web pages, simplicity means using as few of
everything — design elements, graphics, and text sizes — as is reasonably
possible.

Simplicity has specific advantages in Web design; in fact, the impact of
download time constraints and the differences among users’ computer
setups make simplicity a necessity. The fact that it takes time to download
each element on a Web page means that a simply designed Web page usually
loads faster than a complicated one, and users really like fast-loading pages.
(Actually, they hate slow-loading pages, but I'd rather describe the situation
in a positive way.)
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|
Figure 2-1:
The top

of a For
Dummies
content
page is
simple,
offering
tools,
navigation,
and content.
|

The differences among users’ computer setups reward simplicity as well.

One user can be looking at your Web page on a mobile phone screen; another
on a small “sub-PC” screen with 256 colors; another can be looking at it

on a large, high-resolution screen with thousands of colors. The simpler your
Web page design, the more likely the page will look about the same on all the
different computer setups out there.

To you as a novice Web-page author, simplicity is especially important. You
don’t have the hard-earned experience of having tried many things that
didn’t work. “Experience,” it’s been said, “is what you get when you don’t get
what you want.”

Novices also lack the technical knowledge to always do things right, espe-
cially when they’re trying something new and complicated. The simpler you
keep your design, the more likely you are to not mess up.

Simplicity is most important in confent pages, Web pages where the user

is reading an article or looking at a picture. The user doesn’t want to be
distracted from what he or she is doing. Figures 2-1 and 2-2 show the first
and second screenfuls of content for the table of contents of Dreamweaver
CS3 For Dummies on the For Dummies Web site. Notice how both Web pages
allow you to focus on the content.
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Producing predictability

Predictability means the user can easily guess where things are on your
Web page and how they work. In other words, one of your goals as you
design your Web page is to achieve a sense of predictability for the
content, layout, and functionality of your page when it’s compared to other,

similar Web pages.

An important reason that the Web is so popular is that Web pages nearly all
look and work alike. Web pages that go too far from the norm tend not to be

very popular with users.

Part of the reason this book is called Creating Web Pages and not Creating
Web Sites is that it’s focused on people just starting out, who are likely to
want to create a single Web page first, and then perhaps expand that page
into a small site. But another reason is that users really do experience the
Web as a series of individual Web pages. Tests show that many users aren’t
even aware, when they click a link to a different site, that they’ve left one
site and gone to a different one. People really do experience the Web one

Web page at a time.
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|
Figure 2-3:
Diagram

of a typical
article page.
|

To understand the value of predictability, imagine what a Web page with a
newspaper article on it should look like. The first thing to catch your eye may
be a picture — almost always one picture, if any. You’d also expect to see the
headline describing the article and the reporter’s byline.

You would expect to see some navigation at the top of the screen or along
the left side. You'd expect a banner ad across the top (but you’d be
pleasantly surprised if there wasn’t one). The rest of the left side would
then be empty below the navigation area. The right side may be empty as
well, or have some small ads.

On some sites you may see features, such as buttons for e-mailing and
printing the article, somewhere on the first screen. And you may also see a
box with headlines for related articles. Figure 2-3 shows a sketch of what the
major elements in an article page might look like.

Now imagine if one or more of these features was present but was imple-
mented much differently from what you’d find on other sites. For instance,
imagine that the button for e-mailing the article was labeled “Transmit
Content.” You'd be frustrated and confused. The clever person who put an
original label on the button hasn’t impressed you — he or she has just made
the page harder to understand and use.

Navigation and Branding

Navigation Banner ad Related
or? stories
. O E-mail it
Headline O Print it
Article body
Ad
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That, in a nutshell, is what predictability is about. For any Web page you
create, find a few examples of pages on the Web that accomplish something
similar to what you’re trying to do. See whether your page is similar in
content, layout, and functionality. While you’re at it, compare the simplicity
of your design to the examples you’ve seen. If your page is different,
consider modifying its design to reduce or eliminate the differences. That’s
predictability.

Creating consistency

Just as every Web page you create should be predictable when compared to
the other pages out there on the Web (see the preceding section), each page
should also be internally consistent. You shouldn’t dramatically change
fonts, text size, or layout style within a page.

If you create a multipage Web site (as described in Chapter 11, for use with a
WYSIWYG tool, and in Chapter 15 for using HTML directly), all the pages in
the site should be consistent with each other as well. Do all you can to help
users understand that they’re visiting a single, unified Web site.

If your Web pages are simple, and if they’re predictable to experienced Web
users, consistency becomes one of the easier principles to follow. Here are
just a couple of ideas that can substantially improve the consistency of a
small site:

v Use a repeated navigation block or graphic on each page in your Web
site — always in the same position on each page.

v Use a consistent background color and foreground color, the same text
size for body text, the same or similar image placements, and the same
“voice” in the site’s writing.

If you create a large Web site (over 20 pages or so), consistency becomes
more difficult. The only foolproof way to maintain a consistent approach is to
create a template for each of the different kinds of pages on your Web site:
navigational pages, content pages (with and without images), forms pages,
and so on. Every page in your site will be created from an existing template
and then customized for the specific needs of that page. Most really large
sites, such as Amazon.com, and most blogging sites automatically “populate”
templates with content drawn from a database to create each specific

Web page.

No matter what size your Web site is, the easiest way to achieve consistency
is to print out every page on the site, then compare the printed pages to
each other for consistency in style and approach. This exercise will almost
always help you find inconsistencies in design and may expose errors in
content as well.
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Avoiding Common Design Errors

Simply cruise the Web — especially areas with lots of personal pages, such
as the GeoCities site at www.geocities.com or AOL’s Hometown area at
hometown.aol.com — and you can find many examples of badly designed
pages. But what is it that makes these pages bad? Of the many design
mistakes you can make, three are common among new Web-page creators:
slow-loading pages, ugly color combinations, and small text.

Slow-loading pages

This is the number-one bane of Web-page design, whether amateur or profes-
sional. People think they’re designing a magazine and throw large, uncom-
pressed graphics around, several per page. An uncompressed screen image
of a page at 1024 x 768 resolution — the size used in the screen images in this
book — is over 2 MB in size and takes about 8 minutes to load on a dialup
connection. Imagine the uselessness of trying to view that page on your
cellphone with a slow Internet connection! The same file, lightly compressed
using JPEG compression, is only about 200 KB, one-tenth the size.

Having used large (and perhaps uncompressed) graphics, these same people
might add cute little design elements, each of which has to be sent as a
separate file by the Web server. As each of the different elements appears on
a page, if it’s not carefully designed and implemented, the page’s content may
shift and shimmy in a manner guaranteed to cause motion sickness.

If a page of yours loads slowly, check to see whether you're committing one
of two major errors:

v A lack of care with one or two individual graphics. By leaving these
graphics files large, you doom the whole page to slow loading. Use the
techniques described in Chapter 5 to make your graphics small in their
physical size on-screen as well as in their file size.

1 A profligate use of graphics in general. Highly designed pages can have
lots of little graphical elements that cause many separate file transfers
as the page loads. Unless the page is carefully designed, the page
actually shifts visibly as each graphic comes in. The overall effect can
be quite disconcerting.

Graphics not only can cause your page to load slowly — but they also take a
long time to create, tend to have copyright problems and rights issues, and
present challenging design and page-layout issues. Keep the use of graphics
on your page simple until you get really good at designing with graphics, or
until you can get help from someone who has that particular talent.
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Ugly color combinations

Many Web page publishers don’t much care if the color combinations they
use are attractive or not. Others care, but can’t critically appraise their own
work and see whether the result is ugly and/or difficult to use.

You may understand that certain color combinations can be ugly, but maybe
it seems odd for me to say that bad colors can lead to difficult-to-use pages.
The reason is that on the Web, color identifies hyperlinks; unused links and
recently used links have different colors. The standard colors for links are
blue for unvisited links and purple for visited links. If you change these
colors, or use the link colors for other purposes, your visitors have trouble
identifying which text is links, which links they’ve visited, and which links
they haven't. If you've read the section about creating predictability on your
page, you can understand just how major a sin this is!

<P If you simply must change the link colors, try to use color combinations
that are analogous to the standard ones — a lighter, eye-catching color for
unvisited links, and a dull color for visited ones. This is at least similar,
conceptually, to the standard colors. Then test the design on a few people
and see whether they can quickly figure out which links are which.

Now, back to ugly. Just because the Web makes it possible to use various
color combinations doesn’t mean you should do so. Black text on a white or
off-white background is what people are used to, and is always the safest
choice. And with this combination, the standard link colors show up really
well. You can use a graphical bar at some consistent location on the page
and add in one or two useful or interesting graphics per page to give your
Web pages a colorful, graphical look without sacrificing predictability and
readability within the body of each page.

“&N\BER A few other color combinations work fairly well, but many don’t. Remember
>J also that some users run their monitors in 256-color mode and that only 216
colors out of the 256 — the Web-safe color palette — are the same on PCs and
Macs. So a color combination that looks good on your system may look poor
on a system with fewer colors; likewise, colors that look good on a PC may
not look so hot on a Mac. Use the Web-safe colors described in Chapter 5

to choose, or cruise the Web looking for an existing Web page that uses a
good-looking Web-safe color combination; you can use the same combination
for your own site. (This isn’t stealing — there are only a few such useful
combinations, so the person you're borrowing from didn’t exactly invent the
electric blender either.)

Small text (and large text, too)

A common mistake people make is to use small text on their Web pages,
packed closely together. Small text does look kind of cool, and it allows you
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to pack in a lot of information. Because of these temptations, even large Web
sites (such as early versions of the Microsoft site) have made this mistake.
The trouble is that small text becomes very small text when viewed on a
high-resolution monitor. So small, in fact, that many of the people who visit
your Web site may not be able to read the text on your page easily.

It’s easy to believe that you’'ve packed in a lot of information when you use
small text. But communication is not a one-way street. Written information
gets communicated only if it’s read. Users will often click rapidly away from
dense screens full of text, so nothing gets communicated at all!

Less common, but equally harmful, is text that’s too large. You don’t need to
design Web pages with text that’s readable from 20 feet away. Really. (People
with true vision problems can use special options in Windows and/or their
browser to display text in extra-large size, so they have a way to read text
that starts out normal size.) Large text looks awful, especially when viewed
on a system with relatively low resolution (such as 800 x 600 pixels).

Both of these problems are made worse by the increasing tendency to embed
much of a site’s text in graphic images. This text always has a consistent
look, because it’s treated by the browser as a graphic image, but that look
can easily be too small or large. When you save text as image files, the

text can’t be resized by the browser to accommodate different browser
settings. So users can’t fix any problems they’re having with graphically
displayed text.

So what’s “normal-size” text? Glad you asked. There’s not one exact normal
size, but there’s a normal range. To find it, match the text size in your Web
page to the text size in a few Web pages you like. The current Microsoft page
is a good example; though it still uses some small text, and some graphical
text, it uses “white” space (that is, empty space) to make it all more readable.
See Figure 2-4 for an example.

Once you've compared your site’s text size to other sites’, ask several
people — not all younger and hawk-eyed, nor all older or less visually
acute — to tell you if they can easily read the text while sitting comfortably
a couple of feet from the computer monitor. If not, fix the problem before

it becomes a burden for your Web site’s visitors.

Safely Breaking the Rules

Alot of the fun in creating your own Web page is doing what you want to do
and not what someone else tells you. Yet you want your Web page to look
good. How can you create a design that you like and that also looks good to
other people?
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[ suggest you follow this five-step process:

()

. Get your Web page up.

Include the content and images you want, as I describe throughout this
book. Don’t worry much about how it looks at first. Just do it!

2. Find a model page or two that you like.

Look for pages that have a similar purpose and content. Make sure that
they have a simple, attractive appearance. See the sidebar, “Finding
great home pages,” for places to look.

3. Create a new, reduced version of your Web page, using these models

as your guide.

Get the major pieces — the main text, an image or two, and a list — in
place first. Make this basic page look good.

4. Put additional elements back in, one at a time.

By working in this piecemeal fashion, you can prevent your page from
becoming a hard-to-fix mess, while still indulging your own creativity.
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Finding great home pages

Here are several places you can look to see You can find its home page at www.
how others have designed their home pages on angelfire.com. Click in the Top
the Web: Member Pages area on the left side of the

v~ GeoCities: GeoCities is the top provider of e R U 0 s i ) sles,

home pages for the Web. From the GeoCities
home page at www.geocities.com,
you can access GeoCities Web pages in
many different categories. However, there's
no “best” or “highly rated” list to help you
find the best Web pages. You're going to
have to look at a lot of ugly ducklings before
you find a swan. And if you're looking for
unusual as well as excellent designs, you'll
see a lot of white (ordinary) swans before
you find a black (unusual) one.

Tripod: Tripod is a free Web-hosting com-
pany acquired by Lycos, a leading interna-
tional Web portal. Visit Tripod at www .
tripod.com. To see cool Lycos Web
pages, look in the Member Spotlight area in
the Member sites area. The Home and
Family area is particularly relevant for
personal home pages.

v AngelFire: AngelFire is the other free

Web-hosting company acquired by Lycos.

Hometown: Hometown is the name of AOL's
free Web-page hosting site (see Chapter 4).
You can use Hometown even if you're not
an AOL member (although only members
can use all of the AOL discussion areas and
online help that make Hometown a real
winner). The Hometown home page at
www . hometown .aol . com has a list of
the most popular categories, but you have
to search all the home pages in a category
to find the best ones.

v Homestead: Homestead no longer offers

free personal home pages — only business
pages, and you have to pay for it. But it
offers a lot of support, has some great
Web pages, and prominently features
some of its customers’ better work. Go to
www . homestead.com and look for
customers’ sites.

5. Publish the result and get comments.

Let some friends and colleagues see your newly published page, and

ask them what they think. Let the site sit for a couple of days, and then
take a fresh look at it yourself. Use your own fresh perspective and the
comments you get to improve your page further.

You can repeat this process again and again as you improve your Web page
and add new pages to create a full Web site. Work through these steps
conscientiously, and you may end up with some of the best-looking Web
pages around.
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Getting design help from the pros

The best way to work with a Web-graphic
designer, while keeping your costs under con-
trol, is to create your Web site yourself first.
Then bring in the designer just to improve the
look of the site. Improving the look of your site
may take the designer as much as a couple of
days and cost you a few hundred dollars —
money well spent, if your Web site is going to be
part of your career or your business.

The problem is that many of the designers you
might talk to will be accustomed to doing the

whole job of brainstorming your needs with you,
creating content, revising it all to meet your
needs, publishing the site, and then modifying it
for you. This kind of project could cost you
thousands of dollars — which you're going to
avoid spending by doing nearly everything
yourself for free, by using the information in this
book. The one part where you may need help is
in getting the look right, so do all the other steps
yourself and then bring someone in just for the
graphic-design piece.

Organizing Vour Page with
Tables and Frames

Tables are a layout tool for data tables on Web pages, such as a table in an
article or textbook showing the revenues of a company’s different divisions
each quarter. But the tables capability for Web pages has long been used
(misused?) to control the layout of the entire page.

Designers have found that they can make the cells of a table very large, and
put large graphics or whole blocks of text in them. You can even resize tables
automatically to accommodate various sizes of Web-browser windows —

at least up to a point. (I only touch on this advanced use of tables in this
section.)

Whether and how to use tables was, for a long time, one of the most contro-
versial topics in Web-page design (not exactly an area where controversies
have earth-shattering consequences, but we all need some excitement in
our lives).

Frames are more powerful layout devices than tables, but they have fallen
into disfavor. They allow separate parts of the Web-browser window to be
updated and scrolled separately. However, they produce odd effects; users
seem to prefer one unified window to separate “panes” within a window.
So I barely mention frames in this book.
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|
Figure 2-5:
A simple
Web table
and its
simple
HTML
source.
|

Creating simple tables

When used as intended, tables have rows and columns. For each spot where
arow and column intersect, you have a table cell. Each cell can have its own
formatting — the data in it can be aligned left, center, or right, formatted,
and so on. Tables also have header-data cells, in which you put the column
headings. Here’s the HTML code for a simple table of this type:

<TABLE BORDER=2>
<TR><TH><B>Production

(tons) </B></TH><TH><B>% of goal</B></TH></TR>
<TR><TD><I>>North 40</I></TD><TD>87</TD><TD>102%</TD></TR>
<TR><TD><I>South 40</I></TD><TD>93</TD><TD>110%</TD></TR>
</TABLE>

Figure 2-5 shows how this simple table looks in HTML and when viewed in
Internet Explorer.

Here’s what each part of the HTML code does:

<TABLE BORDER=2> The TABLE tag begins and ends the table. The
BORDER attribute creates a 2-pixel-wide border around the table. Don’t
forget to include a border, so other text and graphics in your Web page
don’t crowd too close to the table.

@ cC and Settings\Smith\My AHTML Tor Figure 2.5 him - Windows Internet Explarer
@L | = | @ Ci\Dacuments and Settings|Smith|My DacLmentsiHTML for Figure 2-5.htm > #21| K |wiey dummies P~
W | @ c\Documents and Settings\SmithiMy Docu... | fa - B v |Shrage v Tk - @~ B 3
Production (tons) % of goal
Norzh 40 |87 102%
Souri: 40 |93 110%
" HTML for Figure 2.5 - Notepad BEE]
File Edit Format View Help
<TABLE BORDER=2>
<TH><TD><B>Production (tons)</B></TD><TD><E>% of goal</B></TD></TH>
<TR><TD><I>Morth 40¢/T></TD><TD>87</TD><TD>102%</TD> </ TR>
<TR><TD><I>So0UTh 40</I></TD><TD>93</TD><TD>110%<,/TD></TR>
</TABLE>
Done ' My Computer HA00%
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<TR>, </TR> Begins and ends the table row.

<TH>, </TH> Surrounds table header data. Table header data is
automatically formatted as bold and centered.

<TD>, </TD> Begins and ends the table data item.

So creating a table in HTML is fairly simple but also fairly tedious. You just
create the rows and data items; if you get the data items right, the columns
take care of themselves.

Getting the data items right can be a problem, though. To make your table
look just right, you have to use a number of alignment and formatting
options. Making mistakes becomes way too easy, and updating the table’s
appearance becomes very hard. That’s why so many people use an HTML
editor like CoffeeCup to create and manage tables — and then, in some cases,
do final tweaking in HTML to get them just right.

Layout with tables

When tables were added to HTML, Web designers quickly figured out how to
take them to a whole other level. Imagine making a Web page one big table.
Using HTML options, you can suppress the display of the table’s cell borders.
You can thus create a large grid with invisible separation lines into which
you insert chunks of text and graphics. This allows you to create a layout
with rows and columns. You can also use tables in this fashion to make sure
that a specific block of text stays next to a specific graphic, even if the user
makes his Web text large or makes the window extra narrow.

Believe it or not, this whole use-tables-for-layouts thing was a bit controver-
sial at first. Why? Because there were some idealistic motives behind the
original design of HTML, such as ensuring that Web pages appear correctly
on just about any screen. Table-based layouts, by contrast, only work well on
screens of at least a certain minimum size, such as a PC screen rather than,
say, a mobile-phone screen.

The controversy largely faded because the people who pay for Web-site
development demand that their sites look good on most of the PCs and Macs
out there, and tables were for a long time just about the only way to create a
complex design that looks good.

For the purposes of designing your own Web page, the key word here is
“complex.” There are so many different elements that you have to adjust in
table-based page design that you need to invest a lot of time and energy to
learn how to use tables effectively for layout purposes. And then a whole
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|
Figure 2-6:
The tool
used for the
BATCS site
uses tables
to organize
content.
|

other set of issues arises about making sure your table-based page design
works well on most or all current computer systems and Web-browser
setups that are in use.

Figure 2-6 shows an interior page of BATCS. The tool I use to create BATCS
uses tables to create a simple, clean layout. Each major horizontal element is
a separate table — the navigation is one table, the first area of the content
another. Use the View=>Source or similar command in your Web browser to
view the underlying HTML source for this page to see how it’s done.

To create your own tables, you can get started by using the Insert=>Table
command in CoffeeCup. However, you really need a more advanced tool to
work effectively with tables in your Web pages — something like Microsoft
FrontPage or Dreamweaver, both of which give you more direct control
over specific options. Of course, your other option is to start doing a lot

of experimenting in HTML until you learn how to get things just how you
want them.

For details on how to use tables for layout, start with this article: www .
anownsite.com/web-design/html-tables.html.
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Friends don’t let friends do frames

Frames divide a Web page into separate areas which you can then update
individually as needed. For example, you can click a link in a frame in the
bottom half of a Web page and update it with new content while the other
frame stays unchanged. This seems like a powerful capability. However,
frames have proven to be less popular than tables.

Why are frames not as popular as tables? Well, frames are hard to create and
manage, just like tables. But advanced Web authors are willing to do just
about anything to make their Web pages more attractive and more useful,
and tables help them do so. With frames, the trouble comes with the “useful”
part; users have a hard time using framed Web pages.

For example, when browsing a framed page, users sometimes have difficulty
finding where the cursor is. If the user moves the scroll bar, which frame
scrolls? Also, going forward and backward in a frame is different from going
forward and backward in the overall Web page, so users may get lost easily.
And printing a framed page properly requires extra steps — users often try to
print the page and end up printing the contents of just one frame instead.

Finally, frames create a functional problem or two. When users resize a
browser window, framed pages don’t always resize correctly. And designing
a framed page to work well for various monitor sizes is even harder than
correctly designing pages with tables embedded in them.

Usability tests have shown that users are confused by frames. Some highly
controlled framed sites (for instance, those with only one scrollable window)
give fairly good results. However, the main purpose of frames on such

sites is to allow complex navigation, advertisements, or both to stay in the
user’s view at all times. Unless you need to offer complicated navigational
options that your users can’t live without, or unless you have advertisers

for your site who demand frames and whose dollars you can’t live without, I
recommend you avoid frames while creating your initial Web pages or simple
Web site.

Still, framed pages can be useful to show complex sets of data and to support
navigation. Because creating and managing the HTML for frames is even
harder than for tables, I don’t describe that process here.

Use an advanced Web-page tool such as CoffeeCup, Microsoft FrontPage, or

Macromedia Dreamweaver if you want to use frames in your pages. (Or look
up the appropriate HTML tags in Appendix B and start experimenting)
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Chapter 3

A Fast and Easy Page with
Google Page Creator

In This Chapter

Introducing Google Page Creator
Registering for Google Page Creator
Taking the steps to a successful Google Page

Google has long seemed like the wildest and craziest multibillion-dollar
business going. Google was started by two Stanford graduate students,
and it grew to hundreds of employees and millions of users before anyone
even thought of how it might make money.

Yet Google is now a wildly successful business. Google dominates today’s
Web, commanding roughly half of all search traffic — and billions of dollars
in profits from advertising.

As part of its “ready, fire, aim” approach, Google launches new Web services
frequently, usually with a “beta” tag on the new service’s Web pages. Beta is a
computer software term that means “not quite ready for wide release” — it’s
sort of like a rough draft of a product. Yet the Google mob does release its
betas widely, allowing many millions of users to try, and test, a service before
it’s completed.

Google News, which uses software to make up a newspaper-like front page,
was in beta for many months before Google removed the “beta” tag. Google
Mail, known as Gmail, which has millions of users, is still in beta at this
writing — years after it was first released.

However, the beta status is not experimental enough to accommodate all the
great ideas at Google. So Google invented Google Labs, home for ideas that
are really experimental; “still in an early testing phase”, as Google puts it.
Google Page Creator is a Google Labs product. (To use Google Page Creator,
it’s recommended that you sign up for a Google Mail account — “early testing
phase” + beta = 7).
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The fact that Google Page Creator is still a Google Labs product as this book
goes to press — as it was for the previous edition two years ago — shouldn’t
worry you much. Google has brought many successful products out of the
Labs, including Google Maps, Google Scholar (for searching academic journal
articles), and Google News Alerts, all products that are widely used and that
I've used myself.

All of these applications and many more are considered examples of cloud
computing, in which purchased software packages are replaced by services
offered online via Web sites, often for free. Just think, in using many of the
tools described in this book, you’re taking part in perhaps the hottest trend
in computing!

Google Page Creator is a strategic offering from Google, as it competes with
offerings from Microsoft, Yahoo! and others, so you should expect Google
Page Creator to go on to ever greater things, whether it’s released from
Google Labs or not.

We can all join in hoping for a good result here, because Google Page Creator
is a slick, easy-to-use service. And it has much room for growth and improve-
ment, given Google’s world-class capabilities in search, online commerce,
blogging (Google owns Blogger — see Chapter 4), and other Web services.

Getting to Know the Creative Capabilities
of Google Page Creator

Google Page Creator has capabilities that seem pretty amazing: You edit your
Web page, live, within a Web page! New Web technologies such as AJAX
(Asynchronous JavaScript And XML), which incorporates the capabilities of
JavaScript and XML — a more advanced relative of HTML — allow Web pages
to take on more and more of the aspects of a “real” computer program.
(Watch out, Microsoft!)

Google Page Creator includes 100 MB of free storage, automatically saving as
you work, and allows you to use HTML tags to directly modify the look of
your page. (The overall layout of the page won’t be changed, just the details
of how the content looks within the page.)

Google Page Creator does have its downside, however. You can’t move the

site to its own URL, nor include a blog, a message board, or even any kind
of form.
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The biggest bogeyman of all is advertising. The beta version of Google Page
Creator does not, at this point, insert ads into your page. But given that
advertising is Google’s business, and one it’s very good at, you have to
wonder whether — or perhaps just when — your page will suddenly have ads
added to it. It may be that at some point in the future you’ll have to pay to
keep your Google Page Creator Web site ad-free.

If you still think Google Page Creator is for you, you should first register with
Google, if you don’t already have a Google account. You can also register
using your mobile phone number, but it’s actually easier to manage commu-
nications with Google using Gmail than via a mobile phone number that
might change (a change which you may well forget to tell Google about).

What's in a Google Name?

Before you begin your Google Page Creator adventure, think a bit about

what name you want to use. Your Google account name will be the user name
of the e-mail address you use to sign up. (That is, the part of your e-mail
address before the @ symbol.) This will also be the default name of your
Google Page Creator Web site. If you've been thinking for years that it’s

funny to have an e-mail address such as redhotkisser@genericmail.
com, perhaps you'll find it less funny for your Google Web page to be called
redhotkisser.googlepages.com.

However, you can change the Web site name and create more than one
Google Page Creator site from your Google account. If you want a unified
online identity, though, you may want to create a new Google Mail account
with the user name you want and have that be the distinctive part of the
name of your Google Page Creator Web site as well. Many desirable Google
Mail user names are already taken, so redhotkisser may no longer be
available! You may need to be creative to come up with a name you like that’s
still available.

If you do want to use a Gmail account, it’s probably best to set it up first,
then follow the steps in the next section to register for your Google account.
The Gmail account setup process is pretty simple. Begin by visiting www .
gmail.com and follow the instructions, which are similar to those for
registering for an account.

One of the first things you can do when creating a Google Mail account

is to check the availability of various names. You must enter your first and
last names first; you can then enter a suggested username and check its
availability. See Figure 3-1 for an example.
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|
Figure 3-1:
An e-mail
address by
any other
name would
not smell

as sweet.
|
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Gmail is a nice, catchy name for Google e-mail, but the real name, which
Google is using and enforcing more and more, is “Google Mail” — possibly
under the influence of its attorneys and marketing and branding people.

When you create and use your new account, you will want to enter your
e-mail address as, say, iamsocool@gmail.com. However, Gmail may in some
cases actually send this as iamsocool@google-mail.com. This disparity
can cause problems when, for instance, attempting to unsubscribe from

some online services. So either always enter your e-mail address as @google-

mail.com or be prepared for some possible difficulties.

Registering for a Google Account

To get a Google account, follow these steps. (The idea of Google having user
accounts is pretty interesting — Google is beginning to look more like an old-

WBER
“&
&

fashioned online service such as AOL or EarthLink.)

1. Open your Web browser.

Google works with any browser and can be used from a mobile phone or
other non-computer device. However, you'll need to use a PC (“proper

computer,” they might say in the U.K.) to create a Web page.
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2. Go to www.google.com.
The screen shown in Figure 3-2 appears, with some differences:

¢ In most countries outside the U.S., you’ll automatically be
redirected to a national version of the Google home page, such
as www.google.co.uk.

e If you're already registered as a Google user, your username and
additional options appear in the top line on the right.

¢ There may be a promotion for a Google service, such as the Google
toolbar, on the page. (The Google toolbar is great; it offers quick
access to Google search and to features such as pop-up blocking.
Try it!)

¢ The Google logo is often changed to reflect national or interna-
tional holidays or events. Find out more at www.google.com/
holidaylogos.html.

3. If you are currently signed in as a Google account holder, your
username appears on the Google home. Skip the rest of the steps in
this section. Otherwise, click the Sign In link.

When you click the Sign In link, the Google Accounts page appears.
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@ ~ [[Cl hetpsfivra. googie.com | =X | | wiley dummies P~
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- ™
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|
Figure 3-3:
Your e-mail
address will
be part

of your

Web URL.

4. If you have a Google account, sign in and skip the rest of the steps in
this section. Otherwise, click the link Create an Account Now.

The Create a Google Account page appears, as shown in Figure 3-3.

@

Enter a current e-mail account.

If you don’t already have an e-mail account, you need to ask a friend
with an e-mail account to work with you on getting signed up for the first
time. Or, you can create a Gmail account, as described in the previous
section. This doesn’t need to be a long-term commitment. After you
create your new Gmail account and use it to create your Google account,
you can set the Gmail account to automatically forward all incoming
Gmail to your existing account. That way you always get your mail from
both sources without ever having to check the Gmail account itself.

6. Choose a password, and then re-enter it.

Enter a password for your Google account. The Password Strength
meter automatically assesses your password to make sure it fits the
rules. However, it will say “too short” until you press the Tab key or
click in another area after entering your password. It will then display
an assessment of the strength of your password. You can click the
Password Strength link for guidance on how to make your password

stronger.
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7.

11.

12.

Click the check box Remember Me on This Computer to automatically
log in to your account when you visit Google.

You are given this option again in the future when you sign in, so
you don’t need to click the check box unless you're sure you want
this enabled.

. Clear the check box Enable Web History if you don’t wish to have

Google keep a history of your Web searches and Web site visits.

Web History allows you to search only on Web sites you've previously
visited and improves your search results gradually over time based on
your past searches. These probably seem like good things, but there are
a few reasons you may wish to avoid Web History:

¢ Enabling Web History means Google is gathering data on your
searches and Web use, which you may not want.

¢ Enabling Web History means that you’ll get different search results
than other people do; if you're a writer or researcher, for instance,
you may want uncustomized search results.

Of course, if you do enable Web History, you can also get uncustomized
results at any time by logging out of your Google account.

. Choose your country from the pull-down list.
10.

Type the verification characters.

As with many other sign-ups, Google requests that you type in the
characters in the verification graphic.

If you are visually disabled and using a screen reader, select the image
of a person in a wheelchair. The characters are read aloud for you to
type in.

Review the terms of service; click the Printable Version link to see an
easy-to-read, easy-to-print version in a new window. For details, click
the Privacy Policy link or the Terms of Service link.

Reply to the verification e-mail.

A verification e-mail is sent to the e-mail account you entered as part of
this process. Retrieve the e-mail message and use the link to verify your
account — either by clicking the link, if your e-mail program supports
that, or by cutting and pasting the link into the address area of your
Web browser.

After you respond to the instructions in the e-mail, you've finished
creating your account.
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Private Google on duty

Google's privacy policy is detailed — there are information as part of a legal process, they
additional, separate details provided for most of may comply with it.
its separate services — and easy to under-

stand. Hars ars some highlights: v~ See yourself: Google commits to efforts to

make your personal information available

v~ Combining information: Google combines to you, and to allow you to correct or
information from your registrations for ser- delete it.
vices, cookies, and your visits to Google

v~ Yes to opt-in: In its detailed privacy policy,

Web sites. . . ;
Google commits to requiring your opt-in
v~ Third parties at arm’s length: Only consent for the sharing of any sensitive
aggregated, non-personal information is personal information; that means you have
provided to third parties. to explicitly click a check box before your

v A different kind of service: If Google i AmEien B,

is served with a request for personal

Creating a Google Page

After you're registered, it’s time to start creating your page. Google Page
Creator gives you a lot of options; the following steps take you through some
of the most important ones:

1. Go to the Google Page Creator page at pages.google.com.

If you are not already signed in, the sign-in area appears in the upper-
right corner of the page.

2. If you are not already signed in, enter your password and click the
Sign In button.

The Google Page Creator start page appears.
3. Click the link labeled Create a new page.

You are asked for a title for your page. This title will be made part of
your Web page’s URL as follows (if you enter newtitle as the title):
newtitle.googlepages.com.

4. Enter a title, then click the Create and Edit button.

A new page appears, as shown in Figure 3-4. (Your page may look
slightly different, but the overall layout of editable areas should
be the same.)
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5. Try different layouts by clicking the Change Layout link.

Although the Change Look button seems to come before it, it’s actually
better to choose the layout first. The layout underlies everything else,
so choosing it early makes it less likely that you’ll need to make big
changes later.

. Click the layout you want.

At this writing, there are only four layouts, as shown in Figure 3-5. The
classic layout for a Web page is the second one, with a title across the
top, a navigation area on the left, and a main content area.

When you select a layout, you are returned to the main Google Page
Creator page, now sporting your new layout.

. Try different looks by clicking the Change Look link.

Before you start entering content, take a stab at changing the look
of the page. When you click the Change Look link, a collection of
looks appears — more than 40 at this writing. But the “looks” are
a bit generic — they don’t necessarily reflect the details of your
selected layout.
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|
Figure 3-5:
Carefully
select the
layout you
want.
|
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& Gnrngle Page Creator - Choose Layout - Windows Internet Explorer S[E[%]

@‘ =T google,com/changePageLayoutiyambook): autht beradasacfesf71sTorcL|v | “2 || K| | wiley dummies P

File Edit View Favorites Tools Help

¢ & | Google Page Creator - Choose Layout fa - B b - [rpage v (GTecs - @ £ 3
GOUS[G Page Creator book il.com | New Features! | Discuss | Help | Sign out

Choose Layout

« Back to Page Editor - Select by clicking below

«Back to Page Editor - Select by clicking above

You are currently using 0MB (0%) of your 10018,

Google Labs - Give Us Feedback - Terms of Use - Privacy Policy

Dane & mnternet H100% T

8. Try different looks by clicking Preview under each look.

Preview brings up a new window with a sample page, using the
previewed look.

Choose the look carefully; although you can change it later, the look
affects all the other choices you make as you design the page. If

you change it later, you may find yourself wanting to change everything
else on the page as well.

9. Select the look you want.

Choose Select; you'll return to the main Google Page Creator page, with
your page shown in the new look.

10. Edit the page title.

The initial page title is your e-mail address plus the words Home Page.
You'll look like a real amateur if you leave it unchanged, so click the title
and change it.

11. Highlight the new page title. Try as many formatting options as
possible — bold, italic, header sizes, and more.

Use every formatting option you can on the title to get a feel for them:
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13.

¢ Bold (the b button), italic (7).
¢ Font (F") and size (¢tT).
e Left, center, and right alignment.
¢ Header sizes versus normal text (A in different sizes and formats).
. Enter new content.
Enter your chosen content. Possible topics include
¢ Information about your friends and family
® A description of your work
¢ Favorite places on the Web, with links

Use the formatting options to arrange your content. Be sure to provide
plenty of headers to break up long blocks of text; Web visitors tend to
scan, rather than read, and headers help make that easy.

Publish your page.

Click the Publish button. Your page appears at the URL e-mail name.
googlepages . com. Click the View It on the Web link to see it. An
example is shown in Figure 3-6.

€y

ey - I%htlp:fﬂynmhnuk‘gDuglepagas.(umf[wpdummias Toe] [#2 [ ] [Gonge o)
: File Edit View Favorites Tools Help
% & | yombook - cwptummies [ fic B & v [rrass v GhToos ~ @~ & 3

ies - Windows Internet Explorer B[E[x]

|
Figure 3-6:
You're a real
Google
publisher.
S

cwpdummies

) Thisis the first day of the rest of your life - enhanced, as we both
My first day of my handmade know it will be, by your reading my wonderful Web site/blog. This
blog Wik siteBlog will help yor coeate Wl pages of 2 Gaiby, yority,
aixd pover Biver bfore anceirtared
My second day of my half-
baked blog

€ Internet A0~
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The 5th Wave By Rich Tennant

AN

“Can someone pleas tell me how long
‘Larry’s Lunch Truck’ has had his own
page on the intranet?”
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u se single-purpose tools to log your journey to star-
dom and to help your page flicker to life — or to

sound off about anything you're interested in. Specialized
sites support all these endeavors. Move your entire
existence to the Web!
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Words and Blogs

In This Chapter
Writing right for the Web
How HTML works with text
Using text you already have
Visiting the wonderful world of blogs
Creating a Blogger site

Writing for the Web isn’t a long-lost art — the Web hasn’t been around
long enough. It’s more an art that hasn’t yet been found. With the
Web so new, the best way to write for it is still evolving.

Web sites are made up, first and foremost, of words. After all, HTML, the core
standard that makes up the Web, stands for HyperText Markup Language. If
“hypertext” sounds like words — “text” — on steroids, that’s just what it is.

In this chapter, I describe some approaches for effective writing online to
make the most of your site visitor’s time and attention. I also describe ways
to use text you may already have and ways to work with the expectations that
your Web site visitors have for your site, rather than against them.

Then I introduce the tool that’s being used to host huge outpourings of
words onto the Web every day — the famous (or infamous) blog. A wonderful
thing in itself, and a sort of lab experiment for better understanding the use
of words on the Web.

A blog — the name is short for Web log — is an online journal of a person’s
thoughts, experiences, and interests. Kept up to date, a blog can help visitors
move with the writer through space — well, Web space, anyway — and time.

In a sense, any site can be used as a blog. Just create a new page on your site
and write your thoughts for the day. Include links to any site that you visited
and want to share with others. Be sure to link to any blog that you find
interesting.
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Then, a day or two later, add another chunk of text — put the new content on
top, pushing your previous work down the page a bit. In your new content,
refer to your earlier posting wherever necessary — and, of course, refer to
other Web sites and blogs you visit.

But using an actual blogging tool makes this very easy, allowing you — and
forcing you — to focus on the content. That blank blogging entry screen can
be as terrifying as any blank sheet of paper has been to a non-computer-
assisted writer!

Over time, your burgeoning blog may develop into an appealing take on your
life and interests — or preoccupations — or even obsessions. You may find
that your blog expands so you need to split it up among multiple pages and
change your links to fit. Your blog may even get linked to by other bloggers
(people who keep blogs) and begin to develop a following of its own.

Getting It Write for the Web

Every new medium develops its own style. Magazine articles are often wordy
and literary in style. Newspaper articles are usually brief, to the point, and
written in a “pyramid” style that puts the most important information first.
The Web has its own style. Learning to use it can make your Web page much
more interesting and effective.

Web realities

The new style of writing found online is based on four underlying realities
about the Web:

v The capabilities of HTML: HTML allows you to specify some simple
text formatting, headings, and lists. Newer versions of HTML also allow
you to specify fonts and specific text sizes, but these may be displayed
differently on different computers, and a user can override these
specifications.

What it means for you: Don’t count on complicated formatting and
specific layout to get your message across. Keep it simple.

v The difficulty of reading from a computer screen: A computer
screen has much lower resolution than a printed page — about 100 dpi
(dots per inch), versus anywhere from 300 dpi on up for print. And the
computer screen glows, while printed pages use reflected light only. So
reading from the screen is harder, and people’s eyes get tired when they
try to read long blocks of text on-screen. (They often don’t consciously
note this as they would, say, tired legs from walking a long way; they just
stop reading.) Figure 4-1 shows how far on-screen letters are from the
smooth lines of printed text.
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|
Figure 4-1:
Zooming in
shows how
“chunky”
on-screen
letters are.
|

chunky

What it means for you: Shy away from long blocks of text. People skim
rather than read online, so you are unlikely to have your site visitor’s
attention for long. Write small chunks of text, then break up what you
write using headers, lists, quotes, and other devices. Go through the text
again and cut what you write down to the fewest words that do the job.

v The ease of clicking away: Web surfing, like real surfing, is all about
movement. One of the most fun aspects of the Web for users is one of
the most vexing for Web publishers: Clicking away to another page or
site is very, very easy. Web content is free and voluminous, so users are
always enticed to go elsewhere.

What it means for you: In addition to keeping your text brief and broken
up, you need to make it as interesting as possible. Take advantage of the
ease of clicking away: Include relevant hyperlinks in your Web text.

1 Web style: In response to all this, Web writing has developed its own
style. It’s characterized by a lack of hype and an informal tone, but
a strong need for accuracy — correct facts and no typos or missteaks
(I meant to do that). Early Web users were military officers and
scientists with Ph.D.s, who set a high standard for correctness that
continues, at least on the best Web sites, today.

What it means for you: You need to show people that you're one of the
voices on the Web worth listening to. Make sure your grammar, facts,
spelling, and punctuation are accurate.

To demonstrate how “sparse” on-screen information is, Figure 4-2 shows a
PDF file from the For Dummies site at www.dummies . com with content from
a previous edition of this book. It’s very well-laid-out online, but the amount
of content displayed is only about half of one printed page (remember, a
book reader sees two pages at a time). The comparison to the Web is even
more unfavorable for magazines or newspapers, which fit even more
information on a printed page than a typical book does.
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|
Figure 4-2:
An on-
screen page
has fewer
words than
a printed

one
|
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If you have something dense and detailed that you really want people to read,
put it on a separate Web page and encourage people to print the page out.

Or, put it in a PDF file that the user can download and print. (The advantage of
a PDF file is that it preserves page layout exactly.) Printing allows users to
carefully read the text rather than scan it, as most people tend to do with text
on the computer screen, and to mark up the copy with notes and highlighting
if they wish.

Even if readers do choose to read online, the use of a PDF gives readers a
sense of their place in a document, preserves formatting, and makes
resizing easy, making online reading easier than from a typical Web page.

The point is that readers get far more content for a given amount of effort
from print than they do from online content. So when writing for the Web,
you need to keep your text short, your layout simple, and your content
interesting.

Once you think you’ve got your text short enough, start over. Identify the
main point of your piece and make that the first sentence of a rewritten
version. Include just enough supporting detail to explain your point. Then
include each of your main supporting points, again with just a bit of detail.
You should end up with about one-third the words you would use if you
were writing for print.
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Sources for Web writing

There are many excellent resources for Web
writing; just remember that it’s still an evolving
practice, so don't expect full agreement from
various authorities. With that in mind, here are
some good resources:

v Jakob Nielsen's useit . com: This justly
famous site has been the leading resource
for Web usability information for over a
decade. There are many good resources
on the whys and hows of writing for the
Web at www.useit.com/papers/
webwriting/.

School for Communication has great
general rules, as well as specifics for
blogging, at www.ojr.org/ojr/
wiki/writing/.

v Web Reference Writing Well for the Web:

These pages on the venerable (by Web
standards) Web Reference site are another
good source and include special treatment
of headlines, particularly important when
readers are skimming as they do on the
Web. Visit www . webreference.com/
content/writing.

67

v USC Annenberg Online Journalism Review:
This publication of USC's famous Annenberg

What HTML Lets You Do with Text

HTML, in its original and most widely supported form, doesn’t give you much
control over the precise layout of text. In fact, because your Web site visitor
may have a different screen size, machine type, and set of available fonts
than you're used to, you can only count on a few things:

v~ Serif or sans-serif text. You can only count on using a serif font, with
little “features” on the characters as you'll see in the text in this book
(such as Courier), or a sans-serif font such as Arial, which looks
cleaner but also cold and inhuman. If you specify a font by name, it’s
quite likely that some of your site visitors won’t have that specific font
on their machines, and a substitute font (also either serif or sans-serif)
will be used instead.

+~ Relative size. You can’t control the absolute size of text, only whether
it’s relatively very large, large, very small, and so on, with seven
sizes to choose from. Nor should you want to specify absolute font
size — a small font that looks fine on a low-resolution screen may
become impossibly tiny on a high-resolution one.

v Headers. HTML supports seven levels of headers; the biggest headers
(H1 and H2, as they’re called) render so large on most browsers as to be
almost unusable, so a lot of top-level headers get coded as H3 or even
H4 headers.
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|
Figure 4-3:
Take
advantage
of Web
formatting
options.
|

+ Bold or italic. Basic HTML includes specific commands for making
text bold or italic. It doesn’t support underlining because underlining
indicates a hyperlink, not an emphasized word.

+* Bulleted and numbered lists. HTML lets you create bulleted and
numbered lists, but usually renders them with odd spacing
between items — blank space above and below the list, but no extra
spacing between items in the list, which to my eye makes the list
hard to read.

+~ Relative indent. HTML lets you indent text from the left-hand margin
not at all, some, or a lot.

That’s about it. I go into detail in the following Parts on using a WYSIWYG
(What You See Is What You Get) editor or “straight” HTML, but it’s good to
know up front what you’re getting into.

Figure 4-3 shows these options for Web text formatting in a single example.
Use it as a resource when deciding what formatting to use in your own
Web page.

[&Bud's page for CWPD < - Compaser =12 x|
' File Edit Wiew Insert Format Table Tools Window Help
‘o A& =

# : Lo e
Link Image Table Spell

<!DOCTYPE html PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN":>

Heading 1 - Major Site Title

MNew Open Save  Publsh  Browse Print

Heading 2 - Page Title
Heading 3 - Intra-page title
Heading 4 - Lesser title

Heading 5 - Small title

Heading 6 - Very small tifle

sesmall - The tinsst fimt. large - One step up from medm
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If you specify fonts, stick to common fonts such as Times, Courier, and either Helvetica or Arial

.’Norma\l CBIHTML Tags  <HTHLY Source | e Prewewl
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What color is your hyperlink?

HTML allows you to use colored text on your Web pages. The problem is, research into
Web page. | generally don't recommend this. making Web pages easier to use and less

Why not? (This book is about all the things you confusing has found that users subconsciously

. count on blue underlined text to indicated
cando on a Web page, after all!) The reason is L . .
unvisited links and purple underlined text to
that people are very used to monotone text, . . . ..
. indicate links the user has already visited. Any
usually black, on a contrasting background. . .
. change in these colors, or any use of underlin-
People have adjusted to the use of colored .
L ing or blue or purple text for other purposes,
text on Web pages, but mainly in the form of causes deen confusion
standard hyperlink colors: blue for a link the P ’
user hasn't clicked yet and purple forarecently So | recommend that you dont use colored
visited link. text, don’t change link colors, and don't use
underlining except in links. The people who visit
your Web page will have a better time using it
as a result.

Some Web page authors customize hyperlink
colors to fit better with the color scheme of their

Don’t use italics much online; italic text online is very hard to read. Use bold
text, but use it in a structural way (as I've done in the bulleted list just shown
here) rather than to emphasize some very important point or another within
a flow of text.

3

Note that these are the features supported by “straight” HTML, the basic
sort that’s widely implemented across old and new Web browsers. A newer
standard, Cascading Style Sheets (CSS), gives you a great deal more control.
However, it’s hard to use properly, doesn’t work the same on every browser,
and can let you do things that look good on your screen but don’t work well
on all equipment — the opposite of the original intent of the Web. I don’t tell
you how to use CSS in this book, and I suggest you use it with caution if you
do decide to use it.

Using Existing Text

Now that you know what you can do with text, what are the real-world
issues that come up when you actually create a Web page or Web site? It’s
amazing how you can wish for months or even years that you had a Web site
or blog — then, when you finally do have one, find looking at that blank
screen that needs to be filled so intimidating. One time-honored approach to
filling it is to re-use existing content; looking at how to best do so highlights
important points about writing well for the Web.
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How to reuse right

In many cases, you're actually doing a disservice to your Web site’s visitors
if you don’t reuse things you already have. Your résumé may be of great
interest to a visitor to your personal site; the information in your company’s
marketing brochures is very likely to be relevant to visitors to a company
site. If you don’t put this information on your site, the visitor will miss

out on it.

You shouldn’t use the text exactly as is, though, because Web formatting is
different and reading from the Web is harder, as described earlier in this
chapter. What you need to do is repurpose it.

Repurposing has two parts — reformatting and condensing. To reformat text
for the Web, you need to tinker with some details:

v Break up paragraphs and add some headers. Since Web users scan,
they may get absolutely nothing out of a long flow of, say, 10 or 20
paragraphs of text with no headers or hyperlinks. Paragraphs should be
a few sentences long and there should be a header every few paragraphs
so users can home in on the things they need to read.

v Use lists with bullets or numbers. People love lists, especially online, as
they’re easy to scan. Use numbered lists whenever there’s a reason for
them, such as a set of steps or a ranked list.

v Add hyperlinks. Web users treat hyperlinks as focal points just as
they do headers. Hyperlinks also add credibility to your text. So gently
introduce a few relevant ones.

v Add or update bold, italic, and underlining effects. If there’s bold,
italic, or underlined text in your original, consider stripping it all out,
then adding bold and italic effects back to the text where appropriate;
reserve underlining for hyperlinks.

v Add illustrations and photos. The easy addition and placement of
illustrations — especially photos — within a flow of text was what really
distinguished the Web from previous hypertext systems. Creating or
sourcing appropriate images is a lot of work, but you have to do it if you
want interesting Web pages that will get read.

True repurposing requires condensing as well. By the time you’ve broken
up text, hyperlinked it and added graphics, you’re almost bound to start
shortening it. Because you're going to start developing a sense of what the
purpose of the text really is, and all that extraneous stuff from the former
version is going to annoy you.
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To help with this, and to fit into the online ambiance, add a bit of wit or
humor. (Unless you're writing for a medical Web site, in which case you
should avoid being humerus.) Web users expect a bit of levity in text. Reading
online is hard; humor makes it easier. And research shows that learning is
actually helped by laughter. Don’t be “another brick in the wall” of boring,
hard-to-read online information; lighten the tone of your text.

The text in this book is not a great example for repurposing, because the For
Dummies style — designed to be used for reference, easily skimmed and
easily read, with icons and illustrations — is already much of the way to good
Web-writing style. But take a look at a few pages of a novel and imagine
rewriting it for the Web.

As an example, let’s take a few sentences from Moby-Dick, or the Whale by
Herman Melville — a book that’s no longer in copyright, so I don’t have to get
permission to reuse it. (Don’t laugh; practical considerations of this type
come up all the time in Web writing and Web graphics.) The beginning of the
book is:

“Call me Ishmael. Some years ago— never mind how long precisely —
having little or no money in my purse, and nothing particular to interest
me on shore, | thought [ would sail about a little and see the watery part
of the world. It is a way [ have of driving off the spleen, and regulating
the circulation. Whenever I find myself growing grim about the mouth;
whenever it is a damp, drizzly November in my soul; whenever I find
myself involuntarily pausing before coffin warehouses, and bringing up
the rear of every funeral [ meet; and especially whenever my hypos get
such an upper hand of me, that it requires a strong moral principle to
prevent me from deliberately stepping into the street, and methodically
knocking people’s hats off — then, [ account it high time to get to sea

as soon as [ can. This is my substitute for pistol and ball. With a philo-
sophical flourish Cato throws himself upon his sword; I quietly take to
the ship. There is nothing surprising in this. If they but knew it, almost
all men in their degree, some time or other, cherish very nearly the same
feelings towards the ocean with me.”

(From the Project Gutenberg edition of this text at http: //www.
gutenberg.org/dirs/etext01l/mobyl0b. txt.)

Figure 4-4 shows how the same text might look, rewritten for the Web —
and updated a bit (with apologies to those who love their Herman Melville
straight!) The H1 (header level 1) HTML tag is used for the header; note that
it’s unattractively large. Although H1 is technically correct, in a real page
H3 or H4 would be used instead due to being rendered in a smaller, more
appropriate size.
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Figure 4-4:
The opening
lines of
Moby-Dick,
updated for
the Web.
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Avoiding existing formatting

If you try to open a formatted word processing file in a Web browser, it will
look like gibberish. Or, worse, your browser — specifically Microsoft Internet
Explorer — will look for a copy of, say, Word on your hard drive and use it

to display the text with correct formatting. I say “worse” because this is a
great technique until others on the open Web try the same trick in a different
browser or without the same word-processing program handy. They, unlike
you, will see gibberish.

Copying and pasting text from a word-processing file solves some of this,
but there’s all sorts of garbage — I mean, carefully inserted formatting
code — mixed in with the text. Your Web-editing tool may ignore it, try to
render it and fail, or successfully render it. In any event, the result is, again,
unpredictable on someone else’s computer or browser.

For instance, your computer may have the font Arial Narrow. It may display
text in Arial Narrow in your word processing program, your Web editing tool
and when you test a Web page. But if a visitor to your site doesn’t have

Arial Narrow, in the size you specified, he’ll see some other font that may be
different entirely. And your text may not fit in the space you’ve laid out for it.
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The only way to completely avoid such problems is to paste the text into

a text-processing program such as Notepad (not WordPad) on a Windows PC
or BBEdit on the Macintosh. These programs are incapable of coping

with formatting and will toss it all out. WordPad, on the other hand, puts
formatting codes in your document, just like Microsoft Word and other word
Processors.

Then, save the Notepad or BBEdit file, just to make sure the former format-
ting (try saying that three times fast) all disappears. Copy and paste the
“clean” text into your Web-editing tool (as described in Parts Ill and IV of
this book). Add formatting there. This process may become quite tedious,
especially on long documents, but well-paid professionals spend hours and
hours doing it anyway because it’s the only sure way to avoid problems.

Getting Copyright Right

WING/
&

It’s easy to run into copyright issues with text — and this is a case where
perception may matter more than reality.

Copyright only protects one’s words against nearly word-for-word copies or
very close paraphrases. The old saw, “Copying from one source is plagiarism;
copying from three sources is research,” captures this reality.

While only a nearly word-for-word copy of someone else’s text is likely to get
you in trouble legally, people’s sense of fairness will kick in quickly if they
believe you're copying. Text can be different enough from an original to not be
legally actionable, but similar enough to bring you unwanted and distracting
suspicion from your Web audience as a copycat.

So be careful how you proceed. You may want to tell your Web site’s visitors
how to add your site to their bookmarks in Internet Explorer — and you may
search online to find out for yourself how to do it. The site you find the
instructions on doesn’t “own” the technique, but it does “own” the specific
wording it used to describe how to accomplish that task.

So when you go to put the steps on your Web site, go through each step
yourself, then write down what you just did in your own words. Double-check
that you haven’t unconsciously copied any of the wording you found online.
Then put your own, new wording on your Web site. This way you’ll be safe
from even unintentional plagiarism.

If you do purposefully quote text (as I did in this chapter with Moby-Dick)

sharply limit the size of your quote. If the text is highly recognizable, or if you
go longer, note that the work is no longer in copyright (as I've done before

www.it-ebooks.info

/3


http://www.it-ebooks.info/

74

Part II: Getting the Content Right

the quotation) or that you've obtained permission (after you've, ahem,
obtained permission) so your site visitors know you’ve done the right thing.
Provide a link to the original. If the work is still in copyright, and you can’t
get permission, don’t include the text.

Discovering the Wonderful
World of Blogs

One of the best ways to get on the Web quickly is through a blog. A blog is
also a great way to practice your Web writing and a great tool for expression
in and of itself.

Blogs tend to offer built-in WYSIWYG editors. So Part III of this book,
which demonstrates WYSIWYG editing using the CoffeeCup tool, is good
background for blogging. And blogs also tend to allow you to touch up
your entries with HTML tags, so Part IV of this book, which demonstrates
the use of HTML for markup (as well as the Cheat Sheet at the beginning
of this book) will also be useful for blogging.

Blogging is not just another tool for generating Web content. Even though it’s
relatively new, blogging has developed such a following that many people
spend hours a day perusing others’ blogs and commenting on them as they
add to their own blogs. There’s even a special word for all this: the blogo-
sphere, the world of blogs and commentary about blogs and blogging. (This
would be different from blogosfear; nobody seems to be shouting “Beware of
the blog!”) Because some bloggers are also journalists (and vice versa), the
blogosphere is intimately tied to the newspapers and magazines that millions
of people read daily.

Some blogs are focused on the Web itself, or on technical matters relating

to computers — different types of computers, different operating systems,
and so on. But some of the most interesting blogs are deeply personal. One
blog that’s a mix of the two is from the famous, or infamous, Dave Winer, a
talented creator and marketer of software who also happens to be a top-
notch complainer. You can find his blog at www. scripting.com, which is
also a great site for blogging information and tools. You can see a snapshot of
it in Figure 4-5.

Blogs have even had a big influence on politics. Remember Howard Dean, the
former governor of Vermont who was the leading Democratic presidential
candidate in late 2003 and early 2004? His blog was one of the leading tools
of his campaign. Through it, people felt they came to know him quickly and
well — and wanted to join him in changing the world of politics.
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Figure 4-5:
Dave Winer
is an

tiber-
blogger.

Both Dave Winer and Howard Dean are known for being, well, intense
characters — and other people who are into blogging can be very intense
about it as well. They tend to talk a lot about blogging and about related
topics such as content syndication, collaboration, and online communities.
You'll run into this if you search around the Web for blogs and conversations
about them (mostly found in other blogs, of course.)

But blogging is now mainstream, having gone well beyond its founding
fathers (and mothers, many of whom blog). During the 2008 Presidential
campaign, one secret of the surprising success of the Obama campaign
was its brilliant use of the Web and e-mail. Any visitor to the Barack Obama
Web site can start a personal blog on it!
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Finding blogs to read

To find some blogs yourself, you can simply do a Web search using blogs as
the search keyword. You're likely to run into a lot of stories about blogs

and some technically oriented blogs before you find personal or otherwise
interesting blogs.
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For instance, in one search about blogging, I quickly found a story on a
sex-related blog that got a U.S. Senate aide in trouble, a Bill Gates speech
about blogging, and some blogging software — but none of the quirky,
interesting, if sometimes self-obsessed content that has made blogging a
phenomenon found its way to the list of top results.

Here are some list sites that give you a quick peek at what other bloggers
are doing:

v www .bloggersblog. com: If you don’t like the sound of “blog,” you
really may not like the name of this site. But it’s a very useful directory
of hot blog topics.

v www .weblogs . com: Some blogs aren’t updated much; this list shows
only recently updated blogs.

V¥ www . technorati.com/pop/blogs: A listing by Technorati of the
top 100 blogs, great fun to surf and a very useful source for ideas.
Also a good introduction to Technorati, one of the most interesting
communities on the Web.

Finding software for blogging

Later in this chapter, I show you how to use Blogger, owned by Google.
Blogger is one of the easiest and best blogging tools out there — but it’s far
from being the only tool in town to suit your blogging fancy.

Be warned: I can’t promise that you’ll ever want to stop blogging once you
start. Blogging can be an art form, so if you want to know more about blogs
and get your own blog started, here are several top blogging resources you
should check out:

V¥ www . typepad. com: Home for the TypePad Web-logging service.

V¥ www .movabletype.com: Movable Type is quite technical and quite
powerful.

v www.diaryland. com: Easy, easy, easy is Diaryland’s claim to fame.

V¥ www.livejournal.com: LiveJournal and its users emphasize the
community aspect of blogs.

V¥ www . hometown.aol.com: AOL’'s Web logging service — free to all, even
non-AOL members.
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Committing to a blog

Ablog takes more commitment than a Web site.
The reason is simple: The diary, or “log,” aspect
of a blog can be time-consuming, day after day
after day. An ordinary Web site can still be
interesting and useful if it's not updated much
for awhile. A blog, by contrast, is valuable
precisely because it contains the latest infor-
mation on a given topic — whether the topic is
software, politics, or the daily musings of a
bored teenager.

You'll see, as you search through various blogs,
that many are started, gain an interesting slant
or approach, start to gain regular visitors and
fans — and are then abandoned. It's very

frustrating to start reading an interesting blog
only to see postings slow down and then stop
completely. Bloggers burn out — and blog
readers also burn out, from keeping up with so
many blogs at once. Because bloggers feel
compelled to keep up with other blogs as part of
making their own blog worthwhile, bloggers
can truly find themselves burning the candle at
both ends.

An example of blog burnout can be found at
www . britblog.com, shown in the figure.
This formerly brilliant blog — “brill,” as Brits
would say — was recently shut down due to
blogger burnout.

‘& BritBlog: British Blog Directory - Windows Internet Explorer [BEx]
@@ ~ 8] hepsfomaw.britbog, comfinder. ki [] (42 /[ % | (britbiog Bl
File Edit View Favorites Tools Help
¥¢ & | BiitBlog: British Blog Directory G- B & [P Gk @ Br 7
[~
THE BRITISH BLOGGERS DIRECTORY

BritBlog: Site Closure

London, UK, 23 April, 2008 - It is with sadness that I announce the closure of BritBlog: the British

Blog Directory.

We’'ve had over four years of fun with this project, but after a recent hacking incident and with the

constant battle against spammers and spam blogs, I have to admit that I just don’t have the time to

put into the project that it needs (and deserves).

Long-time members will be aware that the site has changed little since we went live, and although a

great deal of preparation, research and investment went into plans for a new version of the site

("BritBlog 2.0" so to speak), I've just not been able to find the time to actually put them into action.

I would like to thank everyone who helped make the site a success, especially Nancy, who spent literally

hundreds of hours checking out new signups.

Perhaps one day the site will return in a new guise — and I really I hope it does — but in the meantime

I'm left with no option but to take it offline.

Apologies for any inconvenience this may cause to anyone. Feel free to discuss this announcement or

contact me if you need any further information

Mark Sweeting =
Done & Internet H100% -

Another thing you may notice is a lot of personal
information in blogs. Many bloggers willingly
sacrifice some degree of privacy to participate
in the blogosphere — but you may want to think
twice before following their lead.

So if you're not sure a blog is what you want to
do, consider creating a regular Web site first.
You can then put the skills you gain creating
your initial Web site to good use in creating the
world’s greatest blog — when you're ready to
put in the time to create and maintain it.
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Using Google’s Blogger.com

3

Blogger.com, also known simply as Blogger, is the leading blogging site, with
the most users and the widest name recognition. The site was acquired by
Google in 2003 when Google bought Pyra Labs, the creators of Blogger. At the
time it was acquired, Pyra Labs had just six employees — but more than a
million registered users for its blogging-oriented Web sites. Now another
leading blogging site, LiveJournal, claims over 15 million registered users!

The great thing about Google acquiring Blogger is that it gives ordinary
folks — that’s you and me — some reassurance that the site will be around
for the long term. Many Web sites have come and gone, and when it was
owned by Pyra Labs, Blogger wasn’t immune to those pressures. Google is a
highly profitable Web business, so the chances are greatly increased that
Blogger will go on and on.

Blogger gives you the option of having advertising hosted on your page, with
you and Blogger splitting the money. This is a great way to do it but Blogger
is considered admirably easy, but not as feature-rich as it could be. However,
you may want to consider a paid service, such as WordPress (www.word
press.orq), if you want more advanced capabilities in your site.

All blogs that you set up through the process described here are hosted on
blogspot.com and have similar URLs. If you want to have your site hosted
elsewhere, use the advanced blog setup at www.blogger.com/adv-
create-blog.g. You will need details such as the FTP server to use for
transferring content to your blog; get help from the site host if you need it.

Setting up your blog

Since its acquisition by the megalith Google, Blogger has obtained the
resources to make blogging easier and faster without quickly pushing its
users into paying for services. Blogger has recently updated its interface to
make creating an initial blog even easier — a perfect fit with the purpose of
this book. Follow these steps to get started:

1. Go to www.blogger.com.

The Blogger site appears, as shown in Figure 4-6.

If you look around the Blogger Web site, you see links to BlogThis, a way
to quickly comment on any Web page within your blog.

2. Click the orange arrow to Create Your Blog now.

The Create an Account page appears, as shown in Figure 4-7. Read care-
fully; just about everything you enter is very important to your blogging
happiness.
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3. Supply a username (it’s your e-mail address) and retype the e-mail

address.

Your proposed username is your sign-on name for Blogger; only you
will see it. Because Blogger is so popular, it’s quite likely that most

of the convenient or funny usernames that you may think of, such as
“budsmith” (convenient) or “blogguy” (funny?) are already taken.
Choose something you’ll find easy to remember, but be ready to enter
a second choice if your first choice is already taken.

. Enter your password, and then retype your password.

Unlike your username, you can enter any password you like — it doesn’t
matter if someone else has the same one. Just make sure your password
is both easy for you to remember and hard for someone else to guess.

It may seem as if your password is pretty unimportant because your
blog is going to be immediately posted on the Web anyway. Okay, that’s
true, but it’s not the point. The point is that if someone guesses your
username and password, he can post on your blog (pretending to be
you), and people will think the postings are from you — which could get
pretty embarrassing!

. Enter your display name.

You may be tempted to enter your full name here, but with the increas-
ing power of the Internet, it’s quite likely that others who have your full
name can find out more about you than you might want them to know.
Consider using a display name that doesn’t give away your complete
real name.

Be careful with putting personal information on the Web; identity theft
is becoming a larger and larger problem, and you don’t want to make it
easy for the fraudsters by giving them a good start on a detailed profile
of you.

Think a bit about your display name; if your blog might cover personal
or serious topics, for instance, don’t choose a really silly one. (A posting
from “wild&crazyguy” about your upcoming big business deal, for
instance, may be a bit disconcerting to your blog visitors.) You may also
want your display name to relate in some way to your blog title and
blog address; see Steps 9 and 10 for details.

. Enter the verification characters.

Enter the word you see displayed. This is done to verify that you're a
human (who can make out the letters displayed) and not a script
automatically creating a Web site (which can’t “read” such graphical
lettering).
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7. Click the Terms of Service link.

Before you click to put a check mark in the box that indicates you agree
with Blogger’s terms, click the Terms of Service link to make sure that
you actually do agree.

The Terms of Service appear in a new window, so don’t worry about
losing the data you’ve already entered.

You should always inspect the terms of service for a Web site if you're
going to enter personal information on it, such as your e-mail address.
This is especially true with a blogging site — that’s because, by nature,
blogs require you to put so much data into the service, some of

which may be personal. (Some blogs are embarrassingly personal!)
Blogger’s owner, Google, as a widely respected public company, may
be more trustworthy than most — but you should still see what you're
getting into.

Courts take Terms of Service seriously — after you agree to them, you're
bound by them, whether you’ve read them or not. Some unscrupulous
companies have gotten away with some pretty shady scams this way —
and even big, respectable companies have used them to protect them-
selves from angry users. So give the Terms of Service the once-over.

. Click the check box to accept the Terms of Service, and then click the

Continue arrow.

If you see a new screen called 2: Name your blog (see Figure 4-4), go

to Step 9. If you see the same screen as before, with an error message,
the error message is most likely to be a caution sign and a warning:
“Sorry, this username is not available.” If so, enter a new username and
reenter your password in both blank areas below it. Then click the
Continue arrow.

After your username is accepted, the Name Your Blog screen appears
(as shown in Figure 4-8).

. In the Name Your Blog screen, enter the title for your blog.

You can give your blog any title you want, but give your decision some
thought. Ideally, the title should be rare or even unique; should sum
up what’s different and special about your blog; and should relate

to the blog address you’ll give it in the next step, which also needs to
be unique.

For instance, if you're creating a blog in support of a book about
creating Web pages, you might call it “Creating Web Pages Web Log.”
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Figure 4-8:
Name your
blog.
|

\\3
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10. Enter the blog address, the first part of the URL for your blog. Click
the Check Availability link to make certain it’s not already taken and
in use.

Enter the first part of the blog address for your blog. This portion of the
address is used by Blogger to form the first part of your URL for your
blog. For instance, if you enter caveboy4 in the blog address spot, your
URL is caveboy4 .blogspot .com.

As with your username, your blog address must be unique — if someone
else has it already, you won'’t get it. Believe me — most of the good
addresses are taken! So think carefully about a display name (see Step
5), blog title, and blog address that work together and are unique
enough to pass muster.

Google can help you find interesting blogs on Blogger.com — or other
interesting content on other interesting sites. If you search for site:
blogspot.com caveboy, for instance, you're likely to find most of the
blogs on Blogger.com that have “caveboy” in their content somewhere.
(I say “most of” because Google doesn’t index sites instantly, so you
may not be able to find something that’s moved recently or that has
otherwise escaped Google’s attentions.)

11. Click the Continue arrow.
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|
Figure 4-9:
Showcase
your blog in
a template.
|

12.

If you see a new screen called 3: Choose a Template (see Figure 4-9),
Step 12. If you see the same screen as before, with an error message,
do the following:

The error message is most likely to be a caution sign and a warning:
“Sorry, this blog address is not available.” If so, enter a new blog
address. Then click the Continue arrow. When your blog address is
accepted, you see the Choose a Template screen.

Choose a template.

You'll see a dozen or so templates to choose from — different looks for
your blog. Choose one that fits the way you want your site to appear.
Click the image of any of the templates to see a larger preview appear in
a pop-up window.

It may be tempting to rush this part of the process — especially because
Blogger allows you to change your template (by editing the page’s
HTML) or substitute a different template later, without losing any of
your content. But it’s worth taking the time now to make a choice you
can live with, at least for a while.

Before you click Continue in the next step, be sure to check all your
choices by clicking the “preview template” link below a particular
template sample; once you click the Continue button your blog is
created instantly.

& Blagger: Chovse a template - Windows Internet Explorer

: File Edit View Favorites Tools Help
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* & |3) Blagger: Chaose a template
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MAME BLOG CHOOSE TEMPLATE

Choose a template

Choose a custom
look for your blog.

You can easily
change the
template later, or
even create your
own custom
template design
once your blog is
setup.
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Done
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13. When you’ve made your choice of template by selecting the radio
button underneath a template, think about whether you’re happy
with all the choices you’ve made so far. If you’re happy, and ready to
create your blog, click Continue.

Your blog is created!

14. Click the Start Posting button to open your blog so you can start
adding content to it. When your blog appears, save the URL in your
Favorites list.

In Internet Explorer, click Ctrl+D to add the current page to your
Favorites.

Adding content to your blog

Adding content to your blog is easy — but doing it just the way you want it

can be hard. Not all the options you're used to having for text formatting in,
say, a word processor, are available with the Blogger software. You have to
experiment to find out what you can and can’t do.

From this point, your choices as to what to do, and what order to do it in, are
nearly infinite. You may want to create posts right away; on the other hand,
you may want to understand everything about your blog page before creating
any content — let alone telling anyone how to find it.

To accommodate all the different approaches you can take, the following
sections offer highlights of each page you use to edit your blog. Read each
section briefly — and then roll up your sleeves and go experiment. That’s
what Blogger is there for!

Posting and formatting

The Posting page (see Figure 4-10) is where you create the posts that appear
on your site. You can always edit, delete, or rearrange posts later, but it all
starts here.

If you leave and reenter Blogger, you may find yourself at the Dashboard.
To reach the Posting page from the Dashboard, simply click the link labeled
New Post.

The Posting page allows you to enter plain text and format it using several
options. You can use the easy, word processor-like buttons as shown in the
figure, or use HTML directly.

To use HTML directly, simply click the Edit HTML tab. Your content — and

the formatting you’ve applied to it — is displayed in HTML format, as shown
in Figure 4-11.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 4: Words and Blogs

|
Figure 4-10:
Post to

your host.
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Lewis Mumford was well known as an urban planner, but earlier in his career he set a
benchmark with Technics and Civilization that has perhaps not been equalled.

His work accomplished several things at once:

« Integrating the study of history and the study of technology

+ Grounding what happened in history in what was possible with new advances in science.

+ Showing previously unseen connections between events in one place and time and
seemingly unrelated happenings down the road. (Yes, like James Burke's Connections

series.)
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Here are a few simple options for using HTML in your text:

+* Bold: Makes the text you select bold, as you would guess. You'll see the
HTML tags <b> and </b> surround the text, indicating that the bold is
beginning (<b>) and ending </b>). Don’t overuse bold text (or capital
letters) because it looks like you're SHOUTING.

v Italics: Also obvious — makes text italic. The HTML tags <i> and </1>
surround the text to indicate the beginning and end of italicization.
Don’t overuse italic text because it makes the text hard to read
on-screen. (Printed italic text is much easier to read than on-screen
italic text.)

v Link: Here’s where you link text to a Web address — a big part of the
original purpose of blogging. To use this, highlight the text that you
want to have linked, and then click the Globe-and-Chain icon. You’ll have
the opportunity to link the text. To delete the link, delete the linked text.

Make the linked text short, but at the same time ensure that the users
will be able to tell exactly what they’ll get when they click the link. It’s
extremely annoying to see a link called My Favorite Dummies Book, for
instance, and click it only to find that the link is to the overall Dummies
site, not a description of the specific favorite Dummies book.

You also have the option of spell-checking your content — a capability
added since Google purchased Blogger, and for which those of us with
bad spelling can be greatful (sorry about that).

Using other Blogger options

In addition to posting — which, I hope, you’ll spend the majority of your time
doing — Blogger offers many other options. Highlights include

v View Blog: This option pops up a new window with your blog in it as it
actually looks to a visitor (Figure 4-12 shows an example). Don’t simply
do this to view your site after you make changes — you may also want
to use this option to see what’s currently on your site as you're writing
new posts.

1~ Settings: Settings allows you to change options in separate pages
devoted to Basic, Publishing, Formatting, Comments, Archiving, Site
Feed, E-mail, and Members options. (The E-mail option lets you post to
your blog from an e-mail account.) Carefully check out and test these
options, then use the ones that work for you; they support powerful
capabilities such as posting to your blog by e-mail.

1 Template: Here’s where you can see the HTML code for your template —
and change it any way you’d like, for better or worse. It requires real
HTML skill to navigate through and change the code so it looks exactly
as you want it to and doesn’t “blow out” part or all of the page, wrecking
the “clean” look of your template with content spilling outside the little
“box” it’s meant to be in.
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Don’t be afraid to ask someone for help if you know a skilled person.
You can also choose a different preexisting template here, for which you
won’t need any special skill.

v+ Dashboard: This is the screen you see when you sign in to Blogger in
the future. It’s your starting point for managing your site.

1 Post photos: Blogger is not as photo-oriented as Flickr (see Chapter 5),
but it’s pretty good with photos. Click the photo button at any point to
add a photo to your blog.

v Post from your mobile: In the United States, you can post text or
photos to your blog from your mobile phone. Just send a message to
go@blogger . com from your phone. Blogger creates a blog entry with
the text or photo you sent and sends a code to your phone. Sign in to
go.blogger.com and enter the code to work on your new blog.

You can do a great deal with your site — allow other people to add
comments to it or not, change the look and function of it, and much more.
Have fun with it — and keep posting to it every day or two.(You can even
post photos to your Google blog from Flickr; see Chapter 5.)
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For much more information on how to get the most out of Blogger, go to
Blogger Help at help.blogger.com or join the Blogger Help Group at
groups.google.com/group/blogger-help.

There are many options for including blogging capability in a full Web site, but
one of the easiest is just to use Blogger for blogging, and then copy and paste
the “best of your blog” onto your full Web site — on Google Page Creator
(Chapter 3) or anywhere else.

When you have your blog up and running, let people know! Let them add

comments if you like. That way, your humble little blog can begin to be the
center of a thriving new online community — yours!
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Using Images and Uploading
Photos to Flickr

In This Chapter
Why file size still matters
Creating GIF and JPEG files
Finding and creating images
Using images in your designs
How images fit in Web pages
Flickr plusses and minuses
Uploading a photo to Flickr
Modifying photos on Flickr

A picture is worth a thousand words,” the old saying goes, and the
right picture can convey information or evoke feelings in a way
that may take many thousands of words to accomplish.

Having photos and other images as part of the Web seems like an obvious
winner now — after all, magazines and newspapers wouldn’t work well if you
took away photographs, drawings, and all the little graphical page design
elements that give each publication its own “look.” In fact, including graphics
in your Web pages is such a winning strategy that I've coauthored, with Peter
Frazier, a companion volume to this one, Creating Web Graphics For Dummies
(Wiley). You can refer to that book if you need more graphics-related details
than you find here.

In the 1980s and ’'90s, before the Web, the Internet was almost entirely

a text-only world. E-mail, Usenet newsgroups, and online service forums
were all text-only environments, running mostly on text-only computer
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systems like UNIX and DOS. The Macintosh and early versions of Windows
laid the groundwork for a better, richer way of communicating over
the Internet.

Graphics embedded in Web pages made the Web take off — and they are
also the most difficult aspect of getting your Web pages right. You can use
graphics to convey a thematic “look and feel,” to accent certain portions of a
Web page, or even to convey the main content of a Web site. Some use of
graphics is necessary for just about any site.

In this chapter, I introduce the creating, finding, and preparing of photos and
other images for the Web. In later chapters, I describe how to make your
images work well within your Web page by adjusting the size of the image; by
flowing text smoothly around the image; and by putting a border around it.
This is covered in Chapter 10 for using a WYSIWIG Web page editor and in
Chapter 14 for using straight HTML.

But what if you just want to put photos on the Web for sharing with other
people, without the complexities of creating a full Web page?

Photo sharing is one of the greatest uses of the Web. Flickr is the most
popular photo-sharing Web site around, largely because it’s so easy to use.

Photo files can be very large. But more and more people have digital
cameras and cellphones that take pictures. These pictures are already in
digital form — and they can be automatically compressed, using the JPEG
standard, from their original size of several megabytes to about 100 KB or so.
(A 100KB photo is just a tenth of a megabyte in size, and doesn’t take long

to upload and download.) These photo files go onto Flickr very easily.

The other technological advance is the increasing number of people who
have broadband Web access. Broadband is a catchall name for all sorts of
faster access, usually at least 1 megabyte per second. At this speed, you can
get ten typical JPEG photos uploaded to your Web site — or downloaded to
your screen — in a second. Suddenly, adding a reasonable number of photos
to your site doesn’t slow it to a crawl — if they’re fairly strongly compressed
with JPEG.

The problems of getting photos onto your site and of viewing photos on the
Web are steadily getting easier, but “easier” doesn’t mean truly easy.

To get to easy, someone has to come along and wrap the technology in a
shell that just about anyone can handle — even a For Dummies author like
me. This happened with the Model T Ford for cars, the Brownie camera for
film photography, and the Apple Macintosh for personal computers. Now
Flickr has done it for online photos.
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Naming of parts for images

Because of the underlying technical realities of
using images on the Web, it helps if | use words
carefully here. For Flickr purposes.. ..

A photo is an image captured by a camera
from reality. Photos use thousands of
shades of color to see the shape and the
subtleties of depth in a person’s face, a
flower, or even a chair, even though the
image itself is two-dimensional.

A photo-realistic image is a computer-
generated image that is so complex that it
approaches the subtlety and complexity
of a photograph. In this book, when | refer
to photos, | include photo-realistic images
as well.

The complexity of photos and photo-realistic
images makes them hard for a computer to
store without making the display size of
the image small, then compressing this
shrunken image using techniques that make the
image less than perfect, but greatly reduce the
file size.

The JPEG, for Joint Photographic Expert
Group, standard uses many subtle tricks to
create a highly accurate version of the
image in a small file size. JPEG, which has

won many awards for the members of the
international committees that joined
together to create it, is a towering achieve-
ment of the human intellect (seriously)
and is by far the most popular standard for
compressing photographic images.

A graphic is an image created by people,
and is usually fairly simple in the colors
and shapes used; there is rarely a third
dimension, just a flat image. Because
graphics use few colors and few or none
of the subtle shadings needed for three-
dimensional reality, they can be com-
pressed to small file sizes with little or no
loss of information. The standard used on
the Web for compressing graphics with
fewer than 256 colors is called GIF, for
Graphics Interchange Format.

| use the term image here to refer to photos and
graphics together.

Confusingly, for small images — even photos —
either JPEG or GIF may offer a better trade-off
between good appearance and small file size.
So be ready to experiment with these standards
before deciding which one to use for small and
very small images.

File size (still) matters

To avoid making big mistakes, you need a general understanding of photo file

sizes and the GIF and JPEG graphics standards used on the Web.

To understand just how important compression is, start with the sidebar,
“Text files versus photo files.” Then read the next section carefully.

Making an image smaller

The first step in making an image file smaller is to decide how big you want
the display size to be. There’s a tricky distinction here.
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Web-safe colors

There are still some computer systems out there
that only display 256 colors, and the Web is
designed to work with 256 colors as a minimum.
There are 256 such “Web-safe” colors for
Windows PCs and a slightly different list for
Macs; there are only 216 colors that are truly
“Web-safe"” for both systems at once. If you use
colors that aren’t Web-safe, then display the
resulting image on a 256-color monitor, it will
try to create a compromise, using a dithered

image mixed from the available colors —
sometimes with awful results. However, this
only occurs in some cases, and there are now
so few users with 256-color-only systems that
it's probably not worth boring you with the
details of how to avoid this problem. See
Creating Web Graphics For Dummies (Wiley) or
the manual for your image-editing program if
you want to learn more.
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Using HTML or most WYSIWYG Web page-creation programs, you can
downsize the appearance of the image on your Web page without changing
the image itself. That is, you can display an image whose actual display size
is, say, 1024 x 768 pixels in a much smaller window, say, 40 x 40 pixels.

The problem with this is that it leaves the original image, and its file size,
unchanged. So the user ends up downloading a 200 x 200 pixel file — which
might be, say, 150 KB in size — but only seeing a much smaller 40-x-40 pixel
file (one-twenty-fifth the size, if you're counting). Not much bang for your

downloading buck.

So what you have to do is use a graphics program to actually resize the image

itself to the size you want to display in the Web page. This will get you a file
that’s no bigger than it needs to be.

Now, you might find as you work on your Web page that you actually need
an image size and proportions different from those you originally created —
portrait-shaped (like this page) rather than square, for instance. That’s

fine — just go back to your original image and resize it again.

Always, always, always save your original graphics file. Make a copy, and work

on the copy, or save it under a name like “Master Image — Me,” then under
another name like “Working Copy” that you actually work on. While you're
at it, always do work on your file, such as applying special effects, adding
lettering and so on, to a version of the file that has not been compressed in
JPEG or any other type of compression. Doing the compression should be

the last step.

To make sure you don’t overwrite your original graphic, find its icon in
Windows File Manager, right-click the icon and choose Properties, then
choose the General tab. Click the Read-Only check box, as shown in Figure 5-1,
and save the change. Now, when you open the file, you’ll be forced to save it

under a new name — you won'’t be allowed to overwrite the original.

www.it-ebooks.info



http://www.it-ebooks.info/

Chapter 5: Using Images and Uploading Photos to Flickr 93

|
Figure 5-1:
Make your
original
graphics
files Read-
Only to save
them from
yourself.
|

My Documents
o |
My Computer Thames Gateway cartoon Properties Q%]
_ N General | 5can results | Summany
@) ™) :
3 =
Nt el L) ‘ Thames Gateway cartoon
Gatew..
= Typeoffil:  GIF Image
il Opens with: @ Intemet Explorer Change.
Recycle Bin
Location:  C:\Documents and SettingshFloydhDeskiop
&) Size: 205K (21 062 bytes]

Internet Sizeon disk  24.0 KB (24,576 bytes]
Explorer

Created. 20 November 2007, 15:24:56
Modified 20 November 2007, 15:24:43
Accessedt 01 May 2008, 18:14:04

Atirbutes:  [7] Readonly [ Hidden

ok [ cencel | [ ook

Using GIF and JPEG graphics formats

A graphics program saves files in its own proprietary graphics format — the
specific arrangement of data that the program uses to save its files. For
instance, the popular graphics program Photoshop saves files in the PSD
format (for Photoshop Document); Paint Shop Pro, another popular graphics
program, saves its files as PSP files. (Guess what “PSP” stands for. Time’s up!)
Web browsers typically don’t know how to display files stored in these
formats.

Fortunately, for the purposes of using graphics in HTML, you need concern
yourself with only two formats for graphics files — GIF and JPEG — and
even then you don’t really need to know a lot about the gory details of these
formats to use them. See the “Naming of parts for image files” sidebar for
details.

GIF, or Graphics Interchange Format, is the file format used by most people to
exchange most graphics that aren’t photographs. That’s because people tend
to create graphics using just a few simple colors, which GIF handles well.
There will be a big block of, say, yellow, then a block of red, then a lot of
white. This kind of image compresses very well.
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Text files versus photo files

Text files are much more efficient for comput-
ers to store and transmit across the network
than graphics files. Why? Text is very tightly
coded; a typical Web page full of text contains
about 1,500 alphanumeric characters, which
can be represented in 1,500 bytes, or 1.5 KB, of
space. So a full page of text takes about a quar-
ter of a second to transmit on even the slowest
standard most people use today, a 56K modem.

Graphics, on the other hand, require a lot of
storage. Every graphic has many pixels, and
each pixel contains information about the color
levels of three colors — red, green, and blue.
An uncompressed, full-page, full-color image
takes up about 1.5 MB of space — 1,000 times
more space than text. This size file takes about
4 minutes (!) to transmit using a 56K modem.

This disparity is why most Web pages are made
up of lots of text (which download quickly), fairly
large areas of white space (which takes no
time at all to download), and small, highly
compressed graphics (which still download
more slowly).

It's easy to fool yourself about file sizes when
you create a Web page on your computer and
then test it on a fast connection. Web-page
creation programs and HTML make it very easy
to make animage appearsmall on-screen while
still taking up perhaps 1to 2 MB. Your computer

is perhaps 100 times faster than a 56K modem,
and a fast connection is anywhere from five to
20 times faster. So a 1 or 2MB image will seem
to load fast enough while you're testing.

But when Joe User tries to access your Web
page over a slow modem, and it's loaded with 3
or 4 of these 1-MB-plus images, his entire com-
puter may halt. Even fast connections have their
hiccups and can be overloaded by too many
large files. So sharing your photos may end up
burdening your friends, family members, and
other viewers of your site or photo page with
very long wait times.

There's also potentially a cost issue here. Your
free Web page’s site may have limits on the
number of megabytes you can download per
month before it simply halts — or your paid site
may charge you by the megabyte. If you get a
sudden upsurge in usage, your Web site can
stop working for the rest of the month, or you
can be hit with a bill for hundreds of dollars, just
to download images that were larger than they
ever needed to be in the first place.

The answer is that you have to reduce the
actual file size of your photos, not just resize the
windows in which they display. Okay, it's clearly
important. Now this chapter describes how to
getit done.

GIF images may contain up to 256 colors, so GIF formatting works effectively
for images that have anywhere from a few colors to a few hundred colors.
Most simple images — and most images created on a computer — fall into

this category.

If an image has more than 256 colors, it loses some color information when
you convert the image to GIF. You have to look at the image before and after
you convert it to GIF to see if trimming the additional colors noticeably

affects the image’s appearance.
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JPEG, or Joint Photographic Experts Group format, compresses complex
images, such as photographs, with many color variations. Photographs work
by using thousands of different shades to capture (for instance) the subtle
differences in color as light falls on a person’s face. Photos typically don’t
have large blocks of a solid color, but instead are filled with subtly varying
colors. If you cut down the number of colors in a photo too much, it becomes
ugly and cartoonish.

JPEG uses psychological and graphical tricks to create an image that

looks as detailed as a photo in much less file space. Even very light JPEG
compression, which barely affects the appearance of the image at all, can
easily cut the file size of an image by two-thirds. “Stepping on” the image
harder, with more compression, begins to introduce visible effects in the
image, but at the same time can easily reduce a typical photo to 10 percent
of its former file size.

This capability makes JPEG the image format of choice for displaying photo-
graphs and other natural-looking images on your Web page. (What makes a
photo look natural is that it mimics the way different shades of a color
appear as light falls differently on various parts of an object.) These images
retain their appearance well when compressed with JPEG.

Figure 5-2 shows a Web page from the NASA Web site to graphically illustrate
(pun intended) the difference in GIF and JPEG photo file sizes. Another site
you may find useful shows various versions of the same photo of Marc
Andreessen, one of the founders of Netscape, to illustrate the various file
types and compression options. Here’s the URL:

cgil.netscape.com/assist/net_sites/impact_docs/e-jpeg.html

You can use this GIF/JPEG test page to test the speed of your own Internet
connection. The total size of the page with graphics is about 70 K.

For images with lots of large blocks of solid color, GIF file sizes tend to be
small. Thus, GIFs are better for banners or images with large areas of solid
color, such as bar graphs or icons. In other words, the simple drawings that
most of us create work best with GIF. Dense artistic graphics and photos
work better with JPEG.

However, there are times when choosing a GIF format for a photo is a good
idea. The GIF format gives you some Web page display options that you don’t
always get with JPEG files. For example, you can make the colors around GIF
images transparent to whatever is in the background of the image, and you
can save GIF images in interlaced format. Images saved in this way, and then
downloaded by a browser, first appear at a very low resolution, and then in
progressively clearer resolution, until the whole image appears. This feature
makes GIF images preferable for quickly displaying a rough-looking graphic
that improves with time — and for creating fancy special effects.
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Transparent images have a clear area surrounding the object of interest.

For example, in a photo of a watch, you may not want any background color
surrounding the watch, just the watch itself seeming to sit directly on

the Web page and its background color. To achieve this effect, you use a
transparent GIF, an image with a clear border area. The background color of
the overall Web page shows through the transparent area, and the object

of interest appears to “float” over the background.

Example: Resizing and saving
a screen capture

There’s nothing like actually going through the steps to help you gain a
practical, not just an intellectual, understanding. These steps will show
you how to capture the current image on your screen, resize it, and save
it as a GIF and a JPEG, then compare the file size and appearance of the
resulting file.
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Doing your filing for Web pages

Any up-to-date Web browser can display three
types of data: text with HTML tags, GIF graph-
ics, and JPEG graphics. (Some people pro-
nounce GIF as “jiff,” others as “giff” as in “gift.”
| prefer “giff” as in “gift.”) A typical Web
browser displays HTML-tagged text appropri-
ately, although not all browsers understand all
the same tags. A browser also displays GIF and
JPEG graphics inline — that is, embedded
within the Web page. A Web page with inline

graphics looks like a page in a magazine,
with text and images mixed seamlessly
together. However, each graphics file is stored
separately from the HTML-tagged text that
makes up the underlying Web page. This makes
the Web work better overall, but contributes to
some of the problems — such as the difficulty
of keeping all your Web files together for proper
display — that | describe later in this book.

WING/

There are scores of graphics programs out there, many of them completely
free, free for a limited time, or relatively inexpensive. (A low-cost version
of the industry standard Photoshop program, called Photoshop Elements,
retails for less than US$100, and many computers come with a graphics
program pre-installed for free.) But there’s only one graphics program you
can count on finding on any Windows computer, and that’s MS Paint.

So, if you use Windows, follow these steps to learn how to capture the
current screen image (one of the most useful ways to get graphics, as long
as you respect copyright restrictions), resize it, and save it as both a GIF
file and as a JPEG. (If you use a Mac, there’s no similar standard program,
but you might try downloading Ultimate Paint from a source such as www.
download.com and following roughly the same steps.)

Always think about rights issues when you’re looking for graphics to use. For

the example, I'm going to take a PDF file as represented on-screen and make it
into a very small image to serve as an example of a PDF on a Web page. 'm
going to use a PDF of a page from a For Dummies book I wrote because that
way there are no rights hassles. If you follow my example and put a shrunken
(but recognizable) image of a PDF file on your Web page, be sure to use a
PDF file you have the rights to. It’s just good practice if you want to avoid any

possible rights problems.

For Windows, follow these steps to capture a graphic from the screen and
save it as an uncompressed BMP file, a GIF file, and a JPEG:

1. Create or find the graphic that you want to use online.

This is the fun part! But be careful, any task involving images can
somehow magically expand to take hours more than the time you had
expected it to. Set yourself a realistic goal with lots of room for error —
“a fish,” say, not “a green flounder seen from the side.”

In this example, I've navigated to a PDF of a page from Creating Web
Graphics For Dummies (Wiley).
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2. To capture the entire screen, press the PrtSc key (which may have a

slightly different name on your keyboard); to capture the currently
active window, press Alt+PrtSc.

Usually, you will just want to capture the active window.
When you do this, the image is copied to the Windows Clipboard.

The Windows Clipboard and Microsoft Paint store images in BMP
format, short for BitMaP format. Every pixel that’s captured gets up to
four bytes to allow its color to be captured exactly. This produces an
exact, completely accurate, absolutely uncompressed image that, like an
uncompressed photograph, takes up immense amounts of file space.

Despite the fact that BMP files are large and Windows-specific, you can
put them in your Web page and they’ll seem okay; Internet Explorer
running on Windows will display BMP files, and testing on your own
machine makes the problem of long download times disappear. But
watch out; if you put your page up on the open Web, it will download
slowly for users with slow connections, and the image won'’t even
open on many non-Windows systems. A savvy user will look at your
HTML source code, see you linked to a BMP file, and conclude that you
bothered to read a good book on Web pages (like this one)!

. Open Windows Paint by clicking Start=>Programs=>Accessories= Paint.

Windows Paint will open.

. Resize the image area to the size of the pasted area when you paste in

the image:
a. Choose Image=Attributes or press Ctrl+E to open the Attributes panel.
b. Enter 1 for the width and 1 for the height.
c. Click the Pixels radio button under Units, as shown in Figure 5-3.
d. Click OK.

Resizing the working area to one pixel by one pixel, using the Attributes
dialog box, will make working with pasted-in images much easier.

. Paste the captured image by choosing Edit=>Paste or by pressing

Ctrl+V.

The captured image appears in Windows Paint. The entire image is
selected.

. Save the captured image twice: once as an original file, with a name

like Screen Capture Original, then as a working copy, with a name
like Screen Capture Copy.

Your changes are recorded in the copy, leaving the original alone.

Consider creating a separate folder for each image you work with to
contain the original image and various versions you create.
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To make sure the original image isn’t changed, find the file in Windows
Explorer, right-click it, choose Properties, and then change it to a
Read-Only file (refer to Figure 5-1).

7. To see the size of the pasted image, choose Image=>Attributes or press
Ctrl+E.

The size of the image will appear in the Attributes dialog box.

Always check the size of the pasted image, and always write it down —
on paper, so you have a record, or even in a spreadsheet program so
you can calculate the percentage by which to resize it.

8. To resize the image, choose Imager>Stretch/Skew or press Ctrl+W.
The Stretch and Skew dialog box appears, as shown in Figure 5-4.

9. Decide on the size you want for the image, calculate the percentage
this is of the captured image, and then enter the new size as follows:

¢ Enter the percentage you want to shrink the image by in the
Stretch part of the dialog box, entering the same percentage in
both the Horizontal and Vertical areas. Click OK. The image
will be resized.

e If the result isn’t what you want, press Ctrl+Z to undo and
try again.
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¢ Be sure to enter the same percentage in both the Horizontal and
Vertical areas to evenly shrink the image. (If you shrink the image
unevenly, it will look very odd indeed, distracting from your Web
page’s message).

For this example, I've chosen to shrink the image to about 150
pixels tall, which requires shrinking it to 15 percent of its original
size. The width is also 15 percent, resulting (in this case) in a
width of 115 pixels.

If you're sure you won'’t forget the vital step of resizing, you can use the
original, very large file when creating your Web page, using commands
in your WYSIWIG editor or in HTML to resize its appearance in the Web
page until you have it appearing in the size you’re happy with. Then go
back and make a resized version of the file that fits what you need for
your Web page.

Save the resized file as a BMP file. Choose File=>Save As to open the
Save As dialog box. For Save as type, choose 24-bit Bitmap from the
scrolling list. Enter a name for the file. Click the Save button.

The file is saved. It will have the suffix .BMP to mark it as a bitmap file,
but you won’t see this suffix in Windows, which suppresses filename
extensions.

Always save the file as a BMP file first so you have an uncompressed
version for later editing.
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Consider putting the letters BMP in the main part of the filename so you
can easily distinguish the BMP file from other saved versions of the file,
and do the same for the GIF and JPEG versions.

Save the resized BMP file as a GIF file:
a. Choose Filew>Save As to open the Save As dialog box.

b. For Save as Type, choose GIF from the scrolling list to save the file in
GIF format.

c. Enter a name for the file and then click the Save button.
The file is saved.
Save the resized BMP file as a JPEG file:

a. Choose Filew>Open to open the uncompressed BMP file, or choose
the BMP file from the list of recently edited files at the bottom of the
File menu.

b. Choose Filew>Save as to open the Save As dialog box.

c. For Save as type, choose JPEG from the scrolling list to save the file
in JPEG format.

d. Enter a name for the file and then click the Save button.
The file is saved.

MS Paint always uses a relatively harsh compression setting for doing
JPEG compression, whereas other image programs let you choose how
strongly to compress the file. A JPEG created by MS Paint usually
doesn’t look very good if larger than about 60 pixels in height or width.
If the image is too harshly compressed for you, you can still use MS
Paint initially, but use a more flexible graphics editor to create the final
version of the image.

Check the results of your work:

a. Open the file containing the BMP, GIF, and JPEG versions of the
image and note the file size of each.

b. Right-click each image and choose Open with=Internet Explorer to
see how the image will look in a Web page.

c. Note whether the GIF or JPEG version of the image has the best
combination of low file size and acceptable image quality.

The GIF file will lose some image quality if the original image had more
than 256 colors. For large or medium-sized photos, JPEG is almost
always better, but for small images only experimentation can tell you
which will give better results for a given image.
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The danger of re-(re-)compression

If you're a scuba diver, you are likely to have
been warned about the dangers of coming up
from a great depth too quickly, which can cause
a serious condition called “the bends.”
Unfortunately, it's possible to give your graphi-
calimages “the bends” as well— but the cause
isn't decompression, it's recompression.

When you use GIF or JPEG to save and com-
press a file, the compressed file is significantly
different than the original, in a way designed to
maintain the image’s appearance while shrink-
ing its size. But if you recompress the com-
pressed file a second (or third, or fourth) time, it
gets ugly fast, cluttered with “artifacts” — areas

in which poor compression introduces visible
“scarring” to the original image. So (it bears
repeating) always keep a copy of the original to
work on.

There is one exception to this. Some devices
(such as digital cameras) always save files in a
lightly compressed, still very large, JPEG file.
This kind of file can be re-compressed in JPEG
to a much smaller image size without visible
damage. But this can only be done one time;
re-re-compressing the file makes it really ugly.
So treat large JPEG files as originals — save
them, and only compress them one (more) time
before using them in your Web page.

Obtaining and Creating Images

So you want to put various images on your Web page. Great! But, if you can’t
find the image you need online and use the screen capture method above,
how do you create the images you need and get them in the right format

(GIF or JPEG)? Fortunately, creating the images you want, or finding some to

use, is pretty easy.

The easiest way to obtain graphics is to get access to a clip-art collection.

Computer stores sell many inexpensive collections of business and
recreational graphics on CD-ROM. You can also access a number of royalty-
free graphics and icon collections online.

<P If you're doing a business or professionally focused Web page, it’s important
that it have a clean, professional look. To get this kind of look, you have
to use attractive images and lay out your page carefully. Chapters 11 (for
WYSIWYG editors) and 15 (for straight HTML) tell you how to design your
page appropriately for various purposes.

You can spend endless hours looking for art online. To help you get off to a
quick start, here’s a listing of sites I find especially cool:

v For a large number of different kinds of resources, go to the main
WebReference site at www.webreference. com.

v For images of various types, go directly to the images area at www.
webreference.com/authoring/graphics/images.html.
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v For page backgrounds, visit www.webreference.com/authoring/
graphics/backgrounds.html.

v For photographs, try a site with preexisting stock photos — www . image
state.comis one I can recommend. Another choice, popular with
professionals, is www . gettyimages . com, but these images cost money.

You can find many more sites that offer images and image conversions.
Start with the sites mentioned here and expand your search until you
find what you need.

Using the Image Search feature on Google or AltaVista is one of the best ways
to look for suitable graphics. Be careful, though: Most of the graphics you find
are copyrighted; for your Web site, you should only use images that are
explicitly made freely available.

One of the best places to find images that are free to use is on various govern-
ment Web sites — with URLs ending in . gov in the U.S. and . gov.uk in the
U.K., just to give two examples. The taxpayers in each country have paid for
the images, so they’re made available for widespread free use. So government
sites are a great resource for free images and, to a lesser extent, sound and
video files.

In addition to searching online, another way to get graphics is to whip out
any paint program and draw the graphics that you want. For example, you
can use the free Windows Paint program (described above) for your initial
graphics work. Even inexpensive paint programs today enable you to create
some stunning graphics; you’re limited mostly by your imagination and artis-
tic ability (which for some of us is a pretty strong limit!).

For big-bucks commercial work and fine art, people regularly use high-end
programs such as Adobe Photoshop and Adobe Illustrator. If you lack talent,
you can always ask one of your artistically inclined friends to help you, or
you can even recruit a starving art student.

Another technique is to use a scanner. You may already have one at home,
or have use of a scanner in your office. If not, head to your favorite copy
shop or Internet cafe and rent some time on its scanner. Simply scan your
graphic or photo, save it in GIF (for graphics) or JPEG (for photographs)
format, and slap it on your Web site.

Unfortunately, scanned images tend to have “noise” — little bits of dust, folds
in paper, and so forth — that not only mess up the appearance of your image
but that also completely undermine compression by breaking up what might

otherwise be solid areas of white or some other color. It can take many hours
to clean up this noise if you need a high-quality, well-compressed image.
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More on graphics

The Graphics File Formats FAQ (Frequently detailed technical information about GIF, JPEG,
Asked Questions page or area on a site) can  and other file formats. For a detailed description
answer almost any conceivable question about of how to use images well, see cgi.
graphics. For a wide array of information, netscape.com/assist/net_sites/
visit www.martinreddy.net/gfx/ impact_docs/index.html.
utils-hi.html. Links from this site lead to

\\3

For photos, work with a photo developer, such as a suitably equipped local
developer, a chain store such as Wal-Mart or Rite Aid, or a mail-order and
Internet operation such as PhotoWorks (www.photoworks . com), that can
develop your film right to diskette or Photo CD.

A great way to get photographs is to take them with a digital camera.
Digital cameras come with cables that connect the camera to your PC to
download the photographs onto your computer. They also come with
software that enables you to edit the photos on your PC and save them in
JPEG format.

Many cellphones in use today take pictures that are good enough for casual
Web use. These files are usually stored as JPEGs that you can downsize
further for Web use. However, as you put these photos onto your Web site,
you may find yourself wishing that your camera had a flash (or a better
flash), a little more resolution, zoom, or some other features of a “real”
camera.

No matter what format your graphic came in originally, you can convert it to
GIF or JPEG by using software that you can easily obtain from the Web. Mac
users can run GIFConverter (available at www.kamit.com/gifconverter),
and Windows users can run the excellent LView program to convert between
multiple formats (find LView at www. 1view.com). Save your graphic as a GIF
or JPEG file, and you’re ready to incorporate the graphic into your Web page.

Save your image in the program’s default format before saving it as a GIF or
JPEG. When you save as a GIF or JPEG, the image can lose information. Every
time you reopen the GIF or JPEG image, edit the file, and then save it again,
you lose even more information. So save your file in its default format to
preserve the data in it for later editing, then save a separate copy in GIF or
JPEG to use on the Web.
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What about rights?

You can find a number of great graphics in
books and magazines and on Web sites. Can
you just scan or copy these graphics and use
them in your own Web site? Should you?

Yes and no. Yes, you can; but no, you shouldn't.
Publishers either own the images that they use
or obtain a license for them. You can’t legally
use mostimages on your own Web site without

For some images on the Web, simply sending a
note to the WWebmaster gets you a quick okay.
But for most Web images and for nearly all
images in print, permissions may be very hard
to get. Creating a new image that serves the
same purpose is often easier than negotiating
permissions. And then maybe you can make a
little money licensing your new images out to

I
either buying or licensing them. CUETpEaplE)

Designing with Graphics

The most difficult aspect of including graphics in your Web pages is resolving
all the design issues that accompany the use of graphics. Creating effective
graphics and placing them properly in relation to your text is not as easy

as boiling water. Although this book doesn’t cover all the complexities of
graphic design, I can give you a handle on the additional concerns that

arise when you use graphics on the Web. That way you can effectively apply
your own graphics skills — or those of people who work with you — to your
Web pages.

More on download speed

One of the Web’s ongoing problems is download speed — the amount of time
a Web page takes to appear on the user’s screen. Download times are
especially slow for graphics-rich pages, which, although more interesting to
view, can be more frustrating because they appear more slowly. And the
trade-off is not simple; lots of variables intervene — these, for example:

v Access speeds: Different users access the Web through connections that
run at different speeds. And the same server can serve up a Web page at
different speeds, depending upon how busy the server is. When you test
your brand-new, graphics-rich page on your local machine, everything
may run fast. But when you upload that same page to a server and
access the page over a 56Kbps (kilobits per second) modem, the page
loads much more slowly.
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Many more users now have broadband (fast) access at home, as well
as at work. The good news is that most users will see your graphics
quickly. The bad news is that the still-substantial minority with slow
access are getting more and more frustrated as Web authors who have
broadband access get careless about page sizes!

+* Good and bad graphics: If you plan to spend your users’ time on down-
loading big graphics, invest some effort up front to make sure that the
graphics are as high-quality as possible. People don’t mind waiting for a
good graphic nearly as much as they mind waiting for a bad one. A good
graphic may be a product shot that shows a Web surfer exactly what he
or she is going to get. A bad graphic may be a banner that says “HELLO!”
in hundreds of rotating fluorescent colors.

v Frustration levels: The same users who enjoy watching your page
appear in the morning while drinking a cup of coffee may be tempted to
scream at their browsers when they try to quickly check out your page
just before heading home from work — especially if they had a bad hair
day, a bad boss day, or even a bad browser day. The better the job you
do with your graphics, the more your page will please people.

Table 5-1 shows the time necessary to download 60 K (kilobytes) of data. A
text-only page is usually just 2-3K, but pages with graphics are much larger.
A complex, quarter-screen GIF image, for example, may be about 60 K,
whereas a photo measuring about 150 x 150 pixels would have to be strongly
compressed to be that small. Compare the total size of all the elements in
your page to the times shown in Table 5-1 to get an idea of how quickly your
page loads for the most speed-deficient user, and then design with that
person in mind.

Table 5-1 Download Times

Access Speed Description Time to Download 60 K
28.8 Kbps Low-end Internet modem 35 seconds

33.6 Kbps Mid-range Internet modem 30 seconds

56 Kbps Fast Internet modem 20 seconds

DSL Special phone line, modem 4 seconds

Cable modem Special cable hookup, modem 1 second

Ethernet Standard network Less than 1 second

Avoiding three big mistakes with images

Don’t make these three big mistakes that hamper effective usage of images on
the Web:
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v+ No images: Sorry, but having no images on your Web pages means
boring pages, no matter how good the text. Because you'’re reading this
chapter, I assume that you're trying not to make this mistake.

+* Too many images: Using too many large, slow-to-download images may
be the biggest newbie Web-author mistake. (A lot of old hands make a
similar mistake — everything is well-designed and compressed, but one
uncompressed or too-lightly compressed photo sneaks through, making
the whole page download slowly and shaking the user’s confidence in
the entire site.)

+” No text alternative: An increasing number of vision-impaired people
use the Web, and some users surf Web pages on text-only or slow-
connection devices (such as a cellphone’s Web browser). You need to
accommodate these users by creating your page in a way that supports
text-only access as well as graphical access, as described in Chapter 10
(for WYSIWYG Web page editing programs) and in Chapter 14 (for HTML
editing programs).

Try an experiment: Go into your browser, turn off the graphics display, and
load your Web page. If you can’t tell what’s on the page or what links go
where, you need to redesign your page. (Then, just to blow off steam, or if
you don’t have a Web page up yet, try the same experiment on some other
people’s pages and send them a polite note if you encounter problems.)

The usual way to redesign your page for text-only access is to include a
textual menu linking to the same places as your graphical menu. Some sites
provide a whole parallel set of Web pages that are purely textual rather than
graphical. Providing parallel, text-only pages lets the user choose whether to
go for the attractive, bandwidth-sucking graphical pages or for the very fast
text-only pages, and enables those with visual impairments (or those using
other devices such as cellphones) to enjoy the full benefits of the Web.

In the past, many have chosen text-only access because of slow download
times. However, because the percentage of users with non-broadband access
continues to drop, providing a complete set of text-only pages may be
overkill. Consider providing a text-mostly version, with limited use of images,
simpler layout, and alternative text for images. This option may be just the
ticket for users with visual impairments or those who are visiting via limited
clients such as cellphones.

Here are the most important rules for supporting text and graphical access:

v As you design and create your page, think about how your page will look
with all graphic access turned off as well as on.
v Test your page with graphics turned off.

v Test your page in different browsers.
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v Include ALT tags — actually, the ALT attribute within the IMG tag — in
all images so that explanatory text appears whenever a graphic isn’t
displayed.

v Provide text-only menus in addition to icon-based selections and
image maps.

v If you want to make everyone very happy, consider creating a separate,
text-only version of your site.

<P If you're considering creating a Web site that’s accessible by portable devices
such as Windows Mobile-powered phones or the RIM Blackberry line of
handheld devices, then creating a text-only version of your site makes a great
deal of sense. The text-only version of your site is a good starting point for
handhelds.

Flickr forward

Flickr is a great resource for working with images because it’s all about
photos — and about making photos easy to use online. The home page of
Flickr is shown in Figure 5-5.

€ Welcome to Flickr - Photo Sharing - Windows Internet Explorer SEe|
@-‘, D ] Tae] [#21[%] [Gona e

File Edit View Favorites Tools Help

¥ # | Welcame to Flickr - Photo Sharing | B - B & - [DrPase - Gk - @ Br

Sign In

Create Your Account

AND

h h viDEo
Share your photos.
Watch the world.
4,528 things uploaded in the [ast minute - 558,832 thinas tagged with urban - 2.4 million things neotagged this month - Take the tour

=ity 1]

DEELEA
I HErEEE : ‘“&J
Figure 5-5; PRy RJeesy @ t i %
Flick your Share & stay in touch Upload & organize Make stuff! Explore...
photos onto
Flickr. B
| € mternet H100%  ~
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The constant surge of camera phones and digital cameras has created a
problem — many photos don’t get printed anymore. That’s right: The photo
gets taken, maybe shown to a couple of people on-screen, maybe e-mailed
to a friend or two, and then forgotten in a folder somewhere.

Even the few photos that do get printed have all the limitations of any physi-
cal object: They cost money to create, can only be in one place at a time,
and have to be stored somewhere or thrown away. All of those limitations
can add up to a burden on your wallet and on the environment.

Enter Flickr, which bills itself as “the best way to store, search, sort, and
share your photos.” (Try saying that three times fast; you’ll end up saying
“searching, shorting, and sharing.”)

As a visitor to Flickr, you can have an awful lot of fun. You can search
through photos in a bunch of different ways, from the sensible to the quirky.

But you get the most out of Flickr by using it to store and show off your own
photos. When you try this, you find out the really great things Flickr lets
you do:

v Storing your photos: You can create a free account that holds hundreds
of photos. With a free account, you can upload 20 MB of photos a
month, or about 100 reasonably sized JPEG images. The number of
photos is also limited — to 200. Or upgrade to a Pro account and store
thousands of photos.

You can simply store all your photos online, at least up to a point. Or
you can just store the interesting ones and keep the rest on your PC —
or take the opportunity to send them to the great big bit box in the sky.

v~ Sharing your photos: People can visit Flickr and see your photos —
under your control! You can keep private photos confined to a
small group of viewers, whereas others can be seen by anyone who
visits Flickr.

v Sorting your photos: As your “photobase” grows, you can sort and
organize your photos in many ways, making them more interesting and
convenient to access for your own use and for others.

1 Searching through photos: Labeling and organizing your photos well
makes it very easy for you to find just the ones you want — and for
others to find the photos you want to share with them as well.

All these uses for Flickr are covered in this chapter. I show you how to get
the most out of Flickr and your photos.

In addition to doing these basic things, you can also get involved with the

Flickr user community. There are special things you can do with photos on
Flickr that you can’t do other places. You can
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v+ Add notes to a photo: For instance, you can name everyone in that
picture from the office party.

1 Add tags to a photo: Make it easy for people to find your picture among
others like it. For instance, by adding the tag “Golden Gate Bridge” to
your photo, you can make it easy for people to find your photo among
all those of the famous San Francisco landmark.

v~ Put a photo in a pool: Pools of photos are photos linked in some way;
if you see an open pool that’s relevant, you can dive right in and add
your photo to it!

v Engage in discussions about photos: You can share comments about
photos on a message board — even highlight an area on a photo and
mark it up with a message. (Yes, you'll see lots of immature “kiss me,
you fool”-type messages if you look around.)

1 Publish photos to a blog or your Web site: You can put pictures hosted
on Flickr in your blog or other Web site. You can even see recent Flickr
uploads on your mobile phone.

[ don’t describe these additional features of Flickr in much detail here —
after you start using Flickr, you can easily (perhaps too easily) spend all your
time there. I don’t want to be seen encouraging you to do too much of that,
or your boss, spouse, kids, and other folks who need your attention might
blame me when you “Flickr out” for days on end.

Despite all Flickr does for you, you may want to master one capability for
processing images before you upload them: making smaller versions of your
photos, as described early in this chapter. Many digital camera images are
very large, say, 1024 x 768, and with millions of colors, resulting in a multi-
megabyte image. This is way more than you need for most purposes (except
ordering prints), and means you’ll use up your 20MB monthly allotment very
quickly. (Mobile phone camera images tend to be much smaller.)

Flickr resizes photos during uploading, but you may want to control the
process by doing it yourself.

So, to spare yourself trouble, find an image-manipulation program that

you can use to make images smaller. Fortunately, Flickr has good image-
manipulation features built into the site. You can also try Photoshop
Express, an offering from Adobe (www.photoshop.com/express), though
online reviews rated the initial version below Flickr’s tools. One very good
free program is InsightPoint. You can download a completely free version
from sites such as CNET’s Download.com (www . download. com). Or, look
to see if an image manipulation program was provided with your digital
camera.
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Flickr flaws

Not everything is perfect in Flickr-land. Here are a few flies in Flickr’s
ointment that you should be aware of going in:

v Too adult? For some potential users, Flickr may have too many grown-
up images. Despite strict rules forbidding “frontal nudity, genitalia,
and intimate moments” in Flickr photos, it’s not hard to find nudity and
semi-nudity on the site. If you post family photos on Flickr for your
children to view, they may keep looking on the site and find some things
you’d rather they not see.

Flickr’s terms of service limit users to those 13 or older, but there’s no
way for anyone to enforce it — probably, few users even know it. So it’s
up to you to decide whom you want to encourage to use Flickr.

v Too easy? Flickr makes it very easy to upload huge numbers of not-
very-interesting photos. (Is every picture you take with your mobile
phone worth sharing with the world?) You have to exercise consider-
able restraint to make sure all the photos you upload are worth the
time your friends and family might spend looking at them.

v Too open? Flickr has excellent privacy protections, but it’s still easier to
do the lazy thing and make all your photos public — or for passwords
to be shared more widely than you planned. Someone putting Tom
Cruise’s head on your body might be funny — but there are enough
weirdos out there that you may want to think twice before letting photos
of, say, your kids be widely viewed.

v Too flexible? Professional photographers are always careful to get a
signed model release (permission form) from everyone depicted in a
photograph they want to sell or otherwise use. You don’t necessarily
need to be that careful — but the jury’s still out (pun intended) on
exactly what the limits are. Be careful, especially about using photos
without rights in any way that may help you make money (for instance,
on a business’s Web site).

v Too good? Flickr is so good that it’s been acquired by Yahoo! You now
need a Yahoo! ID to open a new account. The changes that Yahoo! makes
may end up improving it — or not, depending on your point of view.

Think over these concerns before you commit a bunch of time and energy
to Flickr. You may prefer to put your photos online some other way. Or,
use Flickr to host your photos, but put the best of them on your own site
for viewing. No matter what, you have many more options with Flickr
than without.
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QNING/ If you share a computer with others, you may not have as much privacy as
Yy you think. The History function of your browser can make it easy for others to
see Web pages you’ve visited, and photos get cached in ways that a lot of
bright 10-year-olds can figure out. So be very careful if you think you can use
“private” areas on Flickr to upload and view highly personal photos, and then
let others use your computer and not have access to them. They may see
more than you intend for them to.

Uploading a Photo to Flickr

Here’s a quick guide to getting a photo onto Flickr. It’s amazing how
confidence-building it can be just to do something simple like this once.

1. Get a JPEG photo onto your computer system.

The easiest way is to upload or e-mail a photo to yourself from your
mobile phone. Or, copy pictures from a digital camera. Find a photo on
your hard disk. (Choose Start>Search=>For files or folders, and then
choose Pictures, Music, or Video.) Or copy a photo from the Web —
use a search engine to find images that are free for use.

2. Open your Web browser.

As is the case with more and more Web sites, Flickr can be used with
any kind of PC — or even with a mobile phone. But when you're just
getting started, it’s best to have a PC with fast Web access to use when
you upload photos to Flickr.

3. Go to www. flickr.com.

A screen like the one shown earlier in Figure 5-5 appears, although the
screen may change to reflect new quotes, different sponsorships, or
increased influence from Yahoo!, Flickr’s owners.

4. Sign in.

If you're already a Yahoo! or Flickr member, click the Sign In link on the
home page and use your ID to sign in. If not, click Sign up! and create
an ID.

After you're signed in, an opening screen like the one in Figure 5-6
appears. Resist the temptation to explore — it’s time to get
something done.

5. Click the link Upload your first photo (or Upload photos if you've
uploaded before).

The Upload Photos page appears.
6. Click the Browse button.

The Select File dialog box appears over the Upload Photos page, as
shown in Figure 5-7. Note that you can easily specify up to six photos
at a time.
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7.

10.

Use the Select File dialog box to locate an image — or several images.

Find an image on your PC to upload to Flickr. Repeat to upload multiple
images.

You can avoid the step of copying files to your PC if you can attach your
mobile phone or camera to your computer. Just use the Select File
dialog box to find the mobile phone or camera as an attached device,
and then copy the files directly from there.

Make sure you don’t upload an image if you think anyone in the picture
may not want his or her face plastered all over the Web. Some people
have lost job opportunities (or even jobs they already had) because
personal photos that depicted (for instance) drunken behavior at a
party were put up on somebody’s Web page.

. Upload your photos.

Click the Upload button; your photos are uploaded, and Flickr creates
various preview and thumbnail versions for use in various places. Click
the “add a description?” link to bring up the Describe This Upload
screen.

. Add one or more tags to describe the image(s).

Add descriptive words, called tags, to describe your pictures. Using tags
in a way that makes sense to you, and that fits the way others use tags
on Flickr, is a bit of an art — for now, just pick a descriptive word or
two. You can always edit tags later.

Choose privacy settings.
There are five possible privacy settings in Flickr:

® Public: Everyone can see your photos. Click the Public radio
button to choose this setting.

® Private: Visible to you only. To get this setting, click the Private
radio button, and then leave unchecked the Visible to Friends and
the Visible to Family check boxes.

® Private: Visible to Friends. Click the Private radio button, and
then check the Visible to Friends check box. Clear the Visible to
Family check box.

® Private: Visible to Family. Click the Private radio button, and then
check the Visible to Family check box. Clear the Visible to Friends
check box.

® Private: Visible to Friends and Family. Click the Private radio
button, and then check the Visible to Friends check box and the
Visible to Family check box.
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\\3

|
Figure 5-8:
Now it's
time to title,
describe,
and tag your
photos.
|

11.

12.

You specify friends and family by adding them to lists. (Yes, you can add
one person to both lists, which is sort of like an “all access” pass.) When
those folks sign in, they get the access you've specified.

The Private setting visible to you only — which you achieve by choosing
the Private radio button and clearing both the Visible to Friends and
Visible to Family check boxes — is a bit hidden, but very useful. You

can use this setting to store all your photos on Flickr, and then “publish”
selected photos to others by changing their privacy settings.

Add titles, descriptions, and tags to your photos.

Now’s the time! It’s easy to skip this step, but if you don’t do this now,
you may never get around to it — and you may have difficulty finding
some of your precious photos again. A typical result is shown in
Figure 5-8.

Save your photos.

Finally, you're on Flickr! Figure 5-9 shows the first set of photos the
author uploaded. Note that the middle picture is sideways — I fix that in
the next section.
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|
Figure 5-9:
Three's a
lucky
number.
|
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Modifying Photos on Flickr

One of the great things about Flickr is that the people who created it have
thought through the whole process. They don’t make you fix a photo before
you upload it, or figure out every detail of a description the first time — you
can change most of those things after you upload a picture.

Here’s a quick checklist of things you can easily change after you upload a
picture — avoiding, for now, some of the more advanced sharing features

of Flickr:

v+ Add note: You can annotate a picture with a note in a specific location.

v Order prints: You can buy copies of your photos — this works better on
photos with relatively high resolution (1024 x 768 or larger), thousands
or millions of colors, and taken with a steady hand (not blurry).

1 Rotate: My favorite! I like to take pictures at different angles, and Rotate
saves me time because I don’t have to fix the rotation until after I

upload them.
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1 Change privacy settings: It’s easy to change who can see a picture.

1 Change the title, description, and tags: Easy to do, and redo, and
redo — but hard to get around to if you've uploaded a bunch of pictures
without giving them meaningful titles, descriptions, or tags.

v Flag as “may offend”: I'm sure that my wonderful readers would never
upload a racy image — but in case you do, here’s your chance to keep it
from vulnerable eyes. Just flag the photo as “may offend” and you keep
it from being found on a normal search.

Follow the instructions below to make the preceding changes, or even more,
in a photo:

1. Click a photo you’ve uploaded to Flickr.

Find any photo you've uploaded and click it. You are taken to an editing
screen for the photo.

2. Click the button you want to apply to the photo.

You can apply all sorts of changes or actions to the photo (see the
preceding list). For example, if you click the Rotate button, a small
window appears to preview the rotate operation.

3. Finish the action you’ve chosen.

Depending on what you’'ve chosen to do — add a note, order prints,
and so on — you’ll be prompted to take one or more steps to finish the
action. Figure 5-10 shows how the screen looks after choosing Rotate
for a specific picture, and then clicking the turn-right icon; the preview

o window shows the rotated photo.

Flickr-ing photos to your blog

You can “flick” photos onto your blog very your blog known to Flickr, enter the password,
easily once you set up a couple of things. and so on. Once setup is done, it's just a matter
Blogger, the blogging service referred to in  of a couple of mouse clicks to move photos,
Chapter 4, is one of the many blogging services  with comments, to your blog. (Fellow Flickrers
directly supported by Flickr. Start by visiting who don't want their photos blogged can
www.flickr.com/blogs.gne to make specify that as well.)
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Figure 5-10:
You can
make your
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4. Click
The s

OK to complete the action.

creen reappears with the update you’ve chosen.

5. Add comments.

Comments make photos more interesting — and you can use basic
HTML to format them, as shown in Figure 5-11. See the Cheat Sheet at
the front of this book for some basic commands, or go to Chapter 8
for more information. Here’s a brief list of tags:

b. Traditional formatting is <b> to start bold text and </b> to
end bold.

i. Traditional formatting is <i> to start italicized text and </i>
to end italic.

blockguote. Marking out text with <blockgquote> before
and </blockguote> after keeps its original formatting and line
breaks.

a = href, target. You can use traditional HTML formatting,
<a="www.flickr.com">. Give a link from the picture to a
Web address.
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Taking Flickr Further

You can do much more with Flickr. Getting experience with uploading,
modifying, commenting on, and tagging photos prepares you to take
advantage of all of Flickr’s features.

You can organize your photos using Organizr, Flickr’s photo-file management
system. You can change access permission, dates, and tags. You can create
sets and modify your Photostream, the log of recently updated photos.

As you do more with photos, even your view of Flickr’s home page changes
to reflect your work.

Flickr can, all by itself, become a major preoccupation. For example, you can
find popular tags on Flickr and set yourself the task of creating and adding
new photos that extend your favorite tag sets.

You can also use Flickr to host photos that you then publish on your own

Web site or blog, as described in previous chapters — so Flickr can be a
resource for all your Web publishing. Enjoy!
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Chapter 6
Playing Sounds on Your Site

In This Chapter

Using sound on Web pages
Getting sounds

Creating an MP3 file
Creating a MySpace account

Sound is one of the most important sensory resources we have. It’s our

early warning system and our primary means of communicating directly
with each other. Music is one of the great artistic forms and one of the main
pleasures in most people’s lives.

Music download sites, for legal, illegal, and gray-market recordings, are
among the most popular sites on the Web, consuming huge amounts of band-
width and attracting usage, attention, lawsuits, and even prosecutions in
large numbers. The leading legal music-download site, iTunes, is one of the
great successes in not only Web but business history.

Yet most Web sites offer only “The Sound of Silence” (to name-drop Simon
and Garfunkel). And thankfully so, many of us think; having sound come on
suddenly when one visits a Web site is one of the greatest and, often, nasti-
est surprises that can happen to someone using the Web. (As you’ll know if
you've ever been embarrassed at work by people turning around to see what
the noise suddenly coming from your PC is all about.)

As the example of noisy Web sites illustrates, sound is also very basic and
very emotional for people. We have strong reactions to sounds. Teenagers —
and, in the U.K. and other countries, soccer fans — often organize into tribe-
like groups around music and songs, and music has been used throughout
history to organize, direct, and inspire soldiers. So using sound wrongly has
penalties that may outweigh the benefits of using it right.

Sound is also a vital — if overlooked — part of video files, the subject of the
next chapter. It’s the unification of the power of sound with the power of
moving images, offering a decent simulation of a real-world scene, that makes
video so affecting.
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This chapter describes some of the issues around using sound on a Web site —
and the much sunnier picture for downloadable tunes, including how to post a
tune on MySpace, the extremely popular Web-site host.

Compressing and Decompressing Sound

The human ear is really, really good at distinguishing among different
sounds. We can usually spot “foreigners” — whether from another country
or maybe just from another neighborhood — by their accents in a second or
two, or recognize a favorite tune in just a couple of notes.

This is because there’s a tremendous amount of information in the sounds
we can hear. To capture this information accurately for computer storage
and transmission takes a lot of cleverness — not to mention bandwidth. A
relatively uncompressed file format such as the Windows WAV format and
the roughly comparable Apple AIFF format take about 170 KB for each second
of sound, or about 10 MB per minute. Even a fast Internet connection can’t
deliver “live” WAV sound; users must wait anywhere from several seconds

to many minutes before they can hear the sound, depending on how fast the
connection is and how long the sound file is.

The most popular compressed file format, the MP3 format — the audio equiv-
alent of the marvelous JPEG photo format described in Chapter 5, using tricks
of psychology and physics to capture music in a compressed file — takes
about 17 KB per second of sound, or about 1 MB per minute, one-tenth the bit
rate of a WAV file. This is just within the capability of most Internet connec-
tions to play back an MP3 live, or nearly live, or to download the file within a
few minutes for later playback.

Despite its cleverness and success, MP3 may not be as aesthetically success-
ful as its pictorial equivalent, JPEG. Why not? After all, the slight coldness
and tinniness of MP3 files is probably, objectively, no worse than the slight
visual “noise” found in moderately compressed JPEG files. But because sound
is so emotionally involving, MP3 files are perhaps more likely than JPEGS to
be experienced as not-quite-good-enough. Two indicators of this dissatisfac-
tion: Vinyl record albums seem to be experiencing a slight resurgence, and
there’s some support for more precise audio-file formats, despite the cost in
file size and transmission time.

Not every computer out there has all the necessary elements to play back
sounds in a sound file — a program to decode the sound and play it, sound
hardware to deliver sound to output(s), and speakers and/or a headphone
jack to actually produce sound the user can hear. Where all the elements
are in place, they can be turned off (or the headphones not plugged in), and
users may be anywhere from slightly disinclined to absolutely unwilling to
turn on the sound gear just to hear the sound you want them to listen to.
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Naming of parts for sounds

Here I'm going to refer to sounds to mean any tunes you hear on the radio — including (just to
of the range of different kinds of sounds you focus on a typical American radio lineup) rock
can put on a Web site and tunesto mean music  'n’roll, country and western, classical, Spanish-
files intended for listening, like the kinds of language, and experimental radio stations!

Using Sound within a Web Page

Many of us would like to have a soundtrack or mood music for our Web sites —
that is, a tune that plays continuously while the user surfs around our site.
This would make using the site more pleasant — and contribute to its having
a personality. Ideally, the user would be able to easily turn the sound on or
off — most users would probably prefer being offered this choice before any
sound started.

Unfortunately, making this seemingly simple set of desiderata happen in a user-
friendly way is just about impossible. You can put a sound file in a Web page
but not a Web site. So you can indeed start a sound playing on a given page of
your site. But when the user leaves that page for the next one, sound stops.

On serving the next page, you can play a new sound file — or the same sound
file again — but it won’t pick up seamlessly from where the sound on the
previous page left off. In fact, it’s just about impossible to know where the old
sound file stopped so as to try to make the sound on the new page pick up
again in the same spot.

In the example that follows, I show how to place a sound file in a Web page
and attempt to have it start playing automatically. Giving the user a choice
before the sound starts playing requires JavaScript or other more advanced
Web technologies that are beyond the scope of this book. If you want to offer
this capability to the user, see JavaScript For Dummies (Wiley) or another
source about JavaScript.

Alas, the seemingly unambitious goal of having background music play as the
user visits one’s Web site is surprisingly difficult to make work consistently.

Using sound on a Web page is easier on any specific type and version of a Web
browser, but not easy across different types of Web browsers and different
versions. The accepted HTML coding for this capability has changed over the
last several years. It used to be that the embed HTML command could, well,
embed any kind of multimedia file in a Web site. But EMBED never became an
official standard, so Microsoft stopped supporting it, supporting the bgsound
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(background sound) command instead. Due to popular demand, Microsoft
then added support for embed back in, but not all users of Internet Explorer
have the fix.

Without embed in Internet Explorer, to make sound work across all types of
browsers required that you execute the embed HTML command for some
browsers and the bgsound HTML command for others. This can be done by
combining the two commands, as [ show later in this chapter (and explain in
later chapters as well).

Unfortunately, the JavaScript code that could help you make the decision
has compatibility problems across early browsers as well. If you made any
mistake at all, or were just unlucky, sound would either not play, or the same
sound would play twice, with the two instances of the sound slightly out of
synch with each other!

Because of all this complexity, few Web sites embed sounds in Web pages.
Because it’s rarely needed, some users haven’t downloaded the software
needed to play back sounds from within Web pages. So if you go to the effort,
and make it work, you may still be asking the user to go through a difficult
and time-consuming program download just to play a background sound in
your Web page.

So, believe it or not, there’s no simple, reliable, completely user-acceptable
way to make a sound play in your Web page. Except by embedding the
sound in a video file! No wonder more music videos are now played back on
YouTube than on MTV and other music-oriented TV channels.

However, embed is supported widely enough for “fun” use, where it doesn’t
reflect badly on your professional competence or your organization if

it doesn’t work for some people. I show how to embed an audio file via
MySpace in the example that’s coming up shortly.

Getting, Creating, and Including
Sound Files by Download

Luckily it’s fairly easy to set up a sound file to play by download. If the user
has the necessary software and hardware set up and turned on, sound will
play. If not, the user probably knows it, and won’t click the download link,
limiting the impact of any problems on you, the Web-page creator.

Making the user click a link avoids the problem with the conflict between the
embed command and the bgsound command described above, so you don’t
need to use JavaScript or some other technology to try to help your Web
page decide what to do.
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When standards fail

Early versions of HTML included support for two
media types: hypertext and GIF images. JPEG
images were notincluded, and sound and other
multimedia files weren't either.

When JPEG files first became popular in Web
pages, back in the mid-'90s, you had to down-
load a separate player to view them. Some of
these players were pretty good and produced
amazingly sharp images; others were crummy.
But HTML was still flexible at this time, and
JPEG support was added so widely that it
became a standard part of the Web browsers
that people use today.

Technical Stuff: At first, embedding a multime-
dia file was easy; the embed command was
used, usually bringing up Apple QuickTime
as the player. But Microsoft quit support-
ing embed, apparently for security reasons.
Microsoft recommends the bgsound tag
instead, but Mozilla — including the currently
popular Firefox browser, with about 10 per cent
of the user base — doesn't support it.

A similar problem has hampered the physi-
cal equipment needed to play back sound.
Simply put, sound playback was not part of
the PC standard set by IBM back in the '80s,
and is still not a completely standard part of a
desktop PC, partly because corporations (until
recently) have not seen the need for sound, or
even actively have discouraged using it. Sound
hardware is standard for laptops, but that's still
only a part of the market.

For standards to work, all the major play-
ers involved have to work together. With
Microsoft supporting Windows Media Player,
the ex-Microsofties at Real Networks push-
ing RealPlayer, Apple proliferating its own
QuickTime, and the Mozilla people requiring
extra steps for any sound support at all, the
standards process for sound files within Weh
pages has broken down. Of course, with univer-
sal hardware support lacking, it's little wonder.
What is potentially one of the most important
tools a Web-page author would like to have in
his or her arsenal is missing in action.

Steps shown in Chapter 10 (for a WYSIWYG editor) or Chapter 14 (for
“straight” HTML) show how to include a link to an MP3 file. When the user
clicks on the link, if everything’s set up and turned on, sound will play.

But how do you get a sound file, or create one? [ show you here. Then you
can make sound available to your users, putting it just a click away.

Getting an MP3 file

At first, it seems fairly easy to find an MP3 file on the Web. However, people

know that MP3 files are desirable, so there are a lot of conditions around

many of the files out there. Also, some people who want to distribute viruses,
spyware, and other malware use MP3 files to attract visitors to their sites —

and the innocent visitors leave with more than they bargained for.
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|
Figure 6-1:
CNET's
music-
download
siteis a
haven,

away from
MP3-related
spyware.
|

Also, the most desirable MP3 files are free copies of hit songs. These files

are illegal and attract increasingly aggressive litigation and prosecution. So,
although they’re common on the Web, they tend to be hidden away or only
available to those who use file-sharing services (which may themselves carry
viruses, spyware, and other such dismal “free gifts”).

One trustworthy source for virus-free, legal, free MP3s is the music-download
section of CNET’s download. com, at music.download. com. See Figure

6-1 for an example of what’s available. Not many hit tunes are there, but not
many problems are, either.
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You can search the Web for other sites, many of which are trustworthy —
but make sure your virus-protection software is up to date and running first!

Check the permissions on any MP3 file you find carefully. Once you're certain

the file is free of copyright problems and available for free use, you can do
either of two things:
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v Link to it in place from your own site. This is easy and convenient.
If this gives the appearance of the file being on your site, there is the
possibility of problems with copyright, as you've made someone else’s
property appear to be your own, so make sure the file is free to use. If
you bring a lot of file downloads to the site, you're also abusing their
bandwidth, as someone else’s bandwidth is serving your purposes. This
is unlikely to be a problem for an occasional download, but for heavy
use it’s unfair to the file’s host.

+* Download the file and transfer it to your own site. If permissions allow
this, it gives you control and responsibility. It also gives you the bill
if there are a whole lot of downloads and you’re paying for download
bandwidth.

In either case, to make the file available for download, you link to it from your
Web page to the location where it’s hosted, whether that’s on someone else’s
site or your own site.

The HTML code for this is simple:

To get the latest a capella song by me, sung loudly and off-key in the shower,
<a href=''www.dummies.com/myfile.mp3''>click here</a>.

[ show how to incorporate this functionality into a Web page a little farther
along in the book, using a WYSIWYG Web-page creation tool in Chapter 10
and using HTML in Chapter 14.

Creating an MP3 file

It’s very satisfying to create and deliver your own MP3 file. In this example, I
use the simplest possible tools to create a sound file and convert it to MP3.

The example is a voice file, because that’s the easiest to create for the most
people and more often useful in a typical, rather than a specialist music, Web
site.

MP3 is so good with music that it’s a bit of overkill for voice files, which can
be encoded and played back with less-powerful compression algorithms. But
so many people have set their systems up to play MP3 files these days —
both on their PCs and on music players such as the Apple iPod — that you
may as well go with the flow and join the crowd (with apologies for using two
clichés in a row).
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If you have a Mac, it includes well-regarded built-in software to accomplish
these tasks called iLife; please refer to the iLife documentation for steps.
Follow these steps to create an MP3 file under Windows:

1. Find the built-in microphone, if your system has one, or attach a
microphone to your computer.

It’s good if you have a built-in microphone or one lying around. If not,
try to determine the size of the microphone opening on your PC, or take
your PC with you to the shop so you can be sure of getting a fit. Or, if
you have an unused USB connector, consider buying a USB microphone,
which are well-regarded and are certain to fit.

2. Open Windows Sound Recorder by choosing Start~>Programs->
AccessoriesEntertainment=>Sound Recorder.

The Sound Recorder application window is very small and can’t be
resized. However, like MS Paint (described in the previous chapter), it
includes a lot of capability; you can make sounds louder, quieter, faster,
and slower, for instance. The Sound Recorder application is shown in

Figure 6-2.
My Documents
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g =5 File Edit Effects Help
.’
4 cmpiies Postion Length
18.00 sec. £0.00 sec.
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«) i
3
Flaces
2
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Retycle Bn File Edit Effects Help ]
Positon Increase Volume (by 25%)
@ 5000sec Decrease Volume

Internet
Explorer

| Increase Speed (by 100%)

Decrease Speed

1+ Add Echo

Reverse

3. Record your message. Click the red Record button, wait three sec-
onds, and speak. When you’re finished speaking, wait three seconds
and click Stop.

The sound is recorded. The three seconds of “blank tape” at the begin-
ning and end give you room to play with in editing and prevent the
recording from seeming to start or stop too abruptly.

4. Click Play to hear your message. Choose File->New and then return to
Step 3 to re-record if necessary.

When you’re happy with your message, go to the next step.
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5. Save the file as a WAY file.

This is the only file format supported by Sound Recorder — no tricky
choices to make here.

6. Convert the file to MP3.

You may already have a converter program on your PC. If not, search
the Web for “MP3 converter” or look for a program of this type on
CNET’s download. com. One well-regarded program that’s free is
Audacity, which you can download from audacity.soundforge.net.
It should be quite simple to open the WAV file and save it in MP3 format.
You can read the Help file information for instructions on how to edit
your file.

7. Play the MP3 file to test it.

You should be able to play the file by double-clicking it. It will play back
in Windows Media Player, QuickTime, or another media player you have
on your computer.

8. Compare the file sizes of the WAV and MP3 files.

Just to convince yourself of how great MP3 is, do a comparison: In
Windows Explorer, navigate to the folder where the files are stored. Right-
click each file icon and choose Properties. Inspect the size of each file.

You're done! You now have an MP3 file ready to host on your Web site. And,
more importantly, you've learned the process of creating an MP3 file from
scratch.

The process is the same for podcasting as for Web-page hosting, so you may
have a future in creating your own music or talk show for playback on iPod
and other MP3 players.

Posting a Sound File on MySpace

MySpace is amazing, and amazingly popular. It’s the graffiti wall for the digi-
tal generation, hugely popular with teenagers, young adults, and others who
keep up with music, along with smatterings of all kinds of people.

There are a huge number of things you can do on MySpace, but there’s one
thing it’s definitely the best place for: sharing your enthusiasm about music.
There are millions of people on MySpace interested in and willing to listen
to, comment on, and even become a fan of a new artist or group of just about

any type.
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MySpace is also famous for being relatively “wild,” with lots of, as the Brits
would say, “dodgy” (or downright objectionable) videos and other content that
only get taken down slowly, and after complaints are made, if at all. Also, even
some of the non-obscene content is not for all tastes; when [ was logged on,
there was a constantly looping video on the home page of two furry toys beat-
ing the heck out of each other, which was sort of funny but not what [ would
have chosen to watch over and over and over. So MySpace is not the place to
send your 9-year-old nephew to listen to your latest upload; kids might find lots
of objectionable stuff after they view your new cultural contribution.

Join the MySpace cadets

Joining MySpace is relatively simple. Follow these steps:

1. Go to the MySpace home page at www .myspace. com (as shown in
Figure 6-3) and click the orange Sign Up button.

The Join MySpace Here! Page appears. Click the Sign Up Button to start.
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. Enter login details — a valid e-mail address and a password.

The e-mail address you enter will be used to confirm your sign-up and
possibly to send you a MySpace newsletter. It may be best to avoid
using your work e-mail address, as the MySpace newsletter may not be
what your management expects you to be receiving at work.

. Note the extra sign-up areas at the right for BAND/MUSICIAN,
COMEDIAN, and FILMMAKER members. If you fit in one of these cat-
egories, click the appropriate Sign up Here link to sign up.

Because MySpace has landed in some trouble for hosting copyrighted
material, it limits what users can post. These options allow you to
upload files of your own performances — MP3s, for instance, for BAND/
MUSICIAN members — but only if you pass MySpace’s checks (which can
vary from one period of time to the next) that you really do qualify as a
BAND/MUSICIAN. Ditto for the other creative categories of members.

. Enter personal details — your name, location, birthday, gender, and
language. Decide whether you want to allow others to see if it’s your
birthday.

The location info is to allow friends and family to find you on MySpace.
On the birthday option, I chose “No,” not wanting to get any kind of
MySpace spam — or, for that matter, to learn what might be more than I
wanted to know about my fellow MySpacers’ ideas of appropriate birth-
day greetings.

. Enter the verification text. If you can’t make it out, click the Refresh
button to bring up different characters.

The verification characters prevent automated entry of new MySpace
membership details.

. Right-click the Terms of Service and Privacy Policy to open them each
in a new browser window. Read them, and then close the browser
windows. Then click the check box to indicate you’ve read them.

Note that this process may include signing you up for a MySpace news-
letter and other materials from MySpace. Refuse this option if you wish.

. Click the Sign Up button.

The Welcome screen appears, giving you the chance to upload a photo
or add friends.

. Click Skip this step twice to skip the photo and friends options for now.
Your MySpace home page appears.
. Click the Edit Profile button.
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The Profile Edit page appears. You can enter HTML or even CSS code
here. As you learn more about HTML, you can use your new MySpace
page to experiment.

10. Embed a link to a sound file.

All sorts of code to do things in MySpace can be found easily online.
Embedding is a bit tricky because of the need to accommodate both the
embed and bgsound commands, but it can be done, as shown in Figure
6-4. (The last part of the command is </noembed>.) By placing the com-
mands in the Headline area, the sound plays automatically when the
user visits the page.

One good source I found for MySpace-ready HTML, with plenty of links
to other resources, is www . hypergurl . com.

11

Click Save to save your work.
You'll return to the MySpace home page.

12. Visit and test your page.

You'll return to the MySpace home page.
13. Keep updating your MySpace!

MySpace is a great place to have fun and to learn Web-page skills as
well. Keep having fun with it.
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Screening Videos on Your Site

In This Chapter
Keeping your clips short
The role of YouTube in Web video
Finding video clips to use
Making your own videos
Converting to different formats
Uploading a clip to YouTube

A great deal of derision is poured on television — “a vast wasteland,” it
was once called, by the chairperson of the Federal Communications
Commission, no less. Even the best-known and most widely used Web site for
videos, YouTube, gets far more usage than it does respect.

But video is actually the highest form of multimedia. Incorporating images,
animation, and sound, it evokes reality better than any other medium. And
video is increasingly used even when the primary purpose is to convey
sound, as in playing a music video.

Keeping Online Uideo Small,
Short, and Sweet

Pervasive as it is online, video has the potential to impose tremendous bur-
dens on even the most powerful personal computer and the fastest Internet
connection. In fact, no one even thinks about recording, transmitting, and
playing back uncompressed video full-screen. The bulk of online video you’ll
see is compressed and concise, for some very good reasons. . . .
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Why Web video is compressed

To play back a completely uncompressed widescreen video at 30 frames per
second would require a connection with a speed of more than 1 Gb/second
(1 gigabit, or one billion bits, per second), more than a thousand times faster
than the rated speed of a very fast home or office connection. We're just not
there yet. Instead, video is heavily compressed, using a three-stage process:

v First, video is shown in a small window. YouTube recently upgraded
its offering and began showing most videos in a relatively generous 480 x
360-pixel window, exactly one-fifth the pixels available on a typical 1024
x 768-pixel screen.

+* Then the frame rate is reduced. Though players are meant to adapt to
the bandwidth available, a rate of 10 frames per second — one-third the
frame rate of television — is considered acceptable.

v Then the images themselves are compressed. JPEG compression, good
as it is for images, only works with one frame at a time, so MPEG —
Motion Picture Experts Group — video compression is used instead.

MPEG standards are very widely used online (MPEG audio compression is
more widely known as MP3), and no wonder: MPEG compression is quite
clever. It takes advantage of parts of a scene that don’t change from one
frame to the next, and only encodes the changed parts. Unfortunately, when
part of a scene changes very fast, or all of a scene changes fairly fast, there’s
often visible distortion in the scene until the compression and decompres-
sion can catch up.

For amateur videos such as those seen on most Web sites or on YouTube,
this is not a big problem. But for enthusiasts and professionals, image-quality
concerns can consume many hours of work and rework.

It’s very common for video clips, even on the relatively robust YouTube site,
to stall during playback, sometimes for a long time. This is extremely frustrat-
ing for users — and for you, if the video is on your Web site. Unfortunately,
there is so much variation at all points in transmission, reception, and display
of online video — from the servers, across the Internet and on the user’s
computer — that it’s impossible to give users any quick or certain fix for any
problems they experience. (Though you can make good money selling more
reliable video solutions to corporations and government agencies.)

Keeping your video clips short

Compression helps your video work well on the Web, but to make it sweet,
keep it short. Long videos can work (see the accompanying sidebar), but
they have some problems that make them the exception rather than the rule:
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For typical YouTube-style video clips — medium-size 480 x 360-pixel images,
harshly compressed, usually grainy and a bit dim — each 15 seconds of video
takes up roughly 1 MB. That’s 4 MB per minute. Not too bad a size for a three-
minute music video, but that one-hour CEO speech at the annual results
announcement is going to take up 240 MB!

v Video can’t be searched with the same precision as text. Searching
the video part is tedious, with the necessity to drag the slider back and
forth, and searching for a string of words is just about impossible. (If
the text has been transcribed quite accurately and made searchable, it
becomes possible, but this is rare.)

v~ Start time is an issue. If you watch the progress bar on YouTube closely
when you watch a video, you'll see that the video begins to download
first, then playback starts only after a chunk has downloaded. Basically,
the player waits until it can get a head start sufficient that the download-
ing, as it continues in the background, should complete before the play-
back in the foreground catches up. If playback overtakes downloading,
the video clip must pause for downloading to get ahead of playback again.

For a short video clip, the initial wait for a “buffer” of downloaded video to
accumulate is only a few seconds. But for a long clip, the wait may be many
minutes.

So keeping your video clips short makes sense for the user, as well as for
technical reasons. For that CEO speech, a few minutes of highlights will get a
lot more downloads than a full version. Instead of a complete video, the full
speech can be delivered in audio as a podcast, perhaps synched with display
of any charts or photos that the CEO showed.

If you must deliver a long video — if the CEO wants every moment of his or
her precious speaking time to be immortalized in downloadable form for the
ages — break up the speech into clips. Preface each clip with a brief descrip-
tion. And hope that at least some of your site visitors have the patience to get
through all of it.

Any good long videos out there?

For an example of long video clips that work,
visit the U.S. Consumer Product Safety
Commission’s high-quality MPEG download
page at www.cpsc.gov/mpeg2.html.
To accompany their press releases, they offer
high-quality clips (as an alternative to lower-
quality streaming video). Clips available are up

to 100 MB in size and take 10 minutes or more
to download, even over a fairly fast broadband
connection. Yet the playback, while high-qual-
ity, is in @ much smaller video window than on
YouTube. That's a trade-off to keep in mind if
you want to go long.
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The Role of YouTube

The cost of storing and downloading videos is high enough for even large,
well-funded organizations to think twice before posting them, let alone indi-
viduals out to have a little fun. This is where YouTube comes in.

YouTube allows you to use its site as a storage site for your video clips. You
can store your video clips on YouTube, link to them from your own site, and
they play as if you were storing them on your own server. All YouTube gets
for this is a YouTube logo showing on the clip and the right to make your
videos available on YouTube as well.

This is one of the greatest deals since — well, since Google bought YouTube
for $1.65 billion in 2006. That’s a lot of money, but for the king of Web search
to acquire the king of Web video — as YouTube’s founders described it when
they announced the deal — for a small fraction of its value today was one of
the steals of the Internet’s short but exciting history.

YouTube was suffering from increasingly serious service problems before
the acquisition, and Google’s involvement has been critical to the continued
success of YouTube. Google uses proprietary techniques for storing and
retrieving large amounts of video quickly and cheaply that were very much
needed to support YouTube’s continued growth. And Google’s deep pockets
supported the investment needed to keep the service growing even as some
of the sharper business brains around tried to figure out how to make money
from it. (In early 2008, YouTube’s bandwidth costs alone were estimated at
$1 million a day.)

And now that I've brought it up, how will they make money from it? The
answer, so far, is similar to how Google makes money from search capabili-
ties: by placing small, relevant text ads next to the video when it’s played
back on YouTube. This kind of thing is a multibillion-dollar business for text
search, and may become similarly large for videos. But it’s a pretty harmless
way for your free video storage and playback to be paid for.

All of this is important to you as a Web-page creator because a potentially
huge source of technical problems — and cost for you in using video in your
site — is completely solved for you by YouTube. “You” can just put your
videos on their site and have them played back for free on any “Tube” on the
planet! Pretty cool, huh?

Don’t think you’re the only one doing this. Governments, political campaigns,
and global corporations all host video on YouTube. Figure 7-1 shows the
YouTube channel of the U.K. Foreign and Commonwealth Office as just one
of many examples. (The clip would have benefitted if they’d given the young
woman a bit of frontlighting, as described in the next section.) Join the
crowd!
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Finding Uideos for Your Site Online

The easiest way to get video for your Web site is to find a video you like on
YouTube, link to it from within your site, and the user will be able to play it
while looking at your site, yet all the mechanics are handled by YouTube.

Each video on YouTube is accompanied by the HTML tags for including
it in your Web page. Putting YouTube-hosted videos in your Web page is
described in Chapter 10, for use with WYSIWYG Web-page tools, and in
Chapter 14 for working directly in HTML.

For finding videos for your site, you should use YouTube’s Advanced Search,
as shown in Figure 7-2.

Searching for specific kinds of videos on YouTube may not always be easy.
Yes, it is easy to find music videos by a specific artist, for instance (of course,
if the person who posted a video misspelled “Duran Duran” or whatever the
band’s name is in the posting, nobody’s likely to find it!). But the kinds of
searches you’ll want to do for Web site use might be quite different.

Let’s say you want a clip that demonstrates cooking in a wok, just to bring to
life the concept of what a wok is for people who may never have seen one.
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When I searched for “wok” using YouTube advanced search, I found a couple
of clips prominently featuring obscenities, but also several that showed a
wok in an interesting way that I could use on a personal Web site.

But let’s say [ wanted to show using a wok to cook vegetables on a site for
vegetarians — so [ don’t want any meat involved. Typing in “wok vegetables”
only got me one suitable clip. And the clip was a bit too long; there was no
way for me to edit it down.

Getting a bit creative, and stretching my knowledge of Japanese food prepa-
ration to the limit, [ tried “wok tempura.” This got me a bunch of clips, sev-
eral of which involved the use of a wok to make vegetable tempura. The word
“wok” wasn’t mentioned in the words though; I had basically backed into
what I wanted, the wok, by association with a dish that’s commonly made in
a wok, tempura.

Inspired (bored? obsessed?), [ tried several other combinations of words,
dropping “wok” altogether, and got several promising clips I could consider
for my intended purpose.

The problem gets even worse if you want to use video, or music attached to a

video, to set a mood. The initial results for “peaceful” include a movie trailer
for “Peaceful Warrior” and typography relating to “tragic peaceful death.”
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The first result for “calm” shows two young men playing a war-themed video
game in a tournament. Yikes.

However, none of this means the desired results aren’t out there, just that
they are likely to be hard to find. Set yourself broad goals before looking for
a specific piece of video — and be prepared to look at a lot of stuff, not all of
it necessarily wholesome, before finding what you want (or settling for some-
thing you deem close enough).

If you really want to have a YouTube video on your own hard drive, there

are many tools you can find online for grabbing them. Perhaps the simplest
is KissYouTube, an online site that makes getting a video clip from YouTube
ridiculously easy. You just navigate to the video you want on YouTube, then
insert the word “Kiss” into the URL just in front of YouTube. Press Enter, and
a download box appears to ask you where you want to save the movie to.
(For detailed instructions, visit KissYouTube at www . kissyoutube.com. For
a couple of gentle-but-timely caveats, see the next couple of paragraphs and
the handy sidebar.)

Be careful how you use the clips you download; the person who uploaded the
video to YouTube did not thereby agree automatically to your borrowing and
re-using it. If you’re downloading video because you want to use it on your
site, ask the owner first — and abide by the answer you get. If the person got
the video from somewhere else, doesn’t own it, and can’t really give you per-
mission to use it, you're better off not using it on your Web page.

You can link to online video clips from many sources besides YouTube, but
those hosts may well frown on your linking to their expensively produced,
stored, and served clips — especially as they may have rights worries of their
own. Be very careful whose online videos you link to from your site, especially
if you embed the video clip in your own page. Remember that (as mentioned
in Chapter 5) the government is always a good source of free media content.

Capturing Uideos from a Camera

You can also capture your own videos for online use. There used to be a lot
of things to think about in doing this but, with the availability of YouTube to
“launder” your videos into an acceptable format and size, store and serve
them for you, and provide you with the HTML to embed them in your Web
page, many of those concerns are taken care of.

There are a variety of tools you can use to edit video; if you're using a cam-
corder, it probably came with one of several available tools. The Macintosh
comes with iLife, which includes a well-regarded movie program, and Windows
comes with Windows Movie Maker — which you can download for free from
Microsoft if you don’t have it already. There are also tools available free, or
free for an initial trial period, from sources such as CNET’s download. com.
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Legal concerns for video?

There are huge copyright issues with video and
with YouTube. But as | write this, I'm listening
to an REM video on YouTube. (The visual part
of the video is just a static shot of their album
cover; it's the sound I'm interested in.) REM is
famously protective of their intellectual prop-
erty, but they don't object to fans posting a
grainy-looking video with somewhat tinny audio
on YouTube.

It's possible that someday the band (or their
record label) will go after YouTube. But it's
pretty unlikely that ordinary people who link
to the video from their own Web sites will be
involved. However, if your site makes money,
or if you have a lot of money that you need to
protect, you may want to talk to a lawyer before
linking to copyrighted content.

Another similar issue relates to model
releases— permission forms that say, in effect,
“Sure, you can use this image of me for the pur-
pose you've explained to me.” Before you use
a photograph of someone else for any purpose,
but especially before using it to make money,
you should have a signed model release listing

the rights you have to the image, or the person
depicted can come after you legally.

The same reasoning used for photographs
applies to video; even if people willingly upload
videos of themselves with no thought of com-
pensation, your re-use of such a video on your
site could make you liable to compensating the
person later.

But, as with music copyrights, these concerns
seem to be mostly ignored when it comes to
video on YouTube. Again, if your site makes
money — or if you, personally, have a lot of
money — you may want to talk to a lawyer
before linking to content that depicts recogniz-
able individuals who have not given permission
for you to use their image.

Overall, such legal worries seem (to me) to
favor using YouTube — which encourages the
re-use of their videos — as opposed to other
online sources for video. Google is bhig and rich
enough to go toe-to-toe with anyone who might
come after YouTube for infringement of copy-
right or image rights. In protecting themselves,
they'll be protecting you as well.

\\3

[ won’t describe how to use these different programs here, as there are so
many of them; refer to the program’s online help file, its manual, or a third-

party book on it.

If you're planning to make a habit of making your own video clips and upload-
ing them to YouTube or elsewhere — hey, no copyright worries! — check out
Digital Video For Dummies, 4th Edition (from Wiley). It covers making video
with Windows, Mac, and Linux machines.

Meanwhile, some general steps for capturing video are coming right up.
Whichever program (or platform) you use, don’t worry too much about
which video format to save the resulting file in. YouTube accepts .WMV

(Windows movies), .AVI (a common Windows format), .MOV (QuickTime
video), MPEG (the cross-platform standard), and .MP4 formats.
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Just for your interest: YouTube will convert the video to a proprietary stan-
dard using the Sorenson codec and MP3 audio, controlled by a Macromedia
Flash wrapper. Flash does require a plug-in on the user’s computer for play-
back, but most people have it already installed, if only because of previous
visits to YouTube. If your users don’t yet have Flash installed, it should install
automatically when they visit your Web page.

Follow these steps to capture a video for use on your Web site via YouTube:

1. Set up the shot with strong lighting.

All laptop users, and more and more desktop users, have LCD monitors,
most of which are a step back in terms of image quality and clarity from
the best of the old (expensive, clunky) CRT screens. Also, your video
may well be viewed, particularly if on a laptop (or on a mobile phone!),
in mediocre or even poor lighting conditions, such as bright room
lighting or sunlight. All this means your clip needs to be as bright as
possible. Light is the key secret of still photography and one of the two
secrets of making video.

2. Get light onto the faces of people (and animals) and onto the front of
objects of interest.

See Figure 7-1 at the beginning of this chapter as an example of too little
frontlighting.

If you don’t specifically light the faces of people and the fronts of things,
they won’t be very visible. If you have the background lit but not the
foreground — say, if you're filming people with the sun at their backs —
the camera will compensate to make the bright background acceptably
dimmer, which will make the dim foreground nearly invisible. Although
it can be uncomfortable, your subjects should face toward the light (if
indoors) or the sun (if outdoors).

3. Try to capture several seconds of the scene before and after the main
action occurs.

Having a few quiet seconds of “intro” and “outro” allows the viewer to get
used to the scene before anything happens, and to relax afterward before
it ends. (People who watch YouTube a lot don’t need this cosseting.)

4. Try to keep motion slow and within a relatively small part of the
frame.

Because of the way MPEG compression works, fast motion — or motion
across the majority of the frame — is likely to cause visible distortion on
playback.

5. Spend extra time and effort on sound.

Sound is the other big secret of video. If you're going to use sound
picked up during filming, consider using an external microphone —
either a lapel microphone on the subject or a boom microphone that
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can be held close to the subject, but out of the picture. If you're going to
add sound after filming, take your time and do it right.

As with light, any sound you don’t capture during filming is lost forever.

. Try a rehearsal before you shoot the real thing.

It’s surprisingly easy (and surprisingly uncommon practice) to do a dry
run before shooting an important scene. Have your kids run around on
the grass and film them a few days before the big soccer match. Have
someone stand onstage behind the podium and try filming her for

five minutes a few days before the big speech. Go through your entire
production process (however simple it might be) and try the resulting
video clip on the Web before the real event. What you learn will help you
improve your final product many times over.

You can use the soundtrack from your video, if it’s good enough, as an
audio podcast as well.

. Think twice before using a Web camera.

It seems that most of the videos on YouTube and other online video
sites are the head of some young person tilting down to talk into the
built-in or added-on Web camera on a PC; YouTube makes this very easy
with their Quick Capture feature. But (as some of us have found out

the hard way) most of us don’t look so good from a shooting angle that
points halfway up one’s nose. Webcams are fun and convenient, and
they’re fine for young people who may not know each other in any other
way except via Webcam conversations. But such clips don’t work well
for most older people, nor for most halfway serious purposes.

. Don’t spend too much time in production.

You can’t make a silk purse out of a sow’s ear, as the saying goes, and
you can’t add quality to a video after it’s captured — you can only clean
it up a bit. (Okay, if you're a pro or a talented amateur, you can clean it
up a lot, time and budget permitting.)

Your work is likely to be viewed in a small window on a crowded
computer screen in bad lighting and heard over cheap built-in laptop
computer speakers (or viewed on a mobile phone screen and heard
over a mobile phone speaker!). Don’t sweat the small stuff, or even the
medium-sized stuff.

. Enjoy yourself.

It’s easy to forget, after worrying about legal, technical, and creative
concerns, but video is the most natural of media types, and putting
video on the Web and playing it back should be fun. Spend some time
worrying about the “hygiene” issues described here, but then just relax
and enjoy yourself. Any sense of joy and playfulness you bring to your
efforts will come through in the result.
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Opening up the convert-sation

Even if your video clip is not already in one of the
formats YouTube accepts — WMV (Windows
movies), .AVI (a common Windows format), MOV
(QuickTime video), MPEG (the cross-platform
standard) or .MP4 — you should be able to con-
vert it to one of the accepted formats.

To find out the file type, look at the icon in
Windows Explorer. For details, right-click the file
icon in Windows Explorer; choose Properties
from the cursor menu. Click the General tab; the
file type will appear within a little icon symbol.

=
My Documents
8
My Computer
)
=

My Hetwork
Places

(o)

3

)
=)

Recycle Bin

e
Internet
Explorer

windows Movie
Maker 2 Sam...

[Windows Movie Maker 2 Sample File Properties (26

General | Sean resuls | Summary

H ‘windows Movie Maker 2 Sample File
vy

Windons Media Audia/Videa fle
(& Windows Wedia Player

C\Docurnents and SettingsiFlopdhDesktop

Type of file:

Opens wih

Locatior:
Size 628 KB (643,170 bytes)

Size ondisk: 632 KB (647,168 bytes)

Created: 02 May 2008, 11:03:01

Modified: 19 Movember 2002, 10:41:48

Accessed 02 May 2008, 11:03.01

Attributes: ] Read-only [ Hidden

Advanced

To convert the file, either open itin any program
you have that will open it, and try to save it in
one of the formats YouTube will accept; or visit
www . download.com and search for “file

converter” and the actual and desired file types
for your file, for example file converter
f1v wmv. You're likely to find a suitable con-
verter.

Uploading a Video Clip to VouTube

Uploading a video clip to YouTube is almost hilariously easy, as long as it’s
in one of the right video formats, as it’s likely to be. (See the “Opening up the
convert-sation” sidebar for what to do if it’s not in one of the right video for-
mats.) Follow these steps to put a clip on YouTube:
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1. If you haven’t previously joined YouTube or Google, get a Google ID,

as described in Chapter 3.

A Google ID will not only let you use YouTube, but also all sorts of other
cool Google services.

2. Go to youtube. com and sign in to YouTube.

. Click the yellow Upload button in the upper-right corner of the home

page (and most other YouTube pages).
The Video Upload (Step 1 of 2) page appears.

. Enter key facts about your video — think carefully about the

right words, as this is how people will search for it. Enter a Title,
Description, a Video Category, and Tags.

You really want people who know you to be able to find the video, so
enter your name in the Title, Description, or Tags area. An example is
shown in Figure 7-3. Then a search on your name will find the video.
Consider including the name of the place it was recorded and the names
of people who helped create it and/or who appear in it. Don’t worry
about getting this wrong, though; you can always change it.

Depending on the category you choose for your clip, YouTube offers
selected, standard suggested tags that you simply click to add to your
Tags list. Use as many of the suggested tags as apply to your posting;
experienced YouTube users know these tags and search on them specifi-
cally, so you should use them where they make sense.

A future employer may someday Google your or a friend’s name, so be
careful if the video is risqué, and don’t post it at all if it shows anything
that even looks illegal.

. To change Broadcast Options, click Choose Options if you want to

change your video from Public, the default, to Private — that is, view-
able only by a list you specify of up to 25 contacts you have in Google.

Try to choose Public if you can to make it easier for people not in your
Google contacts list to find and enjoy your video. Also, remember the
Private designation is only relative; people on your list can still gather
others around their PC to see your clip, or use external programs such
as KissYouTube to make a copy and forward it. (Even if it’s sent to just
one additional person, who sends it to one more, who sends it . ...)

If your video clip really needs to be private, don’t put it on YouTube, or
e-mail it, or otherwise share it.

. To change Date and Map Options, click Choose Options. Then enter

the date the video was recorded and, if you’d like, select where it was
recorded.

It’s quick and fun to enter the date recorded — enter an approximate
date if you're a bit hazy — and it’s great to have the date with the video
for future reference.
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upload your
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& YouTube - Broadcast Yourself. - Windows Internet Explorer =) =IE
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File Edit View Faverites Tools Help
e = »
6 4|l vouTube - Broadcast Yourself - B - - e v @Took - @~ by
~
Y @ flovdsm8 | £4(0) ount ¥ | Quicklist (0) | Help | Lo Out | Site: @
Broadcast Yourself Home Videos Channels Community
Upload
Video Upload (=
About uploading...
Title | Sydney Harbor boat tour Uploads usually take 1-5 minutes per B on a
high-speed connection. and converting your video
Description:* 5 T takes a few minutes
Your video is limited to 10 minutes and 1024 MB.
z - Farmore detalls aboutuploading videos, ses the
Video Categony:” | Travel & Events v Help Center
Tags:™ Tags are keywards used to help people find your video. (space separated)
Sydney harbor "Bud Smith” tour boat cityscape crui
Click to add suggested tags:
Adventure, Cityscape, Cruise, Culture, Destination, Events, Landmark,
Huzeum, Nature, Travel Log
(* indicates required fieid)
Broadcast Options: close
@ Public Share yourvideo with the world! (Recommended
() Private Viewable by you and up to 25 other people
Date and Map OPtONS: o date or iocation has been set cheoss octions
v

I found it a bit time-consuming to specify the location for my video on
Google Maps, but there are people who spend hours messing around
with geocoding information so perhaps it’s worth doing this as well.

7. To change Sharing Options, click Choose Options.

Here you have some choices to make (but you knew that) . ..

* You can change comments options so you can moderate or simply
block comments; block comment voting; and moderate or block
video responses to your own posting.

* You can also block people from using YouTube to rate your video;
to embed it in their Web page; and to view it from mobile phones
or TV. However, people can still do these things themselves, with-

out YouTube’s help.

¢ As with many sites, this seems like a lot of options, but it will not take
you long to go through this once you’ve done it a couple of times.

e If you're worried about straightforward, rude, or even obscene
comments from viewers of your video, then be sure to block or
moderate comments as needed — because YouTube users are
often straightforward, rude, or even obscene. But unless the video
is for work purposes or for family viewing with younger children,
consider leaving all options open for now; interaction is what

makes YouTube so much fun.
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8. Select a video to upload.

To capture a video from a Web camera and then upload it, follow Steps 9
through 13 in this step list.

To proceed with a video you already have, click the Upload a Video
button. The Video Upload (Step 2 of 2) dialog box for a video upload
appears, as shown in Figure 7-4. Here’s the procedure from there:

a. Click Browse and select the video file to upload.
b. Click Upload Video.

Wait until the upload completes before doing anything else. That
process can take up to several minutes, depending on the size of
the file and the speed of your connection. On a 56K modem (or on
a bad broadband day), the upload may take as long as 3 minutes
per megabyte. On upload, your file is automatically converted to
YouTube’s proprietary format, as described above. Eventually, the
Video Upload — Upload Complete screen appears.

c. Go to Step 13 in this step list for what to do next.

[@ YouTube - Broadcast YourseH. - Windows Internet Explorer
A : 7
g‘ ¥ EﬁBD:HWWW‘voutube‘cam@v,\/\deosjup\oad x| ]| % Pl
O : = »
¢ 4 | I% YouTube - Broadcast Vourself f3 - B - & - [hPage - @ Tods - @~ B
~
Y @ flovdsm8 | B4(0) | Account ¥ | Quickiist (0) | Helo | Log Out | Site. ©
uu u E = Choose file R[]
Broadcast Yourself Home Vid o,
Lok in: | (@} Deskion | = ek B
|3 My Documents
- 4 3 My Conputer
Video Upload (Siep 2 My Recent &1y Network laces
Dosuments g sydney harbor
=
Select a video to B
upload, Desktop
Browse.
Upload Video My Documents
-
Do not upload any TV shows, music videos, music concerts, 5
without permission unless they consist entirely of content yg| My Computer
yourself. The Copyright Tips page and the Community Guid =
you determine whether your video infringes someone else’ ‘_}
5
By clicking *Upload Video," you are representing that this videa d|  MiNework — File nsme: ] | Open
YouTube's Tems of Use and that you own all copyrights in this vi s e s o ™ g
authorization to upload it Tesoitoe: [ ) | Q
|
Figure 7-4: ) )
g . [ Gocgle | Add to iGooale Videos | v| 1. ¢ Face The Candidates
Find a fine -
file to feed
fans. i 3
| @ mhernet St -
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|
Figure 7-5:
Capture a
cute clip.
|

9. To capture a video with a Web camera, click the Quick Capture
button. (To proceed with a video you already have, go to Step 8.)

The Video Upload — Quick Capture (Step 2 of 2) screen for a camera
capture appears (as shown in Figure 7-5), along with a request to allow
access to your recording hardware (which is necessary in order to com-
plete the process of recording-and-uploading).

10. Click Allow to allow access to your camera and microphone.

The Record screen appears.

€ YouTube - Broadcast Yourself. - Windows Internet Explorer BE[*]
@ ey [ it v youtube. comjimy_videns_guick_capture [¥] 4:-'){ 12
File Edit View Faverites Tools Help
S — = »
* & ‘E *fouTube - Broadeast Vourself. | ‘ [t il - e - [ page v [ Teok v @ [
T~
Y @ flovdsm8 | (59(0) | Account v | QuickList (0) | Helo | Log Out | Site: @ (m
Broadcast Yourself ™ Home Videos Channels Community
sstings
| | ‘Vldens \VI[ Search ] adysnced search Upload
Video Upload - Quick Capture (=t
About Quick Capture...
W Carntasia Studio Vider| » = | Soundhi Digital Audi '-J Quick Capture allows you to record a YouTube
videa instantly via your computers webcam
lake sure your webcam is installed and warking =
correctly
flobe Flash Player Seftings Did you mean to upload an existing videa fram
Camers and Micophone Access @) our compuiter?
i youtube. com is requesting acosss
to your samera and microphone. i you
sl Allow, you may be r2corded
o)
[~
microphone found.
(&3 Google | Add toiGoogle | [Videos \vl[ Search | i Face The Candidates
o]
& & Internet HA00% -

11. Click Record, and wait until the server is ready. Then record up to 10
minutes of action into your Web camera, and click Stop when you’re
finished.

12. From the options that appear, choose what to do next:
¢ Click Preview to preview your video.
¢ If you're happy with your clip, click Save.

¢ If you want to redo, click Cancel, and then click Record again.
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¢ Repeat until you're happy with the result; click Save when you
have it right.

The Video Upload — Upload Complete screen appears.
13. Complete the upload.

a. From the Upload Complete screen (see Figure 7-6), save the Embed
code in a word-processing or similar file for later re-use.

b. Wait until YouTube finishes processing the video, which may take up
to several hours.

You'll receive an e-mail when the video is up on YouTube.
c. Click the link in the e-mail to view your video.

Success — you’re now on YouTube!

€ YouTube - Broadcast Yourself. - Windows Internet Explorer B[]
Ow- |2 sy kb comny_videos_upload_complete?claim_videombhas_in_video_ads=rev_sh ideo_id—wasdsh|se] [ 42| [ x| [cox Pl

File Edit View Favoerites Tools Help
»

U6 &0 ¥ YouTube - Broadcast Yoursel, - B - v e v Tock v @~ Ly
~
Y @ floydsma | B4(0) | Account ¥ | QuickList (0) | Heln | Loa Qut | Site; @

Home Videos Channels Community

Videos [v] ij

if

Broadcast Yourself

Upload

Video Upload - Upload Complete

| »
Doritos
Thank you! Your upload is complete.

This video will be available in [y Videos after it has finished processing.

See your ad on TV
Embed this video on your website. and win 520,000

Copy and paste the code below to smbed this video
Start Here »

beds </objects

Upload videas directly from your
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In this part . . .

A What You See Is What You Get, or WYSIWYG, tool
will help you work on a screen that looks like your
Web page and handle many of the messy HTML details for
you. This book includes the excellent CoffeeCup Editor
trial software so you can get started today.

www.it-ebooks.info



http://www.it-ebooks.info/

Chapter 8

Using a WYSIWYG Editor

In This Chapter
Comparing WYSIWYG editing to plain text
Introducing CoffeeCup HTML Editor
Using CoffeeCup HTML Editor

\\3

ou can use online tools, such as Google Page Creator discussed in

Chapter 3, to create your initial Web page using a template. However, at
some point, you will probably want to go further with your Web page than a
template allows. To go beyond templates, you have to move away from the
online tools and create your own Web page on your own hard drive. Then
you can upload tried-and-tested Web pages to any number of different Web
hosts, including Google itself.

This chapter describes how to create your initial Web page locally, on your
own hard drive, using a WYSIWYG editor. As an example, I use the Visual
Editor included in the tool on the CD-ROM, CoffeeCup HTML Editor.

The chapters in this Part describe how to improve your Web page and how
to extend your Web page into a multipage Web site using CoffeeCup Visual
Editor. Chapter 11 tells you how to publish one or more Web pages that are
on your own machine onto the Web.

The next Part tells you how to create and improve Web pages using HTML on
its own.

This chapter helps you choose the approach you want to use and then shows
you how to create your initial Web page.

Google Page Creator lets you go pretty far with your Web page. However, it
locks you into having your hosting done on Google. If you feel comfortable
keeping your Web page on the same host for a long time to come, you may
want to continue using these tools. The approach [ describe in this book, how-
ever, gives you more opportunities to keep costs low and flexibility high. You
can even edit your pages locally and then upload them to Google for hosting.
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Choosing WVSIWVG over Plain Text

You can use a couple of different approaches to create and edit Web pages
on your own computer. One approach is to use a WYSIWYG Web page editor.
WYSIWYG is pronounced “whizzywig,” and stands for What You See [s What
You Get. A WYSIWYG Web page editor is like a word processing program —
what you see on-screen is at least close to what you get when you publish
your Web page and look at it online.

The problem with this is that WYSIWYG doesn’t work perfectly on the Web.
Different Web browsers can interpret the same HTML tags differently. Also,
users can have different browser settings, which means the same page can
take on a different look for different users. This variability undermines your
efforts to make your Web page look just so. To work around these problems,
and to create Web pages that work well on the widest possible range of com-
puters and browser versions and settings, knowing what’s going on with the
underlying HTML really helps.

For this reason, many Web page publishers work directly with HTML tags.
Others work with a WYSIWYG editor, but frequently check what the underly-
ing HTML-tagged text — usually just called “the HTML” — looks like.

Whether you work in HTML directly or in a WYSIWYG editor, your capabilities
still reflect what HTML is capable of. The difference is in the ease of working
(higher for WYSIWYG) and direct control (higher working directly in HTML).

[ recommend that you either work directly in HTML or use a simple WYSIWYG
tool that doesn’t try to do too much for you, and look frequently at the under-
lying HTML. If you do want to use a tool, | recommend CoffeeCup Visual
Editor, part of the CoffeeCup HTML Editor 2008 package included on the
CD-ROM.

Working directly in HTML gives you a great deal of control and helps — okay,
forces — you to learn HTML quickly. But there are problems too. Imagining
what your Web page is going to look like is quite difficult when you’re just
looking at text and tags. You can easily make mistakes in the construction of
your Web page when you’re working directly with the tags — and easily get
lost in looking at all that HTML-tagged text when you’re trying to remember
where to make an addition or change.

As a WYSIWYG tool, CoffeeCup Visual Editor works smoothly with CoffeeCup
Code Editor, which lets you work directly with HTML code — as described in
Part IV. This gives you the best of both worlds — the ease and speed of work-
ing in a WYSIWYG tool, along with the power and precision of being able to
work with HTML code directly.

Figure 8-1 shows a simple Web page as it appears when being edited in the
CoffeeCup Visual Editor (left) and a text editor (right). You may be able to tell
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just from looking at the picture which kind of environment you prefer to work
in. If not, try both, using the instructions in this chapter, and see which one
you prefer.
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Why drink from the CoffeeCup?

There are a lot of companies that thought it
would be easy to create Web page authoring
software — only a few of them have survived
and thrived. CoffeeCup Software is one of
those few. They've racked up a large number of
awards for their dozens of different products,
all relating to Web page creation one way or
another, from Google SiteMapper, for search
engine friendliness, to several Flash tools.

Software companies work in a lot of different
ways. The CoffeeCup people have done it the
hard way — creating free and low-cost tools,
building an audience through word of mouth
(and “word of mouse” online), and gradually
creating a business around their products. Like
a lot of technically based business, they seem
to create tools they need for their own use, then
turn them into products for others to use.

One very unusual feature of CoffeeCup pro-
grams is their lifetime licenses. Once you buy
a program, you get free updates for life. Also,
today, CoffeeCup programs fill a real gap in the
market. Web authoring tools tend to be either
unreliable freeware or big, complex, expen-
sive professional tools designed for profes-
sional software developers. (Microsoft has
even stopped selling its once wildly popular
FrontPage program.) CoffeeCup is left standing
in the middle, toward the higher end in capabil-
ity but the lower end in price.

The HTML Editor is the original product from
CoffeeCup, so it has over 10 years of develop-
ment behind it. The new (at this writing), 2008
version has great reviews, well-trafficked mes-
sage boards (no small thing among such tools),
and a whole host of companion tools if your
needs grow beyond the core program.
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Working within WYSIWVG

As aleading WYSIWYG Web pages tool, CoffeeCup HTML Editor has all the
important basic features that you need to build basic Web pages. Using these
features, you can:

v Create and edit Web pages without seeing HTML tags

v Drag and drop links to other Web locations without typing the URL or
pathname

v Cut and paste graphics into your Web page, resize graphics, and add
alternate text

v Create and edit tables

v Create and edit forms — interactive data entry fields commonly found on
Web pages

You can also insert multimedia files and computer programs into your Web
page. However, not all users can play back those files or run those programs
because they may not have the appropriate browser or the right plug-ins
installed.

If you add advanced elements, such as multimedia files or computer programs,
into your Web page, be prepared to test your pages with several different
browsers and to tell your Web visitors what to expect.

CoffeeCup HTML Editor supports forms, but it can’t give you the CGI (short
for Common Gateway Interface) scripts that you need to make the forms work.
These CGI scripts process the data that the user enters into a form; if you

can create CGI scripts, you're probably ready for a more advanced tool than
CoffeeCup HTML Editor. However, if you don’t want to mess with creating
these scripts, you can get CGI scripts from others on the Web.

Plusses and minuses of CoffeeCup
HTML Editor

CoffeeCup HTML Editor has most of the advantages of an HTML tool, with
few of the disadvantages. Here are its six key advantages as an HTML tool:

v CoffeeCup HTML Editor is free to try. CoffeeCup makes HTML Editor
available for free for 30 days — but the version accompanying this book
gives you 90 days free. This is long enough to develop a site and stop —
or to decide you want to keep using the software.

v It’s easy. CoffeeCup HTML Editor is very easy to use. It leaves out some
complex advanced functions in favor of drop-dead simplicity.
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v~ Its functions match HTML tags. The functions available in HTML Editor
are the functions available in HTML — and only those functions. You can’t
do things in your Web page that aren’t supported by Web browsers.

v It uses “generic” HTML. The only functions available in HTML Editor are
those supported by all widely used versions of HTML. Web pages that
you create with CoffeeCup are likely usable by all major Web browsers
on all computer platforms.

v~ It lets you see and edit HTML. HTML Editor gives you one-click access
to the HTML tags underlying your Web page, simply by moving between
the Visual Editor and the Code Editor. You get ease of editing in
WYSIWYG mode but can still always see and edit the underlying HTML-
tagged text.

v It’s part of a whole suite of programs. CoffeeCup HTML Editor includes
several cool tools, but you can also get a whole bunch more from
CoffeeCup. Nearly all of these are available as free trials — which allows
you to do just about anything once or twice for free. If it becomes a
long-term need, buy the software. Fair’s fair.

These features of CoffeeCup HTML Editor place it comfortably between
using a text editor and using more advanced HTML editors. The starting and
ending points of that spectrum look like this:

v Text editors: Working directly with HTML tags can be frustrating and
lead you to make mistakes in the look and layout of your page.

v Advanced HTML editors: These programs, such as Microsoft
Expression Web Designer and Dreamweaver, may overwhelm you with
complex functionality (and certainly will overwhelm you with their
price).

[ recommend that most beginning Web publishers use HTML Editor in Visual
Editor mode and check the underlying HTML frequently to see what’s really
going on. As you get more knowledgeable with HTML, you may wish to buy
and use a more advanced HTML editor — or go the low-tech route (as many
Web professionals do much of the time) and use a basic text editor or the
Code Editor side of CoffeeCup.

I recommend that you consider using CoffeeCup HTML Editor initially, even if
you own a more advanced HTML editor such as Dreamweaver or FrontPage.
The functionality of CoffeeCup HTML Editor is simpler, making it easier to
learn the core features of HTML, and you can follow along better with this
book.
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Taking a sip from the CoffeeCup

<WECD At this writing, the current version of

install the software.

To check for an updated version, go
html-editor/, shown in Figure 8-2.
on the CD-ROM for your initial work;

CoffeeCup HTML Editor is called

$ CoffeeCup HTML Editor 2008. This is also the version on the CD-ROM that
comes with this book. Follow the directions in Appendix C, On the CD, to

tohttp://www.coffeecup.com/
However, consider using the version
it has a longer free trial period, and
it is sure to match the descriptions and figures in this book. You can then
upgrade to the newer version if you decide to purchase the software.

Website Design Software W Get More Website Visitors

e | COffeeCup HTML Editor 2008

Figure 8-2:
Find the
latest
version of
CoffeeCup
HTML
Editor.
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o ee up est 1906 Over 46,420,380 Downloads in 87 Countries

] 2 Tall a Frisnd About Our Cool Softuars

 Free Swff

Buy Our Software | Products & Downloads |  Software Support Center | AboutUs | ContactUs

\s Order Online Now
Get fr f

fras upgrades for life!
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=2 Download Free Trial
e

! g Get Software Suppnr;

<]
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D Internet

‘x\gN\BEI? In order to run CoffeeCup HTML Editor, you need a computer running
& Windows XP or Windows Vista. It doesn’t run on the Macintosh or Linux/Unix
operating systems. However, the newer Macintosh computers and many ver-
sions of Linux/Unix can run alongside Windows XP or Vista. You can use these

compatibility solutions to run CoffeeCup software.

Throughout the remainder of the book, I describe how to use CoffeeCup
HTML Editor to make specific kinds of changes in your Web site. But before
L Editor and get oriented to using it:

that, follow these steps to start HTM

1. Start CoffeeCup HTML Editor.
Start the HTML Editor from the

Start>Programs=>CoffeeCup Softwarer>CoffeeCup HTML Editor 2008.

Start menu by choosing
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The program opens to the Code Editor window, as shown in Figure 8-3.

«. CoffeeCup HTML Editor 2008 - C:\Program Files\Coffee Cup Software'Working'Temp.html BE
File Edit View Projects Document Insert Format Tools Window  Help
o-dr 2 @ YRR AL AR Y

Code Editor visual Edicor Preview

@ & p % (B0 ERERERE SRR = ©&- B

<!DOCTYPE HTHML FUBLIC "-//W3C//DTD HTHL 4.01 Transitional//EN">

& Files

iitor 2008 -->

<t ewed on 0
<head:>
<titler</titler
<meta http-eguiv="eontent-type" content="texe/html;charset=UTF-87/>

[D Projects

] </ head>
10 <bodyr

11 </body>
12 </btmls

e Code Snippets

LI
Figure 8-3: B
CoffeeCup |;
givesyoua |
busy start- |2
ing page. | ...
| |l LINE: 10 COL: 7 - UNSAVED

2. Switch to the Visual Editor by clicking the Visual Editor tab.
A warning message appears.

Like many Web editors, CoffeeCup HTML Editor has to change HTML
code you write to make it compatible with some of the capabilities it
supports in WYSIWYG mode. The reason for saving your code from
the Code Editor is so you can return to it if necessary after CoffeeCup
changes the version in the Visual Editor.

3. Click Save & Continue. Save your HTML code — even if you haven’t
added to it — and click OK.

The Visual Editor window opens.

<P Buttons along the top of the entry-window area are shortcuts to many of
the functions in the Format and Insert menus, introduced in the next two
steps. Consider entering a small amount of text (even sample text such
as “The quick brown fox jumped over the lazy red dog”) for experimen-
tation. You can type in a single sentence, then copy and paste it repeat-
edly for experimental purposes.

4. Pull down the Format menu and inspect the options.

The Format menu appears, as shown in Figure 8-4. It includes options
you can apply to text. Options include changing the font (not to be done
without some thought; see Chapter 9); making text bold, italic, or under-
lined; aligning it left, center, right, or fully justified; indenting text, and
other effects.
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|
Figure 8-4:
The Format
Menu helps
you specify
the look of
text.
|

A\

Consider trying formatting commands on individual characters, words,
or a larger block of text.

v CoffeeCup HTML Editor 2008 - C:\Program Files\Coffee Cup Software'Working'Temp.html 8=
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| 1 ‘ % strikeThrough
| 5 strong
2 EM Emphasis
&
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Shift+Cirl+.

£ Unelndent  Shift+Cirb,

i N P Paragraph  CirkEnter

Kk i ¥ Break

o = ®.  Subscript

% B-: =" Superscript

S m, £ Preformatted

L =

TemE‘h-lm\

hkml > bodsy | saved

5. Pull down the Insert menu and inspect the options.

The Insert menu appears, as shown in Figure 8-5. It includes different
things you can insert into your Web page. Options include inserting a
link to another Web page; inserting an image; inserting a horizontal rule;
and inserting a title for the Web page.
Consider inserting various options among a few blocks of text. If you

do this, note that inserting a link to another Web page works best if you
select the text that you want to use as the clickable Link Text before
choosing Insert=>Link.

6. Pull down the remaining menus and inspect the options.

It’s always good to begin to familiarize yourself with the options in

a new program. For CoffeeCup HTML Editor, you'll see that many of
the options have to do with managing a project; others relate to spell-
checking, testing, and so on. (But try the Special Characters tab under
the View menu for one particularly useful feature.) These capabilities,
which for the most part allow you to polish your work and to collabo-
rate with others, are not so important right now, but are very much
appreciated by CoffeeCup users who work with the tool over time.
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Chapter 9

Creating a WYSIWYG Page

In This Chapter
Writing for the Web
Formatting Web text
Using HTML lists
Entering text in HTML
Entering text in SeaMonkey Composer

Tle previous chapter shows you how to get started in a mainstream
WYSIWYG editor, CoffeeCup HTML Editor. This chapter shows you how
to create your first Web page, put some text in it, and get the text formatted
so it looks good.

This chapter draws on the discussion of using text in Web pages in Chapter 4.
Review that chapter for information about how to write for the Web. Web writ-
ing is a bit different than other kinds of writing. It’s also kind of fun, once you
get used to it.
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Most Web-authoring tools try to hide HTML
from the user; you can use one of these tools
to create a Web page without knowing a thing
about HTML. But CoffeeCup is one of many tools
that present HTML right next to a WYSIWYG
editor so you can see what you're doing and
the on-screen results of your actions. Here are
some advantages to learning HTML even as you
do most of your work in WYSIWYG:

v+ To understand how the Web works: This
understanding is pretty valuable if you're a
heavy Web user (or a light one), especially
if you plan to publish on the Web. Some of
the Web's limitations, such as “what you
see is not (exactly) what you get,” are hard
to understand if you don't know something
about HTML.

1

P

Why bother with HTML basics?

To use free Web tools: Many free Web tools
enable you to enter HTML tags directly to
jazz up your text. Knowing a few tags can
go a long way.

To work directly in HTML: Many Web
pros tire of managing HTML tags by hand
and start using a tool that hides the tags.
Others swear by HTML. (Everyone swears
atHTML, at least some of the time. But the
only way to have a choice is to know some
HTML.)

To do bhetter work using your tool: When
you're using a tool that hides the gory details
of HTML from you, knowing enough HTML
to understand what's going on “behind the
scenes” is an advantage.

Get Ready: A Refreshingly Brief

Description of HTML

HTML is a specific way of adding descriptive tags to regular text so that all
the formatting, linking, and navigational information you need in a Web page
is in text form, contained in the same file with the regular text that appears
on the Web page. HTML is designed to be something that humans can read
and that machines can process, a kind of common ground for human-to-

machine communication.

Suppose you want to add bold to a word in your text, such as

You can use HTML to specify that a word is bold.

To add bold formatting to a sentence using HTML, just take the regular sen-
tence and add a couple of tags to specify where the bold starts and stops.

Here’s the previous line in HTML:

You can use HTML to specify that a word is <b>bold</b>.
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When you display the sentence with the HTML tags in a Web browser, the
browser displays all the words, but not the tags — the information between
angle brackets. The Web browser uses the tags to do extra things to the text,
such as add formatting to it. In this case, the formatting is simple: Start using
bold text immediately after the word “is,” and stop using bold text immedi-
ately after the word “bold.”

Because HTML tags exist alongside the text that users see on your Web page,
a document with HTML tags in it is called HTML-tagged text. A file with HTML-
tagged text in it is called an HTML file — but it’s really just a specific kind of
text file.

An HTML file usually has the extension .htm or .html at the end of the file-
name. If you look at HTML-tagged text in a text editing program, you see the
angle brackets and HTML commands; if you look at it in a Web browser, you
see a Web page with formatting, links, and so on.

A document with no formatting — such as italic and other formatting added
by a word processor — is called a plain-text document. HTML-tagged text
documents are considered plain-text documents because they’re made up
only of text characters, even though some of the characters (the tags) carry
formatting information. Word-processing documents that aren’t plain-text
documents have additional formatting codes embedded in them to tell
machines how to display and print the text.

You can add HTML tags to regular text to create your own Web documents in
any text editor or word processing program. (However, in a word processing
program, you must explicitly save the Web document as a text file.) Or you
can use a Web-editing tool that hides the gory details of HTML tags, such as
the Visual Editor in CoffeeCup. (The Visual Editor creates an HTML-tagged
text file, but displays to you what that file will look like in a Web page. It
makes the HTML-tagged text available directly on the Code Editor tab.)

After you publish a few Web pages, you can take the time to find out more
about HTML. At that point, you may want to see the full HTML appendix at
the back of the book (Appendix B).

If you like to know everything that’s going on before you roll up your sleeves
and plunge into things, you may want to start by looking at HTML, XHTML &
CSS For Dummies, 6th Edition, a comprehensive guide to HTML by Ed Tittel
and Jeff Noble (Wiley).
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Examining the HTML script

Take a closer look at the term for which HTML is
an acronym, HyperText Markup Language. You
may already know that hypertext is text that has
links init. A linkis just a connection to another file.
So far so good. But what's a markup language?
(It's not that confusing language that car dealers
speak when they decide how high to jack up the
price!) A markup language is simply a way to put
information about a document — for example,
information about hypertext links and format-
ting—in the document itself. Markup languages
often use tags — labels placed within text that
give display instructions. So HyperText Markup
Language — HTML — is a specific way of using
tags to convey information about a document.

Most tags in HTML come in pairs: One starts
a change and the other ends it. In the follow-
ing sample sentence, the first tag, <b>, means
start displaying text in a bold typeface; the
second tag, </b>, means stop using bold.

Here's how the sentence looks when “marked
up” with HTML tags:

That's a <b>good</b> idea.

Here's how the sentence looks when displayed
on-screen:

That's a good idea.

The browser reads the original, text-only
sentence — That's a <b>good</
b> idea. — and says to itself, “I display
That's a, turn bold on, display good, turn
bold off, and display idea.” The person who
created the original sentence puts in the HTML
tags, the browser interprets them, and the user
only sees the effect — in this case, the word
good displayed in boldface type.

The <b> and </b> tags are formatting tags
that describe how a browser displays text.
Another kind of tag in HTML is the linking tag.
(Links are the basis of hypertext.) Linking tags
specify outside information brought into a docu-
ment. Here's some complicated-looking HTML
text that shows examples of formatting and link-
ing tags:

To learn about <i>Pokemon</
i>, the "pocket monsters"
that were so popular
with kids, go to the
official Web site for <a
href="http://www.pokemon.
com">Pokemon</a>.

The text appears on-screen as follows:

To learn about Pokemon, the
"pocket monsters" that
were so popular with kids,
go to the official Web
site for Pokemon.

The <i> and </i> formatting tags specify that
the first occurrence of the word Pokemon is
displayed in italics. The <a> and </a> link-
ing tags specify that second occurrence of
the word Pokemon is displayed as an anchor
— that is, the starting point of a link. On most
browsers, as here, anchors are underlined. So
what does the extratext—href="http://
www . pokemon . com" — inside the <a> tag
mean? href is short for Hypertext REFerence.
If you click the anchor, your browser looks for
the URL that serves as the hypertext reference,
which in this case is the Pokemon Web-page
address that appears after the equal sign.
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Viewing HTML documents

You can see HTML anytime you use the Web. Just pull up a Web page in your
browser and choose Viewr>Source for Internet Explorer, or a similar com-
mand for other browsers. A new window opens, the contents of which are the
HTML source code that underlies the Web page. Figure 9-1 shows the home
page of the For Dummies site and its HTML source code as an example.

[ Home - For Dummies - Microsoft Internet Explorer
& WileyCDA[1] - Notepad
File Edit Format View Help

@BECk % ﬂ ﬂ ) |[c'DOCTVPE HTML PUBLIC "-/AW3C//DTD HTML 4.01 Transitional//En">
= <!-- Build: R14B00Q5 --»
Ackdress | ] http: s, dummies.comileyD| < == STrand Id: 1516012852 -->

<!-- Jayout( New Layout for Dummies Home Page J --»
<htm1

<hnk href "Awileycoassite/dummies/Ainclude/style. css” type="text/cs
<titl

Home - For pummies

<ftitles
<1ink hrewC "http:/Amedia. wiley. :Dm/asSet5/1443/04/144304 css" medi
<l-= pr'\marycnntemt ( dscommon:trug prnEerty head ) : ssite/dummie
|| <meta name="description” content="explore hooks, fres ar't1c1es produ
<!-- / primarycontent ¢ iscommon:true property:head ) /s1te/dumm

</head>
Everyday Advanced <bndy bgcolor="#FFFFFF" bnttnmmargm ‘0" Teftmargin="0" marginheigh
Computing | Computing <div style="width: 776px
L. LA acementzume ¢ num: 1 5] e

Ttanle widthot oo cellspazing="0" callpadding="0" border="0">
<t-- p;a(er{\ent ¢ pos:0 Zﬁ?e il 3 ATIC ——q_‘ —
<tre<td valign="top"><table width="100%" cellspacing="0" cellpa

From Us to Vou! <tr>

aTips <td><img sro="http://media.wiley. com/assets 0/52/spac

</trz

Subscribe to our free <{r 3

newsletters, <td align="canter">

Sudoku/Puzzles <!-- begin ad tag -—> . )

Free printable Sudoku and <script language="lavascript" type="text/javascript"s

ord=math. random()“lOODDDDOOOOOOOOOO
document.write( <script language="Javascri sre="http://ad. doublec]

HKakuro Puzzles each day!
</scriptr<noscripts<a href="http: /7ad. SoRerine net /] tmp,/dim. hp,s 52

Podcasts

3 ) <122 End ad tag —-»
Whether reading a Dumimies </t
book or listening to a Dummies <ftrs
podcast, when you get Dumimies, <Tr> ) ) )
= S <tds><img src="http: //media.wiley. com/assets0/52,/spac
&1 </tr>

Having the ability to view a document’s HTML code instantly does naturally
lead to the temptation to “borrow” attractive documents from the Web, save
them to your hard drive as HTML files, and then use them as templates for
your own work — kind of a magpie approach to Web page building. But don’t.

Borrowing someone else’s material is okay for basic HTML formatting, but
for more sophisticated formats that are distinctive and embody a great deal
of work, get permission before you use them — or don’t use them. Simply con-
tact the Webmaster at the site you admire, describe how you want to use the
format, and request permission. You may be surprised how many people say
yes — without even exacting a promise from you that you hand over your
firstborn.
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Setting up a Web page

When you first create a Web page, you need to do a certain amount of setup.
Luckily, CoffeeCup enters the necessary HTML tags for you (in contrast to
having to type them out yourself in a text editor, which Chapter 13 covers).

The needed tags are of five types:

+* Begin and end HTML: Though your Web page will almost certainly work
without them, you really should tell the Internet what protocol your
page is made up of. You do this by framing the entire content of your
Web page with the <html> and </html> tags at the beginning and end
of the page.

+* Head and body: The Web page is made up of two blocks of information.
Head information is processed before anything visible shows up on the
Web page (with one exception, next). The head area is surrounded by
the <head> and </head> tags. Body information is everything you see
on the Web page, including text, links, and more. Right after the closing
</head> tag is the opening <body> tag, and the body area is terminated
by the </body> tag — the last thing in the HTML file except for the
</html> tag.

1~ Page title: The title of a Web page is meant to be descriptive information
for different programs that crawl the Web, such as search engines. But
some early Web browsers displayed the contents of the title at the top
of a Web page, and now it’s noticed by Web users — to the extent that
it’s important you get it right. The title is in the head area, and is sur-
rounded by the <title> and </title> tags.

1 Meta tags: Meta tags are “meta-information”, that is, information about
the Web page as a whole. For instance, CoffeeCup automatically inserts
the standard information, <meta http-equiv="content-type"
content="text/html;charset=UTF-8"/>. Meta tags were once
used heavily by search engines, but now are less used or even ignored.
The best way to use meta tags is for the information of yourself or
others who might look at the HTML code to tell what the page is about;
and if the meta tags help a search engine along the way, great.

v Comments: Comments are notes to yourself or future Web authors
who might look at the HTML. CoffeeCup automatically inserts a few
lines of comments, such as the following: <! -- Created with the
CoffeeCup HTML Editor 2008 -->.You may wish to add comments
in the HTML — there’s no way to add them in the Visual Editor.

These tags are demonstrated in CoffeeCup later in this chapter, along with
the commands and tags used for formatting Web text.
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Formatting Web Text

A\

Whether you use a text editor (as described in Part IV) or a WYSIWYG editor
(as described here), the capabilities that HTML makes available for format-
ting Web text are the same:

1 Headings: You can specify six levels of headings in HTML, using the

tag pairs <h1> and </h1> for the largest, top-level heading; <h2> and
</h2> for the next level; and so on down to <h6> and </h6>, the lowest
level of headings.

What it means for you: The ideal way to use headings is as intended —
<h1> for the most important heading and so on, down to <h6>. However,
you may notice that the heading you're using seems too large in compari-
son to the text beneath it. Many people use <h4>, for instance, for what’s
really a second-level heading, or use text size commands and bolding to
create their own header styles. Try using the intended headings first, and
then use your own formatting if you really need a specific look.

v+ Font sizes: HTML allows you to specify font sizes that are larger or

smaller than medium, or standard, size. You can go two sizes smaller
or three sizes larger than medium. This formatting works even if users
specify a font size or style in their browser setup or in Windows. (As
people get older, and their eyes weaken, they resort to various tricks
to make using the computer easier — as the author knows from experi-
ence.)

What it means for you: You don’t want your Web page to look like a hos-
tage note, with all different styles and sizes of text mixed up, but font
sizes can be a good way to make a point (with a larger font size) or fit a
lot of text into a small space (with a smaller size).

Using relative font sizes is one of the few formatting tricks that almost
always work well in different Web browsers.

1 Character formatting: You can make text bold or italic using the <b>

and </b> tags to start and stop bold and the <i> and </1i> tags to start
and stop italic. You can also underline text, but [ don’t recommend it,
because users can easily get confused — because HTML links are usu-
ally underlined.

What it means for you: You should feel free to use bold and italic to
emphasize your point, but don’t overdo it. Structured use of bold and
italic, such as the bold used to highlight items in this list, is one good
solution. As for underlining, avoid using it on the Web — people confuse
it with the underlining (and use of a color, usually blue) used for hyper-
links. See the “What color is your hyperlink?” sidebar for details.
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v Advanced character formatting: Using tags that aren’t supported by all
browsers currently in use, you can specify the fonts used in your Web
page, as well as font colors. There are problems with doing this, though.
Only a limited set of fonts is available for use on all Windows machines
or all Macintosh machines. And there isn’t much overlap between the
specific fonts on Windows and Macintosh, so you won’t get the specific
effect you desire on the “other” platform. (You can specify backup fonts
for use if the desired font isn’t there.)

What it means for you: 1 don’t recommend using advanced character
formatting because it’s complicated and because, just when you start to
depend on it, you find it doesn’t work for some of your users. Stay away
from this kind of formatting unless you’re working at a professional
level, with the design help and testing resources needed to make it work
well for all your users.

Follow these steps to enter and format text in CoffeeCup:

1. Start CoffeeCup and inspect the HTML in the Code Editor tab.

Note the beginning and ending HTML, head, and body tags as well as the
Title tag.

2. Move to the Visual Editor tab.
Save the Code Editor contents as prompted.
3. Choose Insert->Title.
The Page Title dialog box appears.
4. Enter an appropriate title, such as My Home Page, and then click OK.
5. Move the cursor to a new line.
6. Type some text introducing your Web page.

When someone searches for your Web page by using a search engine,
the search engine may display the Web page title, as described above,
and the first few words that appear in the document. So make the first
few sentences of text that follow the title an introduction to the entire
page or Web site.

In the document I created for this chapter, I typed:
Sierra Soccer Club

Sierra Soccer Club is a boys' soccer club that
practices and plays at the highest altitude of any in
the United States.

7. Highlight text that you’d like to make a header.

In my document, I highlighted the words Sierra Soccer Club at the
beginning.
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8. Choose Format-~>Font~>Header Sizes and the header size you want,
from 1 (largest) through 6 (smallest).

The text will change to a header of the selected size. I chose header size
1 as this is the header for all the content that follows.

9. Highlight other text that you want to format.

In my document, I highlighted the word “highest” in the middle of the
first sentence.

10. Click the toolbar button for the formatting style that you want: the B
button for Bold, the I button for Italic, or the U button for Underline.
Or choose Format=>Bold, Italic or Underline.

The highlighted text takes on the formatting you choose. In my example,
[ made the word “highest” bold.

Any HTML styles — paragraph-level formatting commands — that you
choose affect the entire paragraph of text in which the cursor rests.

Figure 9-2 shows the CoffeeCup Visual Editor tab with the text formatted
as described here. Note that Header 1 may actually be too large for our
purposes.
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What color is your hyperlink?

HTML allows you to use colored text on your
Web page and to change the colors used
for unvisited, visited, and active hyperlinks.
(“Active” means the mouse pointer is over
the link, but the mouse button hasn’t yet been
clicked.) | generally don’t recommend this.

Why not? (This book is about all the things you
cando on a Web page, after all!) The reason is
that people are very used to monotone text, usu-
ally black, on a contrasting background. People
have adjusted to the use of colored text on Web
pages, but mainly in the form of standard hyper-
link colors: blue for a link the user hasn’t clicked
yet, and purple for a recently visited link.

Some Web-page authors customize hyper-
link colors to fit better with the color scheme

of their Web pages. The problem is, research
into making Web pages easier to use and less
confusing has found that users subconsciously
count on blue underlined text to indicated unvis-
ited links and purple underlined text to indicate
visited links. Any change in these colors, or
any use of underlining or blue or purple text for
other purposes, causes deep confusion.

So I recommend that you dont use colored text,
don't change link colors, and don't use under-
lining except in links. (With the exception being
if you have the time to come up with a really
consistent, carefully thought through and highly
usable alternative, which usually requires using
a template or a professional level of attention.)
The people who visit your Web page will have
a better time using it as a result.

Using HTML Lists

People really like lists. David Letterman’s Top Ten lists are the highlight of
his Late Night show and have been the subject of several books. Everywhere
you look, you see lists. Here are my top three reasons why lists are a good

thing — in a list, of course:

v~ Lists are interesting to look at. Web pros are always telling people to
use lots of white space to vary the appearance of their pages so they’re
not just featureless blobs of text. Lists do this; they break up text.

1~ Lists are easy to scan. As | mention earlier in this chapter, people are
more likely to scan text on the Web than to read it carefully. Lists are
very easy to scan. With the key points highlighted, people can go in

depth by carefully reading the points that interest them, and then skim
the ones that don’t.

v~ Lists make the writer get to the point. When you write a list, you have
to cut and condense what you're trying to say. You may end up editing
a page of boring, monotonous text down to three or four points in a bul-
leted list. All this extra work you have to do greatly benefits the reader,
especially the reader who’s reading from a computer screen.
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HTML and Web-page editing programs based on HTML (such as CoffeeCup)
offer three kinds of lists, but only two are used much.

+~ Bulleted lists: Bulleted lists are by far the most widely used kind of list
on the Web. And why not? Bulleted lists are flexible and fun, both to
write and, more importantly, to read. You start a bulleted list with the
<ul> tag, which stands for unordered list. You end it with the </ul> tag.
Each list item is preceded with <11i>, which stands for — you guessed
it — list item.

List items don’t have to have an ending tag, though you can add one (it’s
</1i>, as you might expect). After your text, the browser expects to see
either another <1i> tag, for the next list item, or the </ul> tag to end
the list.

What it means for you: You can convert many, or even most, long blocks
of text into a bulleted list — and make the text shorter, easier to read,
and more interesting in the bargain. If you have to move existing text to
the Web, consider “bulletizing” parts of it as a quick way to make it more
Web friendly.

+* Numbered lists: Numbered lists look weird when you create them in
some Web editing programs — the program puts a number symbol (#)
next to each item, and the number isn’t assigned until the page displays.
(CofteeCup, fortunately, displays actual numbers.) Numbered lists are
very useful, but are found much less often on the Web. Numbered lists
begin with <ol> for ordered list, end with </01>, and — like bulleted
lists — use the <1i> tag to mark the beginning of each list item.

“&N\BEH What it means for you: Any time you have a list that has an order in
& terms of importance, sequence in time, or any other reason, make it a
numbered list. Putting your list items in numbered order makes the list
even easier to scan than a regular, bulleted list.

v~ Definition lists: Definition lists give a term and then a definition for the
term. They’re rarely used, though finding a use for them in your Web
page is a good exercise. A definition list starts with <d1> and ends with
</d1l>. Each term is preceded by <dt>, for definition term, and each
definition is preceded by <dd>, for definition data. Again, if you'd like,
you can close the tags by adding </dt> and </dd>, respectively, after
the data.

What it means for you: The appearance of definition lists in your Web
page is a bit funny — some Web browsers put the term on one line and
then the definition, indented farther in, on the next line. You can help
the reader who'’s scanning find the terms easily by making them bold, as
in the definition list you're reading here. People like definition-type lists,
but not necessarily formatted the way most Web browsers do it. Use def-
inition lists where you can, or use bold text and bulleted or numbered
lists to create your own definition-type list.
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v~ Lists within lists: You can insert or nest one list inside another. The

nested list can be the same kind of list, or a different kind, than the list
that contains it.

What it means for you: In the limited view offered on most users’ screens,
users have a hard time keeping track of where they are in the overall list
if you start throwing sublists at them as well. I believe that putting one
list within another is usually a case of something that’s technically pos-
sible, but not editorially desirable. (I look forward to one of you proving
me wrong by coming up with a good use for nested lists on a Web page.)

Follow these steps to create a list in CoffeeCup:

1. Add the text for your list in the Visual Editor.

In the document I created for this chapter, here’s what I typed:

If you meet the following qualifications, you may be
eligible to become a member of Sierra Soccer Club:

Born in 2000 or 2001. Sierra Soccer Club has played
together since its founding members were 5 and 6 years
0ld and will stick together as they grow up. All our
club members must be born in 2000 or 2001.

Some soccer experience. If you have played in organized
leagues before, or if you're a skilled school player,
we may be able to help take your game to new levels.

Good academic record. We are proud that our club mem-
bers maintain good standing in school as well as in
soccer.

. Highlight the lines that you want to make into a list.

In my document, I highlighted the lines that begin with these phrases:
Born in 2000 or 2001
Some soccer experience

Good academic record

. Choose Insert=>List or click the List button in the Visual Editor.

The Insert List dialog box appears, as shown in Figure 9-3.

The Insert List dialog box is a good example of the benefits of using a
WYSIWYG editor. It includes options for bullet styles that you might not
have known were part of HTML, or for which you might have forgotten
the details. With this dialog box, you’re not only reminded of the button
styles, but also can easily test how they look within your page.
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4. Choose the type of list you want and (optionally) the bullet style.

For this example, I've made a bulleted list of the list items for the soccer
club members, and chosen the square bullet style. | then removed extra
carriage returns so there would only be three bullets.

Figure 9-4 shows the sample page with all the formatting described in

the numbered steps in this chapter applied.
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5. To see the underlying HTML, click the Code Editor tab.
The HTML for your page appears, as shown in Figure 9-5.

<P When you’re working in a WYSIWYG (What You See Is What You Get)
tool such as CoffeeCup, you often want to look at the underlying HTML
code. Doing so enables you to find out how HTML works and gives you
the chance to make adjustments in the HTML tags that affect the way
your page looks and works on the Web.

@‘“\NG! The only problem with looking at the HTML code in CoffeeCup is that
S you’ll be prompted to save the HTML code, even if you haven’t changed
anything in the Code Editor. However, doing this does give you the
opportunity to create a backup of the work you’ve done in the Visual
Editor, even if that wasn’t your original intent.
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CoffeeCup or a more sophisticated package?

Although offerings change with time, you can  »~ Truly easy: Because it's designed as an

usually get a free trial version of excellent introductory program, CoffeeCup has only
Web-page editing software such as Microsoft basic and intermediate features — not too
Expression Web or Adobe Dreamweaver from much complexity, which you don’t need
the companies’ Web sites, or an online down- most of the time, to make things confusing.

load site such as CNET's download.com
(at www . download. com, natch). Why use
CoffeeCup instead of a free trial version?

v~ Far less expensive: If you choose to pay
for CoffeeCup, you'll only pay a small fee,
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and you’ll only pay it once — CoffeeCup
includes free lifetime updates.

v Truly HTML-compatible: As an introduc-
tory program, Composer only supports
features that work on just about any Web
browser out there. By contrast, using all
the features in Microsoft Expression Web
or Dreamweaver may mean that you add
things that don't work in older browsers or
across platforms.

In addition, of course, my argument is that you
can better follow along with the instructions in
this book if you're using the software that | use

for many of my examples and figures — either
straight HTML or CoffeeCup.

If you're sure that you're going to be using
Expression Web or Dreamweaver soon, or if
you already have a copy, you may want to use a
trial version of the program that's in your future.
Even then, you may want to use CoffeeCup for
easy work and the full-featured program for
advanced features. If you do work in a full-
featured Web-page editor, most of the steps in
the sections of this book dedicated to CoffeeCup
will still work for you — you just need to substi-
tute the specific commands for your program in
place of the instructions and illustrations given
for CoffeeCup.

Chapter 9: Creating a WYSIWYG Page

175

Linking to Qutside Web Pages

The secret of Web pages is hyperlinks. This is where the phrase “surfing the
Web” comes from, with the ease of moving from one page to another and one
site to another making the Web easy to use and fun.

This section shows you how to use one form of links: links to totally different
Web sites. These are the simplest links, even though they’re also the most
powerful, allowing you to reach out to any Web site or any Web page on any
Web server anywhere in the world.

Hyperlinks are so important that they're reflected in the names of the two

key technical standards underlying the Web. HyperText Transfer Protocol, the
http you see in a Web-page address, is the standard for file transfer used to
support Web pages. (When you click a link to a new Web page, an HTML file is
transferred to your machine, and links within the HTML file cause graphics to
appear within the page.)

HyperText Markup Language, or HTML, is the standard for writing Web
pages. While many HTML tags, such as the bold and italics tags (<b> and
<1i>) are for formatting rather than hypertext, the links described in this sec-
tion, for linking to outside Web pages, are definitely hypertext markup.
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1 link, therefore | am

A hypertext link to an outside Web page has two parts: the text that appears
as a hyperlink — most often underlined and displayed in blue — and the
destination page that appears in the user’s Web browser if the user clicks on
the link.

The text is made into the starting point of a hypertext link by surrounding it
with the <a> and </a> tags, with a standing for anchor. The link’s two ends,
the start that the user clicks on and the page that appears as a result, are
both called anchors.

The destination of the link is called the hypertext reference, or href for
short. So a link to another Web page in HTML looks like this:

Make your own cider with <a href="http://www.ciderspices.com">cider spices</a>.

Simple, isn’t it? Part of the reason it’s so simple is a couple of assumptions:

If you use a domain name for a link, such as www.ciderspices.com, your
Web browser looks for the index.htm or similarly named file first, so you
don’t have to include the filename in the link destination. And the browser
further assumes that the destination is the top of a Web page unless you
specify a location within the Web page. (I go into more detail on this when
discussing links within a Web page and links to graphics and multimedia files
in the next two chapters.)

A simple link in a CoffeeCup

Follow these steps to create a simple hypertext link in CoffeeCup’s Visual
Editor:

1. In the Visual Editor, highlight the text that you want to make into a
hyperlink.

In the document I created as an example for this book, I highlighted the
words “soccer experience” in the second bullet point.

2. Click the Links button or choose Insert~Link.
The Insert Link dialog box appears, as shown in Figure 9-6.
3. Enter the destination Web address, or URL, in the URL box.

Enter the full Web address, including the preceding http://, and check
whether the address includes www. or not; a few Web addresses don'’t.
Also make certain that the site ending really is . com, .org, .co.uk, and
SO on.
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You can open a Web browser to find or check the Web address you need
while the Insert Link dialog box is open.

Enter a title for the link in the Title: area.

The title for the link is text that appears when the user puts the mouse
pointer over the link. (Text of this sort is called a tool tip from its use in
computer programs.)

If you leave this area blank, the URL will appear as the tool tip. Often
this is self-explanatory, as in a link to a Wikipedia entry. You may wish
to enter the URL, without http://, as the link title to make it a bit more
comprehensible for the user.

If the URL is long or confusing, enter a simple title that describes the
page. For instance, the URL for the book HTML For Dummies, 5th Edition,
on www . dummies . com is intimidatingly long and confusing:

http://www.dummies.com/WileyCDA/Section/id-DUMMIES_SEARCH_RESULT.
html?queryText=html%20for%20dummies

I'd enter a tool tip such as HTML, For Dummies on dummies.com
instead.

Click OK to accept the link URL and the link title, if any.

The text will appear as link text, underlined and in blue. (Unless you've
changed the appearance of the links for this page.)
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Chapter 10

Graphics and Media,
WYSIWYG Style

In This Chapter
Gazing at images in a WYSIWYG editor
Giving voice to your Web page by adding sound

Livening up a Web page with video

A\\S

n the early days of the Web, it was embedded GIF graphics files that really

brought Web pages to life. Then came embedded JPEG files, and more
recently downloadable sound files and embedded videos have kept making
the Web more and more interesting, relevant, and useful.

Chapters 5, 6, and 7, describe how to create and use images, sounds, and
videos (respectively). In this chapter, [ show you how to actually put all
these kinds of files in your Web page using a WYSIWYG editor, with specific
examples using CoffeeCup. By the end of this chapter, you should be able to
create very lively Web pages.

Chapter 14 uses this same approach, showing you how to create Web pages
“by hand” in Notepad. It looks pretty similar to this chapter; that’s intentional.
[ figure at least some consistency helps shrink confusion.

In the early days of the Web, the only kind of media file that could be really
included in a Web page was a GIF graphics file. Though the HTML file itself
was text, any GIF file that was linked into the Web page via the IMG tag was
displayed as if it were part of the page. JPEG graphics files were included via
the EMBED command and were opened with one of a variety of “player” pro-
grams that contained the somewhat complex code needed to display a JPEG
image.

Fairly quickly, browsers were upgraded to incorporate JPEG files, which
can now be handled via the TMG command. PNG graphics files are now fairly
widely supported, and even Windows BMP files are supported by Internet
Explorer. But GIF and JPEG images remain the only ones that you can really
count on including within the “flow” of a Web page.
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Web-page authors have had to put up with a certain limitation of standard
Web browsers: They can’t display or play back sound and video files; for that
you need a player application such as Windows Media Player, QuickTime, or
RealPlayer (to cite three common examples). Even the HTML for including a
sound or video file isn’t standardized. So if you're going to include these files
in a way that most people can use, you have some tweaking and finessing to
do. Fortunately, CoffeeCup helps you do it.

Including Images in WYSIWVG

Including images in a Web page isn’t all that simple. The complexities of how
to create the images themselves are covered in Chapter 5. Linking to images
isn’t all that easy either. (Similar considerations apply to sound and video,
but they’re less-used than images.)

There are three kinds of links you can use to include an image in a Web page:

v Linking to a Web URL. Most every image on the Web has its own URL.
So, to include the image in your own Web page, you can just use the IMG
tag and give the Web address of the image as the source. When the user
sees your Web page, it will look like the image is part of it, even though
it’s hosted on a different Web site.

Plusses and minuses: This is easy for you as a Web author, but you can’t
count on the image staying there forever. It also represents the image
as your own when it actually belongs to someone else. Finally, it’s much
slower for the user than hosting the image on your own Web server.

To find the URL of a Web image on a Windows machine, right-click it and
choose Copy Shortcut. The URL will then be placed in the Clipboard, mean-
ing you can paste it into a text editor, HTML program or other program.

v Linking to the same folder as your Web page. If an image file is in the
same folder as the HTML file that links to it, you only need to give the
name of the image file, no folder or path information.

Plusses and minuses: This is very simple, like linking to a Web URL,

fast and easy. When you transfer your files to a Web server, there’s no
problem with keeping the files in the same relative position. The only
disadvantage is that the folder the Web page is in can get quite crowded,
especially as many images are used over and over again by different
Web pages. So you can end up with one folder containing all the Web
pages and images in a site, which can be a mess.

v Linking to a different folder on the same machine as the Web page.
The image file is on the same machine as the Web page, but in a different
folder. The link contains either a relative pathway from the Web page
to the image file, including moves up and down a tree of folders, or an
absolute address relative to the root of the machine.
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Plusses and minuses: This is where a lot of problems occur. You have to
describe the pathway from the HTML file to the image file, or the abso-
lute location of the file on the machine, and this can easily change or get
mangled when files are transferred to a Web server.

Using a WYSIWYG tool such as CoffeeCup solves many of the possible
problems of keeping images in a separate file by automatically generat-
ing the path information between the files. CoffeeCup goes one step
further and encourages you to arrange the files sensibly.

All the different possible ways of linking an HTML file to an image file are
described in Table 10-1. Inspect it carefully now, and use it as a reference when
you're creating links to image files. (There’s one just like it in Chapter 14 for
those hardy folks who’ve decided to use Notepad instead of CoffeeCup.)

Table 10-1 URL and Web Page Examples

Location of URL Web-Page Graphics

Target Example Example*

Same folder filename <a href=" <img src="
mycv.html"> myface.jpg">
text</a>

Subfolder at pathname/ <a href=" <img src="

a lower level filename subpages/ grfx/myface.

of the same mycv.htm"> jpg>

path text</a>

Folder on pathname/ <a href="../ <img src="

a different filename theother- . ./sharegfx/

path page/ proface.gif>
otherpage.
htm>text</a>

Different domainname <a href=" <img src="

server, home http://www. http://www.

page (index. largedomain. largedomain.
htm or index. com">text</ com/good-
html) a> face.jpg">

Different Domainname/ <a href=" <img src=

server, pathname http://www. "http://www.

interior page largess.com/ largess.com/
files/bud. gifs/icon27.
htm">text</ gif">
a>
(continued)
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Table 10-1 (continued)

Location of URL Web-Page Graphics
Target Example Example*
Link within a Any of the above <a name="my Doesn’t apply
page + #anchor anchor"></a>;
name <a href="
http://www.

largess.com#
myanchor">Go
to my anchor
</a>

* These examples leave out the alt option and other important graphics options, described later in
this chapter.

Follow these steps to enter and format text in CoffeeCup:
1. Open the Visual Editor tab in CoffeeCup; move the cursor to the point
where you want to insert the graphic.
The Visual Editor makes many aspects of linking to a graphic easier.
2. Click the Image button or click the Insert menu and select Image.
<P The Insert Image dialog box appears, as shown in Figure 10-1.

Move the dialog box to one side (if possible) so you can see the area
where the image is going in.

Insert Image
ﬁ) |—) Graphics v @_ﬂj

Mame
\-)backgrounds
icons
Zplano

General ' Thumbnail

| Image:

Figure 10-1: Al Text: &
Insert Image Algn: [l Border: [0 |

gives you width; Heicht: Resst_] [@lindude Sizs
most of the Create Image as Link.
options you < = v] =]
need. &

|
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3. Navigate to the image you want to include and select it.

Chapter 5 describes how to create and find images of the right format,
adjust image size, and so on. (However, see Step 10 for a quick-and-dirty
way to resize an image.)

4. If CoffeeCup asks you to copy the image to the working folder, say Yes
to do so, or No to leave the image where it is.

In most cases, it’s better to choose Yes; this will place the image in the
same folder as the Web page, creating the simplest possible path from
one to the other.

5. Enter alt text at the Alt Text prompt.

alt text is very important for two reasons. alt text is read out loud
by screen readers and other programs for visually disabled users. (The
wheelchair image in the dialog box is the international symbol for dis-
ability, not specifically for wheelchair use.)

alt text is also used as a tool tip, text that appears when the user
mouses over the graphic. For both purposes, alt text should be a short,
simple description of the image, such as the name of a person pictured —
or a description, if the image is for the purpose of providing atmosphere.

6. Choose how the image should be aligned relative to text.

The usual choices are for the image to be aligned to the left, with text
flowing around it on the right, or on the right, with text flowing to the
left of it. This is the magazine or newspaper look, with text and image
integrated together.

Other choices, such as top, bottom, and middle, place a single line of
text next to the image and otherwise leave the image on its own. This
nearly always looks strange.

7. Enter a border size for a black border around the image.

Adding a thin black border around an image makes it appear sharper
and clearer (especially small images). Experiment with border sizes
around your image. The Insert Image box will show a preview to help
guide you, as shown in Figure 10-2.

There’s an additional attribute that allows you to add blank space
around an image that you may want to use; see Chapter 14 for the HTML
code to use in the Code Editor to add this padding.

8. Change the width and height if you want to resize the image in place.

Usually you should resize the image before putting it in your Web page.
However, you can stretch or shrink the displayed image by changing the
width and/or height here.
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|
Figure 10-2:
Use the
preview to
set a border
around the
image.
|
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10.

11.

If you want to keep the image in proportion, change both dimensions by
the same amount. For instance, if you want to resize the width from 180
pixels to 100 pixels, multiply the height by 100, divide it by 180, and use
the result as the new height.

Leave the Include Size box checked so the image size will be included
in the HTML code. This allows the Web browser to draw the Web page
correctly before the image downloads, preventing different parts of the
page contents from lurching about as different elements of the page
download.

. To make the image a link, enter a URL, or browse to the destination

file on your local machine or network.

You can link to a Web destination or use images to create an image-
based menu.

To create a smaller version of the image, click the Thumbnail tab, as
shown in Figure 10-3.

You can choose the percentage for resizing, the file format, and the qual-
ity setting (for JPEG images).

If you want to give the user the option of clicking the small image to see
the larger version, click the Link to Original Image check box.

This is a great feature for creating a thumbnail image, but also a fast and
easy way of creating a smaller image “on the fly.”

Click OK to accept the image settings.

To change the settings later, click the image; the options will show up at
the bottom of the Visual Editor area.
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Figure 10-3:
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Adding Sound to Vour Page

A\

Whether it’s a good idea to add sound to your Web page, the plusses and
minuses are discussed in Chapter 6. (Also described there are how to host

a music file on MySpace.) [ mention there that you can’t, for instance, have
background music for an entire site — sound is controlled one page at a time.
But what are the actual mechanics of adding sound?

Because sound is not a standard part of the Web’s definition, there are actu-
ally two contradictory ways to do it. Briefly, one is with the bgsound tag, and
one is with the embed tag.

The bgsound tag works well and has useful options for controlling sound.
However, it’s not supported by all browsers.

The embed tag is one of the “wild cards” of HTML, not officially supported by
the HTML standard at all — but supported by most browsers. One big prob-
lem with embed, from a standards point of view, is that the options (officially
called attributes) for embed are different for different players. Each player is
controlled by a single company — Microsoft, Apple, and Real Networks, for
the three major players — and this is not a very standards-friendly situation.

The user can stop sound from playing by clicking the browser’s Stop button;

you may wish to let your users know this in text on your Web page; many
(even most) users don’t know it.
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Given this confusion, CoffeeCup does an excellent job of supporting the
embedding of sounds, but it’s still a mess. Follow these steps to add sound to
a Web page in CoffeeCup:

1. Open the Visual Editor tab in CoffeeCup; move the cursor to the begin-
ning of the text.

This will put the HTML code for embedding the sound at the beginning
of the BODY area of the Web page, where it will be easy to find if you
need to modify it.

2. Choose Insert>Sound.

The Insert Sound dialog box appears, as shown in Figure 10-4.

Insert Sound

Lookin: |1 Sounds & iz
o DR

i_GetMoreFreaSounds mera Ldcar icash chcaco\a
2| coma idriva iglass L4 |un |4 |mao
14| ot isweethrt iturkjsh iwhuosh | wings
2| wonderful

Figure 10-4:
Choose a
sound to
please — or
annoy? — Sound to Insert:

your page’s -] :
visitors. o cacel | ()

3. Navigate to the sound file you want to include — one of the sample
files included with CoffeeCup (as shown in the figure) or another
sound — and select it.

The pathway to the file shows up next to the Sound to Insert prompt.

4. To preview — or “pre-hear” — the sound file, click the green triangle.
To open the application that’s associated with that type of sound file
on your machine, click Play in Associated Application.

The sound file will play — without showing the application, if you click
the green triangle, or while showing the application, if you click the Play
in Associated Application button.

5. Click OK to accept the sound.

A small image will appear in the Web page and the sound will now play
whenever the page is opened.
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The HTML code generated by CoffeeCup will actually play the same
sound twice. To correct this, and to set other options, follow the next
steps.

. Click the Code Editor tab.

The code for playing the sound, both an embed tag and a bgsound tag,
will appear.

. Correct the code to make the sound play only once.

There are three solutions to this:

¢ Remove the embed tag. This way the sound will only play — once,
not twice — on the (many) browsers that support bgsound. Users
whose browsers don’t support bgsound won’t hear anything and
won’t know what they’re missing.

¢ Remove the bgsound tag. This way the sound will play — only
once, not twice — on the (many) browsers that support embed.
Users whose browsers don’t support embed won'’t hear anything
and won’t know what they’re missing.

e Surround the bgsound tag with the <noembed> and </noembed>
tags. These tags allow the bgsound tag to only execute on brows-
ers that don’t support the embed tag; you only hear the sound
once, but you miss the 1oop option of the bgsound tag. Speaking
of which. ..

For the bgsound tag only, you can add 1oop="3", for instance,
for the sound to play a total of three times, or loop="infinite"
if you want the sound to keep playing. (This can be, well, infinitely
annoying.)

Adding Uideo to Your Page

\NG/
Vg&\

The whys and wherefores of adding video to your Web page are discussed
in detail in Chapter 7, along with the specifics of how to upload a video to
YouTube.

You can host a video on your own site or on YouTube. If you use YouTube,
you get the advantage of using Google’s massive server and processing capa-
bilities — Google owns YouTube — for compressing your video and serving
it, all free of charge to you. If you host video on your own site, you may have
to pay fees if download activity gets too high.

If a video hosted on a server you pay for “goes viral” — suddenly getting hun-
dreds or thousands of hits — the download charges could scale rather dra-
matically as well.
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YouTube even helps with the mechanics of putting the video in your Web
page — which can be done with the same code, wherever it’s hosted, except
for the contents of the hypertext reference. For every video on YouTube, the
code is provided to link to embed that video in your Web page. However, it’s
not that hard to do the same thing yourself.

Here’s a quick example of how to include a video in your Web page, wherever
it’s hosted:

1. Open the Code Editor tab in CoffeeCup; move the cursor to wherever
you want the video to appear in the Web page.

2. If the video is hosted on YouTube, go to the relevant YouTube page
and copy the code for the video from there. Paste it into your Web
page. Otherwise, type in the following: <embed src="path">.

If the video is in the same folder as your Web page, the path is just the
filename; if the video is on the Web, the path is its URL (of the video, not
the page it’s on; find this by choosing View=>Source for the Web page
hosting the video). If the file is in a folder on your machine, include the
path to it.

You can figure this out by linking to a graphic in the same folder, using
the Insert Image command described earlier in this chapter, then copy-
ing the path generated in the dialog box but substituting the video’s
filename.

3. Test the video in your Web page.
Try the video in your Web page.

If you're having no luck successfully including the video in your Web
page, or if you're worried about download charges, then upload the
video to YouTube or another host. Provide a “normal” link to the Web
page that hosts the video on your Web page. Users can then return to
your site after they’'ve viewed the video.
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Laying Out Your Site in WYSIWYG

In This Chapter

Using mailto links

Linking your Web page internally

Creating a navigation bar

0ne of the trickiest things in creating Web pages is going beyond “just
putting up a page” to creating a full site. The questions around design-
ing a multiple-page site never get fully answered, even by the experts. (That’s
oddly reassuring, as it leaves room for creativity.)

In this chapter, I demonstrate how to use links to create first a complex page,
then a full site, complete with basic navigation.

Using mailto Links

Oddly, mailto links are one of those “simple” things that actually have some
complexity to them — complexity that’s easy to work around if you know how.

Amailto linkis alink that has as its destination an e-mail address. If your
system is set up properly — a big if — clicking an e-mail link brings up an
open e-mail message, already addressed to the e-mail address described in the
mailto link. (If you're really clever, the subject line of the e-mail can also be
pre-filled.) The user just has to enter the content of the e-mail and click Send.
See Figure 11-1 for an example of a link and the resulting e-mail message.
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True enough, mailto links are cool, a nice “hack” that makes a difficult prob-
lem — getting an e-mail address exactly right — much easier. Unfortunately,
there are a few “buts” to take into account before using e-mail links. Here are
the problems with them:

v mailto links often don’t work at all. Many people don’t have their
systems set up correctly (that is, so their main e-mail program is rec-
ognized by the system and “called” when amailto link is clicked). The
result of clicking a link might be that an unused e-mail tool is started,
or even that the system asks the user to find the e-mail program on the
hard drive — not something most people want to do (for one thing, it’s
annoying).

v mailto links often don’t work in the way that’s wanted. Different
people use different e-mail programs for different purposes. The same
person may do e-mail work primarily in Outlook, using his or her job’s
domain name, may handle personal e-mail through Hotmail or Gmail —
possibly through a Web browser window, possibly also in Outlook.

The mailto link can’t “know” which e-mail program or source domain
the user wants at any given point, but it often guesses wrong. It may
(for example) strike the user as strikingly inappropriate to bring up the
“work” e-mail when the present objective is to book a vacation. This
problem can even contribute to getting the user into difficulty: It’s easy
to miss an e-mail reply that goes to the “wrong” account or use the
“work” e-mail application for inappropriate personal purposes. (Try
saying that three times fast!)

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 11: Laying Out Your Site in WYSIWYG

v mailto links often aren’t what the user expects. When users click a
“Contact Us” link, for instance, they want and expect a page of contact
information with, ideally, one or more names, addresses, and phone
numbers, as well as Web links and e-mail addresses. If, instead, a pre-
filled e-mail message to a discouraging address (such as contact@
wewontanswer . com) comes up, the user feels cheated.

Luckily, there’s a way to use mailto links that maximizes their advantages
and minimizes their problems. Just follow these rules, which work together
to “tame” mailto links and make them friendly:

1 Never use mailto links in navigation. Users expect navigational links
to lead to Web pages. Don’t surprise them. Use mailto links within Web
pages, where the user expects them.

v Provide alternatives to e-mail contact. Don’t make e-mail the only way to
contact you unless you absolutely have to. Everyone knows that e-mails
(especially e-mails to anonymous addresses such as contactuse@...)
often go unanswered. So make the e-mail route just one way to get in
touch. (And if you really want to be effective, promise a time frame in
which the e-mail will be answered and stick to it.)

v Signal that the mailto link is present. Use wording coming up to the
mailto link that indicates that’s what the users will get when they click.
Something like this: “To complain, call us at 1 800 555-1212 or send us
e-mail....”

v Spell out the e-mail address as well. Many users are aware that clicking
amailto link doesn’t work for them. By spelling out the e-mail address
as well as providing it in a link, you give them another way to accom-
plish your shared purpose, which is for them to send you an e-mail.
(You also signal that the adjacent e-mail link is just that.)

So a proper use of mailto links is within a Contact Us or other page, in a
form like the following:

To respond, send e-mail to wewanttohear@ourcompany . com.
This will signal the user that clicking the link, e-mail, will bring up an e-mail
message addressed to wewanttohear@ourcompany . com — and give them a

workaround if they want to use the e-mail address themselves.

Creating a mailto link in CoffeeCup is just like creating a regular link, only
simpler. Follow these steps:
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1. Open the Visual Editor tab in CoffeeCup; move the cursor to the spot
where you want to insert the mailto link. If the text you wish to use
for the e-mail link is already present, select it.

2. Choose Insert>E-mail Link or click the Link button and choose E-mail
Link.

The Insert E-mail Link dialog box appears, as shown in Figure 11-2.

Insert E-mail Link
& Link Text:
o 1 Email
| E-Mail Address to link to: (For Example: YourMame@YourDomain.com)
Figure 11-2: ‘
Insert E'mail Subject (opt\;na\):
. Status \Window Message:
g|VeS yOU a” [ Show Status Wlndgnw Message On MouseOver
the options E
you need —
and more. oK Cancel @
|
3. If the Link Text: area is not already filled in with text you selected
before opening the dialog box, enter the link text you want to use.
NG/ 4. Enter the e-mail address you want the link to link to.
QNG
Sy Be sure to get the e-mail address right, and test it after you finish.
Nothing is more frustrating to the user than a bad e-mail address in a
mailto link.
<P If there’s background work that needs to be done — for instance, if you

want to use a generic e-mail address such as contact@, but behind the
scenes you want to link that to a few people’s e-mail In boxes — do that
work now so the link works as needed from the beginning, even during
testing.

5. Optionally, enter a Subject line for the e-mail.

This can be convenient for both you and the users, but can be changed
by the users (or can be ignored completely if users send e-mail to the
designated address themselves). So don’t count on it working for all
e-mails you receive from this mailto link.

6. Optionally, click in the check box to show a status window message
when the users move their mouse over the linked text. Then enter the
message.
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This option makes a message appear in the status-bar area in the user’s
Web browser; if you don’t enter anything here, the word mailto: and
the destination e-mail address will appear instead. Unfortunately, most
users have the status-bar area turned off (that’s the default in recent
versions of Internet Explorer, the most popular browser) and, if they do
have it on, they expect to be able to see link destinations there when
they mouse over a link. So it’s probably best not to use this option.

7. Click OK to accept the e-mail link properties.
The appropriate HTML code is added to your Web page.

Internal Links within a Web Page

One of the most productive uses of hyperlinks is to create sets of links that,
at first, don’t seem all that “hyper”: links within a Web page.

One of the cleverest elements of Web pages is that, while they're quite
limited in the horizontal dimension — users won’t accept having to scroll
left and right to read a page — they can be very long indeed in the vertical
dimension (up and down). Like an ancient scroll, a Web page can “unroll” to
be very long indeed.

But only if you make things easy on the user. You can help a user navigate
within a given Web page by using internal links — links that go to a specific
spot within a Web page.

Internal links are useful for creating a Web site that’s made up of a single Web
page, divided into sections. Such a page is also a great precursor to a full
Web site with multiple Web pages and navigation.

An internal link has two parts:

1 A destination anchor: This is in the form <a name="targetname"></
a>. Note that there is no text surrounded by the beginning and ending
anchor tags. This HTML code simply gives a name to the spot in the
Web page where it appears. It’s invisible to the user. When a link has the
target as a destination, the Web page scrolls upward or downward so
that the line is the destination.

v A source anchor: This is in the form <a src="#anchorname">text</
a>. This is a typical anchor, but the destination is within a page, as
shown by the # character. The source may also include a Web-page
name, in which case the target after the # character is a destination
anchor within the Web page. If the source doesn’t include a Web-page
name, the destination must be within the current page.
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A classic example of internal links in a Web page that’s part of a full site is the
familiar FAQ (for Frequently Asked Questions) page. Generally, the questions
are all listed at the top, followed by each question with its accompanying
(often quite lengthy) answer. Links within the page make it easy to go back to
the top of the page whenever you're done reading one of the answers.

Follow the instructions here to create an internal link in a Web page in

CoffeeCup:

1. Open the Visual Editor tab in CoffeeCup; enter some text that includes

destinations that you want to link to.

The Visual Editor makes the sometimes complicated task of inserting
internal links easier. But whether using the Visual Editor or not, it’s
easier to create the destinations first, then the links that go to them.

2. Move the cursor to a spot that you want to be the destination of a link.

Usually this will be the beginning of a line of text, often a header.

\3 .
) If you don’t have the content of a Web page ready yet, you can just
create headers and links; then your navigation system will be ready as
you fill in the content.
3. Choose Insert~>Target.
The Insert Target dialog box appears, as shown in Figure 11-3.
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File Edit Yiew Projects Document [nsert Format Toole Window Help
2. B 3 B SEE R R
Code Editar Visual Editor Preview
il R |ai-pr Ny 1] E L=l - B #
) ] S0 100 150 200 250 300 350 400 450 S00 S50 600 6890 700 75
Tlodwa Lo Lo b b Do b b b b o Do b e ey e Do by g |
2 |
.| .1 Sierra Soccer Club
g { Sierra Soscer Club is a boys’ soscer chub that practices and plays at the highest altiude of any in theUnited States
)| 8 Fyoumeet the following qualifisations, you may be eligble to become a member of Sierra Soccer Clib
2[5 1. Insert Target ince its founding members were 5 and 6 years
5 27 j Type the nar;efnr the target, Targets are used with inksto jumptoa |5 rust be born in 2000 or 2001
4 1] position in & document,
E §§ An excample link For & karget with the Name "Chapter2” would be: s before, or if you're a skilled school player, we
= 1 <a href="contents, htmk#Chapter2"»Chapter2 <fa>
| a
R Target Mame: aitttain good standing in school as well as in
Figure 11-3: [ 3
Choose your |z ™
destination | 5| & Emalthe anhor
with Insert ||
Ta rg Et' Soccer Veage‘hlm\
I |t - body Il saved

www.it-ebooks.info



http://www.it-ebooks.info/

Chapter 11: Laying Out Your Site in WYSIWYG

A\

4. Enter a target name.

The target name should include some key phrase or words from the text
just following the target, but the target name should have no spaces.

5. Click OK.

“Hidden” HTML — HTML that can’t be seen in the Visual Editor or in

the Web page visible to the user — is inserted, in the following form: <a
name= "anchorname"></a>. This HTML code simply gives a name to
the spot in the Web page where the HTML occurs — a spot that can now
be linked to.

6. Repeat for additional internal links.

Create all the additional links you need — if necessary, type in headers
or other markers for the internal links to be associated with.

7. Confirm the internal anchors.

To confirm that the internal anchors have been created, choose
Insert=>Quick Link to Open Document and the currently open document.
(You can also choose the Link button as the starting point.) The currently
defined internal anchors will display, in their order within the document.

The link targets given names in this way are often referred to as anchors, even
though technically the beginnings of links are anchors as well. Creating and
using these kinds of anchors (link destinations) is another area where using a
WYSIWYG tool such as CoffeeCup provides a big advantage. Inserting, finding,
and using link destinations directly in HTML-tagged text is quite complicated,
but in an HTML tool, it’s fairly easy with a little planning.

Creating a Navigation Bar Using Text

Navigation bar is a broad term for an area of a Web page that the user recog-
nizes as set aside for links among Web pages. Each separate link or choice in
a navigation bar is called a fab, whether or not it actually looks like a tab as
used in a paper file.

Many more complex sites actually have two or more navigation bars — a
primary navigation bar for the main areas of the site, which is often graphi-
cal and may run down the left side of the site, and a utility navigation bar for
useful functions such as a site map, contact information, and copyright or
legal information. (These functions may be housed on Web pages below the
top level of navigation for the site as a whole, or may be separate from the
site hierarchy and accessible only via the utility navigation bar.) The utility
navigation bar is often text-based (or at least relatively simple) and found in
the upper right or across the bottom of each page of a site.
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Creating a simple text navigation bar is useful as a precursor to the primary
navigation, which may need design input to look good and work well, and
also to learn how to create secondary navigation like that often used for
simple functions. Even a simple text navigation bar can help enforce useful
practices of site design and usability, right from the beginning of creating a
multiple-page site.

A text navigation bar is a consistent visual element that appears on every page
of the site and that always has the same appearance, the same words, and the
same links. It’s not an exaggeration to say that a navigation bar of some sort,
even a simple one consisting of text, is the difference between a Web site and
an unconnected mass of Web pages. Creating a navigation bar forces you to
start thinking hard about how your site is going to be organized.

Here’s an example of a simple text navigation bar for a “personal profes-
sional” site, a kind of online super-résumé:

Home | Résumé | Memberships | Publications | Personal | Contact me

Each tab is underlined to reflect that it’s a link to that page or multi-page area
of the site. Note that the Home tab, as I'll call it, is not underlined. The idea is
that, when you’re on the home page, you can’t click Home to go to the home
page — because you're already there.

When you click the word Résumé on the text menu to go to the Resume page,
however, the text navigation bar should change to reflect where you are —
it’s no longer possible to click REsumé, while Home is linked again:

Home | Résumé | Memberships | Publications | Personal | Contact me

To implement this arrangement, you create a “model” navigation bar with
all the tabs linked — but it’s never used in quite that form. For each page on
your site, you copy the navigation bar to the page, and then remove the link
from the tab that the page in question belongs to.

Follow these instructions to create a text navigation bar:

1. Open a new, empty page in the Visual Editor tab in CoffeeCup.

2. Type in a line of text representing the elements of your site, with a
word or two for each page or area.

Use the vertical bar to separate the tabs. Examples for a personal/pro-
fessional site look like this:

Home | Résumé | Memberships | Publications | Personal | Contact me

If the vertical bar character is not accessible from your keyboard, it
should be available from the Symbol or similar menu. In Microsoft Word,
choose Insert=>Symbol to bring up the Symbol dialog box and select the
vertical bar character.
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3.

Select the text links and click the Center button.

The text menu will be centered.

. To link the Home tab to the home page of your site, select the word

Home (not the spaces to either side). Choose Insert~>Link. (You can
also start with the Link button.)

The Insert Link dialog box appears.

. Type in the URL: simply the filename of the home page, index.htm,

as shown in Figure 11-4. Click OK.

You're returned to the Visual Editor.
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6. For the remaining phrases, repeat this process: Select the tab name

(which might have a space within it, but don’t select the space before
or after); link it to a Web page by name; click OK.

By doing it this way, you can put your navigation feature in place; the
pages don’t even have to exist yet. (When you do create them, however,
you must match the names in the text menu exactly.)

Make the filenames you define here similar to the phrases in the tabs,
but don’t use spaces or capital letters in the filenames. If you do, the
links could break when your Web site is moved to a server for hosting.

When you’re done, you should have a fully linked text menu — every tab
linked to a page, even if the page content doesn’t exist yet.

Consider keeping a copy of the complete menu, with all links in place, on

your home page or in a working page — so if you make changes later, it
will be easier to update the text menu.
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7. Save the page repeatedly using each of the filenames you’ve defined.
As you proceed, delete the link from the tab representing the page
you’re about to save, removing the underline and link color from it.

This will give you the beginnings of your site: a set of pages, each with
<P the text menu present and linked appropriately.

You can remove the link from a piece of text by deleting the linked text
and then retyping the text, with no link.
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Your Site in HTML

T he 5th Wave

“You Know, I've asked you a dozen times not to
animate the torches on our Web page!”
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In this part . . .

t’s always fun to “get right down to the bare metal” in

any endeavor, and HTML is no exception. Use free
tools available on your computer, such as Windows
Notepad, to work directly in HTML, giving you total con-
trol over your Web page —and the ability to grow it into
an effective Web site.
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Using a Text Editor

In This Chapter
Using a text editor (compared to using a WYSIWYG editor)

Introducing Notepad
Using Notepad for HTML

A\

Tle way to really get control of your Web pages is to create and test your
Web pages on your own hard drive before uploading them to the Web.
Then you can upload tried-and-tested Web pages to any number of different
Web hosts, including Google itself. And the way to really, really get control is
to create or edit Web pages directly in HTML.

Using online tools such as Google Page Creator (discussed in Chapter 3) is a
bit like riding a tricycle. Using a WYSIWYG editor, as described in Chapters
8 through 11, is like using training wheels on a bicycle. Using a text editor

is like riding on just two wheels, keeping your balance yourself. You can go
farther and faster — but it’s also more work, and you can crash more spec-
tacularly.

This chapter describes how to create your initial Web page locally, on your
own hard drive, using a text editor. As an example, | use Notepad, the text
editor included in every version of Windows. If you use a Macintosh, the
Simpletext program included with every version of MacOS fills the same role.

The previous Part describes how to create and improve Web pages using

a What You See Is What You Get, or WYSIWYG, editor. The chapters in this
Part describe how to improve your Web page and how to extend your Web
page into a multipage Web site — using Notepad and straight HTML (look,
Ma, no hands!). Chapter 15 tells you how to publish one or more Web pages
created in a text editor from your own machine onto the Web.

This chapter helps you choose the approach you want to use and then shows
you how to create your initial Web page.

As with using a WYSIWYG editor, using a text editor leaves you free to choose

your own host for your Web pages. It also adds a powerful tool to your arsenal
of Web-page creation and Web-editing techniques.
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The good news is, there’s no wrong answer; the bad news is, there’s no
single, simple right answer either. Professional Web-page authors often work
in a combination of tools: a text editor, a WYSIWYG tool, and a Web browser
for previewing. The question isn’t really which approach you’re going to use
in the long run, but how you want to start. Starting in a text editor is a tough
school, but a good one.

Choosing Plain Text over WYSIWVG

A\

You can use a couple of different approaches to create and edit Web pages
on your own computer. One approach is to use a text editor. A text editor
is only partly like a word-processing program: It lets you enter upper- and
lowercase letters, digits, and punctuation, but (unlike a word processor) it
doesn’t give you any way to add formatting such as bold characters or bul-
leted lists.

A core part of HTML (which stands for “HyperText Markup Language,”
remember) is to “mark up” your text — which means adding formatting to it.
So if you're using HTML in a text editor, you're using HTML tags to do part of
what a word processor does — to add formatting.

You may have been using computers long enough to remember that early
versions of today’s word processors worked the same way. In the once-
popular WordStar, for instance, you would put special characters before and
after a word to make it (for instance) bold. The first versions of Microsoft
Word were notable for their heavy reliance on WYSIWYG word processing
rather than WordStar-style markup.

What you don’t get in a text editor is a preview of what the formatting looks
like when it’s in effect — and that’s the core of WYSIWYG. Using a text editor
to work in HTML, however, you can get close. Just enter your text in the text
editor, add HTML tags for markup, then save the file and open it in Internet
Explorer or another Web browser. What you see when you view your HTML
code in IE will truly be what users will get when they view the same Web page
in the same Web browser.

While interactive previewing on your own machine is a great way to see what
your HTML will really do, this doesn’t protect you from all potential problems
with your published Web page. In particular, when you transfer your Web
page to a host machine, the links that worked so well on your own machine
may not work on the new machine. Looking for and fixing these “broken links”
is a key concern of Web publishing.
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Previewing a Web page in one browser gives you an excellent idea of what it
will look like for your Web page visitors — but only the ones who are using the
same browser, with the same settings. You must test in a variety of browsers
to get good coverage, and always be aware that there’s almost always some
combination of a Web browser and settings that will cause some user some-
where to have trouble with your Web page.

[ recommend that you either work directly in HTML or use a simple WYSIWYG
tool that doesn’t try to do too much for you, and look frequently at the underly-
ing HTML. If you do want to use a tool, I recommend the CoffeeCup HTML Editor
2008 package included on the CD-ROM and described in Chapters 8 through 11.

Though working directly in HTML in a text editor ramps up your learning
curve and gives you a great deal of control, frequent previewing is a tough
way to keep on top of the effect your coding will have. It’s also very easy to
get lost in the HTML-tagged text when you're trying to remember where to
make an addition or change.

Figure 12-1 shows a simple Web page as it appears when being edited in a text
editor (left) and previewed in Internet Explorer (right). You can see how the
same HTML-tagged text looks when seen as HTML and rendered as a Web page.

When you work in a text editor and preview in a Web browser, you’ll quickly
figure out why so many professional Web-page authors have large screens,
multiple screens, or a combination of the two. You want to have enough
screen room to put the text-editor window next to the Web browser window,
without overlap. A modern, “panorama”-style laptop screen with 1280 x 800
resolution gives you plenty of width for this, though each window is a bit
short. Try to get a screen with at least 1280 x 1024 resolution.

B deathvalley - Notepad &1 Starting a page - Microsoft Intetnet Explorer B[]
File Edit View Favorites Tools Help i
<html> - s ;
ooy @Beck - lﬂ E § ) search ¢ Favorites &
<titlessStarting a pagec/titles Adress | €7 {T-series|y Documents|Py Picturesideathvalley him|v| [ G0 Liks >
</ heads
‘ s
“HitE Generic H1 header
<hlrGeneric HL header</hls
<h2>Gensric W2 header</h2s Generic H2 header
<h3>ceneric H3 header</h3s Generic H3 header
<hd>Generic H4 header</hd>
<hs>Generic H5 header</hss Generic Hd header
<hé>Generic HE header</hé> Generic H5 header

Generic HE header
</body>

</html>
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Why train in a text editor?

Working in a text editor is great training for  One trick is that you can also edit text in a word
drilling the nuts and bolts of HTML into your processor. It's a distracting environment, but
consciousness, even into your unconscious. (It the excellent spell-checkers, flexible search-
doesn't even hurt. Much, anyway.) and-replace, and powerful formatting tools in a
word processor can help you to tame large or
complex HTML files. You just have to remember
to always copy and paste the text in and out,
without saving— or Word may add its own idea
of HTML to your file.

You can also make the initial job of creating
HTML files easier by keeping “cut and paste”
examples of Web code handy or viewing and
retrieving examples from Web-authoring sites
as needed.

Every computer you'll ever have access to is
likely to include a text editor. So you've got what
you need to create or fix a \Web page anywhere
you are in the world.

You also avoid the problem of having your
lovely HTML code messed with when you
use a WYSIWYG editor. Most such tools rear-
range your HTML code when you bring it into
WYSIWYG mode, and the code that such tools
create is unlikely to look much like your own.
Using a text editor is a “purer” working envi- And knowing enough about how to use an
ronment. HTML editor to switch into one when needed
is always a great help. The CoffeeCup HTML
Editor package onthe CD is a great tool for such
arequirement.

However, even the bravest of “bare metal”
HTML tweakers have learned their own tips and
tricks to make life easier.

Working within a Text Environment

When you begin using a text editor such as Notepad, it’s a good idea to
create a sample Web page that includes the major kinds of formatting, so you
can cut and paste from it into your own Web page in progress. Some features
to include in such a Web page include

v The html, head, and body tags that form a framework for every Web
page
v Links to other Web pages on other Web sites

v Links to graphics that accompany your Web page, including size com-
mands and alternate text

v A simple table, or perhaps a few
\3
P It’s not uncommon for Web-page authors who use a text editor for most of

their work to switch to a WYSIWYG tool for creating, filling in, and editing
tables, and then switch back to a text editor for their remaining work.
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No matter how you edit, if you add advanced elements (such as multimedia
files or computer programs) to your Web page, be prepared to test your
pages with several different browsers — and to tell your Web visitors what to
expect.

As with WYSIWYG HTML tools, you can create HTML forms in a text editor,
but this won’t give you the CGI (Common Gateway Interface) scripts that you
need to make the forms work. These CGI scripts process the data that the user
enters into a form. However, if you don’t want to mess with creating these
scripts, you can get CGI scripts from others on the Web and, after a bit of trial
and error, modify them as needed for your Web site.

Plusses and minuses of Notepad
as a text editor

Notepad has the advantages of any text-editing tool, with few disadvantages.
Here are its four key advantages as a text-editing tool:

v+ Truly basic. You don’t need to do much to learn Notepad. You do
have to learn some things about working in a text editor rather than a
WYSIWYG tool, but these aren’t imposed by Notepad; they’re fundamen-
tal to how you’re working. If you work in a more powerful tool, any prob-
lems you experience could be in your HTML or they could be in the tool.

1 No formatting codes. Notepad is utterly incapable of putting hidden for-
matting codes into your file.

+ Ubiquitous. Notepad is available on any Windows machine. And because
it’s so basic, even non-Windows machines are likely to also have basic,
Notepad-like tools handy.

v Popular. Working in Notepad is a popular way to create and edit Web
pages, so it’s easy to get help from other Web-page authors — anyone
who knows HTML well. If you work in a WYSIWYG editor or a more pow-
erful text-editing tool, the only people who can help you are fellow users
of that tool.

I recommend that most beginning Web publishers use HTML Editor in Visual
Editor mode and check the underlying HTML frequently to see what’s really
going on. As you get more knowledgeable with HTML, you may wish to buy
and use a more advanced HTML editor — or go the low-tech route (as many
Web professionals do much of the time) and use a basic text editor or the
Code Editor side of CoffeeCup.

[ recommend that you consider using CoffeeCup HTML Editor at least occa-

sionally in tandem with editing your Web page in a text editor. The back-and-
forth will actually help you learn faster and get more done.
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Do | have to use Notepad?

The choice of text editor is up to you. Although  platforms. To see some well-regarded ones,
| recommend using Windows Notepad, due visit CNET's download.com site. Search
to its extremely widespread availability, there  for “notepad replacement” under Windows or
are many replacement programs for Notepad Mac software, as your needs dictate. You'll see
that have earned fans of their own. There are  many highly rated programs, blog posts with
also Notepad replacements for non-Windows reviews, and more.

\NG/
Vg\\\

Hitting the high notes in Notepad

In order to run the one and only Windows Notepad, follow the instructions
below. If you want to run a replacement instead, consider using Notepad for
the steps below, then repeating them with your replacement program, just to
be sure you're completely on top of both programs. (As you may want to use
Notepad when using a random Windows machine at a friend’s house, Internet
cafe, or other location.)

When following the steps below, and in other uses of Notepad, don’t open
WordPad instead of Notepad. WordPad stores its own hidden formatting
codes among the text characters you type, just like Word (but without most of
the nice features).

And don’t worry about the Font feature in the Format menu in Notepad, a not
particularly welcome addition in recent versions of Notepad. The Font option
allows you to apply different fonts and a few formatting options (character
size, bolding, and so forth) to all the characters in the document — not selec-
tively to some characters, words, or paragraphs, and not others. You might
even want to use this feature to make your HTML-tagged text easier to read
overall, but it’s useless for clever tricks like putting your HTML tags in one
color and regular text in another. The Font feature in Notepad is so simplistic
precisely because Notepad doesn’t store hidden formatting codes within the
underlying text; the font and other text characteristics are program settings
rather than true formatting of the text. That keeps the text itself blessedly
plain — and easy for many different platforms to use.

Okay, after all that, it’s brass-tacks time. Follow these steps to get started
using Notepad as an HTML-editing tool:
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1. Start Windows Notepad.

The details may vary slightly across different versions of Windows, but
they’ll be very close to the following: Start by clicking the Start button (the
Vista version sports a Windows symbol, but displays the word Start when
you mouse over it.) Choose Start=>Programs=Accessories=>Notepad.

The program opens.

. Click Save & Continue. Save your document under any name you

choose, but don’t use the suffix . txt; instead, add the suffix . htm to
the filename.

This may seem contradictory, but it works: The file will be saved as a
text file, with no formatting codes; the suffix . htm signals to your Web
browser (and, after you upload your file, to Web servers and so on) that
the file is a Web page.

It’s not your fault if you find this confusing; the role of a filename exten-
sion is confusing, and Windows makes matters worse by hiding the
extension from most views of the file or filename.

Right-clicking on a file and choosing Properties will reveal the file’s
suffix.

. Pull down the Format menu and inspect the options.

The Format menu appears, as shown in Figure 12-2. The Font option,
which brings up the Font dialog box also shown in Figure 12-2, lets you
change the displayed font, font size, and formatting (narrowly speaking:
bold, italic, or bold italic only).

The Notepad Format works differently from any Format menu in any
other program you're likely to use. It changes the way all the text in the
currently open file looks on-screen — regardless of whether that text is
selected at the time you choose the Format command — and includes
options you can apply to text. Options include changing the Font (not
to be done without some thought; see Chapter 9) and making text Bold,
Italic, or Underlined.

If you open your Notepad text file on a different machine, it will display
using the font, font style, and size in use by that copy of Notepad, nei-
ther knowing nor caring what settings you were using in the copy of
Notepad you last edited the file in.
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4. Pull down the other menus and inspect the options.

There are very few other options to worry about. And if it occurs to you
that the Font option should appear under the View menu (since it only
affects the look of the text), [ would have a hard time arguing with you.
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Creating a WYSIWYG Page

In This Chapter
Writing for the Web
Formatting Web text
Using HTML lists
Entering text in HTML

Tle previous chapter shows you how to get started in Windows Notepad
as an example of a simple text editor. This chapter shows you how to
create your first Web page in a text editor such as Notepad, put some text in
it, and get the text formatted so it looks good.

This chapter draws on the discussion of using text in Web pages in Chapter 4.
Review that chapter for information about how to write for the Web. Web
writing is a bit different from other kinds of writing. It’s also kind of fun, once
you get used to it.

What the HTML Vou’ll See
in a Text Editor

HTML is designed to be something that humans can read and that machines
can process, a kind of common ground for human-to-machine communica-
tion. You begin with regular text, characters that appear directly on your
Web page, and add descriptive tags so all the formatting, linking, and navi-
gational information you need is in text form, contained in the same file with
the regular text that appears on the Web page.

Suppose you want to add bold to a word in your text, such as you might see
in a book, or on the screen of a word processor:

You can use HTML to specify that a word is bold.

www.it-ebooks.info


http://www.it-ebooks.info/

210 Partwv: Your site in HTML

Why bother with HTML basics?

Using a text editor makes the workings of HTML  understand how the Web works, how to use
even clearerthan using a tool such asthe HTML  free Web tools that allow you to enter HTML
editor within CoffeeCup. To an even greater tags directly, and how to use other tools that
degree, using HTML in a text editor helps you hide HTML to a greater or lesser degree.

To add bold formatting to a sentence using HTML, you start with the regular
sentence and add a couple of tags to specify where the bold starts and stops.
Here’s the previous line in HTML:

You can use HTML to specify that a word is <b>bold</b>.

When you display the sentence immediately above in a Web browser, the
browser displays all the words, but not the fags — the information between
angle brackets. The Web browser uses the tags to do extra things to the text,
such as formatting it as bold text. In the case of this single-line example, the
formatting instruction is simple: Start using bold text immediately after the
word “is,” and stop using bold text immediately after the word “bold.”

HTML tags exist alongside the text that users see on your Web page, so a
document with HTML tags in it is called HTML-tagged text. A file with HTML-
tagged text in it is called an HTML file.

An HTML file usually has the extension .htm or .html at the end of the file-
name. If you look at HTML-tagged text in a text editing program, you see the
angle brackets and HTML commands; if you look at it in a Web browser, you
see a Web page with formatting, links, and so on.

A document with no formatting — such as italic and other formatting added
by a word processor — is called a plain-text document. HTML-tagged text
documents are considered plain-text documents because they’re made up
only of text characters, even though some of the characters (the tags) carry
formatting information. Word-processing documents that aren’t plain-text
documents have additional formatting codes embedded in them to tell
machines how to display and print the text.

You can add HTML tags to regular text to create your own Web documents in
any text editor or word-processing program. (However, in a word-processing
program, you must explicitly save the Web document as a text file.) Or you
can use a Web-editing tool that hides the gory details of HTML tags, such as
the Visual Editor in CoffeeCup. (The Visual Editor creates an HTML-tagged
text file, but displays to you what that file will look like in a Web page. It
makes the HTML-tagged text available directly in the Code Editor.)
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When you work in a text editor, such as Notepad, you work directly with
HTML from the very beginning. So you might find yourself looking frequently
at the full HTML appendix at the back of the book (Appendix B).

If you like to know everything that’s going on before you roll up your sleeves

and plunge into things, you may want to start by looking at HTML, XHTML &
CSS For Dummies, 6th Edition, a comprehensive guide to HTML by Ed Tittel

and Jeff Noble (Wiley).

Viewing HTML in Web pages

You can see “pure” HTML anytime you use the Web. Open any Web page in
your browser and choose the right command — View=>Source for Internet
Explorer or a similar command for other browsers. A new window opens, dis-
playing the HTML source code that underlies the Web page. Figure 13-1 shows

a page from the For Dummies site and its HTML source code as an example.

What HTML really, really means

HTML is an acronym for HyperText Markup
Language. The tags described here are the
“Markup” part; the tags are also used to spec-
ify hyperlinks to other documents, which is the
“HyperText” part.

The way a browser works is described by a
mathematical construct called a “finite automa-
ton.” Such a construct reads text like a ticker-
tape, one character at a time. It can neither
store what has already been read nor look
ahead beyond the character just in front of it.

Let's see how this works with a Web link,
known in HTML jargon as an anchor. Here's an
example:

The <a href="www.
ninjaturtles.com">Teenage
Mutant Ninja Turtles</
a> are becoming popular
again.

The browser begins by reading the first half
of the sentence — The <a href="www.

ninjaturtles.com">Teenage
Mutant Ninja Turtles — one charac-
ter at a time, and says to itself, “I display The,
begin a link, store the destination, www.ninja
turtles.com, and display the following
words in blue and with an underline: Teenage
Mutant Ninja Turtles.

The browser then reads the rest of the sen-
tence —</a> are becoming popular
again. —again, one character ata time. The
browser notes the end of the link, denoted by
the close anchor tag </a>, and displays each
remaining character in normal text.

The anchor tags <a> and </a> serve as linking
tags, denoting a hyperlink. They also, in order to
do their job, serve as formatting tags, changing
the way the text they enclose is displayed. The
change in how the enclosed text is displayed
signals the link to the user.
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Figure 13-1:
The For
Dummies
site is made
of HTML-
tagged text
and
graphics.
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Resist any temptation to “borrow” the HTML from attractive pages on the Web
directly. At some point in doing this, you might cross the line into violating the
author’s copyright. Instead, use existing HTML as a reference, contributing to
your efforts to create your own Web page design.

When in doubt, contact the Webmaster at the site you admire, describe how
you want to use their code or formatting, and request permission. It’s not
uncommon to get a positive response — just hope you don’t get asked to
toss your car keys into the bargain.

Setting up an HTML page

When you first create a Web page, you need to do a certain amount of setup.
Working directly in HTML using Notepad, you must enter the needed tags
yourself (the CoffeeCup HTML Editor in Chapter 9 sets them up for you, but
we're all adventurers here, right?).

The tags you have to create in Notepad are of five types, each serving a
distinct function:

+” Begin and end HTML: Though your Web page will almost certainly work

without them, it’s good form to begin and end your Web page with the
<html> and </html> tags.
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v Getting a Head: Your Web page begins with “head” information, which
is information that describes the entire page. With one exception, it’s
processed before anything visible shows up on the Web page. Surround
the head area with the <head> and </head> tags.

v Granting your page a title: The title of a Web page was originally meant
to be descriptive information for search engines and other programs
that crawl the Web. But early Web browsers began displaying the title at
the top of a Web page, and now it’s noticed by Web users, so it’s impor-
tant you get it right. The title, in the head area, is surrounded by the
<title>and </title> tags.

v Growing a Body: Body information is everything the user sees on the
Web page, including text, formatting, and links. The opening <body> tag
comes right after the closing </head> tag. The body area is terminated
by the </body> tag, and the entire Web page is then closed by the
</html> tag.

1 Meta tags: Meta tags are “meta-information,” that is, information about
the Web page as a whole. For instance, CoffeeCup automatically inserts
the standard information, <meta http-equiv="content-type"
content="text/html;charset=UTF-8"/>. Meta tags, once used
heavily by search engines, are now less used or even ignored. Today,
the best way to use meta tags is for the information of yourself or others
who might look at the HTML code to tell what the page is about. If meta
tags help a search engine along the way, great.

v+ Comments: Comments are notes to yourself or future Web authors
who might look at the HTML. A typical comment is something like
<!-Created in December 2008 by Bud Smith>. While it’s a good
idea to add comments in HTML if you do it consistently, there’s also a
school of thought that says it’s better to put the energy into good, clean,
understandable HTML code and a better page design.

These tags are demonstrated in Notepad later in this chapter, along with the
commands and tags used for formatting Web text.

Create a model HTML page that you can open anytime you want to start a new
Web page without re-entering the “same old” initial tags. To make sure the model
HTML page stays unchanged, right-click on the file icon and choose Properties
from the menu that appears. In the Properties dialog box that appears, check
the Read-only check box. This will ensure that, when you open, change, and then
save the file, you're forced to save it under a new name, leaving the original file
unchanged.
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Formatting Web Text

Whether you use a WYSIWYG editor, as described in Part III, or a text editor,
as described here, the capabilities that HTML makes available for formatting
Web text are the same:

1 Headings: There are six levels of headings in HTML that you can use,
with the tag pairs <h1> and </h1> used for the largest, top-level heading;
<h2> and </h2> next, down to <h6> and </h6> for the lowest (very
small) level of headings.

What it means for you: The intended way to use headings is to start with
<h1> for the most important heading right down to <h6> for the lowest
level. This kind of usage makes life easier for visually impaired people
who use screen readers (which read Web pages aloud). However, the
highest-level headings are very large in comparison to regular text. As
a result many people use <h4>, for instance, for what'’s really a second-
level heading, or use text size commands and bolding to create their
own header styles. Try using the intended headings first, and then use
your own formatting if you really need a specific look.

1+~ Font sizes: HTML allows you to specify relative font sizes that are larger
or smaller than medium, or standard, size. You can go two sizes smaller or
three sizes larger than medium. This formatting works even if users specify
a font size or style in their browser setup or in their operating system
(Windows, Mac, and so on). (As people get older, and their eyes weaken,
they resort to various tricks to make using the computer easier — as the
author knows from experience.)

What it means for you: You don’t want your Web page to look like a
hostage note, with all different styles and sizes of text mixed up, but font
sizes can be a good way to make a point (with a larger font size) or fit

a lot of text into a small space (with a smaller size). Using relative font
sizes is one of the few formatting tricks that almost always work well in
different Web browsers.

1~ Character formatting: You can make text bold or italic using the <b> and
</b> tags to start and stop bold and the <i> and </i> tags to start and
stop italic. You can also underline text, but [ don’t recommend it, because
users can easily confuse text that’s underlined for emphasis with text
that’s underlined because it’s an HTML link. The same holds true for using
any unexpected colors in your hyperlink text — it’s potentially confusing.
Best not to go there (see Chapter 9 for a discussion of why).

What it means for you: Use bold and italic to emphasize your point, but
don’t overdo it. Structured use of bold and italic, such as the bold used
to highlight items in this list, is one good solution.

1 Advanced character formatting: You can specify the fonts used in your
Web page, as well as font colors. But different fonts are available on

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 13: Creating a WYSIWYG Page 2 ’5

A\

Windows and Macintosh computers, so you have to be clever about how
you do this. (You can specify backup fonts for use if the desired font
isn’t there.)

What it means for you: 1 don’t recommend using advanced character for-
matting when you're starting out because it’s complicated and because
it won’t work for some of your users. You may want to postpone using
this kind of formatting until you’re working at a professional level, with
the design help and testing resources needed to make sure your pages
work well for all your users.

Create a model Web page with examples of different kinds of headers, charac-
ter formatting, and so forth. Then copy and paste from it into your Web page
in progress, modifying the model to create your “real” Web page. The model
page gives you a way to preview different formats before committing to them
and allows you to build your Web page in blocks. Unfortunately, once your
Web page is built, all the HTML tends to run together!

Follow these steps to enter and format text in Notepad:
1. Open Notepad. Enter the beginning and ending HTML, HEAD, and

BODY tags.

Make sure to spell the tags correctly and check for matching open and
closing tags.

2. Between the <head> and </head> tags, add the tags <title> and
</title>.

3. Enter an appropriate title, such as New Home Page, then click OK.
4. Move the cursor to a new line after the opening <body> tag.
5. Type some text introducing your Web page.

When someone searches for your Web page by using a search engine,
the search engine may display the Web page title (as described earlier)
and the first few words that appear in the document. So make the first
few sentences of text that follow the title an introduction to the entire
page or Web site.

In the document I created for this chapter, here’s what I typed:
Death Valley Hockey Club

Death Valley Hockey Club is a girls' field hockey team
that practices and plays at the lowest altitude of any
in the United States.

6. Surround the text that you’d like to make a header with the <h1> and
</h1> tags.

In my document, I highlighted the words Death Valley Hockey Club at
the beginning.
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7. Identify other text that you want to format.

In my document, I selected the word “lowest” in the middle of the first
sentence.

8. Surround the text with the tags that support the formatting you want,
such as <b> and </b> for bold or <i> and </i> for italic.

The surrounded text will take on the appropriate formatting. In my
example, I made the word “lowest” bold.

9. Save your file with the extension . htm to specify that it’s an
HTML file.

Do this early when working in Notepad so you remember to enter the
suffix . htm; if you don’t, Notepad will use the . txt filename extension,
and your document won’t automatically be treated as a Web page.

WMBER
@&
&

10. Open the file in a Web browser to preview its appearance.

Carefully check that each tag you use in the HTML file has the desired
effect in the actual displayed Web page. HTML ignores tags it doesn’t
understand, so if you type <n> instead of <b>, for instance, the only

ill effect will be a lack of bolding (the </b> tag you follow it with has no
effect); a lack of formatting such as bolding is easy to miss when quickly
checking a page, unless you compare your tags with their desired effects.

Figure 13-2 shows Notepad and Internet Explorer with the text formatted as
described here. Note that Header 1 may actually be too large for our purposes.

8 deathvalley - Notepad = &1 Death Valley Hockey Club - Microsoft Internet Explorer  (=JEIEd
File Edit View Favorites Tools Help o

<html> i - - 8
<heads (€S 1x] Ig W ) ssach 57 Favorkes £2)

<titlespeath valley Hockey Club</title> Address €] Ci\Documents and Settings)T-seriesiiy Documents | [Eg G0 Liks
</head>

<body: Death Valley Hockey Club

<hl>peath valley Hockey Club</hl>

Death Valley Hockey Club is a gitls' field hockey team that

peath-val ley. Hackey:cTub 15 2 girls practices an plays at the lowest altitude of any in the United States

field hockey tea

that practices an plays at the
<b>Tlowest</b> altitude of

any in the United states.

</hody>

</html>

Figure 13-2:
Use HTML
formatting

options.
|

&) Done 4 My Computer
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Creating HTML Lists in Notepad

As mentioned in Chapter 9, people really like lists such as the Top Ten lists
on David Letterman’s Late Night show. They’re interesting to look at, easy to
scan, and inspire you to write short, punchy phrases.

HTML offers three kinds of lists, two commonly used and one not so much.

+~ Bulleted lists: “Bulletizing” your text is the quickest way to improve it
for the Web. A bulleted list, which HTML refers to as an unordered list, is
easy to read and easy to write. Start a bulleted list with the <ul> tag and
end it with the </ul> tag. Precede each list item with <1i> for list ifem;,
no closing tag is needed. The <1i> or </ul> that follows also ends the
list item.

+* Numbered lists: Numbered lists are useful and should be used more
than they are, as they add variety and impose order. Use numbered
lists for items that can be ordered in importance, sequence (such as
steps), and wherever else you can. A numbered list begins with <o1> for
ordered list, ends with </01>, and — like bulleted lists — uses the <1i>
tag to mark the beginning of each list item.

v~ Definition lists: A definition list specifies a term and then the definition
of the term. Use definition lists to add more variety — but test the look
first, as you may find it a bit odd. Use bold formatting of the term to
help. Start you definition list with <d1> and end it with </d1>. Precede
each term in the list with <dt>, for definition term. Then precede the
definition, following the term, with <dd>, for definition data.

v~ Lists within lists: Inserting a list within another one is called nesting it, a
favorite programmer’s trick when writing code. It may not be your favor-
ite trick, as doubly nested lists can be confusing. You can nest the same
or different kinds of lists. A bulleted list within another one will display
with a different style of bullets.

Follow these steps to create a list in Notepad:

1. Add the text for your list in Notepad.
In the document I created for this chapter, here’s what I typed:

If you meet the following three qualifications, most
important first, you may be eligible to become a member
of Death Valley Hockey Club:

8 to 12 years old. Death Valley Hockey Club has girls
from 8 to 12 years old as members. You must have been
8, 9, 10, 11 or 12 on January 1lst of this vyear.
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Good in school. We need you to show us you're a good
student, and to maintain your academic standing
throughout your time with us.

Some sports experience. We would like you to have some
previous organized sports experience in any sport.

. Surround the lines that will make up the list with the list tags, <ul>

and </ul> for an unordered (bulleted) list, or <o1> and </o01> for an
ordered (numbered) list.

In my document, I put the <o1> tag before the line that begins 8 to 12
years old, and the </o01> tag after the period following the words in
any sport

. Precede each list item with the <1i> tag.

In my document, I put the <11i> tag before the lines that begin:
8 to 12 years old

Good in school

Some sports experience

With new standards such as XML and XHTML in place, it’s considered
good form to always close off tags, which means that it’s now recom-
mended that you use a closing </11> tag after each item. This is good
advice, yet there’s never enough time to do all one would like to do, and
this recommendation may fall into that category.

. If you like, for a bulleted list, change the bullet style by adding an

additional element, called an attribute, to each <11i> tag.
With the attribute added, each <1i> tag will read in one of three ways:

<li type=disc>, a filled-in circle or bullet, the same as if you
don’t specify the attribute at all

<li type=square>, a square
<li type=circle>, an open circle

As the example used here is a numbered list, the bullet style options
don’t apply.

In a good WYSIWYG HTML editor, such as CoffeeCup (see Part II), all the
options — including obscure ones like bullet type — are presented to
you as options in menus and dialog boxes, so you don’t have to remem-
ber what the options are (or even that they exist); you just choose them
when you need them. This is one advantage a WYSIWYG editor has over
working in a text editor such as Notepad.
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5. Save your document — adding . htm to the filename, if you’re saving
it for the first time — and open it in a Web browser window (or
refresh the window if you already have this document open).

The list appears in the edited Web page, as shown in Figure 13-3.

The Insert List dialog box is a good example of the benefits that can
come from using a WYSIWYG editor. It includes options for bullet styles
that you might not have known were part of HTML, or might have forgot-
ten the details of. With the dialog box, you're not only reminded of the
button styles, but also can easily test how they look within your page.

B deathvalley - Notepad &1 Death Valley Hockey Club - Microsoft Internet Explorer |9]=[x]
F File | Edit View Favorites Tools Help 7
<html> »
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<titlesbeath valley Hockey Club</titles || Addess €] CiiDocuments and SettingsiT-seriesiMy Documertsi v | Ed G0 Links
</head>
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If you meet the following thres

quafifications, most 'imEDr'tam: First, 1. Bte 12 years old. Death Valley Hockey Club has girls from 8
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throughout your time with u

<1i>some sports experience. we would
T1ike you to have some previous organized
sports experience in any sport.
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</body>
</html>

IFor Help, click Help Topics on the Help Menu, Contains commands for working with the selected items.

External Web-page Links

Regardless of the method you use to create your Web page, the secret of
moving smoothly from one Web page to another is the use of hyperlinks.

In this section [ show you how to create links to totally different Web sites,

the simplest kind of links — but the most powerful, as they can take you
almost instantly to a page from another computer anywhere on Earth.
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Notepad or a more sophisticated package?

Notepad is at the simplest end of the range of downloading, versions, updates, and such. It's
ways to edit a Web page, and other options a good idea to learn how to work using HTML
are tempting. Only Notepad, though, is free in Notepad now so you always have the option
and available on any Windows PC without of doing so later on.

Don’t think, just link

If you're building a hypertext link to an external HTML page by hand (so to
speak), you should know it’s built a bit like an iceberg: It has a visible part
(the link text, which appears as blue, underlined text by default) and an
invisible-but-impressive part that’s normally hidden (the specification of just
which file clicking on the link will lead to). The visible part is the friendly,
appealing bit; the invisible part will work for you too, but only if it’s con-
structed just right.

Text in an HTML document is made into the starting point of a hypertext link
by surrounding it with the <a> and </a> tags, with a standing for anchor.
The link’s two ends, the start that the user clicks on and the page that
appears as a result, are both called anchors.

The destination of the link is called the hypertext reference, or href for
short. So a link to another Web page in HTML looks like this:

Make your own cider with <a href="http://www.ciderspices.com">cider spices</a>.
Oddly enough, this is almost as simple as it looks, and here’s why:
v If you use a domain name for a link, such as www.ciderspices.com,
the first thing your Web browser looks for is index.htm or a file with a

similar name); you don’t have to specify a filename in your link’s
destination.

v The browser also assumes that the destination is at the top of a Web
page unless you specify a location within the Web page.

That said, the next order of business is to hand-craft a link in Notepad.
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So why’s everybody all hyper?

Hyperlinks are more than just hype; they’re the http you see in a Web page address, and
key to hypertext, which is reflected inthe names  HTML (HyperText Markup Language). See
of the two key technical standards underly- Chapter 9 for a closer look.

ing the Web: HyperText Transfer Protocol, the

A simple link in Notepad
Follow these steps to create a simple hypertext link in Notepad:

1. Find the text that you want to make a link.

In the document I created as an example for this book, I highlighted the
words “Death Valley” in the text before the numbered list.

2. Surround the text with the <a> and </a> tags.
Getting the end tag in right away will prevent you from forgetting it.

3. Enter the destination Web address, or URL, by adding href=url to
the <a> tag (where url is a full Web address).

Enter the full Web address, including the preceding http://, and check
whether the address includes www. or not; a few Web addresses don't.
Also make certain that the site ending really is . com, .org, .co.uk, or

<P whatever it’s supposed to be.

In up-to-date Web browsers, you can open an additional tab to check your
Web address while leaving the first tab for previewing your Web page.

4. Enter a title for the link by adding the title attribute.

The title for the link is text that, in some browsers, appears when the
user puts the mouse pointer over the link.

If you leave this area blank, the URL will appear as the title. Often the
URL is self-explanatory, as in a link to a Wikipedia entry. You may wish
to enter the URL, without http://, as the link title to make it a bit more
comprehensible for the user.

If the URL is long or confusing, enter a simple title that describes the
page. For instance, here’s the long-winded URL for HTML, XHTML & CSS
For Dummies, 6th Edition on the For Dummies site:

http://www.dummies.com/WileyCDA/DummiesTitle/HTML-XHTML-CSS-For-Dummies-6th-
Edition.productCd-047023847X.html
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Figure 13-4:
You think
then you

link.

Using a tool tip — HTML,, XHTML, & CSS For Dummies on dummies.
com — saves your visitors some hassle and you some screen real estate.

Being able to see the URL or title when you mouse over a link is very
good for usability. However, in Internet Explorer, the URL or title
appears in a strip at the bottom of the screen called the Status Bar —
and the Status Bar, in recent versions of IE, is turned off by default.
There’s not much you can do about this for your users, but at least
you can turn on the Status Bar yourself — choose View=>Status Bar in
Internet Explorer to turn it on.

Save the Web page to your hard drive and open it in a Web browser
to preview and test the link.

The text will appear as link text, underlined and in blue, as shown in
Figure 13-4, with the URL showing in the Status Bar. Clicking on it should
bring up the target page.
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Chapter 14

Graphics and Media in HTML

In This Chapter

Building links to external files

Adding images using HTML
Using HTML to add a sound
Playing videos in HTML

Tle first Web pages supported only one kind of media besides text: GIF
graphics files. JPEG images had to be opened in a separate viewer. Now
downloadable sound files and embedded videos keep making the Web more
and more interesting, relevant and useful.

In Chapters 5, 6, and 7, you learn how to create and use images, sounds and
videos, respectively. In this chapter, I show you how to actually put all of
these kinds of files in your Web page using Windows Notepad as one example
of a text editor. By the end of this chapter you should be able to create very
lively Web pages in Notepad.

<® In case you're wondering, Chapter 10 goes about creating Web pages in much
the same way, using the CoffeeCup HTML editor; don’t worry if you’ve read
that chapter and feel some déja vu. Whichever approach you start with, you’ll
have a consistent idea of the steps involved in Web-page creation.

In the early days of the Web, the TMG command could handle only GIF files.
Soon, though, Web browsers were upgraded to include the extra code needed
to display JPEG images as well. Before that, JPEG graphics files were included
via the embed command and were opened with one of a variety of “player”
programs that contained the somewhat complex code needed to display a
JPEG image.

PNG graphics files are now fairly widely supported, and even Windows BMP files
are supported by Internet Explorer. But GIF and JPEG images remain the only
ones that you can really count on including within the “flow” of a Web page.
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Unfortunately for us, the Web-page authors, sound and video files aren’t
included as a standard part of what a Web browser can display or play back.
For sound and video files to be standardized, Web browsers would have to
include playback code, instead of depending on a separate player engine such
as Windows Media Player or the QuickTime player. Not even the HTML for
including a sound or video file is standardized. So including these files in a way
that most people can use them is hard work and not completely reliable.

Including Images in a Text Editor

Including images in a Web page isn’t all that simple, and it is in some ways
harder in a text editor than in a WYSIWYG editor such as CoffeeCup. The
complexities of how to create images are covered in Chapter 5. Creating links
from your Web page to images isn’t all that easy either. (Similar consider-
ations apply to sound and video, but they’re less-used than images.)

There are three kinds of links you can use to include an image in a Web page:

v Linking to a Web URL. Like every Web page, every image on the Web
has its own separate URL. (A URL is just a path to a file, and each image
is a separate file, so therefore has its own URL.) To include an image out
on the Web in your own Web page, you just use the IMG tag and give
the Web address of the image as the source. When the user sees your
Web page, it will look like the image is part of the page, even though it’s
hosted on a different Web site.

Plusses and minuses: Linking to images that are already out there is easy
for you as a Web author, but you can’t count on the image staying there
forever. Doing this also represents the image as your own when it actu-

ally belongs to someone else. Finally, it’s much slower for the user than

hosting the image on your own Web server.

To find the URL of a Web image on a Windows machine, right-click on
the image and choose Copy Shortcut. The URL will then be placed in the
Clipboard, meaning you can paste it into a text editor, HTML program,
or other program.

v Linking to the same folder as your Web page. If an image file is in the
same folder as the HTML file that links to it, you need only to give the
name of the image file, with no other folder or path information.

Plusses and minuses: This is very simple; like linking to a Web URL, it’s
fast and easy. And when you transfer your files to a Web server, there’s
no problem with keeping the files in the same relative position. The only
disadvantage is that the folder the Web page is in can get quite crowded,
especially as many images are used over and over again by different
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Web pages. (Also, Web authors find themselves keeping older versions
of a file, or alternate versions, in the Web browser.) So you can end up
with one folder containing all the Web pages and images in a site, plus

working versions of the files, which can be a mess.

v~ Linking to a different folder on the same machine as the Web page.

In this way of doing things, the image file is on the same machine as the
Web page, but in a different folder. The link typically contains a relative
pathway from the Web page to the image file, including moves up and
down a tree of folders. The link can also be to an absolute address rela-
tive to the root of the machine.

Plusses and minuses: This is the most common kind of linking, as people
like to keep different types of files in different folders, but is also where a
lot of problems occur. You have to describe the pathway from the HTML

file to the image file, or the absolute location of the file on the machine,
and the relative or absolute location can easily change or get mangled
when files are transferred to a Web server.

Using a text editor such as Windows Notepad exposes you directly to
naming hassles. Follow the recommendations in this chapter to manage

them more easily.

All the different possible ways of linking an HTML file to an image file are
described in Table 14-1 (a duplicate of which appears in Chapter 10 for the
folks using a WYSIWYG HTML editor). Inspect it carefully, use it as a refer-
ence when you're creating links to image files, and (oh, yeah) double-check
your typing in Notepad to make sure it’s accurate.

Table 14-1 URL and Web-Page Examples

Location of URL Webh-Page Example Graphics

Target Example*

Same folder filename <a href="mycv. <img
html">text</a> src="myface.

jpg">

Subfolderata  pathname/ <a <img

lower level of filename href="subpages/ src="grfx/

the same path mycv.htm">text</ myface.jpg>
a>

Folder on a pathname/ <a href="../the <img src="../

different path filename otherpage/other sharegfx/
page.htm>text</ proface.gif>
a>
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Table 14-1 (continued)

Location of URL Web-Page Example Graphics

Target Example*

Different domainname <a href="http:// <img src

server, home www.largedomain. " http://

page (index. com">text</a> www.large

htm or index. domain.com/

html) goodface.
jpg">

Different domainname/ <a href=" http:// <img src =

server, interior  pathname www.largess. "http://www.

page com/files/bud. largess.com/

htm">text</a> gifs/icon27.

gif">

Link within a Any of the above  <a name= Doesn't apply

page + #anchor- "myanchor">

name </a>; <a

href=" http://
www.largess.
com#myanchor">Go
to my anchor</a>

* These examples leave out the ALT option and other important graphics options, described later in

this chapter.

Follow these steps to add images to your Web page in Windows Notepad:

1. Open your HTML file in Windows Notepad. Move the cursor to the
point where you want to insert the graphic.

. Enter the <img> tag where you want the image to appear.

Note that the <img> tag has no closing tag.

3. Within the <img> tag, add the SRcC attribute and the pathway, file-

name, and extension of the file. (An example is src=bigpic. jpg for
a JPEG file in the same folder as the HTML page.) Refer to Table 14-1
for examples of different kinds of pathways to files.

JPEG files sometimes end with the extension JPG and sometimes with
the extension JPEG — the same file could be called bigpic.jpg or
bigpic.jpeg. If you get it wrong, the link won’t work.

To find out which extension a given file uses, right-click on the file icon
in Windows Explorer, choose Properties, open the Details tab, and note
the extension.
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4. Again within the <img> tag, add the alt attribute and alternate text
for the image. (An example is alt="Grass in Death Valley" fora
scenic image.)

alt text is very important for two reasons. alt text is read out loud by
screen readers and other programs for visually impaired users. It can
also appear in place of the image when the page is viewed on a device
that doesn’t support graphics, like some mobile phone Web browsers,
or even a PC with graphics display turned off.

alt text is also used as a tool tip, text that appears when the user
mouses over the graphic.

For both purposes, alt text should be a short, simple description of the
image, such as the name of a person pictured — or a description, if the
image is for the purpose of providing atmosphere.

5. Then, still within the <img> tag, specify how the image should be
aligned relative to text.

An example is <img align="left">.

¢ The usual choices are for the image to be aligned to the left, with
text flowing around it on the right, or on the right, with text flowing
to the left of it. The values for this are "left" and "right". This
is the magazine or newspaper look, with text and image integrated
together.

e Other choices, such as "top", "bottom", and "middle", place a
single line of text next to the image and otherwise leave the image
on its own. This nearly always looks strange.

6. To add a black border around the image, add the border attribute
and specify how many pixels wide it should be.

e An example is <img border="2">. Several combinations of image
options are shown in Figure 14-1.

¢ Adding a thin black border around an image makes it appear
sharper and clearer, especially for small images. Experiment with
border sizes around your image.

There’s an additional attribute that allows you to add blank space
around an image that you may want to use; see step 7 for the HTML
code to use in the Code Editor to add this padding.

7. To add a blank area around an image, add the hspace and/or vspace
attribute and specify the number of pixels of horizontal and vertical
padding, respectively.

The blank area is called white space, or padding.

e An example is <img hspace="2" vspace="2">.
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™ the lowest altitude of any in the United
ou meet the following three
qualifications, most wapottant Orst, vou may be eligible to become a
member of Death Valley Hockey Club:

1. Bte 12 years old. Death Valley Hockey Club has girls from 8
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<14i>8 to 12 years old. Death valle ot 12 on January 1st of this year.
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image.
E— | 10 /e s, govidevaiplanyounisitseasons htm Contains commands for working with the selected items
e It’s often necessary to add a small amount of padding around an
image to keep text from flowing too closely to it. The amount of
padding needed can depend on whether an image is near a head-
line, another image, or such, which can vary as a user makes the
browser window wider or narrower. So this attribute is usually
specified on a trial-and-error basis.
<P ¢ Adding more than two or three pixels of padding is likely to make

the image appear to float oddly in a “puddle” of blank space
around it. Keep the number of pixels of horizontal and/or vertical
space very few in most cases.

Figure 14-2 shows various hspace and vspace settings for the same
image.

8. Add the height and width attributes to specify the image size, in
pixels, or to change the width and height if you want to resize the
image in place.

Here’s an example: <img height="100" width= "50">.

e It’s usually better to modify the image itself in a graphics program
before putting it in your Web page. However, you can stretch or
shrink the displayed image by changing the width and/or height here.

e If you want to keep the image in proportion, change both dimen-
sions by the same relative amount. For instance, if you double the
width, also double the height.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 14: Graphics and Media in HTML 2 29

B deathvalley - Notepad =12/ &1 Death Valley Hockey Club - Microsoft Internet Explorer =& ]
File | Edit View Favorites Tools Help i

<htmlz = =
cheads Qe - O - [6] [l @ Lo
<ritlespeath valley Hockey Club</Titles || Address|E]iT-seriestmy Documents\Ply Picturestdeathaliey.him | £ 6o Links »
</head> )

<borky> Death Valley Hockey Club

<hl=peath valley Hockey Club</hls

avarites {64}

Death Valley Hockey Club is a gitls' field hockey team that practices
an plays at the lowest altitude of any in the United States. If you

<a_href="http: //www, nps. gov/deva/ >Death
valley</a> ankey C'ILAE is a girls' field
hockei]/ team that practices an plays at
the <h>lowest</b> altitude of any in the
United States.

<img src="deathvalleygrass, gif"
alt="Grass in peath valley" ahgn Teft”
border="2" hspace="0" vspace="0

<img src="deathvalleygrass, gif"
alt="Grass in peath valley" align="left"
border="2" hspace="4" vspace="4">

I | <img sro="deathvalleygrass. gif

alt="Grass in peath valley” ahgn “Teft” || may be eligible to become a member of Death Valley Hockey Club
border="2" hspace="8" vspace=

Figure 14-2: £ you meet the folloving thres 1 8to 12 years old Death Valley Hockey Club has girls from 8
Don't get f}ga SRR e sl to 12 years old as members. Tou must have been 8, 9, 10, 1
. of Dpeath valley Hockey Club: or 12 on Jamary 1st of this year.
lostin |« 2 Goodin school We need you to show us you're & good

<14>8 to 12 ﬁear‘s old. Death valley _ 4
h Hockey Club has girls from 8 to 12 years student, and to maintain your academic standing throughout
Space and 0ld as members. You must have heen 8, 9, your time with us
10, 1 or 12 on January 1st of this year.
vspace <'\1>Guud e e you R 2 Same ennrte sonardencs We ol e san o have came
p . us you're a good student, and T 2 = ’

(vl

EEE— Contains commands for warking with the selected ikems

¢ Even if you don’t resize the image using <img> tag attributes, it’s
good practice to specify the <img> tag attributes that fit the image
as it is. Why? By “telegraphing” the image size in the <img> tag,
you give the browser the information it needs to set aside space
for the image when downloading the page. This prevents different
parts of the page contents from lurching about as different ele-
ments of the page download.

9. To make the image a link, surround it with the <a> and </a> tags, and
add the href= attribute to the <a> tag to specify the link, as described
in Chapter 13.

You can link to a Web destination or use images to create an image-
based menu.

10. Save the file and preview the results in your Web browser.

An example is shown in Figure 14-3.

Adding Sound to Vour Page

The plusses and minuses of adding sound to your Web page, as well as how
to host a music file on MySpace, are discussed in Chapter 6. But what are the
actual mechanics of adding sound?
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Figure 14-3:
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Because sound is not a standard part of the Web’s definition, there are actu-
ally two competing ways to do it: with the <bgsound> tag and with the
embed tag.

The <bgsound> tag works well and has useful options for controlling sound,
but it’s not supported by all browsers.

The <embed> tag is not officially supported by the HTML standard at all, but
it works in most browsers. <embed> has different options — different HTML
attributes — for different media players, such as Windows Media Player or
Apple QuickTime. This is a standards-unfriendly situation.

You may want to share a tip with your Web page’s users: They can stop sound
from playing in your Web page by clicking the Stop button in their browsers.

Follow these steps to add sound to a Web page in a text editor:

1. Open your Web page in Notepad.

2. Enter the <embed> tag and a link to the sound file you want to use, as
follows: <embed src="pathname/filename">, where "pathname/
filename" is a link to the sound file.

The rules for creating the link to a sound file are the same as for a link

to a graphics file, as shown in Table 14-1. The simplest way to be sure
you have the link right is to place the sound file in the same folder as the
Web page; that way the link is simply the filename.
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3. Save the file in Notepad and open or refresh it in your Web browser.
The sound should play.

It’s important to test the link right away to be sure it will work.

4. If the sound doesn’t play, experiment to make sure you have the path
right, and that sound plays on your machine.

Here are a couple of places to start:

¢ To make sure you have the link right, put the file in the same folder
as your Web page and simplify the link. If this fixes the problem,
experiment with having the file where you want it and constructing
the link properly, using Table 14-1 as a guide.

¢ To make sure that sound playback works on your machine, navi-
gate to the file in Windows Explorer and click on it. It should play.
If not, identify and fix the files affecting sound playback on your
machine.

<P You can also use the <bgsound> tag instead of <embed>. (The linking
part is the same.) Each will fail to work on some Web browsers and each
has options the other lacks; some of the plusses and minuses of each
are described in more details in Chapter 10. I tend to favor <embed> as
it’s also useful for video clips and its options, such as showing or not
showing a visible player for the file.

Adding Video to Your Page

Chapter 7 describes the plusses and minuses of using video in your Web page
and steps you through uploading a video to YouTube.

When you add video to your Web page, the video file can be stored on — that
is, be hosted on — your own Web server, some other Web server or, in particu-
lar, YouTube. YouTube offers free hosting for videos you upload to YouTube,
which can potentially save you a lot of trouble compressing the video, worry-
ing about performance of the server storing the video, and paying for the many
megabytes downloaded. (YouTube supports virtually unlimited video download-
ing for free.) You get the advantage of using the massive server and processing
capabilities of Google, YouTube’s owner, free — if you don’t mind the YouTube
logo stamped into the lower-right corner of every frame of your video.

QNING/ If you host a video on your own site and it becomes a hit, you could be “hit”

Y with very large charges for file transfer. If you link to a video on someone
else’s site (besides YouTube) and thus drive many hits to it (while making it
appear to be on your site), that’s very rude of you and you may be found out
and charged.
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Almost every video on YouTube includes a box with the code you paste into
your Web page to play the video there, surrounded by your own content.
This code is customized for playback in Flash, a specialized media playback
tool:

<object width="425" height="344"><param name="movie"
value="http://www.youtube.com/v/HhcLUF590h4&hl=en&fs=1"></param>
<param name="allowFullScreen" value="true"></param>
<embed src="http://www.youtube.com/v/HhcLUF590h4&hl=en&fs=1"
type="application/x-shockwave-flash" allowfullscreen="true"
width="425" height="344"></embed></object>

Flash was originally used mostly for animations but is increasingly used as a
container for video and audio.

Here I'll demonstrate how to include a video in your Web page, wherever it’s
hosted.
1. Open your Web page in Notepad.

2. Specify the path and filename that allow access to the video you want
to use.

Here are some commonly used hosting options:

e If your video is hosted somewhere other than YouTube, type in the
following, using the actual path and filename:

<embed src="pathname/filename">
e If the video is hosted on YouTube, go to the relevant YouTube
page and copy the code for the video from there. Paste it into

your Web page. (For more about hosting videos on YouTube, see
Chapter 7.)

e If the video is in the same folder as your Web page, the pathname
is just the filename; if the video is on the Web, the pathname is the
URL of the video. (Find the URL by choosing Viewr>Source for the
Web page hosting the video.)

e If the file is in a different folder on your machine than the Web page,
include the path to the video. (Refer to Table 14-1 for examples.)

3. Add the size of the video to your Web page.
It’s a two-step process:
a. Specify the size of the video using the <object> tag:
<object width="xxx" height= "yyy">
b. Add the same width and height attributes to the <embed> tag.
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The <object> tag tells the user’s Web browser that there is something
in the Web page, at this spot, of the size you specify. The width and
height attributes do roughly the same thing. Specifying the size in both
ways, as YouTube does, is a way to make sure that the Web browser
sets aside space for the video when it first displays the Web page.

. Save the file and open it in a Web browser. Try the video.

See the previous section of this chapter, on including an audio file, for
what to do if the video doesn’t play.

If you you're having trouble successfully including video in your Web
page, or if you're worried about download charges, then upload the
video to YouTube or another host. On your Web page, you can provide
a “normal” link to the Web page that hosts the video. Users can click the
link to see it and then return to your site after they’ve viewed the video.
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Chapter 15

Laying Qut Your Site in HTML

In This Chapter
Adding mailto links in HTML
Setting up internal links in HTML

Creating a text navigation bar

Even experts have trouble telling people exactly how to go from “just put-
ting up a page” to creating a full Web site. That’s because the needs and
abilities of people vary so much for each site they create.

In this chapter, | demonstrate some steps along this route: how to use links
to create amailto link, a complex page, and a full site, complete with basic
navigation.

Using mailto Links in HTML

Although mailto links seem simple, actually they have some complexity to
them. Here’s how to work around it.

Amailto linkis a link with an e-mail address as its destination. Instead of
bringing something into your Web browser (the way most Web links work),

it brings up something outside: an e-mail message, pre-addressed as specified
by the destination given in the mailto Link. (If you're really clever, the sub-
ject line of the e-mail can also come up already filled in.) The user just has to
enter the content of the e-mail and click Send. (See Figure 15-1 for an example
of a link and the resulting e-mail message.)

At least this is what’s supposed to happen. It only works if the user has a default

mail program set up in Windows or some other operating system, and if the
default program is the one the user wants for that particular e-mail message.
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Often this is not the case. It’s quite common for users never to see Outlook
Express except when they click a mailto link — especially if the manufac-
turer set up Outlook Express as the default program for that computer, and
the user never changed it to full Outlook, Lotus Notes, or the Web-based
e-mail program he or she uses.

The other problem is that many users juggle different e-mail systems for
different purposes. A user might use Lotus Notes for work but occasionally
book a vacation (for instance) on that work computer. For that purpose,
someone might want a personal e-mail account (such as a Hotmail account),
to appear in response to amailto link.

Also, users know what happens when they click a link: Another Web page
comes up. It can be disconcerting when an e-mail message comes up instead.
This is even more the case if the mailto link is used in navigation — the
users think they’ll be moved around the site, perhaps reaching a page with
all sorts of contact information, and instead they get a partly pre-filled e-mail
message that they suspect might never reach a human being.

Here are a few quick hints that should help you use mailto links productively:
v Provide means of contact other than e-mail. Always provide a phone
number; many users are visiting your Web page just to find one. If you

“hide” it (as the users will see it) and offer only a cold, impersonal
electronic replacement, you’ll just make them angry.
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v+ Don’t use mailto links in navigation. Instead of having a Contact tab in

navigation, backed only by amailto link, provide a full page of contact
information.

v Use the words around the mailto link to identify it; spell out the

e-mail address in the text so users can copy and paste it if they prefer.
A proper use of amailto link is within a Contact Us page, for instance,
that includes an address and a phone number as well. The mailto link
should be in a form like the following:

To reach us by e-mail, click here to send an e-mail message to yes
wecan@thecompany . com. We'll respond within two business days.

This will signal users that clicking the underlined link (here) will bring up
an e-mail message addressed to yeswecan@thecompany . com — while
also providing a workaround if they want to copy the e-mail address to
paste it into a message themselves.

Although the usability concerns around using one can be complicated, creating
amailto link in HTML is simple. Just follow these steps:

1.
2.

Open your Web page in Windows Notepad.
Create the text in which you want to insert the e-mail link.

See above for some ideas on getting this right.

. Surround the link text, such as e-mail us, with the beginning and

ending anchor tags, <a> and </a>.

Entering the closing anchor tag in the beginning ensures that you don’t
forget later.

. Add the mailto link as a value for the href (hypertext reference)

attribute, in the following form:
href="mailto:username@website.com"

Be sure to get the e-mail address right, and test it after you finish.
Nothing is more frustrating to the user — and quicker to make you look
bad — than a bad e-mail address in amailto link.

. Optionally, enter a Subject line for the e-mail. To do so, add a subject

to the mailto value, as follows:
href="mailto:username@website.com?subject=Mail from the site"

The Web browser will be able to recognize that spaces in the subject

line don’t mean the end of the value for the attribute, as the spaces are
included within the quotation marks around the mailto value. But if you
forget the quotes, expect problems with how the mailto link works.
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The subject line can be very convenient for you when you receive the
e-mail, but you have to be aware that the user can change it. Because of
this, it might be better to create a specific e-mail address used only for
this link than to count on the subject line remaining the same for every
e-mail sent from this link.

6. Save the file and open or refresh the Web page in a Web browser. Test
the e-mail link, including sending an e-mail, as shown in Figure 15-2.
Make sure the message is received where you intend it to go.

If you don’t discover any problems, your users will!

31 Untitled Message S prer
: File Edit View Insert Format Tools Table Window Help Type 2 question for help » X o
isssend | - [WI8 )¢ 8| ¥ || optons.. e - sorwss €8
WTo... budsmith2000@aol.com a =
G Liks
e Al
Subject:
= m= | | o JLACLB L U= = i=
is a girls'
fices an plays
" ||y the
I the following
lgible to
Figure 15-2: i
2
A view ? e gils from 8
of the [ yoor—scamemrescarey 8,910, 1
tt‘u:nughuut your time with us. s or 12 on January 1st of this year.
. <1i>Some sports experience, We wou ; .
Mmailto e iahere some rerions oaanized 2. Good in school. We need you to show us you're a good
spuqts experience in any sport. student, and to maintain your academic standing throughout
“fols
code, Web |’ yous tie with us
7= 3. Some sports experience. We would ke you to have some
href="mailto:budsmith2000@a0]. com'>send i i
page, and mail</ar to budsmith2000€ac].com it piEwous Brgeitized Spoits supetisnce iay SHOL
il you'd Tike.
end mail to budsmit aol com if you'd like
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</hody>
message.
</html> E] maio:budsmith2000@anl com +d My Computer
I

Internal Links within a Web Page

Compared to the drama of using a hyperlink to go to a whole new Web site,
using a hyperlink to move the user to a new location in the same Web page
might seem a bit of a letdown.

But a great advantage of Web pages is that they’re vertically just about unlim-
ited, like an ancient scroll. And users are accustomed to moving up and down
in long documents, including long Web pages. So a structured way to use this
characteristic is welcome.

Having everything about a given topic in one long Web page can be quite
helpful to users. They know which page to go to for that topic — and most
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of them know how to use the search option in their Web browser to get to a
particular phrase or word they remember.

Now usability people will tell you that people don’t like to scroll unless
they’re sure of the benefits of doing so. But internal links — links that go
to a specific spot in a Web page — can use the vertical dimension of the
Web page without the user having to scroll. He or she simply clicks links.
(Possibly even unaware that they are moving around in a Web page, not
moving between one Web page and another page.)

To create an internal link, you have to create a destination anchor. The desti-
nation anchor marks the spot in the page that the users go to when they click
an internal link.

The destination anchor is in the form <a name="targetname"></a>.
You create your own memorable name to help you organize the page. Note
that there is no text surrounded by the beginning and ending anchor tags.
This HTML code simply gives a name to the spot in the Web page where it
appears.

The destination anchor is invisible to the user. When the user clicks on a link
to the destination anchor, the Web page scrolls upward or downward to that
line destination.

The link to the destination anchor is a normal link, but the value of the SRC
attribute includes the character # followed by the target name of the destina-
tion anchor, as in <a href="planets.htm#mars"></a>. (That # can be the
hardest part of the whole process to remember, so pay special attention to it.)

You can certainly create a link to an internal anchor that, instead of being on
the same page, is on another page. The other page can be on your own site or
a distant site. However, users are so accustomed to links going to the top of a
page that [ suggest alerting them, in the text preceding the link, so that they’ll
be going to a destination within a page. Here’s what that looks like:

To learn more about ancient Greek cooking oils, you can visit a great
page on the subject. To go directly to the entry on Greek cooking oils, in
the middle of a long page about cooking oils, click here; to start at the top
of the page and survey the entire cooking-oil topic, click here instead.

Wordy, but effective.

A classic example of internal links in a Web page that’s part of a full site is an
FAQ page, for Frequently Asked Questions. Generally, the questions are all listed
at the top (see Figure 15-3), with the rest of the page containing a question, its
answer, the next question, its answer, and so on. Links within the page go down
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to each question and, from the end of each answer, back up to the top of the
page.

Follow the instructions here to create an internal link in a Web page in HTML:

1.

Open your Web page in Windows Notepad. Move the cursor to a spot
that you want to be the destination of a link.

Usually this will be the beginning of a line of text, often a header.

If you don’t have the content of a Web page ready yet, you can just
create headers and links; then your navigation system will be ready as
you fill in the content.

. At the target destination, enter the destination anchor, such as the

following:
<a name="UKpolitics"></a>
Note there’s no text between the beginning and ending anchor tags.

Make sure the destination is near a recognizable point in your Web page,
such as a header, so the link makes sense to you and to users.

. Repeat for additional internal links.

Create all the additional links you need — if necessary, type in headers
or other markers for the internal links to be associated with.

. Test the links by linking to them.

Here’s a typical instance:
<a href="#ukpolitics">British politics</a>

Create links to each of your destinations, either because you need them
now or, if not, to test them.

. Save the file and open it in a Web browser. Test the links and fix any

that need repair.

Internal links cause many problems; it’s best to make them your ally,
rather than a source of frustration, by getting them working right from
the start.
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Frequently Asked Questions

Why this age?

Why academic qualifications?

Why some sports ezperience? Why not more?

<4 name="academic"></a><h2>why academic
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the results more?
for a set
. Is it fun?
of internal ]
|in ks Contains commands for warking with the selected items.
E —
<P The link destinations for internal links are often referred to as anchors, even

though technically both the beginnings and endings of links are anchors.
While a tool such as CoffeeCup, as described in Part III, is good for managing
internal anchors, some other tools can’t handle them. So if you use a different
WYSIWYG tool for Web-page creation, you may still find yourself managing
internal anchors directly in HTML.

Creating a Text Navigation Bar

A navigation bar is an area of a Web page set aside for links among the pages
that make up a site. Each separate link or choice in a navigation bar is called
a “tab,” whether or not it actually looks like a tab as used in a paper file. A
site might have multiple navigation bars that cover content, perhaps in main
navigation, and tools or supporting elements, such as a site map and legal
reminders, in a secondary navigation bar.

A navigation bar of any type is a consistent visual element that appears on
every page of the site and that always has the same appearance, the same
words, and the same links. It’s not an exaggeration to say that a navigation
bar of some sort, even a simple text one, is the difference between a Web site
and an unconnected mass of Web pages. Creating a navigation bar forces you
to start thinking hard about how your site is going to be organized.

www.it-ebooks.info


http://www.it-ebooks.info/

2052  Partiv: Your Site in HTML

Web-page authors use simple, text-only navigation bars for all purposes
during site development — and for several purposes even after creating the
graphical main navigation:

v To echo main navigation at the bottom of each Web page.
v For secondary (or tertiary or — get ready for this one — quaternary)

navigation functions on complex sites.

Even the simplest text navigation bar can help enforce useful practices of site
design and usability right from the beginning of creating a multiple-page site.

Here’s an example of a simple text navigation bar for a small consulting business:
Home | Services | Memberships | Publications | Experience | Contact me

Each tab is underlined to reflect that it’s a link to that page or multipage area
of the site. Note that the Home tab, as I'll call it, is not underlined. The idea is
that, when you’re on the home page, you can’t click Home to go to the home
page — because you're already there. So the area of the site you're already in
is not linked.

When you click the word Experience on the text menu to go to the
Experience page, the text navigation bar should change to reflect where you
are — it’s no longer possible to click Experience, while Home is linked again:

Home | Services | Memberships | Publications | Experience | Contact me

To implement this, you create a “model” navigation bar with all the tabs
linked — but it’s never used in quite that form. For each page on your site,
you copy the navigation bar, and then remove the link from the tab that the
page in question belongs to.

Follow these instructions to create a text navigation bar:
1. Open a new, empty page in Windows Notepad. Save it under a name

of your choice with .htm as the extension, such as navbar.htm.

2. Type in a line of text representing the elements of your site, with a
word or two for each page or area.

Use the vertical bar to separate the tabs. You may find it on your
keyboard, or choose Examples for a personal/professional site:

Home | Services | Memberships | Publications | Experience | Contact me
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If the vertical bar character is not accessible from your keyboard, it
should be available from the Symbol or similar menu in a word process-
ing program. (There’s no such option in Notepad.) You can then copy
and paste the vertical bar into Notepad.

. Center the navigation bar on the page by using the center attribute

of the paragraph tag, like so:

<p center>Home | Services | Memberships | Publications | Experience |
Contact me</p>

The text menu will be centered. Note the closing paragraph tag —
always a good idea, but especially so in this case, to stop the centering.

. To link the Home tab to the home page of your site, surround the

word Home with the <a> and </a> tags. (Exclude the blank spaces to
either side). Add the href attribute like so: <a href="home.htm">.

The Insert Link dialog box appears.

. Repeat for the remaining phrases — link to the relevant page on your site.

The pages don’t have to exist yet, though of course the links won’t work
until the pages are there. Whenever you create a page, the name must
match the name in the text menu exactly.

On some Web servers, capitalization matters — the Budsmith.htm file
is different from the budsmith.htm file — so use all lowercase to avoid
problems. Also, don’t use spaces in the filenames. If you do, the links
could break when your Web site is moved to a server for hosting.

When you’re done, you should have a fully linked text menu — every tab
linked to a page, even if the page doesn’t exist yet.

Consider keeping a copy of the complete menu, with all links in place,
on your home page or in a working page — so if you make changes later,
it will be easier to update the text menu in one place, then copy and
modify it onto all the pages involved.

. Copy the menu to each Web page of your site, or create a new file (for

any pages that don’t yet exist) and put the menu in it. As you proceed,
delete the link from the tab representing the page you’re about to save.

Adding this basic (but vital) feature will give you the beginnings of a true
site, not just a bunch of pages.
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M y Top Tens give you a cache of dos and don’ts for
creating Web pages so you can look like a pro your

first time out on the Web.
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Ten Web-Publishing
Dos and Don'ts

Life today is complicated, and so is fiction. Batman has gone from a do-
gooder to a “dark knight” (mostly appearing, of course, on dark nights),
lately seen in prison right alongside the evil Joker. Ambivalence crops up
everywhere.

In the spirit of helping you solve, or avoid, knotty problems, I offer a mixed
list of light and dark — ten (plus a couple extra) essential dos and don’ts.
Use them to make your site stronger from the start and to help you resist the
temptation to let it become hard to use or to fall behind the times.

DO Think About Your Target Audience

Who is your Web site targeting? A little thought along these lines can make
your pages much more appealing to your visitors. Before you begin creating
your Web site, choose the right look and feel, and a style of presentation that
is appropriate for your audience.

For instance, if your target audience is your family, keep your site simple and
fun — but if it’s a business site, keep the personal stuff well separate.

Include links that your visitors find interesting, not just the ones that you find
interesting — unless “all about you” is the point of your page, of course.

Use good sites as models. Many top-rated sites have settled on relatively
simple designs. Identify what works in a site you like. Is it . . .

v The use of color and the layout of the Web page?
v The fact that the site loads quickly?

v The well-organized content?
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Google is a good example of a site that is well-focused around a key observa-
tion: Speed matters. The Ford site, which could hardly be more different, also
does a good job for its customers — by giving cars pride of place.

Research other media, such as newspapers and magazines that have an audi-
ence similar to yours (check the articles and the ads to determine this), to
find good and bad examples.

But don’t overcomplicate things. Stick to basic HTML that works for every-
one; try more advanced technologies on “leaves” of your site, on individual
pages, before extending their use across your site.

If you want and need to offer something a bit more exciting like a QuickTime
movie, help your site visitors by plainly labeling it and offering them any
needed support, such as a link to the QuickTime download page on Apple’s
Web site.

DON'T Forget the Basics

Your site may be the greatest thing since sliced bread, but if you forget to
include contact information for yourself in the site, how will you find out that
you misspelled “bureaucracy” all over the place?

Similarly, don’t put the order form for your spiffy new number-crunching
widget five levels down in the “Fruit Bat Guano Statistics — 1876” Web page.
If your customers can’t find it, they can’t buy it.

More basics:

v Have a useful, search-engine-friendly title (the title tag) for each page.
v Include your e-mail address on your Web page or Web site.

v If you create a Web site of more than 5 to 7 pages, add a site map.

1 Make the important information prominent.

 Include a copyright notice, usually in this form: © 2008 MyCo Inc.

DO Think Before You Create

When creating Web pages, a surprising number of people just jump in and
start throwing around text and HTML tags with no clue about where they’re
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going or what they want to accomplish. That approach is fine if you just want
to play around; in fact, it can be a lot of fun. But if you want to make a good
impression on the Web, sitting down and thinking about a few things ahead
of time really pays off.

Sketch your ideas on paper. Then describe them to someone else and ask
for feedback. This prep work forces you to consider things that you may not
think about otherwise:

v Page layout

v Graphic design

v Relationship between pages
v Target audience

v Content structure

v Link grouping

Remember that your Web pages are available and accessible to the whole
world. Think a bit about foreign audiences. Do you use colloquialisms that
may not be understood by international Net surfers? How do your pages look
to your colleagues who view them through a slow Net link? (Fast Internet
connections are still very expensive in some places.) Should you include
content in multiple languages? Will your humorous or risqué content offend
someone in another country or culture?

‘3‘& When you become a Web publisher, you also become a global citizen, and
your Web pages play on a global stage. Think through the accessibility and
meaning of your pages in advance.

All these issues and more, when properly considered and acted on, can make
your site a first-class Web-surfing experience.

DON'T “Borrow” without Asking

Make sure that content you get from the Web to use on your own Web page is
labeled as being freely available for reuse, or else get permission to reuse it.

WMBER
‘3‘& If a Web page doesn’t explicitly say that its content can be freely borrowed,
& - . . .
assume that it’s copyrighted or otherwise protected — which means you

should ask before borrowing any of it.
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You can easily peek at the HTML source of any Web page, and that’s legiti-
mate, and a good way to figure out new design techniques. But you can also
easily grab any content that exists on the Web, even privately owned content
that belongs to others. However, the fact that you can easily grab others’
content does not make doing so right or legal. It’s also not necessary.

You can find a great deal of public-domain content, and getting permission to
use some private content is not all that hard to do. Many people are happy to
let you use their content as long as you provide proper attribution and recip-
rocal links so that they can gain exposure to new Web users who visit your
pages. In the process, you may just gain new friends or business contacts, as
well as avoid legal problems down the road. (And in case you get tempted to
borrow quietly, keep in mind that word of unethical practices gets around
quickly on this amazing global network.)

DO Use Links to Outside Sites

No matter how great your content is, you're wasting the most important
feature of the Web if you don’t include links to sites outside your own. No
matter what your topic, you can find complementary sites out there. Giving
your visitors links to those sites is not only courteous — it’s also part of the
foundation on which the Web was built.

If you research your links carefully and organize them well, your links can

be a valuable resource for others. In your own Web surfing, you’ve probably
found that one of the best experiences on the Web is the serendipity of stum-
bling upon some cool site that you had no idea existed. Give your visitors
that same experience. Point them to the outside world. That’s why it’s the
Web and not the Hole.

You can use as many links as you like, as long as they fit within a structure.
Beginners often organize their pages in ways that make their sites hard

to navigate. If your site has more than 5 to 7 pages, you should put some
thought into how your visitors navigate it. Nobody likes wandering from page
to page with no idea what is where. Likewise, users don’t want to follow mul-
tiple links to find one piece of information.

Keep the relationship between your pages simple. Make clear which links are

internal to your own site and which go out to other sites. Provide a site map or
a common menu. And make navigation work consistently throughout the site.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 16: Ten Web-Publishing Dos and Don'ts 25 ’

DON’T Abuse Graphics and Multimedia
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A prime attraction of the Web is that it’s designed to present graphical infor-
mation. Include pictures, icons, bars, and graphical menus in your Web page.
Go ahead, try out transparent GIFs. Multimedia is a great addition, too, where
appropriate; one or two sound files, a QuickTime movie, even a simple ani-
mated GIF can really liven up a site.

Yet the biggest mistake that some beginning Web authors — and some
experts — make is overusing graphics and multimedia on a page. Keep in mind
that not everyone has a cable modem or DSL connection wired directly to his
or her home PC; many folks around the world still receive Web pages via a more
limited 56K or slower dialup connection. For most pages, keep your page size —
including both text and graphics — under 50 KB.

People also forget that each separate graphics file linked to in your Web
page, no matter how small, generates a separate download request. Because
of the nature of IP-based networking (IP is Internet Protocol), a random file
access can fail, requiring another request, or take a long time. So it can take a
page with a lot of different graphics in it a while to “settle down” even over a
fast connection.

Here are ways that you can keep down your page size without sacrificing
design flexibility:

1 Resize photos and convert them to JPEG format.

v Use simple icons and banners — images without very many colors or
complex textures — in GIF format.

v Combine several different small graphics into one physical graphic
that includes the white space — a lot of visual impact for one graphics
access.

v Lay out your site to limit the amount of graphics on any one page; add
pages if you need to display more graphics.

v Use <alt> tags to provide text alternatives to meaningful graphics;
leave out the <alt> tags for designer elements that improve the look
but don’t add to the content.

1 Use thumbnail icons to give access to larger images.
The bottom line is that sites that carefully use graphics and multimedia are
much more interesting than purely text-oriented ones. Give it a go. But be
prudent.

All these strategies make your pages more interesting, yet quick to download.
Your Web-surfers will thank you.
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DO Test Your Pages

You can find so-called “easy-to-use” Web server packages on the market, and
Web server capability is now built into many Macs and PCs. But even with
these efforts, buying (or using your existing PC), setting up, and maintaining
a Web server can become the most expensive, most complicated, and most
frustrating part of Web publishing.

Luckily, you can put your content on someone else’s Web server using the
free services I describe in this book, or you can use an inexpensive paid ser-
vice while you figure out the other tricks of the trade. Then, as your knowl-
edge and experience grow, consider setting up your own Web server.

No matter where your pages are, you need to test them. Testing your pages
is easy. You probably don’t send out a memo without spell-checking it.
Similarly, you should not put up your Web pages without testing them. That
means looking at your pages on your own machine before testing them on
the Web — follow links, see how graphics and text fit together, and so on.

Also, looking at your pages in different browsers doesn’t hurt. If you can’t do
it, ask a friend or even a stranger to help. And, of course, don’t forget to spell-
check your pages.

After you upload your files to the Web, test again on your own machine, your
friends’ and neighbor’s machines, any machine you have access to — you
may be surprised by the differences you see. And if you really want a shock,
ask a couple of friends or family members to go to your site and click around
on it, telling you what they think as they go along; the way they use your site
is almost certain to be different from what you expected.

DON'T Break Netiquette Rules

Lapsing into poor netiquette — the etiquette, or “Miss Manners” rule book, of
the Internet — is too easy to do, and it can bring you a lot of negative atten-
tion. If you make any serious offenses against good Internet practices, your
Web service provider’s server may remove your pages. And you can even get
into legal problems.

Avoid the following dubious practices:

v Spamming, or sending unwanted e-mail to publicize your site or sell
things
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v Flaming, or being fervently disparaging of other people or other Web pages

v Posting offensive material on your page without some kind of warning label

Netiquette is an amorphous and evolving area of online behavior, so you may
want to join a Web-oriented newsgroup where you can ask questions before
publishing. Also, check out this site for in-depth info:

www.albion.com/netiquette/corerules.html

Yet, within the bounds of netiquette, you still need to publicize your site.
Nothing is more frustrating than putting up a site that no one visits.

Fortunately, publicizing your site is not hard. Add your site to the popular
indexes, for example, through the Submit-It site at www. submit-it.com.
(Like many other such services, the Submit-It site charges a fee.)

You can also send e-mail to appropriate blogs, put out a press release, send
e-mail to friends and business contacts, or shout from the rooftops.

DO Ask for Feedback

Put your e-mail address on your home page and ask for comments. You’ll be
amazed by what people say about your pages. (Some of the comments may
even be complimentary!) People who have never before seen your site can
offer a good, fresh perspective and give you feedback on things that you may
not have previously thought about.

After you have your site working the way you want it to, experiment. Try weird
things. Keep asking for feedback. Never be afraid to figure out complex and
hard stuff. (It’s only complex and hard because you don’t understand it yet/)

Everyone can benefit from outside input. Criticism by your prospective audi-
ence is not only useful, it’s also educational. You can learn a lot about what
people expect and want. Criticism can’t hurt anything but your pride, and
listening to it almost always improves your site.

Whether from outside input or your own research and ideas, you can find so
much neat stuff out there that can make your Web-publishing efforts even
more exciting — JavaScript, multimedia, new browsers and publishing tools,
Net-based games, and online business infrastructure. All this new stuff is
understandable and usable by normal folks like you and me. Don’t be intimi-
dated. You can use all of it. (If you’'ve come this far, you've got what it takes!)
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DON'T Let Your Site Get Stale

A static site is a boring site. True, it works for some purposes, but in general,
if you want people to keep revisiting your site, you must keep it updated. The
best sites are those that continually provide new and interesting content.
Include pointers to information that’s frequently updated, such as “Thought
for the day” or “Links to new, cool sites.” Let users know how often to expect
updates and be sure to showcase new content. A “New” icon next to recently
added or updated content can work wonders.

You can easily add a blog piece to your site. Some packages make this auto-
matic; or, use your knowledge of HTML to easily update your site with new
commentary every few days.

In addition to updating your site, update yourself! Broadening your knowl-

edge of Web design, new trends and technologies, and what’s “cool” at the
moment can only help improve your site.
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Ten Places to Host Your Page

Wlere to host your Web site is always a good question. And these
days, with so many different kinds of Web services, the very defini-

tion of a Web site is under question.

I[s a Facebook page a Web site? Is a set of photos you’ve unloaded to Flickr?
Literally speaking, yes.

But a true standalone Web site, built from the ground up, not only offers you
more choices — it can also knit together all your other online involvements
in a coherent whole, a kind of control panel for your online life.

So here are ten places to host “real” Web sites — though I include two blog-
ging sites, as blogs can so easily be expanded into complete sites.

Google Page Creator

Google Page Creator is a very flexible page creation service, described in
Chapter 3. It will hold your hand in setting up a simple site — or simply give
you space to put up as complicated and customized site as you want.

How to use it: Go to pages.google.com and log in or sign up for an
account.

Network Solutions

Network Solutions is the original provider of Web URLs and still one of the
biggest. Network Solutions also offers easy-to-use Web-page creation tools
and Web hosting. It’s on the expensive side, and they are quite good at selling
services. But there’s a lot of functionality available.
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If you look for a Web URL on Network Solutions, they can apparently “lock
down” the URL for a few days — so if you search for it again, it seems to be
gone, but actually it’s just being held. Consider doing your domain name
searches at another site, such as www.123reg. com, to avoid this.

How to use it: Go to www.netsol.com and look at the services on offer.

Fasthosts

AOL

Fasthosts is a U.K.-based hosting provider that’s like a slightly less polished —
and slightly less expensive — Network Solutions. I've used their services and
like them.

How to use it: Go to www . fasthosts.co.uk and check out what’s available.

Say what? Yes, America Online. AOL may be well known as a business failure,
a company that once was big enough to merge with Time Warner and is now
being sold off in chunks to various other companies around the world, but
there’s more to the story.

They developed good Web-page creation services at their peak, and the offer-
ings are still there.

How to use it: Go to www.aol .com and look carefully at the offerings; there
are several levels of service available, so check carefully before committing.

Vahoo!

Yahoo! is one of the original founding companies of the Web, and many
people still weave in and out of the Yahoo! site and various Yahoo! services
several times a day. And they have good Web-page creation offerings that
fit with their other services. The leader is GeoCities, which was bought by
Yahoo! some years ago and is still a major player in free Web pages.

How to use it: Go to www.yahoo . com and sign up for an account, then look
at some of their existing Web pages and sites. Or go straight to www. geo
cities.com if you want to skip the Yahoo! site, though you’ll still need a
Yahoo! account to use GeoCities.
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Blogger

Blogger is a very early provider of free blogging. Since being purchased by
Google a few years ago, they’ve stabilized their platform and have grown
steadily. (Using Blogger is described in some detail in Chapter 4.)

How to use it: Go to www.blogger . com and see what’s there, though you’ll
need a Google account to use Blogger.

WordPress

WordPress is gradually emerging as the serious alternative to blogger. Word
Press offers free services, but many of its users pay at least something — more,
it seems, than on many other blogging sites — and they seem happy to do so.
Don’t expect total ease of use, though; a business whose catchphrase is “code
is poetry” hardly shies away from offering power tools.

How to use it: Go to www.wordpress.org and give a careful look around
before committing.

MobileMe
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If you are a Mac user or an iPhone owner, you simply have to consider
MobileMe, which until recently was called .Mac (“dot-Mac”). MobileMe will
cost you — $99 a year in the U.S. — but more than a million users say it’s
worth it. MobileMe offers not only Web-page creation and hosting but all
sorts of related services such as calendaring, e-mail, and more. All in the
easy-to-use interface you expect from Apple.

Apple — and its users — suffered serious teething problems in the transition
from .Mac to MobileMe; a very small percentage (but still a large number) of
users lost some stored e-mails. The optimistic view of the aftermath can be
summed up as, “they’ve gotten that out of their system”; the pessimistic view,
“once bitten, twice shy.”

How to use it: Go to www . apple.com/mobileme and look at the offerings

carefully; consider not only the cost but the hassle of transitioning to MobileMe
from products, many of them likely to be free, that you already use.
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Weebly

Ning

Weebly is based on Ajax, the Web 2.0 technology that’s helping bring many
sites to life with interaction and animation. Weebly is relatively new, but
already quite popular. Consider it seriously, especially if you like social-
networking tools such as Facebook, Flickr, and YouTube.

How to use it: Go to www.weebly.com and see if you like the look of their
users’ pages more than what you see at the better-established competitors.

Different from the rest, Ning is actually for creating your own social network,
not just your own Web site. If you like Facebook but have exhausted all its
capabilities and want to do more, or want a Web page that’s anything but
boring, consider Ning.

How to use it: Go to www.ning.com and try the idea of being a social-
networking guru on for size.
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Ten Ways to Make
Your Page a Site

‘ reating a Web page is a real thrill, but once the excitement dies down,
you might be left feeling a bit anxious. How to convert your fun Web
page into an interesting and enduring site?

Here are ten techniques for making the leap to a lasting, interesting Web site
you’ll be proud of.

Specialize

The tendency when you create a Web page is to mention several things, or
even everything that interests you. It’s your Web page, so it should be about
you, right?

Maybe, but when you expand to a Web site you should consider specializing.
People go to Web sites for what the site offers, and people expect the site to
be like a mosaic, with each page contributing to an overall picture. Unless
you're so famous, or so fascinating, that people really want to build up a pic-
ture of you just because you're you, they probably want to learn about some
company or topic. Focus your efforts into a coherent site with a single over-
arching theme. (Even if you keep the focus on yourself, consider choosing an
aspect such as your career, family, or creative use of the online world across
various other sites.)

Let Go of Your Tool

Tools such as Google Page Creator are great for getting started. You do
everything online, so there’s no worry about getting your pages hosted;
they’re hosted for you even as you're creating them.
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However, the only way to have real flexibility in the design and develop-
ment of your site is to move away from online tools and templates to your
own chosen approach. The quickest way to get there is to move to a more
independent model: developing your site on your own computer, and then
uploading files to the Web to bring them to life.

Copy Your Page to Your Hard Drive

Even if you leave your page or site in an online tool for a while, you can still
benefit from keeping, and working on, a local copy. It’s nerve-wracking to be
working in an online tool with little or no backup, knowing you can wreck
your site with a few poorly chosen keystrokes and mouse clicks.

Copy your Web site to your hard drive, a page at a time, and then work on
the copy of your site that lives on your own computer. This will increase
your understanding and capability very quickly. Then copy and paste from
your work on your own machine into the tool that makes changes in your live
site. Soon you’ll be ready to bypass the tool and upload entire pages (and
their graphics) files directly to your Web host.

Use FTP

The all-too-frequently seen FTP, or File Transfer Protocol, has done more to
discourage Web-page authors than perhaps any other aspect of Web publish-
ing. With FTP, you have to log in to a remote site, and then transfer files in a
process that feels more like trying to keep up with the nerds in the computer
lab than, say, updating your Facebook profile.

Still, you have to learn it. Use the tools available on your host (which are just
FTP with a pretty face) or download an FTP program from CNET’s excellent
download. com site to get going, and take the time to learn how to use it.
You'll be glad you did.

Get a URL

Having your own URL — that is, an independent Web address for your site,
notmysite.geocities.combut www.mysite.com—is a big step that
will make your site feel very “real” indeed. You don’t need to do this on Day
1; in fact, getting a URL can actually distract you from getting started. But as
your Web page takes on a life of its own, getting and using a URL becomes a
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necessary step in your site’s growing up. Use the services described in the
previous chapter to find and purchase a URL and, if needed, Web hosting.

Add a Blog

[ was slow to warm to blogs — I even found the name offputting. But they’ve
proven themselves to be the single simplest and best way to steadily expand
a site with fresh content. (Blogging will do a lot to give you ideas for other,
structural additions to your site as well.)

You can even blog from your mobile phone. Use the tools in Chapter 17 (or
other tools) to add a blog to your site, and keep using them so your site grad-
ually expands and improves.

Add Other Tools

Many Web hosts offer fun tools to add to your site, such as online poll-

ing, message boards, news feeds, and such. Or use RSS — Really Simple
Syndication — to bring in news or other information. There are hundreds of
things you can do; look around at sites you like and figure out how to add
your favorite features from those sites to your own site. (If nothing else, this
effort will make you steadily better at Web searching.)

Add Navigation

Keep working on your site navigation — extending it, improving it, or making
it easier to use. Navigation is what makes a Web site hold together, like the
covers and binding of a book. Unlike a hard-copy book, however, a Web site
can gradually improve, especially as you refine your navigation to make your
Web site better and better with time.

Ouote Others

Bring in quotes, contributions, and material written or drawn by others. Link
to relevant videos on YouTube. (Even if you have to create them yourself —
but include the comments others make about your video on YouTube.) Keep
getting in outside opinion.
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Keep Plugging Away

Keep adding little things here and there. It took months before my wife and
[ got the site for her business, at batcs.co.uk, into decent shape — but,
to my worry, something was still missing. As we gradually added press cov-
erage, information about courses, and a few frequently asked questions,
suddenly the site seemed to become more solid, real, and interesting. We
reached a tipping point in which there was enough valuable content to be
interesting, and even a bit impressive. Keep plugging away at the details,
adding content and functionality, and you will too.
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Appendixes

T_he 5th Wave By Rich Tennant
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In this part . . .

Often appendixes are the miscellaneous extra bits of a
book — but these are useful enough that they
deserve their own section: A glossary of Web-publishing
terms, a guide to basic HTML tag definitions, and all you
need to know about the CD-ROM included with this book.
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Appendix A
Web Words Worth Knowing

' his glossary defines important terms used in this book. To see where a
term is used in the book, check the index.

56K. 56 kilobits per second, a standard speed for dialup Internet access used
by most current modems. Actual online access speeds are limited by U.S.
government regulation to a top speed of about 53 Kbps, and your 56K modem
may not achieve even that speed reliably, depending on the quality of the
connection you get when you dial in.

absolute address. A description of a file’s location that starts with the
domain name, machine name, or disk name on which the file is located. See
also pathname and relative address.

ActiveX. A Microsoft technology for distributing executable files called
ActiveX controls (programs that can change your file system directly) over
the Internet. ActiveX is powerful, but it only works on Windows — and it
triggers warning messages from security software even on that operating
system, so beginning Web authors should avoid it.

anchor. One end of a link between two files. When you look at a Web page,
the underlined, colored text that you see is an anchor at one end of a hyper-
text link. Clicking the text brings up another Web page, which is the anchor
at the other end of the link.

animated GIF. A GIF graphic that includes several slightly different images in
sequence. Browsers that support animated GIFs display the graphics one at a
time to create an animation.

attribute. In HTML, an attribute is a qualifier added within an HTML tag.
The attribute modifies the tag’s purpose. For example, in the tag <IMG
SRC="budpic.jpg">, the attribute is SRC (short for “source”). See also fag.

blog. Short for “Web log,” a form of Web site in which the author’s frequent
postings are recorded, usually with the newest posting first. Site visitors are
often allowed to comment. Web logs use special software to prevent the user
from having to set up or manage the Web page.
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broadband. Any kind of fast Internet access, whether by cable modem, DSL,
or other connection significantly faster than the 56K top speed of a modem.
Broadband connections are typically “always on” and do not require dialing in.

browser. A program used to look at World Wide Web documents. Mosaic was
the first popular browser, followed by Netscape Navigator; Microsoft Internet
Explorer is the current market leader.

bulleted list. See unordered list.

cable modem. A form of broadband access to the Internet that uses a cable
TV connection. (If the local cable company that serves your house offers this
service, it’s worth a look.)

Cascading Style Sheets (CSS). A language used to control the look of a Web
page (colors, fonts, and so on), whereas HTML is used to control the struc-
ture of the content (headings, paragraphs, and so on).

clickable image map. A graphic that includes areas called hot spots, which,
when clicked, take you to different Web pages or different locations within
a Web page. Some large Web sites use clickable image maps on their home
pages to entice the users to move farther into the site.

Common Gateway Interface script (CGI script). A kind of program often used
to transfer data from an HTML form to an application. The CGI script runs on
the server that hosts the Web page with the form. See also form.

compression. Storing a file in less space than previously required. Lossless
compression creates a file from which the original file can be exactly re-
created. Lossy compression eliminates some (hopefully less important) data
from the original file in order to allow the compressed file to be smaller.

definition list. A type of HTML list in which terms occupy a column on the
left side of the screen and definitions occupy a wider column on the right
side.

DHTML (Dynamic HTML). DHTML is not a markup language (as is HTML);
the term refers to the use of three languages together in Web design: HTML,
CSS, and JavaScript.

domain name. A name that represents a Web site to the outside world. In the
United States, the domain name can end in . com (for businesses), . edu (for
educational institutions), . org (for nonprofit organizations), or the presti-
gious .net (for organizations that are part of the structure of the Web itself).
Newly added suffixes, which haven’t necessarily caught on yet, include .biz
and . firm. When visiting a domain that was created for an organization out-
side the United States, you may see different suffixes that have been added
to represent a country or region. For example, . uk signifies that the domain
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was created for the United Kingdom. The part of the domain that precedes
the suffix, such as stanford in stanford. edu, is either the name of the

group that puts up the Web site, or a name that attracts people to the site.
Domain names can start with www if desired, but it’s not always necessary.

DSL. Digital Subscriber Line, a type of broadband Internet access that uses a
phone line. (Not available in some areas, but worth serious consideration if
it’s available to you.)

electronic mail (e-mail). A message sent over a network from one computer
user to another computer user. The most popular service on the Internet.
Used as a noun (“I just got an e-mail.”) and a verb (“E-mail me on that, will
you?”). Also used as singular (“I just deleted an e-mail.”) and plural (“I just
deleted all my e-mail.”).

embed. To place a reference to a file of a type not directly supported by

the HTML specification in a Web page, using the embed HTML command.
Multimedia files are the ones most commonly embedded. The file is then
played back by a helper program such as RealPlayer, QuickTime, or Windows
Media Player.

File Transfer Protocol (FTP). An Internet service for transferring files between
different machines, including those that run different operating systems. It’s a
commonly used mechanism for uploading Web pages to a Web site.

firewall. Hardware, software, or a combination that protects a network from
unauthorized access while allowing authorized access.

form. An HTML-defined way to specify text boxes and pull-down menus to
enable users of a Web page to enter data. The data from the form must be
processed on the Web server by a program such as a CGI script.

freeware. Software that can be used for free, though often with a license that
contains some restrictions on its use. See also shareware.

Graphic Interchange Format (GIF). Can be pronounced “jiff” or (my prefer-
ence) “giff.” A format for encoding less complex images, such as computer-
generated graphics, for transfer among machines. GIF format is the most
popular means for storing images for transfer over the Internet and is sup-
ported by all graphical Web browsers. An image stored in GIF format is often
referred to as “a GIF.” See also JPEG, transparent GIF.

Graphical User Interface (GUI). Software that enables users to interact with
a computer by using a mouse and keyboard to manipulate images and menus
on the computer’s screen. The Windows and Macintosh user interfaces are
both examples of GUIs.
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hexadecimal. What the witch did to her accountant so her tax bill would
be more favorable. (Just kidding.) Actually, a way of counting that uses 16
“digits,” 0 through 9 plus A through F, instead of the 10 digits that common
decimal numbering uses. Hexadecimal numbers are often used to describe
values stored inside a computer — in particular, colors used in Web pages.

In hexadecimal numbering, 0 through 9 have their normal values, but A rep-
resents 10, B represents 11, and so on through F, which represents 15. Place
values are also different; each successive place represents the next greater
power of 16. For example, 2F in hexadecimal translates to 47 in decimal; the 2
represents two 16s, and the F represents fifteen 1s.

hit. This is what you hope your Web site will become. Also, a successful con-
nection, file transfer, and disconnection between a Web client and a Web
server. Accessing a single, text-only page generates one hit; accessing a single
page with three graphics on it generates four hits. Hits can be counted fairly
easily and are a crude measure of the popularity of a Web site. When you see
a site that advertises “a million hits a week,” remember that the number of
hits may be many times greater than the number of different people who vis-
ited. See also Web client and Web server.

home page. A Web page that you intend users to come to directly when they
visit your Web site. If a Web site has multiple pages, the home page usually
serves as the front door to the rest of your site, and the guide to all the other
pages housed there.

HTML 4.01. Currently the most broadly used version of Hypertext Markup
Language, invented by Tim Berners-Lee (now, not coincidentally, Sir Tim
Berners-Lee) in the late 1980s. All browsers available today support this ver-
sion of HTML, though different browsers may interpret some tags differently.

Hypertext Markup Language (HTML). The language used to annotate, or
“mark up” text documents so they can be formatted appropriately and linked
to other documents for use on the World Wide Web. See tag.

Hypertext Transfer Protocol (HTTP). The agreed-upon format used by
Web programs to exchange messages among World Wide Web servers and
between Web servers and clients.

image map. See clickable image map.
Integrated Services Digital Network (ISDN). Sometimes jokingly spelled out
as “It Still Does Nothing,” this special type of phone line is available to many

businesses and homes as a broadband connection option that supports faster
transmission of data than standard phone lines.
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Internet. The hardware and software that together support the interconnec-
tion of most existing computer networks, allowing a computer anywhere in
the world to communicate with any other computer that’s also connected to
the Internet. The Internet supports a variety of services, including the World
Wide Web.

Internet Protocol (IP). The networking specification that underlies the
Internet. IP’s most important feature is its support for routing of the packets —
small chunks of information that make up a communication — across multiple
connections to the final destination.

Internet service provider (ISP). A company that offers connection to the
Internet and support for Internet services such as the World Wide Web. An ISP
may also provide Web site storage space and related services to customers.

intranet. An internal network used for distributing information broadly
within an organization, but not to the general public. Many intranets work
just like the Internet and World Wide Web, only on a smaller scale.

Java. A programming language that supports the creation of distributed
programs, called applets, whose functionality can be easily and flexibly split
between a client computer and the server that it’s connected to. Java provides
a way for the Web to support easy sharing of programs and data and, unlike
ActiveX, Java is cross-platform. Java has become less widely used within Web
pages, but it is widely used on Web servers and corporate networks.

JavaScript. Largely unrelated to Java (except through their common parent,
(), JavaScript is often used to add interaction or some dynamic quality to

a page (a calculator, a menu) through lines of text commands placed in the
document or in a separate, linked file.

Joint Photographic Experts Group (JPEG). A format for storing compressed
images. JPEG images were once supported by helper applications but are
now directly supported by nearly all browsers. JPEG is the best format for
most photographs. See GIF.

link. A connection between two documents on the Web, usually specified by
an anchor in an HTML document.

mirroring. Keeping a copy of data on additional servers to make data avail-
able more quickly and to a greater number of simultaneous users.

MP3 and MPEG. Formats created by the Motion Picture Experts Group (or
MPEG) for storing compressed sounds (MP3) and movies (MPEG). These files
can be played back by a variety of helper applications but are not directly
supported by browsers. See JPEG.
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multimedia. Literally means “many media,” and in this sense, a Web page
with graphics is multimedia. However, multimedia is usually understood to
mean either more than two types of media or, alternatively, time-based media
such as animation, sound, or video and space-based media such as 3-D and
virtual reality. On the Web, multimedia is also used to mean any extension of
the Web beyond the basics of text, hyperlinks, GIF graphics, and JPEG graph-
ics. Multimedia is beyond the basics, so it usually requires a special plug-in
or player to support it.

newsgroup. An ongoing exchange of electronic messages about a specific
topic, such as pets, restaurants, or Web authoring. To access newsgroups,
users must use special software called news reader software, which is avail-
able on the Web and also included as a feature of current browsers.

numbered list. See ordered list.

online service. Also referred to as a “traditional” or “proprietary” online
service to differentiate from the Internet, which is seen as an “open” online
service. Traditional online services, such as America Online and CompuServe,
package access and content into a single branded product. The Internet and
the Web have eroded the boundaries between online services by allowing
cross-service functionality, such as e-mail between subscribers of different
online services. The online service providers are further eroding these bound-
aries by offering Internet access, Web access, and Web-authoring support.

ordered list. A numbered list. A type of HTML list in which each item is given
a number, in sequence, when the list displays. The author of the list can rear-
range the items as needed, and the numbers adjust accordingly because the

numbers are assigned only when the list appears onscreen. See unordered list.

page-description language. A defined format for specifying the appearance
of a document when displayed or printed. Adobe’s PostScript, used by many
programs and in many laser printers, is a page-description language; it’s not a
structural markup language such as HTML or SGML.

pathname. A description of the location of a file. Pathnames can be specified
by absolute addressing or relative addressing.

plug-in. A small program that works with a Web browser to allow multimedia
files to be displayed in a Web page, or that otherwise extends the capabilities
of the browser.

protocol. An agreed-upon format for exchanging data, such as FTP (file-transfer
protocol).
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QuickTime. A multiplatform standard from Apple Computer, Inc., for multi-
media. See also multimedia, QuickTime plug-in, and QuickTime VR.

QuickTime plug-in. A plug-in for Firefox and Microsoft Internet Explorer that
supports user interaction with QuickTime and QuickTime VR content embed-
ded in a Web page. See also QuickTime and QuickTime VR.

QuickTime VR. A multiplatform standard for image-based virtual reality. See
also QuickTime and QuickTime plug-in.

relative address. The path from a base document, such as an HTML docu-
ment, to another document on the same computer, such as another Web
page on the same site. See also pathname and absolute address.

shareware. Software that can be used for free for a limited period of time,
after which the user is requested (though usually not forced) to pay a fee for
continued use. See freeware.

shrink-wrapped software. (No, this is not software developed and packaged by
psychiatrists.) Shrink-wrapped software is sold as a product and packaged
in a box (rather than offered as a download over the Internet); the user pays
up front before taking possession of the software. See also freeware and
shareware.

site management. Capabilities in a Web-authoring package that help authors
work on characteristics of an entire Web site, instead of just one page at a
time. Site-management capabilities include maintenance of links between
Web pages (and offering notification when links are no longer functional),
spell-checking, built-in uploading of Web pages to a server, and easy search
and replace across an entire site.

standard. An agreed-upon way to do something, such as building a computer
system (for example, the IBM-compatible standard) or exchanging data (for
example, the ASCII standard). Many different standards exist, ranging from
those created by a single manufacturer for its own purposes (the DOS standard)
to those created by internationally recognized standards bodies such as ISO
(the International Standards Organization). In other words, in computing, the
definition of standard is not very standard.

Standard Generalized Markup Language (SGML). A full-featured specifica-
tion for describing the content and structure of documents but not their
exact appearance when displayed. HTML is a subset of SGML.

syntax. A fee paid for moral or legal violations (no, wait, that’s a “sin tax”). In

computer languages and protocols, the syntax is the ordering of the elements
that make up the instructions to the computer, as with HTML.
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system operator (sysop). Pronounced “siss-op.” A person responsible for
some part of the operations of a computer system, including online services.
A sysop’s responsibilities can vary from the technical, such as backing up a
computer hard drive, to the nontechnical, such as monitoring a newsgroup
for inappropriate or irrelevant content and removing it if found.

tag. Part of an HTML document that contains information besides the actual
document content, such as formatting information or an anchor. For exam-
ple, the <b> tag starts bolding the characters that follow it, and the </b> tag
ends bolding. So to make a word or phrase bold, surround it with the <b>
and </b> tags.

text editor. A program that allows text to be entered and edited but not
formatted for display. Text editors save their files without proprietary for-
matting information, so the files are portable across different application pro-
grams and different computer systems. Examples are Notepad (Windows),
BBEdit (Macintosh), and vi (Unix).

thumbnail. A small graphical image that serves as a preview of a larger
image.

Transmission Control Protocol/Internet Protocol (TCP/IP). A communica-

tions protocol that was developed under contract from the U.S. Department
of Defense in the 1970s to connect different systems and different networks.
TCP/IP is the protocol on which the Internet is based.

transparent GIF. A file stored in Graphic Interchange Format and modified so
that one color — usually, the color of the area around the objects of interest —
is assigned transparency. This capability makes the rectangular frame around
the objects seem to disappear so that the graphic appears to float over the
page on which it appears.

Uniform Resource Locator (URL). A specification for identifying any file on
the Internet. The URL is made up of the name of the protocol by which the
file should be accessed, the name of the server that the file is stored on, and
the pathname of the file on the server. Here is a sample URL for an HTML file
named MyCruise, to be accessed by using the Web protocol http, which is
stored on a server called www.bigweb.com in the Travel directory:

http://www.bigweb.com/Travel /MyCruise.html

If no filename is given at the end of the path, a default file, typically index.
htm or index.html, is returned.

unordered list. A bulleted list. A type of HTML list in which each item is dis-
played next to a symbol such as a bullet.
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Web authoring. Creating documents for use on the World Wide Web. This
process includes creating text documents with HTML tags, as well as creating
or obtaining suitable graphics and sound or video files for inclusion in the
Web page — and putting them in.

Web browser. See browser.

Web client. A computer that connects to the World Wide Web and down-
loads Web pages and other data from it.

Web page. An online text document that uses HTML tags to specify format-
ting and includes links from the document to other content, including docu-
ments, graphics, and sound or video files.

Web publishing. The entire process of creating and maintaining a Web site,
from creating text documents with HTML tags and graphics, to putting the
documents on a server, to revising the documents over time.

Web server. A computer that connects to the World Wide Web and hosts
HTML-tagged text documents, graphics, and multimedia files to be down-
loaded by Web clients.

Web site. One or more linked Web pages accessed through a home page.
The URL of the home page is made available to users on other Web sites, and
often through other advertising and marketing means as well.

wiki. A Web site that can be cooperatively updated to capture the knowledge
of a number of people and share it — with the original authors and possibly
with others. The most famous example is Wikipedia (www.wikipedia.org),
an extensive and popular online encyclopedia maintained via modified wiki
principles.

word processor. A program for creating and editing text files with format-
ting. Files created by a word processor contain formatting codes and cannot
be used on the Web unless specifically saved in text-only or plain-text format,
without the proprietary codes that word processors embed in the file to indi-
cate formatting.

World Wide Web (also known as the Web). An Internet service that pro-
vides files from servers linked by Hypertext Transfer Protocol (HTTP). The
Web specification allows formatted text and graphics to be viewed directly
by a Web browser and allows other kinds of files to be opened separately by
helper applications specified in the Web browser’s setup. After e-mail, the
Web is the most popular Internet service, partly because it can also be used
to access other Internet services, such as newsgroups and FTP.
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Appendix B

A Quick Guide to HTML Tags

0ne of the best resources on the Web is The Bare Bones Guide to HTML.
At this writing, this excellent reference lists nearly all the tags in the
most widely supported version of HTML, Version 4.0, plus Netscape
extensions.

This site was developed and is maintained by Kevin Werbach, a Harvard Law
School graduate and former FCC attorney in Washington who has invested a
lot of time and thought in Web authoring. You can find out an awful lot about
Web authoring from the thoughts, resources, and examples on the Bare
Bones Guide home page at http://werbach.com/barebones.

The Bare Bones Guide lists tags from the different versions of HTML, with
notes describing which version of HTML a given tag supports. [ thought that
splitting the HTML tags into separate tables, organized by the version of
HTML they support, would help you zero in on the ones you need.

In the version of The Bare Bones Guide in this book, I include only HTML tags
from HTML versions through Version 4.0. For frames only, [ use HTML 4.0
tags; see Table B-26 at the end of this chapter. I do this because HTML 4.0
tags are the most commonly used by the broad range of Web pages and Web
browsers out there. The online version of The Bare Bones Guide to HTML lists
tags up to the current version of the HTML standard at the time that you
access the site.

The original The Bare Bones Guide to HTML, from which I adapted this ver-
sion, is copyrighted (©1995-2008) to Kevin Werbach. You can reproduce the
original, as long as you include this statement:

Copyright ©1995-2008 Kevin Werbach. Distribution is permitted, as long
as there is no charge and this document is included without alteration

in its entirety. This Guide is not a product of Bare Bones Software. More
information is available at http: //werbach. com/barebones.

For more on HTML, you may also want to visit the World Wide Web consor-

tium, the organization with the most responsibility for Web standards. A good
starting point is the HTML4 area at www.w3 .org/TR/html4/.

www.it-ebooks.info


http://www.it-ebooks.info/

2 76 Part Vl: Appendixes

WBER
“&
&

Just a few things to keep in mind about The Bare Bones Guide to HTML:

1 It’s not affiliated with Bare Bones Software, makers of the BBEdit text
editor for the Macintosh (www .barebones . com).

v 1 got Kevin’s permission to use it. And it’s everywhere (see the accom-
panying sidebar), but it’s handy to have in this book.

1+ HTML is not case-sensitive. You'll notice that Kevin uses UPPERCASE
characters in HTML tags. [ decided to use lowercase characters through-
out this book, in keeping with current HTML standards.

Versions of HTML

The tags in this table are part of the HTML 4.0 standard and are supported by
all up-to-date browsers. So if you aren’t worried about ancient history — in
Web terms, that’s anything that happened more than a year ago — and aren’t
worried about the stubborn few users of your Web pages who may still have
old browsers, you can ignore this section and go straight to the tables. But if
you really want to know the details, read on.

The versions of HTML I describe in this appendix are

v HTML 2.0: All browsers available today support this basic version
of HTML. However, some tags are interpreted differently by different
browsers. For example, a top-level heading, marked by an <H1> tag, may
be formatted somewhat differently in different browsers.

1 Netscape Navigator 1.0, 1.1: These early versions of Netscape Navigator
fueled the first huge surge in the growth of the Web. These were the first
browsers to provide support for centered text, floating graphics, and
colored text and backgrounds by using new “extensions” to HTML 2.0.
Other browsers and HTML 3.2 have adopted many of the features and
new tags introduced by Netscape in Netscape Navigator 1.0 and 1.1.

Twenty-two world languages
in The Bare Bones Guide

Online, you find versions of The Bare Bones German, Hebrew, Icelandic, Indonesian, Italian,
Guide in English in plain text, formatted text, Japanese, Korean, Norwegian, Portuguese,
and table versions, as well as translations into  Romanian, Russian (three versions), Slovenian,
additional languages: Chinese (two versions),  Spanish, Swedish, and Turkish.

Danish, Dutch, Estonian, Finnish, French,
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v HTML 3.2: This is a widely supported version of the HTML standard.
Many of the ideas originally included in the HTML 3.0 proposal, such
as tables and paragraph alignment, were first supported by Netscape
Navigator 1.0 and 1.1.

1 Netscape Navigator 2.0: This years-old used version of Netscape
Navigator implements a few minor features, plus a major one: frames,
which are specific areas within the browser window that contain differ-
ent content and can be updated separately.

v HTML 4.0 and later browser versions: HTML 4.0 is the latest standard-
ized version of HTML. It includes some features that were introduced
by Microsoft and Netscape in their own browsers. However, HTML 4.0
includes some complex features that are not consistently implemented
in current browser versions.

Over time, browsers are updated and improved to support a wider range of
tags. However, a few users still have the old version of their browser. So don’t
assume that just because a new version of a browser supports specific tags,
all users of that browser will upgrade and gain the ability to view those tags
correctly.

How to Use This Appendix

To use this appendix when creating your own pages, start with the first table,
a basic list of HTML 2.0- and HTML 3.2-compliant tags that work with almost
any browser. If you use only the tags in this list, your pages will be as widely
usable as possible. Then you can selectively spice up your pages by using
tags from the different sets of HTML extensions listed in the later tables. You
can also use this list to create separate versions of your pages: one version
for all browsers and another for browsers that support the specific exten-
sions that you use.

This appendix includes HTML tags that I did not discuss in the text of this
book. To find out more about a specific tag, experiment with it in your Web
text and your browser. If you need more information than you can get by
experimenting, buy a more advanced book on HTML, such as HTML 4 For
Dummies, 5th Edition, by Ed Tittel and others (Wiley).

www.it-ebooks.info


http://www.it-ebooks.info/

278 Part Vl: Appendixes
Reading the Tables

Within the tables you may see some tags that are not preceded by a dash,
followed by tags preceded by a dash, such as

Tag Name Tag Notes
Preformatted <PRE></PRE> Display text spacing as-is
- Width <PRE WIDTH=?></PRE> Width in characters

The tags with descriptions that start with a dash are actually options within
other tags. These optional tags modify the effect of the tag that they appear
with. You will always see the option listed with the tag that it modifies, so
that you can see how to use it in your own HTML-tagged text.

The use of the dash symbol to indicate optional tags and other symbols in
the tables are described in Table B-1.

Note: In order to align columns correctly, some tags are broken. At the points
that these tags break, I placed a downward, left-curving arrow (D) to
indicate the break.

Table B-1 Symbols Used in the Tables

Symbol Meaning

URL URL of an external file (or just filename if in the same
directory)

? Arbitrary number (for example, <H?> means <H1>, <H2>,
<H3>, and so on)

% Arbitrary percentage (for example, <HR WIDTH=%> means
<HR WIDTH=50%>, and so on)

i Arbitrary text (for example, AL T="***" means fill in with
text)

358558 Arbitrary hexadecimal number* (for example, BGCOLOR=

"#$5$$$$$ " means BGCOLOR="#00FF1C", and so on)

| Alternatives (for example,
ALIGN=LEFT |RIGHT | CENTER means pick one of these)

- Option An option within a tag

*For an explanation of hexadecimal numbering, see Appendix A.
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Widely Supported Tags

The tags in Table B-2 through Table B-10 are in all versions of HTML since 2.0
(in some cases) or 3.2 (in others) and should work in all browsers.

Table B-2 Generally All HTML Documents

Should Have These Tags
Tag Name Tag Notes
Document Type <HTML>< /HTML> Beginning and end of file
Title <TITLE></TITLE> Must be in header
Header <HEAD></HEAD> Descriptive info, such as title
Body <BODY></BODY> Bulk of the page
Table B-3 Structural Definition: Apearance Controlled

by the Browser's Preferences
Tag Name Tag Notes
Heading <H?></H?> The HTML 2.0 specifica-

tion defines six levels
Block Quote <BLOCKQUOTE> Usually indented </
BLOCKQUOTE>

Emphasis <EM></EM> Usually displayed as italic
Strong Emphasis <STRONG>< / STRONG> Usually displayed as bold
Citation <CITE></CITE> Usually italics
Code <CODE></CODE> For source code listings
Sample Output <SAMP></SAMP>
Keyboard Input <KBD></KBD>
Variable <VAR></VAR>
Author’s Address <ADDRESS></ADDRESS>
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Table B-4 Presentation Formatting: Author Specifies
Text Appearance
Tag Name Tag Notes
Bold <B>< /B>
Italic <I></I>
Typewriter <TT></TT> Displayed in a monospaced
font
Preformatted <PRE></PRE> Displays text spacing as-is
- Width <PRE WIDTH=?>,) Width in characters
/ PRE>
Table B-5 Links and Graphics
Tag Name Tag Notes
Link <A HREF="URL"></A>
Link to Target <A HREF="URL#***"></A> If in another document
<A HREF="#***">< /N> If in current document
Define Target <A NAME="***"></A>
Display Image <IMG SRC="URL">
- Alignment <IMG SRC="URL" ALIGNL) HTML 3.2 and beyond
=TOP | BOTTOM | MIDDLE| O only
RIGHT|LEFT>
- Alternate <IMG SRC="URL" ALT="***">
- Imagemap <IMG SRC="URL" ISMAP> Requires a script
Table B-6 Dividers
Tag Name Tag Notes
Paragraph <P> See Table B-14 for more info
Line Break <BR> A single carriage return
Horizontal Rule <HR> HTML 3.2 only
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Table B-7 Lists: Can Be Nested
Tag Name Tag Notes
Unordered List <UL><LI></UL> <LI> before each listitem
Ordered List <OL><LI></0L> <LI> before each listitem
Definition List <DL><DT><DD></DL> <DT> =term, <DD> = definition
Table B-8 Special Characters: Must All Be Lowercase
Tag Name Tag Notes
Special Character &#7?; Where ? is the 1SO 8859-1 code
for the character

< &lt;
> &gt;
& samp;

&quot;
Registered TM &reg;
Copyright &Copy;

See a complete list of special characters at www.bbsinc.com/symbol.html.

Table B-9  Forms: Generally Require a Script on Your Server

Tag Name Tag Notes
Define Form <FORM ACTION=,)

"URL" METHOD=GET |

POST></FORM>
Input Field <INPUT TYPE="TEXT| D

PASSWORD | CHECKBOX | D
RADIO | IMAGE |HIDDEN | O
SUBMIT |RESET">

- Field Name <INPUT NAME="***">
- Field Value <INPUT VALUE="***">
- Checked? <INPUT CHECKED> Check boxes and
radio buttons
- Field Size <INPUT SIZE=?> In characters
- Max Length <INPUT MAXLENGTH=?> In characters
Selection List <SELECT></SELECT>
(continued)
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Table B-9 (continued)

Tag Name Tag Notes
- Name of List <SELECT NAME="***">D)
</SELECT>
- # of Options <SELECT SIZE=?>
</SELECT>
- Multiple Choice <SELECT MULTIPLE> Can select more
than one
Option <OPTION> Items that can be
selected
- Default Option <OPTION SELECTED>
Input Box Size <TEXTAREA ROWS=? COLS=?>¢)
</TEXTAREA>
- Name of Box <TEXTAREA NAME="***">ccc
</TEXTAREA>
Table B-10 Miscellaneous
Tag Name Tag Notes
Comment <lo— Rkk > Not displayed by the
browser
Prologue <!DOCTYPE HTML)

PUBLIC"-//IETF// O
DTD HTML 2.0//EN">

URL of This File <BASE HREF="URL"> Must be in header

Relationship <LINK REV="***"1 In header
REL="***"HREF="URL" >

Meta Information <META> Must be in header

Other Widely Used Tags

The tags in Table B-11 through Table B-17 work with nearly all the browsers
currently in use. For a frequently updated list of widely used tags, see The
Bare Bones Guide to HTML at the URL listed at the beginning of this chapter.
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Table B-11 Structural Definition: Appearance Controlled
by the Browser's Preferences
Tag Name Tag Notes
- Align Heading <H? ALIGN=LEFT|D HTML 3.2 Option
CENTER | RIGHT></H?> within the HTML
2.0-compliant
Heading tag
Division <DIV></DIV> HTML 3.2
- Align Division <DIV ALIGN=LEFT|D HTML3.2
RIGHT | CENTER |
JUSTIFY></DIV>
Large Font Size <BIG></BIG> HTML 3.2
Small Font Size <SMALL></SMALL> HTML 3.2

Table B-12 Presentation Formatting: Author
Specifies Text Appearance

Tag Name Tag Notes

Subscript <SUB></SUB> HTML 2.0

Superscript <SUP></SUP> HTML 2.0

Center <CENTER></CENTER> Netscape 1.0. widely
implemented; for both
text and images

Table B-13 Links and Graphics

Tag Name Tag Notes

Dimensions <IMG SRC="URL" D HTML 3.2. Image

WIDTH= "?" HEIGHT=D
n ? n >

width and heightin
pixels
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Table B-14 Dividers
Tag Name Tag Notes
Paragraph <P></P> HTML 3.2. Paragraph tag, <P>,

redefined as a container tag,
< /P> is optional

- Align Text <P HTML 3.2
ALIGN=LEFT| D
CENTER |RIGHT | O

JUSTIFY></P>

- No Line Breaks <P NOWRAP></P> Internet Explorer only

Table B-15 Backgrounds and Colors

Tag Name Tag Notes

Tiled Background <BODY BACKGROUND=) HTML 3.2
IIURL ll>

Background Color <BODY BGCOLOR=) HTML 3.2. Color order,
"HSSSSSS > red/green/blue

Text Color <BODY TEXT=¢) HTML 3.2. Color order,
"HSSSSSS > red/green/blue

Link Color <BODY LINK=,) HTML 3.2. Color order,
"HSSSSSS > red/green/blue

Active Link <BODY ALINK=,) HTML 3.2. Color order,
THSSSSSS > red/green/blue

Visited Link <BODY VLINK=,) HTML 3.2. Color order,
THSESSSSS > red/green/blue

You can find more info at www.werbach.com/web/wwwhelp.html.

Table B-16 Tables

Tag Name Tag Notes

Define Table <TABLE></TABLE> HTML 3.2

- Table Border <TABLE BORDER>) HTML 3.2. Either on or off
</TABLE>

- Table Border <TABLE BORDER>J) HTML 3.2. Can set the
</TABLE> border width in pixels
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Tag Name Tag Notes
-Cell Spacing <TABLE CELLSPACING=?> HTML 3.2
- Cell Padding <TABLE CELLPADDING=?> HTML 3.2
- Desired Width <TABLE WIDTH=?> HTML 3.2. In pixels
- Width Percent <TABLE WIDTH=%> HTML 3.2
Percentage of page
Table Row <TR></TR> HTML 3.2
- Alignment <TR ALIGN=LEFT|RIGHT|  HTML32
CENTER | JUSTIFY
VALIGN=TOP| D
MIDDLE | BOTTOM>
Table Cell <TD></TD> HTML 3.2. Must
appear within table
rows
- Alignment <TD ALIGN=LEFT| D HTML 3.2
RIGHT| CENTERJ
VALIGN=TOP |MIDDLE |
BOTTOM>
- No Line Breaks <TD NOWRAP> HTML 3.2
- Columns to Span <TD COLSPAN=?> HTML 3.2
- Rows to Span <TD ROWSPAN=?> HTML 3.2
- Desired Width <TD WIDTH=?> HTML 3.2. In pixels
- Width Percent <TD WIDTH=%> HTML 3.2

Percentage of table

- Desired Height

<TD HEIGHT=?>

HTML 3.2. In pixels

- Height Percent

<TD HEIGHT=%>

HTML 3.2
Percentage of page

Table Header

<TH></TH>

HTML 3.2. Same as
data, except bold

centered
- Alignment <TH ALIGN=LEFT|RIGHT|)  HTML32
CENTER | JUSTIFY |CHAR.
VALIGN=TOP| O
MIDDLE | BOTTOM>
- No Line Breaks <TH NOWRAP> HTML 3.2
- Columns to Span <TH COLSPAN=?> HTML 3.2
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Table B-16 (continued)

Tag Name Tag Notes

- Rows to Span <TH ROWSPAN=?> HTML 3.2

- Desired Width <TH WIDTH=?> HTML 3.2. In pixels
- Width Percent <TH WIDTH=%> HTML 3.2.

Percentage of table

- Desired Height

<TH HEIGHT=?>

HTML 3.2. In pixels

- Height Percent

<TH HEIGHT=%>

HTML 3.2.
Percentage of page

Table Caption

<CAPTION></CAPTION>

HTML 3.2

- Alignment <CAPTION ALIGN=TOP|D HTML 3.2. Above/
BOTTOM> below table
Table B-17 Miscellaneous
Tag Name Tag Notes
Script <SCRIPT></SCRIPT>
- Location <SCRIPT SRC="URL"></
SCRIPT>
- Type <SCRIPT TYPE="***"></
SCRIPT>
- Language <SCRIPT LANGUAGE="**%*">
</SCRIPT>
Java Applet <APPLET> HTML 3.2
- Applet Name <APPLET NAME="***"> HTML 3.2
- Alternate Text <APPLET ALT="***"> HTML 3.2
- Applet Code <APPLET CODE="URL"> HTML 3.2
Location
- Code Base <APPLET CODEBASE="URL"> HTML 3.2
Directory
- Applet Window <APPLET HEIGHT=?> HTML 3.2. In pixels
Height
- Width <APPLET WIDTH=?> HTML 3.2. In pixels

- Horizontal Offset

<APPLET HSPACE=7?>

HTML 3.2. In pixels
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Tag Name Tag Notes
- Alignment <APPLET HTML 3.2
ALIGN=[left]|D
right|top| L
middle|bottom]>
Applet Parameter <PARAM> HTML 3.2
- Parameter Name, <PARAM NAME="applet HTML 3.2
Value name", VALUE="
parameter value">
3.2 Prologue <!DOCTYPE HTML HTML 3.2

PUBLIC"- //W3C//DTD
HTML3.2 FINAL//EN">

Less Frequently Used Tags

Some Netscape Navigator-only tags were slow to be adopted by non-Netscape
browsers. However, most of the tags in Table B-18 through Table B-26 can be
used with up-to-date browsers. HTML 4.0-specific tags are only supported by
relatively recent browsers.

Table B-18 Structural Definition: Appearance Controlled
by the Browser's Preferences

Tag Name Tag Notes

Defined Content <SPAN></SPAN> HTML 4.0

Quote <Q></Q> HTML 4.0. For short
quotations

- Citation <Q CITE="URL"></Q> HTML 4.0

Insert <INS></INS> HTML 4.0. Marks
additions in a new
version

- Time of Change <INS DATETIME=":::"></ HTML 4.0

INS>
- Comments <INS CITE="URL"></INS> HTML 4.0
Delete <DEL></DEL> HTML 4.0. Marks

deletions in a new
version
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Table B-18 (continued)

Tag Name Tag Notes
- Time of Change <DEL DATETIME=":::"> HTML 4.0
</DEL>
- Comments <DEL CITE="URL"> HTML 4.0
</DEL>
Acronym <ACRONYM>< /ACRONYM> HTML 4.0
Abbreviation <ABBR></ABBR> HTML 4.0
Table B-19 Presentation Formatting: Author Specifies
Text Appearance
Tag Name Tag Notes
Blinking <BLINK></BLINK> Navigator 1.0. Most
derided tag ever
Font Size <FONT SIZE=?>¢) HTML 3.2. Ranges from 1-7
</FONT>
Change Font Size <FONT SIZE=+]|-?>¢) HTML 3.2
</FONT>
Base Font Size <BASEFONT SIZE=?> HTML 3.2. From 1-7;
defaultis 3
Font Color <FONT COLOR=. HTML 3.2
"#SSSSSS "> </FONT>
Underline <U></U> HTML 2.0
Strikeout <S></S> HTML 2.0
Select Font <FONT FACE="***"> HTML 4.0
</FONT>
Table B-20 Links, Graphics, and Sounds
Tag Name Tag Notes
- Target Window <A HREF="URL" D HTML 4.0
TARGET="***"></A>
Action on Click <A HREF="URL" D HTML 4.0

ONCLICK="***"></A>

Mouseover Action <A HREF="URL" HTML 4.0
ONMOUSEOVER="***">< /A>
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Tag Name

Tag

Note

Mouseover Action

<A HREF="URL" QD
ONMOUSEQUT="***">< /A>

HTML 4.0

- Alignment <IMG SRC="URL"QD Navigator 1.0.
ALIGN= LEFT|RIGHT| D Option within the
TEXTTOP | ABSMIDDLE | O HTML 2.0-compliant
BASELINE| ABSBOTTOM> Display Image tag
- Image Map <IMG SRC="URL" HTML 3.2. Option
USEMAP="URL"> within the HTML
2.0~compliant
Display Image tag
- Map <MAP NAME="***">D) HTML 3.2. Describes
</MAP> the map. Option
within the HTML
2.0-compliant
Display Image tag
- Section <AREA SHAPE="RECT" HTML 3.2. Option
COORDS="#, #, #, "HREF=) within the HTML
"URL" | NOHREF> 2.0~compliant
Display Image tag
- Border <IMG SRC="URL" HTML 3.2

BORDER="?>

Runaround Space

<IMG SRC="URL"QD
HSPACE= ? VSPACE=?>

HTML 3.2. In pixels

Low-Res Proxy

<IMG SRC="URL"J
LOWSRC= "URL">

N1.1 Client Pull <META HTTP-EQUIV=,) HTML 2.0
"Refresh" CONTENT=
"?; URL=URL">
Embed Object <EMBED SRC="URL"> Navigator 2.0. Insert
object into page
- Object Size <EMBED SRC="URL"Q Navigator 2.0,
WIDTH ="?" HEIGHT=,) Internet Explorer
n ? n >
Object <OBJECT></0OBJECT> Navigator 4.0
Parameters <PARAM> Navigator 4.0
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Table B-21

Dividers

Tag Name

Tag

Notes

- Clear Text Wrap

<BR CLEAR=LEFT|
RIGHT |ALL>

HTML 3.2. Option within
the HTML 2.0—~compliant
Line Break tag

- Alignment

<HR ALIGN=LEFT|D
RIGHT | CENTER>

HTML 3.2. Option within
the HTML 2.0—compliant
Horizontal Rule tag

- Thickness

<HR SIZE=7?>

HTML 3.2. In pixels. Option
within the HTML 2.0-com-
pliant Horizontal Rule tag

- Width

<HR WIDTH=?%>

HTML 3.2. In pixels. Option
within the HTML 2.0-com-
pliant Horizontal Rule tag

- Width Percent

<HR WIDTH=?%>

HTML 3.2. As a percent-
age of page width. Option
within the HTML 2.0-com-
pliant Horizontal Rule tag

- Solid Line <HR NOSHADE> HTML 3.2. Without the 3-D
cutout look. Option within
the HTML 2.0—-compliant
Horizontal Rule tag

No Break <NOBR>< /NOBR> Navigator 1.0. Prevents
line breaks

Word Break <WBR> Navigator 1.0. Where to
break a line if needed

Table B-22 Lists: Can Be Nested

Tag Name Tag Notes

- Bullet Type <UL TYPE=DISC|
CIRCLE| SQUARE>

HTML 3.2. For the whole

list. Option within the HTML
2.0-compliant Unordered List
tag

<LI TYPE=DISC|
CIRCLE| SQUARE>

HTML 3.2. This and subsequent
list items. Option within the
HTML 2.0—-compliant Unordered
List tag
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Tag Name Tag Notes
- Numbering <OL TYPE=A|a|I|i|l> HTML 3.2. This and subsequent
Type list items. Option within the
HTML 2.0—-compliant Ordered
List tag
<LI TYPE=Al|a|I|i|l> HTML 3.2. This and subsequent
list items. Option within the
HTML 2.0-compliant Ordered
List tag
- Starting <OL START=?> HTML 3.2
Number
- Count <OL VALUE=?> HTML 3.2 For the whole list.
Option within the HTML
2.0-compliant Ordered List tag
Table B-23 Forms: Generally Require a CGl
Script on Your Server
Tag Name Tag Notes
- File Upload <FORM ENCTYPE=)) HTML 4.0
"multi part/form-O
data"></FORM>
- Wrap Text <TEXTAREA WRAP=OFF | HTML 2.0
VIRTUAL | PHYSICAL>.)
</TEXTAREA>
Button <BUTTON></BUTTON> HTML 4.0
- Button Name <BUTTON NAME="****">") HTML 4.0
</BUTTON>
- Button Type <BUTTON HTML 4.0
TYPE="SUBMIT| O
RESET | BUTTON" >
</BUTTON>
- Default Value <BUTTON VALUE="****"> 1 HTML 4.0
</BUTTON>
Label <LABEL></LABEL> HTML 4.0
- Item Labeled <LABEL FOR="***x">") HTML 4.0
</LABEL>
Option Group <OPTGROUP LABEL="****"> 1) HTML 4.0
</OPTGROUP>
(continued)
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Table B-23 (continued)

Tag Tag Names Notes
Group Elements <FIELDSET></FIELDSET> HTML 4.0
Legend <LEGEND></LEGEND> HTML 4.0.
Caption for
fieldsets
- Alignment <LEGEND HTML 4.0
ALIGN="TOP| D
BOTTOM | LEFT | O
RIGHT"></LEGEND>
Table B-24 Tables
Tag Name Tag Notes
- Table Alignment <TABLE ALIGN=LEFT | HTML 4.0
RIGHT | CENTER>
- Table Color <TABLE HTML 4.0
BGCOLOR="$$$$88"> D
</TABLE>
- Table Frame <TABLE FRAME=VOID| D HTML 4.0
ABOVE | BELOW | HSIDES | O
LHS | RHS | VSIDES | BOX | O
BORDER></TABLE>
- Table Rules <TABLE HTML 4.0
RULES=NONE | GROUPS | O
ROWS | COLS | ALL></TABLE>
- Desired Width <TD WIDTH=?> HTML 4.0. In pixels
- Cell Color <TD BGCOLOR="#$$3$58%"> HTML 4.0
- Desired Width <TH WIDTH=?> HTML 4.0. In pixels
- Cell Color <TH BGCOLOR="#$$$58%"> HTML 4.0
Table Body <TBODY> HTML 4.0
Table Footer <TFOOT></TFOOT> HTML 4.0. Must
come before
<THEAD>
Table Header <THEAD></THEAD> HTML 4.0
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Tag Name Tag Notes

Column <COL></COL> HTML 4.0. Groups
column attributes

- Columns Spanned <COL SPAN=?></COL> HTML 4.0

- Column Width <COL WIDTH=?></COL> HTML 4.0

- Width Percent <COL WIDTH="%"></COL> HTML 4.0

Group columns

<COLGROUP></COLGROUP>

HTML 4.0. Groups
column structure

- Columns Spanned ~ <COLGROUP SPAN=?>) HTML 4.0
</COLGROUP>

- Group Width <COLGROUP WIDTH=?>¢) HTML 4.0
</COLGROUP>

- Width Percent <COLGROUP WIDTH="%">) HTML 4.0

</COLGROUP>

Table B-25 Frames: Define and Manipulate Specific
Regions of the Screen
Tag Name Tag Notes
Frame <FRAMESET></FRAMESET> HTML 4.0. Instead of
Document <BODY>
- Row Heights <FRAMESET ROWS=,) HTML 4.0. Pixels or
#,#,#,> </FRAMESET> percent
- Row Heights <FRAMESET ROWS=*>) HTML 4.0. * = relative
</FRAMESET> size
- Column <FRAMESET COLS=,) HTML 4.0. Pixels or
Widths #,#,4,> </FRAMESET> percent
- Column <FRAMESET COLS=*>) HTML 4.0. * = relative
Widths </FRAMESET> size
- Borders <FRAMESET FRAMEBORDER= HTML 4.0
"ves | no..:)
</FRAMESET>
- Border Width <FRAMESET BORDER=?,) HTML 4.0

</FRAMESET>
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Table B-25 (continued)

Tag Name Tag Notes
- Border Color <FRAMESET ORDERCOLOR= HTML 4.0
Wk ok kkkkn :)
</FRAMESET>
Define Frame <FRAME> HTML 4.0. Contents of

an individual frame

- Display <FRAME SRC="URL"> HTML 4.0

Document

- Frame Name <FRAME NAME="***" | HTML 4.0
_blank |_self|O
_parent|_top>

- Margin Width <FRAME MARGINWIDTH=?> HTML 4.0. Left and

right margins

- Margin Height <FRAME O HTML 4.0. Top and
MARGINHEIGHT=?> bottom margins

- Scroll bar? <FRAME SCROLLING=) HTML 4.0
"YES |NO|AUTO">

- Not Resizable <FRAME NORESIZE> HTML 4.0

Borders <FRAME HTML 4.0
FRAMEBORDER="vyes |no">

Border Color <FRAME HTML 4.0

BORDERCOLOR="#$55$5%">

Inline Frame <IFRAME></IFRAME> HTML 4.0. Takes
same attributes as
FRAME
Dimensions <IFRAME WIDTH=? HTML 4.0
HEIGHT=?></IFRAME>
Dimensions <IFRAME WIDTH="%" HTML 4.0
HEIGHT="%"></IFRAME>
Unframed <NOFRAMES></NOFRAMES> HTML 4.0 For non-
Content frames browsers

Note: Frame tags introduced prior to HTML 4.0 are not supported by all browsers.
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Table B-26 Miscellaneous

Tag Name Tag Notes

- Prompt <ISINDEX PROMPT=g) HTML 2.0. Text to
kK prompt input

Base Window Name

<BASE TARGET="***">

HTML 2.0. Must be

in header
Other Content <NOSCRIPT></ HTML 4.0. If scripts
NOSCRIPT> not supported
Base Window Name <BASE TARGET="***"> HTML 4.0. Must be
in header

Bidirect Off

<BDO DIR=LTR|RTL>
</BDO>

HTML 4.0. For cer-
tain character sets
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Appendix C
About the CD-ROM

In This Appendix
System requirements
Using the CD with Windows
What you'll find on the CD
Troubleshooting

Tlis handy appendix gets you started using the book’s CD to create and

improve your Web site (which is, after all, why you got the book, right?).
You'll find system requirements, installation instructions, and an overview of
the CoffeeCup trial software included on the disc. Enjoy! (Well, okay, install.)

System Requirements

Make sure that your computer meets the minimum system requirements
shown in the following list. If your computer doesn’t match up to most of
these requirements, you may have problems using the software and files on
the CD. For the latest and greatest information, please refer to the ReadMe
file located at the root of the CD-ROM.

v A PC running Microsoft Windows

v An Internet connection

v A CD-ROM drive
If you need more information on the basics, check out these books pub-
lished by Wiley Publishing, Inc.: PCs For Dummies by Dan Gookin, as well as

Windows XP For Dummies and Windows Vista For Dummies, both by Andy
Rathbone.
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Using the CD

To install the items from the CD to your hard drive, follow these steps:

1. Insert the CD into your computer’s CD-ROM drive.
The license agreement appears.

Note to Windows users: The interface won’t launch if you have autorun
disabled. In that case,

a. Choose Start=>Run.
For Windows Vista, choose Start=>All Programs=>Accessories=>Run.
b. In the dialog box that appears, type D:\Start.exe.

Replace D with the proper letter if your CD drive uses a different
letter. If you don’t know the letter, see how your CD drive is listed
under My Computer.

c. Click OK.

2. Read through the license agreement and then click the Accept button
if you want to use the CD.

The CD interface appears. The interface allows you to browse the con-
tents and install the programs with just a click of a button (or two).

What Vou'll Find on the CD

\NG/
g““

Well, if you hold it up to the light at an angle, you’ll see lovely rainbow patterns
on the surface . . . oh, you want to know what files you'll find on the CD after
you put it in your computer’s CD or DVD drive? Okay, then, here goes.

The CD holds three very useful programs from the nice people at CoffeeCup
Software: HTML Editor, Visual Site Designer, and Website Color Schemer.

These three programs are described in some detail in Part IV, which steps
you through creating your Web site in CoffeeCup software. What follows is
a brief description of each program to help you make up your mind as to
whether you want to install one, two, or all three of them.

These programs are Windows-only. If you have a Macintosh (or a Linux box, for
that matter), you’ll have to use something else that supports Windows. I'm
sorry not to have Mac tools here, but the market for low-cost Mac tools is very
slender — partly because there are fewer Macs (I know, more all the time),

but also because so many Mac users already have a higher-priced tool. One
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strong alternative is the online suite that Apple offers, for a small price, to Mac
owners. Another favorite you may want to check out is BBEdit, at www.bare
bones. comn.

Now for a word about CoffeeCup Software, which is one of the cooler
Windows-only software companies around. There has been ongoing upheaval
in the world of free or inexpensive Web-page creation software, chronicled
over the many editions of Creating Web Pages For Dummies going back more
than ten years. I even skipped including a CD in the previous edition of the
book (call it sheer exhaustion).

That’s because my horses kept getting shot out from under me, to use a
metaphor from Westerns. FrontPage Express, for example — a nice little free
program from Microsoft — disappeared. Netscape Navigator became Mozilla,
then Firefox, losing Web-authoring capability along the way. Even a program
whose creation was led by a former Apple coworker of mine, and that [ wrote
a whole book about — Pagemill — was hoovered up by Adobe, and then dis-
appeared.

Most Web page authors have been affected by these changes. Microsoft
FrontPage, the most popular Web page creation tool ever, was often avail-
able for US$100 or so. It’s now been pulled from the market, replaced with
Microsoft Expression Web — a much more powerful but more complicated
tool that costs hundreds of dollars, and that’s part of a suite that costs sev-
eral times more.

About CoffeeCup

All this time, CoffeeCup has been making good software, steadily improving
it, listening to users, and ending up with what is now widely considered great
software. True techies, yet customer-friendly, they create tools they’d like to
have, buff them up to make them into products, release them to users, then
steadily upgrade them.

Again it’s like a Western: When the smoke clears, they are among the last
ones standing with capable, easy-to-use, sensible tools that do what the vast
majority of us need, plus some nice extras that are bundled into the main
tools, offered separately, or both.

CoffeeCup combines highly rated software with good technical support and
great licensing terms. You can use any of their programs for free for several
weeks, and then pay a reasonable fee to buy them permanently. And that
really does mean forever — once you pay to make the program your own,
you get free upgrades for life! (No, I don’t work for CoffeeCup. But their soft-
ware sure serves the purposes of this book.)
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The three programs included on the CD are just a few of the many made by
CoffeeCup, all of which share free trial versions, a reasonable purchase price,
and lifetime free upgrades.

To learn more about the company and to see the latest versions of CoffeeCup
programs, visit their Web site at www.coffeecup.com.

However, you should try using the program versions on this book’s CD first.
Why? Well, for openers, they have a longer free licensing period than the
versions available online. And the CD versions exactly match the figures and
instructions in the book, so you don’t have to figure out why and how things
look different (because they won't).

The standalone Web Site Color Schemer even comes with a long free licens-
ing period. Then, when you reach the end of that time frame, you get a code
to use. The code converts a downloaded, new version of Web Site Color
Schemer to a fully paid-for one, at no cost to you.

CoffeeCup HTML Editor

CoffeeCup HTML Editor combines two tools that work together like two
sides of a coin. The Code Editor allows you to write “pure” HTML while using
menus and toolbar buttons. It organizes and “pretties up” your HTML code, a
real boon when you set a page aside for a while, then have to come back to it
and figure out what’s going on.

At any point, you can switch to the Visual Editor. This lets you work in a ver-
sion of what your Web page will look like when it’s actually published, just
like a word processor does for your printed documents. Changes you make in
one Editor automatically appear in the other.

CoffeeCup HTML Editor even includes CSS support, an advanced feature
which, among other good effects, pulls even old greybeards like myself kick-
ing and screaming into the modern era. (And me kicking and screaming is not
a pretty site — pun intended.)

CoffeeCup HTML Editor draws positive reviews from the big magazines and
Web sites, including from reviewers who actually know how to use Microsoft
Expression Web, Dreamweaver, and such — as well as glowing user com-
ments year in and year out. Its customers include a wide range of people who
want to stay close to their code but still be productive, without spending a
lot of money — all of which describes a large and growing range of people.
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CoffeeCup Uisual Site Designer

CoffeeCup Visual Site Designer breaks the user’s dependency on pure HTML.
It lets you design a page using drag and drop and free-form text entry. It cre-
ates nicely formatted, sensible HTML behind the scenes — but doesn’t let
you edit it directly in the tool like the CoffeeCup HTML Editor does.

CoffeeCup Visual Site Designer includes Web site templates, graphics, page
backgrounds, and more. It really makes it easy to create a polished Web page.

This book emphasizes staying close to the code, at least while you're learning.
But Visual Site Designer is another big step in productivity and only a small
step away from the code.

What you can do, and how you do it, are still determined by the capabilities of,
and even the spirit behind HTML. You can always bring the HTML code into a
text editor or CoffeeCup HTML Editor and give it a good, long working over.

CoffeeCup Color Schemer

CoffeeCup Color Schemer was probably created by one of the talented Web
programming gurus at CoffeeCup in about, well, two cups of coffee. Then, of
course, it’s been gradually improved until it’s a powerful, flexible tool that
just about anyone can both use and have fun with.

CoffeeCup Color Schemer lets you build a Web site design using any color on
the famous color wheel (of millions of colors) along with colors you “pick”
from any graphic on your computer’s screen, including, amazingly, icons on
your desktop. And it shows you what the colors look like in combination.

Color Schemer is one of the few tools out there that gives an ordinary Web
user-turned-site-designer a fighting chance of actually creating a decent-
looking Web page from colors you select yourself.

Color Schemer is built into CoffeeCup HTML Editor, so you don’t need to
download Color Schemer if you use the HTML Editor.

But if you don’t use the other tools, Color Schemer is a standalone tool worth
having, even if — especially if — you’re a purist who works in straight HTML
typed into a text editor. (Or chiseled into solid rock with a hammer and a die-
punch, if a text editor isn’t basic enough for you.)
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Troubleshooting

[ tried my best to pull together programs that work on most computers with
the minimum system requirements. Alas, your computer may differ, and
some programs may not work properly for some reason.

The two likeliest problems are that you don’t have enough memory (RAM)
for the programs you want to use, or you have other programs running that
are affecting installation or running of a program. If you get an error message
such as Not enough memory or Setup cannot continue, try one or
more of the following suggestions, and then try using the software again:

v Turn off any antivirus software running on your computer. Installation
programs sometimes mimic virus activity and may make your computer
incorrectly believe that it’s being infected by a virus.

v Close all other running programs. The more programs you have run-
ning, the less memory is available to other programs. Installation
programs typically update files and programs; so if you keep other pro-
grams running, installation may not work properly.

+* Have your local computer store add more RAM to your computer. This
is, admittedly, a drastic and somewhat expensive step. However, adding
more memory can really help the speed of your computer and allow
more programs to run at the same time.

Customer Care

If you have trouble with the CD-ROM, please call Wiley Product Technical
Support at 800-762-2974. Outside the United States, call 1-317-572-3993. You
can also contact Wiley Product Technical Support at http://support.
wiley.com. Wiley Publishing will provide technical support only for instal-
lation and other general quality control items. For technical support on the
applications themselves, consult the program’s vendor or author.

To place additional orders or to request information about other Wiley
products, please call 877-762-2974.
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$$$$$$ symbol, 278
% symbol, 278

*** symbol, 278

? symbol, 278

| symbol, 278

“tag (HTML), 281
& tag (HTML), 281
< tag (HTML), 281

> tag (HTML), 281
56K, 265

o/ ] o
Abbreviation tag (HTML), 288
absolute address, 265
access speed, 27, 105-106
account registration (Google), 52-55
accuracy, in Web writing, 65
Acronym tag (HTML), 288
Action on Click tag (HTML), 288
Active Link tag (HTML), 284
ActiveX, 23, 265
Add note feature (Flickr), 116
address
absolute, 265
e-mail, as Web site name, 51
relative, 271
on World Wide Web, 11-12. See also URLs
Adobe, 299
Adobe Illustrator, 103
adult content. See also offensive content
flagging, 117
on Flickr, 111
on MySpace, 23, 130
on YouTube, 23
advertising
on Blogger, 78
and frames, 47
and Google Page Creator, 51
on YouTube, 136

AIFF format, 122
AJAX (Asynchronous JavaScript and XML),
50, 258
Albion (Web site), 253
Align Heading tag (HTML), 283
Alignment tag (HTML), 289, 290
ALT tags, 108, 251
alt text, 183, 227, 251
AltaVista, 103
America Online. See AOL
anchor(s)
described, 211, 241
destination, 193, 239
HTML tags for, 220
internal, 195
source, 193, 239
Andreessen, Marc, 95
AngelFire, 42
animated GIF, 265
Annenberg School for Communication, 67
AOL (America Online)
about, 11
Hometown area of, 38, 42, 76
hosting pages on, 256
testing pages on, 13
appearance (of Web site), 24, 25
Apple, 257
Apple QuickTime, 125
Applet Parameter tag (HTML), 287
3.2 Prologue tag (HTML), 287
Parameter Name, Value tag (HTML), 287
applets, 269
artifact (of image), 102
Asynchronous JavaScript and XML. See
AJAX
attractiveness (Web site), 31-32. See also
Web page design
attribute, 265
Audacity (program), 129
audience(s)
considering your, 249
foreign, 249
for Web publishing, 28, 247-248
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authoring, Web, 273
Author’s Address tag (HTML), 279

ol e
background, HTML tags for, 284
Background Color tag (HTML), 284
The Bare Bones Guide to HTML (Web site),
275-276
Base Font Size tag (HTML), 288
Base Window Name tag (HTML), 295
BATCS (Web site), 20, 21, 46
BBEdit (Web site), 73, 299
begin tag (HTML), 166, 212
“behind the firewall,” 20
Berners-Lee, Tim, 15, 268
betas, 49-50
bgsound command, 123-125
bgsound HTML tag, 185, 187, 230, 231
Bidirect Off tag (HTML), 295
Blinking tag (HTML), 288
Block Quote tag (HTML), 279
blog burnout, 77
Blogger Help, 88
Blogger Help Group, 88
Blogger.com
adding content with, 84-88
downloading photos to, 117
hosting pages on, 257
setting up blog with, 78-84
bloggers, 64
Bloggersblog, 76
blogosphere, 74
blogs
adding content to, 84-88
adding photos to, 117
described, 19, 63-64, 261, 265
finding, to read, 75-76
places to host, 257
setting up, 78-84
software to write, 76
time commitment for, 77
on topical/business sites, 19
BMP (BitMaP) format, 98, 101, 179, 223
Body tag (HTML), 166, 212, 213, 279
Bold tag (HTML), 280
bold text (in HTML), 68

Border tag (HTML), 289
borders
for images, 183, 227
of tables, 44, 45
Borders tag (HTML), 294
BritBlog.com, 77
broadband service, 27, 90, 266
Broadcast Options feature (YouTube), 144
Brownie camera, 90
browser(s)
checking pages on multiple, 252
defined, 10, 266
and HTML tags, 277
player applications for, 180, 224
popular, 28
as requirement, 2
buffering, 135
Building Web Sites All-in-One Reference For
Dummies (Doug Sahlin and Claudia
Snell), 33
Bullet Type tag (HTML), 290
bulleted lists, 171, 217, 266
business Web sites
described, 20-22
goals of, 24
as models, 42
and rights to images, 111
Button tag (HTML), 291
Button Name tag (HTML), 291
Button Type tag (HTML), 291
Default Value tag (HTML), 291

oo

cable modem, 266
camera

digital, 104

Web, 142, 147
capitalization (in filenames), 243
careers, Web-related, 24
Cascading Style Sheets (CSS), 69, 266
case sensitivity (of filenames), 243
CD-ROM (included with book)

contents, 298-299

installing, 298

system requirements, 297
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technical support for, 302
troubleshooting, 302
using, 298
Cell Color tag (HTML), 292
cellphone. See also mobile phones
as camera, 104
and the Web, 28
Center tag (HTML), 283
CERN, 15
CGI (Common Gateway Interface) script,
154, 205, 266
Change Font Size tag (HTML), 288
character formatting, 167-168, 214-215
characters, special, 281
Citation tag (HTML), 279
Clear Text Wrap tag (HTML), 290
clickable image map, 266
client, Web, 273
clip art, 102
closing off HTML tags, 218
cloud computing, 50
Code tag (HTML), 279
CoffeeCup Code Editor, 152
CoffeeCup Color Schemer, 301-302
CoffeeCup HTML Editor
about, 4-5, 152
adding sound with, 186-187
adding video with, 187-188
advantages and disadvantages of,
154-155
creating external links with, 176-177
creating internal links with, 194-195
creating mailto links with, 191-193
creating text navigation bar with, 196-198
formatting text with, 168-169
inserting tables in, 46
linking to images with, 182-184
lists in, 172-174
using, 156-159
CoffeeCup software
about, 153, 299-301
advantages of, 174-175
CoffeeCup Visual Editor, 152
CoffeeCup Visual Site Designer, 301
color(s)
and consistency, 37
HTML tags for, 284
and links, 69, 170

standard, 39

tool for selecting, 301-302

Web-safe, 39, 92
Column tag (HTML), 293

Column Width tag (HTML), 293

Columns Spanned tag (HTML), 293

Width Percent tag (HTML), 293
Comment tag (HTML), 282
comments

as feedback, 249, 253

in HTML, 166, 213

on YouTube, 145
commericial Web sites, 20-22
Common Gateway Interface script. See CGI
communication, via computer, 1
compression

described, 266

of GIF and JPEG files, 102

of images, 91-102

of photos, 18

of sound, 122

of video, 133-134
condensing (of text), 70-71
confidential information, 21
consistency, in design, 37
Consumer Product Safety Commission, 135
contact information, 248
“Contact Us” links, 191, 237
content

adding, to blogs, 84-88

adult, 23, 111, 117, 130

copyrighted, 249-250

developing, 262

on entertainment Web sites, 22

offensive, 23, 249, 253

permission to use, 74, 249-250

updating, 254
content pages, 34
contributors, 261
copies, working from, 260
copyright

of content, 73-74, 249-250

for graphics, 97, 105

for HTML, 212

of images, 111

and MySpace, 131

and video, 139, 140
copyright notices, 248
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Copyright tag (HTML), 281 Dimensions tag (HTML), 283, 294
Count tag (HTML), 291 Display Image tag (HTML), 280
Creating Web Graphics For Dummies (Peter Alignment tag (HTML), 280
Frazier, Bud Smith), 89, 92 Alternate tag (HTML), 280
criticism, as feedback, 253 Imagemap tag (HTML), 280
CSS (Cascading Style Sheets), 69, 266 display names, 80
dividers, HTML tags for, 280, 284, 290
Division tag (HTML), 283

o e Align Division tag (HTML), 283
Dashboard (on Blogger), 87 Document Type tag (HTML), 279
Date Options (YouTube), 144 domain name, 11, 12, 256, 266
Dean, Howard, 74-75 Download (Web site), 97, 110, 126, 129, 139,
decompression, sound, 122 143, 174, 206, 260
Define Form tag (HTML), 281 download speed, 105-106
Define Frame tag (HTML), 294 download times

Display Document tag (HTML), 294 and access speed, 105-106

Frame Name tag (HTML), 294 and design simplicity, 33

Margin Height tag (HTML), 294 and graphics, 27

Margin Width tag (HTML), 294 and image sizes, 94

Not Resizable tag (HTML), 294 reducing, 38

Scroll Bar? tag (HTML), 294 and text-only access, 107
Define Table tag (HTML), 284 downloading

Cell Padding tag (HTML), 285 music, 121, 126

Cell Spacing tag (HTML), 285 sound, 124-129

Desired Width tag (HTML), 285 Dreamweaver (Macromedia),

Table Border tag (HTML), 284 46, 47, 155, 174-175

Width Percent tag (HTML), 285 DSL (Digital Subscriber Line), 27, 267
Define Target tag (HTML), 280 dynamic HTML (DHTML), 266
Defined Content tag (HTML), 287
definition, structural, 279, 283, 287-288
definition data, 171, 217 ® E ®
Definition List tag (HTML), 281 editing
definition lists, 171, 217, 266 live, 50
definition term, 171, 217 of picture Web sites, 18
Delete tag (HTML), 287 e-mail

Comments tag (HTML), 288 address, as Web site name, 51

Time of Change tag (HTML), 288 defined, 267
Department of Defense, 272 forwarding to Google account, 54
descriptions (in Flickr), 117 linking to Web pages. See mailto links
design, Web page. See Web page design embed command, 123-125, 223, 267
Desired Width tag (HTML), 292 Embed Object tag (HTML),
destination anchor, 193, 239 185, 187, 230, 231, 289
DHTML (dynamic HTML), 266 Object Size tag (HTML), 289
Diaryland (Web site), 76 Emphasis tag (HTML), 279
Digital Subscriber Line (DSL), 27 end tag (HTML), 166, 212
Digital Video For Dummies (Keith English language, on the Web, 28

Underdahl), 140 entertainment Web sites, 22-23
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Expression Web (Microsoft), 174-175, 299
external links, 250

in CoffeeCup HTML Editor, 176-177

and HTML editors, 219-222

in Notepad, 221-222

for sound, 127

and WYSIWYG editors, 175-177

to YouTube, 137
extranet, 20

ofF e
Fabrik home page, 26-27
Facebook, 9, 255, 258
FAQ pages, 239-241
Fasthosts, 256
FCC (Federal Communications
Commission), 133
feedback, 249, 253
56K, 265
file size
of graphics, 27
of images, 91-102, 94
recommended for Web page, 251
file transfer protocol. See FTP
File Upload tag (HTML), 291
filenames
capitalization in, 243
extensions for, 207
files, CD, 298
“finite automation,” 211
firewall, 267
Flag as “may offend” feature (Flickr), 117
flaming, 253
Flash, 22, 141, 232
Flickr
about, 12, 14, 18, 90
and blogs, 117
capabilities of, 109-110
modifying photos with, 116-119
potential concerns, 111-112
privacy on, 111, 114-115, 117
uploading photos with, 112-116
Font Color tag (HTML), 288
Font feature (Notepad), 206
Font Size tag (HTML), 288

fonts
serif versus sans serif, 67
sizes of, 167, 214
specifying, 168, 214-215
For Dummies Web site, 11, 13-14, 34-35,
65-66
Ford Motor Company, 248
Foreign and Commonwealth Office (U.K.),
136
form, 267
format, interlaced, 95
Format menu (Notepad), 207
formatting
character, 167-168, 214-215
of existing text, 70
text in Notepad, 215-216
text with CoffeeCup HTML Editor,
168-169
text with HTML (HyperText Markup
Language), 167-169, 214-216
formatting tags, 164, 211
forms
described, 154
HTML tags for, 281-282, 291-292
forwarding, e-mail, 54
Frame Document tag (HTML), 293
Border Color tag (HTML), 294
Border Width tag (HTML), 293
Borders tag (HTML), 293
Column Widths tag (HTML), 293
Row Heights tag (HTML), 293
frame rate, 134
frames
described, 43, 47
HTML tags for, 293-294
and Netscape Navigator 2.0, 277
freeware, 267
FrontPage (Microsoft), 46, 47, 155
FrontPage Express (Microsoft), 299
FTP (file transfer protocol), 10, 260, 267

oG o
GeoCities, 38, 42, 256
Getty Images, 103
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GIF (Graphics Interchange Format),
95, 251, 267
animated, 265
compressing, files, 102
converting images to, 104
described, 93, 94
in early Web, 179, 223
JPEG versus, 93-96
transparent, 272
GIFConverter, 104
Gmail, 49, 51
goals
of business Web sites, 24
of personal Web sites, 16, 17
for Web publishing, 29-30
“going viral,” 187
Google
about, 49-50, 248
and Blogger.com, 78, 257
international home page, 53
logo, 53
and naming, 51-52
registering for account on, 52-55
searching for graphics with, 103
toolbar, 53
and YouTube, 136
Google Labs, 49-50
Google Mail, 49, 51
Google Maps, 50
Google News, 49
Google News Alerts, 50
Google Page Creator
about, 49-50
capabilities of, 50-51
hosting pages on, 255-260
and naming, 51-52
using, 56-59
Google Scholar, 50
Google SiteMapper, 153
government Web sites, 103
graphic design, professional, 43
graphical user interface (GUI), 267
graphics. See also images; photo(s)
compressed versus uncompressed, 38
consistency with, 37
and copyright, 97, 105
defined, 91, 251
designing with, 105-108

and download time, 27
file size of, 27
HTML tags for, 280, 283, 288-289
inline, 97
obtaining and creating, 102-105
spot, 27
Graphics Interchange Format. See GIF
Greater Than (>) tag (HTML), 281
Group Columns tag (HTML), 293
Columns Spanned tag (HTML), 293
Group Width tag (HTML), 293
Width Percent tag (HTML), 293
Group Elements tag (HTML), 292
GUI (graphical user interface), 267

o/ o
hard drive, copying to, 260
head (HTML tag), 166, 213
Header tag (HTML), 279
headers, in HTML, 67
Heading tag (HTML), 279
headings, in HTML, 167, 214
help, with CD-ROM, 302
hexadecimal counting, 268
“hidden” HTML, 195
hit, 268
hit counter, 22
home page, 13, 268
Homestead, 42
Hometown area (of AOL), 38, 42, 76
Horizontal Rule tag (HTML), 280
hosting, Web pages, 255-258
hot spots, 266
href (hypertext reference), 176, 220
HTML, XHTML & CSS For Dummies (Ed
Tittel and Jeff Noble), 22, 163, 211
HTML (HyperText Markup Language)
advantages of, 162
for blogs, 86
capabilities of, 64, 67-68
creating lists in, 170-174, 217-219
described, 10, 63, 162-163, 175, 209-211,
268
for downloading sound, 127
downsizing images with, 92
dynamic, 266
experimenting with, 15
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formatting text with, 167-169, 214-216
“hidden,” 195
and JPEG files, 125
for linking images, 181-182
and MySpace, 132
for sound, 123-124
straight, 69
for tables, 44-45
versions of, 25, 275, 276-277
viewing in, 165, 211, 212
HTML 2.0, 276
HTML 3.2, 277
HTML 4 For Dummies (Ed Tittel), 277
HTML 4.0, 277
HTML 4.01, 268
HTML editors
adding images with, 224-229
adding sound with, 229-231
adding video with, 231-233
described, 155
and external links, 219-222
formatting text with, 214-216
and internal links, 238-241
and lists, 217-219
and mailto links, 235-238
setting up Web pages in, 212-213
and text navigation bar, 241-243
WYSIWYG editors versus, 152-153,
202-204
HTML pages, model, 213
HTML tags
ALT, 108, 251
anchors, 220
for backgrounds and colors, 284
begin, 166, 212
bgsound, 185, 187, 230, 231
body, 166, 213
and browsers, 277
closing off, 218
described, 13, 163, 164, 210, 272, 275-276
for dividers, 280, 284, 290
embed, 185, 187, 230, 231
end, 166, 212
for Flickr, 118
formatting, 164, 211
for forms, 281-282, 291-292
for frames, 293-294
general, 166, 212-213, 279

on Google Page Creator, 50
for graphics, 280, 283, 288-289
head, 166, 213
linking, 164, 211
for links, 280, 283, 288-289
for lists, 281, 290-291
meta, 166, 213
miscellaneous, 282, 286-287, 295
optional, 278
page title, 166, 213
for presentation formatting, 280, 283, 288
for sound, 288-289
for special characters, 281
for structural definition, 279, 283, 287-288
for tables, 284-286, 292-293
HTML-tagged text, 163, 210
HTTP (HyperText Transfer Protocol),
10, 175, 221, 268
humor, in Web writing, 71
Hyper Text Transfer Protocol. See HTTP
Hypergurl, 132
hyperlinks. See link(s)
hypertext, 10
HyperText Markup Language. See HTML
hypertext reference (href), 176, 220

o]e
“I exist” Web pages, 14
icons (for book), 5-6
identity theft, 18
iLife, 128, 139
Image Map tag (HTML), 289
image maps, clickable, 266
images. See also graphics; photo(s)
and copyright, 111
designing with, 105-108
and download time, 27
embedded text in, 40
errors in using, 106-107
and file size, 91-102
finding URLs of, 180, 224
GIF versus JPEG formats, 93-96
and HTML editors, 224-229
obtaining and creating, 102-105
photo-realistic, 91
in repurposing text, 70
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images (continued)

resizing and saving, 96-101

scanned, 103

terms for, 91

thumbnail, 184, 251

transparent, 96

and WYSIWYG editors, 180-184
ImageState, 103
IMG command, 223
improvements, planning for, 29-30
indent, relative, 68
information

confidential, 21

personal, 77. See also privacy
inline graphics, 97
Input Box Size tag (HTML), 282

Name of Box tag (HTML), 282
Input Field tag (HTML), 281

Checked? tag (HTML), 281

Field Name tag (HTML), 281

Field Size tag (HTML), 281

Field Value tag (HTML), 281

Max Length tag (HTML), 281
Insert Table command (CoffeeCup), 46
Insert tag (HTML), 287

Comments tag (HTML), 287

Time of Change tag (HTML), 287
Inside Frame tag (HTML), 294
InsightPoint (program), 110
installing, CD files, 298
Integrated Services Digital Network (ISDN),

268

interactive previewing, 202
interlaced format, 95
internal anchor, 195
internal links

in CoffeeCup HTML Editor, 194-195

with HGML, 238-241

in Notepad, 240-241

with WYSIWYG, 193-195
International Standards Organization

1S0), 271

Internet

communication via, 1

described, 269

text-only, 89-90

and World Wide Web, 10

Internet access, 11

Internet address. See URLs

Internet Explorer, 10, 13, 15, 28, 44, 72, 84,
98, 124, 193

Internet Protocol (IP), 269

Internet Service Provider. See ISP

intranet, 20, 269

intros (video), 141

IP (Internet Protocol), 269

iPhone, 257

ISDN (Integrated Services Digital Network),
268

ISO (International Standards Organization),
271

ISP (Internet service provider), 2, 11, 269

Italic tag (HTML), 280

italic text, 68, 69

iTunes, 121

Java (programming language), 23, 269
Java Applet tag (HTML), 286
Alignment tag (HTML), 287
Alternate Text tag (HTML), 286
Applet Code Location tag (HTML), 286
Applet Name tag (HTML), 286
Applet Window Height tag (HTML), 286
Code Base Directory tag (HTML), 286
Horizontal Offset tag (HTML), 286
Width tag (HTML), 286
JavaScript, 123, 124, 253, 269
JavaScript For Dummies (Emily A. Vander
Veer), 123
Jefflowe (Web site), 16
Joint Photographic Expert Group. See JPEG
JPEG (Joint Photographic Expert Group)
files
compressing, 102
and HTML, 125
JPEG (Joint Photographic Expert Group)
format
converting images to, 104, 251
described, 18, 90, 91, 95, 269
in early Web, 179, 223
GIF versus, 93-96
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oK o
Keyboard Output tag (HTML), 279
KissYouTube (Web site), 139

o/ o
Label tag (HTML), 291
Item Labeled tag (HTML), 291
Large Font Size tag (HTML), 283
layout
on Google Page Creator, 56
with tables, 45-46
in Web publishing, 26-27
Legend tag (HTML), 292
Alignment tag (HTML), 292
Less Than (<) tag (HTML), 281
Letterman, David, 170, 217
lighting, for video, 141
Line Break tag (HTML), 280
link(s)
described, 176, 269
to e-mail addresses. See mailto links
external, 175-177, 219-222
as focal points, 70
HTML tags for, 280, 283, 288-289
identifying, by color, 39
to images, 180-184, 224-229
internal, 193-195, 238-241
mailto, 189-193, 235-238
on personal Web sites, 17
titles of, 221
to Web URLs, 180, 224
Link Color tag (HTML), 284
Link tag (HTML), 280
Link to Target tag (HTML), 280
linking tags, 164, 211
Linux operating system, 2
list(s)
advantages of using, 170-171
bulleted, 171, 217, 266
creating, in HTML, 217-219
creating, with CoffeeCup HTML Editor,
172-174
definition, 171, 217, 266
in HTML, 68
HTML tags for, 281, 290-291
nested, 172, 217

numbered, 171, 217
ordered, 171, 217, 270
unordered, 171, 217, 272
list items, 171, 217
LiveJournal, 76, 78
Lopuck, Lisa, 33
lossless compression, 266
lossy compression, 266
Lowe, Jeff, 16
Low-Res Proxy tag (HTML), 289
LView, 104
Lycos, 42

ol o
.Mac, 257
Macintosh computer (Mac), 90
capturing screen images with, 97
creating MP3s with, 128
editing video on, 139
text editing on, 201
using CD on, 2, 298
mailto links
in CoffeeCup HTML Editor, 191-193
described, 189-191, 235
and HTML editors, 236-238
in Notepad, 237-238
and WYSIWYG editors, 189-193
Map Options (YouTube), 144, 145
Map tag (HTML), 289
Martinreddy (Web site), 104
mashups, 15
Melville, Herman, 71
Meta Information tag (HTML), 282
meta tags, 166, 213
Microsoft, 50
Microsoft Paint, 97, 98-101, 103
Microsoft Web page, 40, 41
Microsoft Word, 202
mirroring, 269
Mobile Internet For Dummies (Michael
O’Farrell), 28
mobile phone(s)
posting from, 87
registering with Google via, 51
and tables on Web sites, 45
on the Web, 34, 108
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MobileMe, 257
Moby-Dick (Herman Melville), 71-72
model HTML pages, 213
“model” navigation bar, 196, 242
model releases, 140
Model T Ford, 90
model Web pages, 215, 247
models, for Web page design, 41-42
modem
cable, 266
speed of, 27
monitors, for text editing, 203
Motion Pictures Experts Group format. See
MPEG format
Mouseout Action tag (HTML), 289
Mouseover Action tag (HTML), 288
.MOV format, 140
Movable Type, 76
Mozilla Firefox, 10, 13, 28, 125, 299
MP3 (MPEG audio compression) files, 125-129
MP3 (MPEG audio compression) format,
122, 134, 269
.MP4 format, 140
MPEG audio compression. See MP3
MPEG (Motion Picture Experts Group)
format, 134, 140, 269
multimedia, 251, 270. See also sound; video
music, downloading, 121, 126
MySpace
about, 129-130
adult content on, 23
joining, 130-131
posting sound on, 132

o\ o
N1.1 Client Pull tag (HTML), 289
names, display, 80
naming (Web page)
on Blogger, 81
in Google, 51-52
navigation
adding, to Web sites, 261
with internal links, 193-195, 238-241
within sites, 250

navigation bar
creating, 195-198, 241-243
primary, 195, 196
utility, 195
navigation blocks, consistency with, 37
nested lists, 172, 217
netiquette, 252-253
Netscape, 104
Netscape Navigator, 10, 299
version 1.0 of, 276
version 1.1 of, 276
version 2.0 of, 277
Network Solutions, 255-256
“New” icons, 254
newsgroup, 270
Nielsen, Jakob, 67
Ning (hosting service), 258
No Break tag (HTML), 290
Notepad
adding images in, 226-229
adding sound in, 230-231
adding video with, 232-233
advantages and disadvantages of, 205
advantages of, 220
creating external links in, 221-222
creating lists in, 217-219
creating mailto links with, 237-238
formatting text in, 215-216
internal links in, 240-241
mailto links in, 237-238
as text editor, 206-208
text navigation bars in, 242-243
text-processing with, 73
WordPad versus, 73, 206
numbered lists, 171, 217
Numbering Type tag (HTML), 291

o () e

Obama, Barack, 75

Object tag (HTML), 289
offensive content, 249, 253
online services, 50, 270
online tools, 259-260
Opera (Web browser), 10
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operating system requirements, 2
Option, 278
Option Group tag (HTML), 291
Option tag (HTML), 282

Default Option tag (HTML), 282
optional tags, 278
Order prints feature (Flickr), 116
ordered list, 171, 217, 270
Ordered List tag (HTML), 281
organizing, picture Web sites, 18
Organizr (program), 119
Other Content tag (HTML), 295
outros (video), 141
overwriting, images, 92

opPe

padding, 227, 228. See also white space

page title tag (HTML), 166, 213
page views, 30
page-description language, 270
Pagemill, 299
Paint (Microsoft), 97, 98-101, 103
Paint Shop Pro (PSP) files, 93
Paragraph tag (HTML), 280, 284
Align Text tag (HTML), 284
No Line Breaks tag (HTML), 284
Parameters tag (HTML), 289
Password Strength meter (Google
accounts), 54
passwords, 20, 21, 54
pathname, 11-12, 270
PCs For Dummies (Dan Gookin), 297
PDF files, 66
permission
for business Web sites, 21
for formatting Web pages, 165
and MP3 files, 126
for using content, 73-74, 249-250
for using HTML, 212
for using images, 97, 105, 111
for video downloading, 139
personal information
on blogs, 77
sharing. See privacy
personal Web sites, 16-18, 42

photo(s)
defined, 91
modifying, with Flickr, 116-119
sharing, on Flickr, 109
sharing, on Web sites, 18, 90
uploading, with Flickr, 112-116
Web sites for sharing, 18
photo files, 90, 94
photo-realistic image, 91
Photoshop (Adobe), 93, 103
Photoshop Document (PSD), 93
Photoshop Elements (Adobe), 97
Photoshop Express (Adobe), 110
PhotoWorks, 104
pictures. See photo(s)
pilot project, Web site as, 25
plagiarism, 73
plain-text documents, 163, 210
planning
for large Web sites, 25
for Web publishing, 248-249
player applications, 180, 223
plug-in, 270
PNG graphics, 179, 223
posting, to blog, 84-85
predictability, in design, 35-37
Preformatted tag (HTML), 280
Width tag (HTML), 280

Index

presentation formatting, 280, 283, 288

Presidential campaign (2008), 75
previewing Web pages, 202-203
primary navigation bar, 195, 196
printing, framed pages, 47
privacy

on Flickr, 111, 114-115, 117

at Google, 56

and personal Web sites, 18

on shared computers, 112
Project Gutenberg, 71
Prologue tag (HTML), 282
Prompt tag (HTML), 295
protocol, 11, 12, 270
PSD (Photoshop Document), 93
PSP (Paint Shop Pro) files, 93
publicizing, for Web site, 253
Pyra Labs, 78
pyramid style, 64
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(e

QuickTime, 271

QuickTime VR, 271

Quote tag (HTML), 287
Citation tag (HTML), 287

o R o
RAM, 302
readability, 39-40
reading, on computers, 64-65
Really Simple Syndication (RSS), 261
RealPlayer, 125
recompression, 102
Registered TM tag (HTML), 281
registering, for Gmail account, 52-55
rehearsal (video), 141
Relationship tag (HTML), 282
relative address, 271
relative indent, 68
REM (musical group), 140
requirements, for using book, 2
resizing
framed pages, 47
images, 91, 92, 96-101, 183-184, 228-229
photos, 110
response, to Web site, 30
restricted access networks, 20
Rotate feature (Flickr), 116
RSS (Really Simple Syndication), 261
Runaround Space tag (HTML), 289

oS e
Safari (Web browser), 10, 13
Sample Output tag (HTML), 279
saving
image files, 104
photos on Flickr, 115
scanned images, 103
screen capture, 96-101
Script tag (HTML), 286
Language tag (HTML), 286
Location tag (HTML), 286
Type tag (HTML), 286
Scripting (Web site), 74-75

scrolling, on framed pages, 47
searching
for domain names, 256
in Google, 55
on YouTube, 137-139
Section tag (HTML), 289
Select Font tag (HTML), 288
Selection List tag (HTML), 281
# of Options tag (HTML), 282
Multiple Choice tag (HTML), 282
Name of List tag (HTML), 282
servers, Web, 252, 273
Settings (on Blogger), 86
SGML (Standard Generalized Markup
Language), 271
shareware, 271
Sharing Options (YouTube), 145
shrink-wrapped software, 271
Simpletext (program), 201
simplicity, in design, 33-34
site management, 271
site maps, 248
size
font, 167, 214
of graphics, 27
of images, 91-102, 94
recommended for Web page, 251
relative versus absolute, 67
of text, 39-40
slow-loading pages, 38
Small Font Size tag (HTML), 283
Smith, Olga, 20
social networks, creating, 258
software
for blogging, 76
replacing, with online services, 50
shrink-wrapped, 271
Solid Line tag (HTML), 290
Sorenson codec, 141
sound
adding, in HTML, 229-231
adding, with CoffeeCup HTML Editor,
185-187
compressing and decompressing, 122
creating MP3 files, 127-129
by download, 124-129
finding MP3 files, 125-127
HTML tags for, 288-289
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loops of, 187
posting, on MySpace, 129-132
using, on Web page, 123-124
for videos, 141-142
Sound Recorder (application), 128-129
source anchor, 193, 239
spamming, 252
Special Character tag (HTML), 281
special characters, HTML tags for, 281
speed, access, 27, 105-106
spell-checking, 86
spot graphics, 27
standard, 271
Standard Generalized Markup Language
(SGML), 271
Starting Number tag (HTML), 291
Statcounter, 22
“stepping on” images, 95
straight HTML, 69
Strikeout tag (HTML), 288
Strong Emphasis tag (HTML), 279
structural definition, HTML tags for, 279,
283, 287-288
Submit-It Web site, 253
“sub-PC” devices, 28, 34
Subscript tag (HTML), 283
succession planning, 20
Superscript tag (HTML), 283
Switzerland, 28
syntax, 271
system operator (sysop), 272
system requirements
for CD-ROM, 297
for CoffeeCup HTML editor, 156

oJ o

Table Alignment tag (HTML), 292

Table Body tag (HTML), 292

Table Caption tag (HTML), 286
Alignment tag (HTML), 286

Table Cell tag (HTML), 285
Alignment tag (HTML), 285
Columns to Span tag (HTML), 285
Desired Height tag (HTML), 285
Desired Width tag (HTML), 285
Height Percent tag (HTML), 285

No Line Breaks tag (HTML), 285
Rows to Span tag (HTML), 285
Width Percent tag (HTML), 285
Table Color tag (HTML), 292
Table Footer tag (HTML), 292
Table Frame tag (HTML), 292
Table Header tag (HTML), 285, 292
Alignment tag (HTML), 285
Columns to Span tag (HTML), 285
Desired Height tag (HTML), 286
Desired Width tag (HTML), 286
Height Percent tag (HTML), 286
No Line Breaks tag (HTML), 285
Rows to Span tag (HTML), 286
Width Percent tag (HTML), 286
Table Row tag (HTML), 285
Alignment tag (HTML), 285
Table Rules tag (HTML), 292
tables
creating, 43-46
HTML tags for, 284-286, 292-293
tabs (navigation bar), 241
tags
in Flickr, 117
in HTML. See HTML tags
on images, 114
on videos, 144
Target Window tag (HTML), 288
TCP/IP (Transmission Control Protocol/
Internet Protocol), 272
technical support, for CD-ROM, 302
Technorati, 76
Template (on Blogger), 86, 87
templates, 37, 83
Terms of Service, 81
testing, Web pages, 13, 37, 205, 252
text. See also Web writing
alt, 183, 227, 251
editing for the Web, 28-29
embedded, 40
formatting, 167-169, 214-216
HTML-tagged, 163, 210
size of, 39-40
using colored, 170
text bites, 28-29
Text Color tag (HTML), 284
text editor, 272
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text editors
described, 155
HTML in, 209-211
Notepad as, 205-208
sample Web pages for, 204-205
using, with WYSIWYG editors, 205
WYSIWYG editors versus, 202-204
text files, photo files versus, 94
text navigation bar
creating, with CoffeeCup HTML Editor,
196-198
in HTML, 241-243
text-only access, 107-108
Thickness tag (HTML), 290
thumbnail images, 184, 251, 272
Tiled Background tag (HTML), 284
time commitment, for blogging, 77
Time Warner, 256
title attribute, 221
Title tag (HTML), 279
titles
in Flickr, 117
on Google Page Creator, 56
tool tips, 177, 183, 222
toolbar, Google, 53
tools
adding, to Web sites, 261
online, 259-260
topical Web sites, 19-20, 77
Transmission Control Protocol/Internet
Protocol (TCP/IP), 272
transparent GIF (Graphic Interchange
Format), 272
transparent images, 96
Tripod (Web host), 42
troubleshooting, for CD-ROM, 302
TypePad (Web-logging service), 76
Typewriter tag (HTML), 280

olf o

Ultimate Paint, 97

“Under Construction” signs, 30
Underline tag (HTML), 288

Unframed Content tag (HTML), 294
Uniform Resource Locators. See URLs

United States
domain names in, 266
web penetration in, 28
Unix operating system, 2
unordered list, 171, 217, 272
Unordered List tag (HTML), 281
updating, Web pages, 29-30, 254
uploading
photos to Flickr, 112-116
video to YouTube, 143-148
URL of This File tag (HTML), 282
URL symbol, 278
URLs (Uniform Resource Locators)
described, 3, 11-12, 272
getting, 260-261
on Google Page Creator, 56
on hold, 256
of Web image, 180, 224
usage, monitoring, 22
USC Annenberg Online Journalism
Review, 67
Useit (Web site), 67
utility navigation bar, 195

o/ e
Vander Veer, Emily A., 123
Variable tag (HTML), 279
verification characters, 55, 80, 131
verification e-mails, 55
video
adding, with CoffeeCup HTML Editor,
187-188
adding, with HTML Editors, 231-233
capturing, 139-142
clips versus streaming, 135
compressing, 133-134
converting, for YouTube, 143
finding, online, 137-139
length of, 134-135
sound for, 141-142
tips for making, 141-142
uploading, to YouTube, 143-148
View Blog option (on Blogger), 86
View Source command, 46, 165, 211
viruses, from music downloads, 125-126
Visited Link tag (HTML), 284
visually impaired users, 55, 107
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o[/ o
warning labels, for offensive content, 23,
253
WAV files, 129
WAV format, 122
Web. See World Wide Web
Web 1.0, 32
Web 2.0, 32, 258
Web address. See URLs
Web authoring, 273
Web browser. See browser(s)
Web burnout, 25
Web cameras, 142, 147
Web client, 273
Web Design For Dummies (Lisa Lopuck), 33
Web History feature (Google accounts), 55
Web logs. See blogs
Web Marketing For Dummies (Jan
Zimmerman), 22
Web page(s)
creating. See Web publishing
described, 10, 13, 273
model, 215, 247
places to host, 255-258
recommended size of, 251
sample, 204-205
setting up in HTML, 212-213
specializing, 16
testing, 13, 252
updating, 254
viewing HTML in, 211, 212
Web sites from, 259-262
Web page design, 24, 25
common errors in, 38-40
consistency in, 37
with graphics, 105-108
modeling, on others, 41-42
predictability in, 35-37
principles of, 32-38
as process, 40-43
simplicity in, 33-34
with tables and frames, 43-47
Web professionals, 32
Web publishing
audience for, 28, 247-248
basics of, 248
described, 273

and design, 24, 25
and download times, 27
external links in, 250
and feedback, 253
graphics and multimedia in, 251
guidelines for, 23-30
layout in, 26-27
netiquette for, 252-253
and permission, 249-250
planning for, 248-249
and planning for improvements, 29-30
as process, 12-15
reasons for, 23-24
setting goals for, 29-30
and testing Web pages, 252
text bites in, 28-29
updating sites, 254
Web Reference Writing Well for the Web
(site), 67
Web servers, 252, 273
Web site(s)
adding blogs to, 261
adding navigation to, 261
adding outside opinion on, 261
adding tools to, 261
business, 20-22
copying to hard drive, 260
described, 10, 13, 273
developing, 261
entertainment, 22-23
getting URL for, 260-261
government, 103
modeling of, 29
and online tools, 259-260
personal, 16-18
picture, 18
and sound, 123
specializing, 259
topical, 19-20
types of, 15-23
using FTP, 260
using links to create, 189-198, 235-243
from Web pages, 259-262
Web pages versus, 196
Web Site Color Schemer, 300
Web surfing, 65
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Web writing, 28-29. See also blogs
accuracy in, 65
and copyright, 73-74
described, 64-66
in HTML, 67-69
humor in, 71
sources of, 67
using existing text in, 69-73
Web-graphic designers, 43
Weblogs (Web site), 76
Webmaster, 24
WebReference site, 102-103
Web-safe color palette, 39, 92
Weebly, 258
Werbach, Kevin, 275-276
What You See Is What You Get Web page
editors. See WYSIWYG editors
white space, 32, 227, 228
Width Percent tag (HTML), 290
Width tag (HTML), 290
wiki, 273
Wikipedia, 273
Windows Clipboard, 98
Windows Media Player, 125
Windows Movie Maker, 139
Windows Vista (Microsoft), 2
Windows Vista For Dummies (Andy
Rathbone), 297
Windows XP (Microsoft), 2
Windows XP For Dummies (Andy
Rathbone), 297
Winer, Dave, 74-75
WMV format, 140
Word (Microsoft), 202
Word Break tag (HTML), 290
word count, for print versus Web, 66
word processor
creating Web documents with, 163
described, 273
editing text in, 204
WordPad, Notepad versus, 73, 206
WordPress, 78, 257
word-processing files, on Web pages, 72

WordStar, 202
World Wide Web, 1, 273
addresses on, 11-12
described, 9-10
English on, 28
and Internet, 10
and ISPs, 11
popularity of, 17
as series of Web pages, 35
terms used with, 13
World Wide Web consortium, 9, 275
Wrap Text tag (HTML), 291
writing, for Web sites. See Web writing
WYSIWYG editors. See also CoffeeCup
HTML Editor
CoffeeCup HTML Editor as, 154-159
external links, 175-177
formatting text in, 167-169
HTML editing versus, 152-153, 202-204
images in, 180-184
internal links, 193-195
lists in, 170-174
mailto links in, 189-193
navigation bar in, 195-198
sound in, 185-187
using, with text editors, 205
video in, 187-188

o X o

XML, 50

° y °

Yahoo!, 50, 111, 256

YouTube
adult content on, 23
advantages of, 187, 188, 231-232
capturing video for, 139-142
uploading videos to, 143-148
and video compression, 134
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Wiley Publishing, Inc.
End-User License Agreement

READ THIS. You should carefully read these terms and conditions before opening the software
packet(s) included with this book “Book”. This is a license agreement “Agreement” between you
and Wiley Publishing, Inc. “WPI”. By opening the accompanying software packet(s), you acknowl-
edge that you have read and accept the following terms and conditions. If you do not agree

and do not want to be bound by such terms and conditions, promptly return the Book and the
unopened software packet(s) to the place you obtained them for a full refund.

1. License Grant. WPI grants to you (either an individual or entity) a nonexclusive license to
use one copy of the enclosed software program(s) (collectively, the “Software”) solely for
your own personal or business purposes on a single computer (whether a standard com-
puter or a workstation component of a multi-user network). The Software is in use on a com-
puter when it is loaded into temporary memory (RAM) or installed into permanent memory
(hard disk, CD-ROM, or other storage device). WPI reserves all rights not expressly granted
herein.

2. Ownership. WPI is the owner of all right, title, and interest, including copyright, in and to
the compilation of the Software recorded on the physical packet included with this Book
“Software Media”. Copyright to the individual programs recorded on the Software Media is
owned by the author or other authorized copyright owner of each program. Ownership of
the Software and all proprietary rights relating thereto remain with WPI and its licensers.

3. Restrictions on Use and Transfer.

(@ You may only (i) make one copy of the Software for backup or archival purposes, or
(ii) transfer the Software to a single hard disk, provided that you keep the original
for backup or archival purposes. You may not (i) rent or lease the Software, (ii) copy
or reproduce the Software through a LAN or other network system or through any
computer subscriber system or bulletin-board system, or (iii) modify, adapt, or create
derivative works based on the Software.

(b) You may not reverse-engineer, decompile, or disassemble the Software. You may
transfer the Software and user documentation on a permanent basis, provided that the
transferee agrees to accept the terms and conditions of this Agreement and you retain
no copies. If the Software is an update or has been updated, any transfer must include
the most recent update and all prior versions.

4. Restrictions on Use of Individual Programs. You must follow the individual requirements
and restrictions detailed for each individual program in the “About the CD” appendix of this
Book or on the Software Media. These limitations are also contained in the individual license
agreements recorded on the Software Media. These limitations may include a requirement
that after using the program for a specified period of time, the user must pay a registration
fee or discontinue use. By opening the Software packet(s), you agree to abide by the licenses
and restrictions for these individual programs that are detailed in the “About the CD” appen-
dix and/or on the Software Media. None of the material on this Software Media or listed in
this Book may ever be redistributed, in original or modified form, for commercial purposes.
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5. Limited Warranty.

(@ WPI warrants that the Software and Software Media are free from defects in materi-
als and workmanship under normal use for a period of sixty (60) days from the date
of purchase of this Book. If WPI receives notification within the warranty period of
defects in materials or workmanship, WPI will replace the defective Software Media.

(b) WPI AND THE AUTHOR(S) OF THE BOOK DISCLAIM ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO
THE SOFTWARE, THE PROGRAMS, THE SOURCE CODE CONTAINED THEREIN, AND/
OR THE TECHNIQUES DESCRIBED IN THIS BOOK. WPI DOES NOT WARRANT THAT
THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS
OR THAT THE OPERATION OF THE SOFTWARE WILL BE ERROR-FREE.

(©) This limited warranty gives you specific legal rights, and you may have other rights
that vary from jurisdiction to jurisdiction.

6. Remedies.

(@) WPT’s entire liability and your exclusive remedy for defects in materials and work-
manship shall be limited to replacement of the Software Media, which may be
returned to WPI with a copy of your receipt at the following address: Software Media
Fulfillment Department, Attn.: Creating Web Pages For Dummies, 9th Edition, Wiley
Publishing, Inc., 10475 Crosspoint Blvd., Indianapolis, IN 46256, or call 1-800-762-2974.
Please allow four to six weeks for delivery. This Limited Warranty is void if failure
of the Software Media has resulted from accident, abuse, or misapplication. Any
replacement Software Media will be warranted for the remainder of the original war-
ranty period or thirty (30) days, whichever is longer.

(b) In no event shall WPI or the author be liable for any damages whatsoever (including
without limitation damages for loss of business profits, business interruption, loss of
business information, or any other pecuniary loss) arising from the use of or inability
to use the Book or the Software, even if WPI has been advised of the possibility of
such damages.

(©) Because some jurisdictions do not allow the exclusion or limitation of liability for
consequential or incidental damages, the above limitation or exclusion may not

apply to you.

7. U.S. Government Restricted Rights. Use, duplication, or disclosure of the Software for
or on behalf of the United States of America, its agencies and/or instrumentalities “U.S.
Government” is subject to restrictions as stated in paragraph (c)(1)(ii) of the Rights in
Technical Data and Computer Software clause of DFARS 252.227-7013, or subparagraphs (c)
(1) and (2) of the Commercial Computer Software - Restricted Rights clause at FAR 52.227-19,
and in similar clauses in the NASA FAR supplement, as applicable.

8. General. This Agreement constitutes the entire understanding of the parties and revokes
and supersedes all prior agreements, oral or written, between them and may not be modi-
fied or amended except in a writing signed by both parties hereto that specifically refers to
this Agreement. This Agreement shall take precedence over any other documents that may
be in conflict herewith. If any one or more provisions contained in this Agreement are held
by any court or tribunal to be invalid, illegal, or otherwise unenforceable, each and every
other provision shall remain in full force and effect.
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Spin a great Web page
quickly and easily
with this friendly guide!

You don't need to be a pro designer to create your own
Web page.This book guides you past the pitfalls of page
design and construction so you can get online with as little
hassle as possible.Whether you want to go “old school”and
use HTML, experiment with online design options, or try
one of the easy editing tools included on the CD, you will
find the secrets to great pages right here!

* Get started — decide what kind of page you want to build and get
a finished product online quickly with Google Page Creator™

* Be designing — learn elements of design, common errors to
avoid, and how to create pages that get noticed

* Expand the possibilities — create photo, audio, and video content
that works for your page and find online resources for storing
your files

* Get down to basics — maintain control by creating and editing
pages in HTML with a text editor

* Take aride on easy street — develop your pages with the bonus
CD’s simple tools designed for beginning Web builders

Bonus CD Includes

Extended, fully functional trial versions of CoffeeCup

Schemer, all covered in the book.

complete system requirements.

Bud E. Smith has been writing For Dummies books since 1995 and is the
author of all previous editions of Creating Web Pages For Dummies. His

other books have covered AutoCAD, Web usability, Web marketing, and
Web graphics.

Software’s HTML Editor, Visual Site Designer, and Website Color

Available for Windows only; see the What’s On the CD Appendix for

Internet/Web Page Design

Open the book and find:

*Tips for picking the type of page
you want to build

* Insight on designing an attractive
and easy-to-use page

* Secrets of writing for the Web

*Ways to get your photos, video,
and audio files ready for your page

* Step-by-step instructions on
building a page with HTML, design
software, and online tools

*Trial versions of the design
software covered in the book

*The best places to post your page
after you're finished

Go to,
dummies.come
for more!

For Dummies®
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